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Preface

This manual explains the various tasks that can be performed using 
IBM® Sterling Call Center and IBM® Sterling Store.

Intended Audience
This manual is intended to provide assistance to customer service 
representatives who are using the Sterling Call Center and Sterling Store 
to capture and access information about orders. This manual is also 
intended for store users who capture and maintain orders after they are 
captured by the Sterling Call Center and Sterling Store.

Structure
This manual contains the following sections:

Chapter 1, "Using the IBM Sterling Call Center and IBM Sterling 
Store Dialogs and Windows"
This chapter discusses the structure of the Sterling Call Center and 
Sterling Store user interface and the various tasks that you can perform.

Chapter 2, "Tasks for a Customer Service Representative"
This chapter describes tasks that a customer service representative 
(CSR) may be required to perform frequently.

Chapter 3, "Tasks for a Store Representative"
This chapter describes the tasks that a store user may be required to 
perform frequently.
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For a description of the various documents in the Sterling Call Center and 
Sterling Store documentation set, see the Sterling Call Center and 
Sterling Store documentation home page at:

<INSTALL_DIR>/documentation/YCD_doc_home.html

<INSTALL_DIR> is the directory where Sterling Call Center and Sterling 
Store and the Sterling Selling and Fulfillment Foundation are installed.

Conventions
The following conventions may be used in this manual:

Convention Meaning

. . . Ellipsis represents information that has been omitted.

< > Angle brackets indicate user-supplied input.

mono-spaced text Mono-spaced text indicates a file name, directory path, 
attribute name, or an inline code example or command.
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/ or \ Slashes and backslashes are file separators for Windows, 
Unix, and Linux operating systems. The file separator for 
the Windows operating system is "\" and the file 
separator for UNIX and Linux systems is "/". The Unix 
convention is used unless otherwise mentioned.

<INSTALL_DIR> User-supplied location of the Sterling Selling and 
Fulfillment Foundation installation directory and Sterling 
Call Center and Sterling Store installation directory. This 
is only applicable for Release 8.0.

<ANALYTICS_HOME> User-supplied location of the Sterling Call Center and 
Sterling Store Business Intelligence Operational Reports 
installation directory.

Note: This convention is used only in the Sterling Call 
Center and Sterling Store: Business Intelligence 
Operational Reports Guide.

<COGNOS_HOME> User-supplied location of the Cognos installation 
directory.

Note: This convention is used only in the Sterling Call 
Center and Sterling Store: Business Intelligence 
Operational Reports Guide.

Convention Meaning
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1
Using the IBM Sterling Call Center and IBM

Sterling Store Dialogs and Windows

To get the most out of Sterling Call Center and Sterling Store, it is 
important to understand the structure of Sterling Call Center and Sterling 
Store and how it can best work to meet your business requirements.

This chapter discusses the structure of the Sterling Call Center and 
Sterling Store user interface and the various tasks that you can perform 
using this application.

Figure 1–1 illustrates the layout of the client application user interface.



2   User Guide

Figure 1–1 Layout of the Client Application User Interface

The Sterling Call Center and Sterling Store dialog elements provide:

Menu Bar—This bar contains various menu options or tasks provided 
in the application. You can select the appropriate task that you want 
to perform.

Menu Bar

Tasks or Related Tasks
Customer Messages CSR Messages

Quick AccessScratch Pad Announcements
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Customer Messages—Each screen in Sterling Call Center and Sterling 
Store displays appropriate customer messages to assist you in 
handling customer interaction smoothly. The customer’s name is 
displayed in the customer message panel, for example, the Quick 
Access screen has the following customer message:

CSR Messages—Each screen in the Sterling Call Center and Sterling 
Store has some CSR messages associated with it.

The messages on this panel display feedback about the tasks being 
performed and the updates that occur in the application. The number 
adjacent to the  (alerts) icon indicates the current number of open 
alerts. The panel also notifies users of newly assigned alerts. For 
more information about alert notifications, see Section 2.11.4, 
"Notifying Users of Assigned Alerts". Additionally the number adjacent 
to the  (announcements) icon indicates the number of latest 
announcements that are available.

Tasks/Related Tasks—This panel displays all the tasks and the related 
tasks that you can perform.

Scratch Pad—This panel allows you to jot down information during a 
call, copy information from one screen to another screen, and refer to 
the information later. The scratch pad can either be displayed within 

Note: In case of the store application, this panel displays 
appropriate messages to store users.

Note: In case of the Sterling Store application, this panel 
displays the status of the most recent action performed for 
various tasks.
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the Related Tasks panel or in a pop-up window. You can also hide or 
display the scratch pad by either using the corresponding option from 
the View menu or with an appropriate hot key. Table 1–1 describes 
the icons provided for performing certain basic functions in the 
scratch pad.

Quick Access—This panel provides visibility to orders, customers, 
items, and quotes.

Announcements—This panel displays all the announcements that have 
been created. Users who belong to a user group that has the 
necessary permissions can view the announcements panel.

Dialog Buttons—Table 1–2 describes the commonly used dialog 
buttons.

Table 1–1 Scratch Pad Icons

Icon Function

Highlight text in bold.

Cut the selected text.

Copy the selected text.

Paste the cut or copied text.

Clear the contents of the scratch pad.

Reverse the last action that was performed within the 
scratch pad.

Reverse the last Undo action within the scratch pad.

Note: When you click the  icon, a "Data may be lost!" 
warning message is displayed. Click Yes to clear the 
contents. Otherwise, click No.
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Table 1–2 Dialog Buttons

Help Assistant—This panel provides instructions about the tasks that 
you can perform in the corresponding screen. The How Do I panel 
lists all the tasks that you can perform. Click the Icon Legends 
hyperlink to view the details of the icons in the corresponding screen. 
Click the Back To Index hyperlink to return to the index page. Click 
the  icon to close the Help Assistant screen. You can also use the 
Esc key to close the Help Assistant screen.

Table Navigation—If the size of table column is small, then you can see 
the complete text by placing the cursor over the column.

Button Function

Search Searches for an order, item, or customer.

Close Closes the current window.

Next Displays the next screen.

Previous Displays the previous screen.

Confirm Confirms the changes and displays the Order 
Summary screen.

Reset Clears all data from the screen.
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Supported Resolutions

1.1 Utilizing the Keyboard Shortcuts and Hot 
Keys

Sterling Call Center and Sterling Store provides keyboard shortcuts and 
hot keys to help you work quickly. Some of these keys are available only 
during certain processes or operations. To invoke any action using hot 
keys, ensure that the focus is on any editor other than the Related Tasks 
panel. To view a list of hot keys and keyboard shortcuts supported by 
Sterling Call Center and Sterling Store, press Ctrl+Shift+L in any screen.

1.2 Applying Filters on Order Lines
Sterling Call Center and Sterling Store supports filtering of order lines 
from any screen that displays a list of order lines. In the screen where 
you can view the order lines for an order, right-click to apply a filter on 
the order lines.

If you select the "Filter On" criteria, the filter is applied to the 
selected item.

If you select the "Filter" criteria for an order line, the Filter pop-up 
screen appears. Enter the appropriate filter criteria information in the 
applicable fields.

To clear any applied filter, right-click and select Clear.

1.3 Supported Resolutions
Sterling Call Center and Sterling Store supports resolutions of 800 X 600 
pixels and 1024 X 768 pixels.

Note: Press Tab to traverse out of a text box in any 
screen in the Sterling Call Center and Sterling Store.
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2
Tasks for a Customer Service

Representative

The role of a Customer Service Representative (CSR) is to capture and 
maintain orders through Sterling Call Center and Sterling Store. The CSR 
typically deals with customers directly and takes the necessary action on 
an order in response to a telephone call or an e-mail message. CSRs are 
often required to investigate the alerts that are raised for orders that 
cannot be validated, or require special handling.

For more information about the general tasks that can be performed by a 
CSR through Sterling Call Center and Sterling Store, such as applying 
filters on order lines or utilizing keyboard shortcuts and function keys, 
see Chapter 1, "Using the IBM Sterling Call Center and IBM Sterling 
Store Dialogs and Windows".

Following are the tasks that a CSR performs frequently:

Performing Search Tasks

Answering Frequent Queries

Performing Order Tasks

Performing Opportunity and Quote Tasks

Performing Fulfillment Tasks

Performing Price Match Tasks

Performing Other Tasks on an Order

Performing Customer Tasks

Performing User Management Tasks

Performing Return Order Tasks
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Performing Search Tasks

Performing Alert and Queue Management Tasks

Performing Announcement Tasks

Setting User Preferences

Viewing the Documentation Library

Performing Report Tasks

Launching the IBM Sterling Business Center Application

2.1 Performing Search Tasks
This task assumes that you need to take some action on an existing 
order, customer, item, or quote in the Sterling Call Center and Sterling 
Store. You can communicate a customer’s request by means of a 
telephone call or an e-mail message. Generally, the customer knows the 
order number or has more information to help you locate the order, 
customer, item, or quote.

2.1.1 Searching for an Order
If you know the order number, telephone number, or the e-mail address 
of the customer, use the Quick Access screen to directly navigate to the 
order.

To search for an order:

1. If you have access to multiple enterprises, the Enterprise drop-down 
list is displayed. Select the enterprise for which you want to perform 
an order search.

2. Enter the complete order number, the telephone number, or the 
e-mail address of the customer in the Quick Access panel.

3. Click Find Order. 

If a single order exists for the search criteria you entered, the 
Order Summary screen is displayed.

If multiple orders exist for the search criteria you entered, the 
Order Search screen is displayed. Enter the appropriate 
information in the Order Search Criteria panel. Click Search. The 
Order List screen is displayed. Double-click the appropriate order 
number. The Order Summary screen is displayed. For more 
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information about viewing order summary details, see 
Section 2.1.4, "Viewing Order Summary".

2.1.1.1 Performing an Advanced Order Search
Using additional options, you can make your searches more precise and 
get more detailed information about the order number, customer’s 
telephone number, or the customer’s e-mail address.

To perform an advanced order search:

1. Do one of the following to open the Advanced Order Search screen:

From Tasks > Search, select Advanced Order Search.

In the Quick Access panel, enter the appropriate search criteria 
and click Find Order.

2. Enter the appropriate search criteria. Select the Order By option from 
the drop-down list based on which the records will be sorted. Select 
Ascending or Descending from the drop-down list and click Search. 
The search results are displayed in the Order List panel.

If you cannot find the pertinent order number, click  icon to show 
the search criteria. You can enter more restrictive search criteria for 
the selected task.

3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed. Click the View History Records hyperlink to 
retrieve orders from the history table. You can click the View Recent 
Records hyperlink to switch back to recent records.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.
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Performing Search Tasks

4. Double-click the appropriate order number. The Order Summary 
screen is displayed. For more information about viewing the order 
summary details, see Section 2.1.4, "Viewing Order Summary".

2.1.2 Searching for a Customer
If you know the customer's e-mail address, ID, phone number or the 
name of the business in case of a business customer, you can use the 
Quick Access screen to directly navigate to the customer.

To search for a customer:

1. If you have access to multiple enterprises, the Enterprise drop-down 
list is displayed. Select the enterprise for which you want to perform 
a customer search.

2. Select the customer type.

3. Enter the customer's e-mail address, user ID, phone number or the 
name of the business in case of a business customer.

4. Click Find Customer.

If a single customer exists for the search criteria you entered, the 
Customer Details screen is displayed.

If multiple customers exist for the search criteria you entered, the 
Customer Search screen is displayed. Enter the appropriate 
information in the Customer Search Criteria panel. Click Search. 

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 

Note: The Customer Type field is displayed based on the 
Order Entry rules configuration.
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The Customer List screen is displayed. Double-click the 
appropriate Customer. The Customer Details screen is displayed. 
For more information about viewing customer details, see 
Section 2.1.2.2, "Viewing Customer Details".

2.1.2.1 Performing an Advanced Customer Search
If you do not know the complete details of a customer such as the 
customer's id, phone number or e-mail address you can perform an 
Advanced Customer Search.

To perform an advanced customer search:

1. From Tasks > Search, select Advanced Customer Search.

2. Select the organization from the drop-down list.

Enter the appropriate search criteria and click Search. The search 
results are displayed in the Customer Search Results panel. If you 
cannot find the right customer, click  icon to show the search 
criteria. You can enter more restrictive search criteria for the selected 
task.

3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.
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Performing Search Tasks

4. Double-click the appropriate customer record. The Customer Details 
screen is displayed. For more information about viewing the customer 
details, see Section 2.1.2.2, "Viewing Customer Details".

2.1.2.2 Viewing Customer Details
You can view the details of consumer customers and business customers.

Viewing Consumer Customer Details
In the Customer Details screen, you can view the details of the customer 
such as the customer's name, ID, e-mail address, phone number, date of 
birth, bill to address and ship to address.

The customer's name, login ID, and status are displayed in the top 
panel.

In the Contact Information panel, you can view the customer's e-mail 
address, mobile phone number, day phone number, day fax number, 
evening phone number, evening fax number, date of birth, spouse's 
date of birth, and wedding anniversary.

In the Bill To Address panel, you can view the details of the 
customer’s bill to address.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 

Note: The Draft Orders, Order History, Return History, 
Opportunities, and Quote History tabs support pagination.

Note: Login cannot be changed after it has been entered 
and saved.
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In the Ship To Address panel, you can view the ship to address to 
which orders for this customer will be sent.

In the Draft Orders tab, you can view all the draft orders that exist 
for the customer. 

The Channel column indicates whether the orders were created (or 
last modified) in the Web or Call Center. To modify or confirm a draft 
order, double-click the appropriate record in the list of draft orders.

In the Order History tab, you can view the details of previous orders 
created for the customer. You can filter the list of orders by hold type 
and status. To filter by hold type, select a hold type from the Hold 
Type drop-down list, and click the Search button. To filter by status, 
select either Open, Backordered, or Shipped, and click the Search 
button. You can click the View History Orders hyperlink to retrieve 
orders from the history table. You can click the View Recent Orders 
hyperlink to switch back to recent records.

In the Return History tab, you can view the details of the return 
orders that were created for the customer.

In the Opportunities tab, you can view the details of the opportunities 
that were created for the customer.

In the Quote History tab, you can view details of all the quotes that 
were created for the customer. You can filter the list of quotes based 
on hold type and/or status. To filter by hold type, select a hold type 
from the Hold Type drop-down list, and click the Search button. To 
filter by status, select either the Open, Closed, or All Quotes, and 
click the Search button.

Open displays quotes that have neither been abandoned nor 
converted to orders.

Closed displays quotes that have either been abandoned or 
converted to orders.

All Quotes displays all the quotes that have been created for the 
customer up-to-date.

In the Addresses tab, you can view the additional addresses of the 
customer. Address descriptions, if any, will be displayed in the shaded 
panels above the addresses.

In the Payment Methods tab, you can view the details of the payment 
methods assigned to the customer.
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Performing Search Tasks

In the Important Notes panel, you can view and add additional 
information about the customer. For more information about viewing 
or adding notes, see Section 2.8.12, "Viewing and Adding Customer 
Notes and Contact Notes".

Viewing Business Customer Details
In the Business Customer Details screen, you can view the details of the 
business customer, such as the customer's name, ID, bill to address, and 
ship to address.

The customer’s business name, customer ID, and status are displayed 
in the top panel. You can click on the customer’s business name to 
access the customer’s Web site, if available, which will open in the 
default browser.

In the Bill To Address panel, you can view the details of the 
customer’s bill to address.

In the Ship To Address panel, you can view the ship to address to 
which orders for the customer will be sent.

Note: The Payment Methods panel is displayed based on 
the configuration.

Note: The Draft Orders, Order History, Return History, 
Opportunities, and Quote History tabs support pagination.

Note: If the status of the parent business customer 
changes to Inactive or On Hold, the status of the business 
customer and business customer contacts also changes to 
Inactive or On Hold, as appropriate. 

Note: Customer ID and Login cannot be changed after 
they have been entered and saved.
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In the Sold To Address panel, you can view the address details of the 
buyer.

In the Contacts tab, you can view the list of contacts that exist for 
the business customer. To view details about a contact, either 
double-click a contact in the list, or click the View Contact Details 
hyperlink in the details panel. 

In the Draft Orders tab, you can view all the draft orders that exist 
for the customer. 

The Channel column indicates whether the orders were created (or 
last modified) in the Web or Call Center. To modify or confirm a draft 
order, double-click the appropriate record in the list of draft orders.

In the Order History tab, you can view the details of previous orders 
created for the customer. You can filter the list of orders by hold type 
and status. To filter by hold type, select a hold type from the Hold 
Type drop-down list, and click the Search button. To filter by status, 
select either Open, Backordered, or Shipped, and click the Search 
button. You can click the View History Orders hyperlink to retrieve 
orders from the history table. You can click the View Recent Orders 
hyperlink to switch back to recent records.

In the Return History tab, you can view the details of the return 
orders that were created for the customer.

In the Opportunities tab, you can view the details of the opportunities 
that were created for the customer.

In the Quote History tab, you can view details of all the quotes that 
were created for the customer. You can filter the list of quotes based 
on hold type and/or status. To filter by hold type, select a hold type 
from the Hold Type drop-down list, and click the Search button. To 
filter by status, select either the Open, Closed, or All Quotes, and 
click the Search button.

Open displays quotes that have neither been abandoned nor 
converted to orders.

Closed displays quotes that have either been abandoned or 
converted to orders.

All Quotes displays all the quotes that have been created for the 
customer up-to-date.
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In the Addresses tab, you can view the additional addresses of the 
customer. Address descriptions, if any, will be displayed in the shaded 
panels above the addresses.

In the Payment Methods tab, you can view the details of the payment 
methods assigned to the customer.

In the Child Customers tab, you can view the list of child customers 
belonging to the current customer. To view a child customer’s details, 
double-click the child customer. To view the parent customer’s details, 
click the Parent Customer hyperlink.

In the Important Notes panel, you can view and add additional 
information about the customer. For more information about viewing 
or adding notes, see Section 2.8.12, "Viewing and Adding Customer 
Notes and Contact Notes".

2.1.2.3 Viewing Customer Contact Details
You can view the consumer contact details directly from the Consumer 
Details screen.

To view the contact details pertaining to a business customer, double- 
click a contact in the Contacts list of the Business Customer Details 
screen or click the View Contact Details hyperlink in the contact 
information display panel. The Contact Details screen is displayed.

In the Contact Details screen, you can view the following details 
pertaining to the customer contact, such as the contact’s name, ID, bill 
to address, and ship to address:

The contact’s name, ID, and status are displayed in the top panel.

In the Contact Information panel, you can view the contact’s e-mail 
address, day phone number, evening phone number, day fax number, 
evening fax number, mobile phone number, job title, department, 
date of birth, spouse’s date of birth, wedding anniversary, and 
spending limit.

In the Bill To Address panel, you can view the details of the contact’s 
bill to address.

Note: The Payment Methods panel is displayed based on 
the configuration.
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In the Ship To Address panel, you can view the details of the 
contact’s ship to address.

In the Sold To Address panel, you can view the details of the 
contact’s sold to address.

The panel below the address panels displays information about the 
approving user and backup approver. 

An approving user can approve an order for a contact who has 
exceeded his or her spending limit. A backup approver can approve 
orders for the contact if the contact is unavailable.

In the Important Notes panel, you can view and add additional 
information about the customer contact. For more information about 
viewing or adding notes, see Section 2.8.12, "Viewing and Adding 
Customer Notes and Contact Notes".

2.1.3 Searching for an Item
Using the Quick Access screen you can search for an item. Search can be 
performed for items or independent services by entering the appropriate 
search criteria for the item. You can also search for items based on 
specification.

To search for an item:

1. If you have access to multiple enterprises, the Enterprise drop-down 
list is displayed. Select the enterprise for which you want to perform 
an item search.

2. Enter the search criteria pertaining to an item.

3. Click Find Item.

If a single item exists that matches the search criteria, the Item 
Details screen is displayed.

If multiple items exist that match the search criteria, the Item 
Search screen is displayed with a list of product items. 

If the search criteria does not match with any item, the Advanced 
Item Search screen is displayed. Click  icon to show the search 
criteria. You can enter more restrictive search criteria for the selected 
task. Based on the configuration, either the Search Through All Items 
panel or the Search Items Currently Being Sold panel is displayed in 
the Advanced Item Search screen. If the Advanced Item Search 
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screen is configured to allow the both the panels, the Search Through 
All Items panel is displayed and a Switch To Search Through All Items 
hyperlink is displayed which will allow you to switch between both the 
panels.

Search Through All Items Panel

In the Search Through All Items panel, you can search for items 
using the identifier of the item or the alternate identifier, description 
of the item, or the manufacturer’s name of the pertinent item.

Search Items Currently Being Sold Panel

In the Search Items Currently Being Sold panel, you can search for 
items based on the enterprise. Select an enterprise from the 
Enterprise drop-down list. You can enter a search criteria for the 
item, specify a price range, and also search for items based on 
entitlements.

To view the item details, select the item and double-click, or in the 
Preview panel click the Item ID hyperlink. The Item Detail screen is 
displayed.

2.1.3.1 Viewing Product Item Details
In the Item Details screen, you can view the details about a product item 
such as the brief description of the item, price, manufacturer or brand 
information, and different fulfillment methods that are allowed.

To view the details of a product item:

1. In the Availability panel, select the country or region name from the 
drop-down list from where the customer wants to check the 
availability of the items and enter the postal code.

Note: If the 
YCD_NO_AVAILABILITY_CHECK_IN_ITEM_INQUIRY rule is 
set to "Y", the Availability column does not display, and 
therefore, you cannot check the item availability.
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2. Click Get Availability. The total quantity of the item that is available in 
the postal code is displayed in the Available Quantity field.

To check the availability of items in other stores, click View Stores. 
For more information about viewing store inventory, see 
Section 2.3.2.2, "Viewing Inventory in Other Stores".

In the Promotions panel, you can view all promotions associated with 
the item. For more information about promotions, click the hyperlink 
in the Short Description column.

3. If you want to view more details of the item, click More Details. The 
More Details Of Selected Item screen is displayed.

4. If you are viewing the details of a model item, the View Style Items 
hyperlink is displayed. Click this hyperlink to select an item’s style. 
For more information about selecting an item’s style, see 
Section 2.3.1.3, "Selecting an Item’s Style".

5. If the Sterling Call Center and Sterling Store application is configured 
to display the URL of a product Web page pertaining to an item, the 
View Product Web Page hyperlink is displayed. Click the View Product 
Web Page hyperlink to view the Web site providing details of the item.

6. If you want to add the item to the order, click Add to Order.

2.1.3.2 Viewing the Service Item Details
In the Service Item Details screen, you can view the details of provided 
services, such as the service description, price, UOM, and the availability 
of the service item.

Note: The availability of the bundle parent item depends 
on the availability of the bundle component items.

Note: You can configure the country or region drop-down 
to ensure that it does not display on the screen. For more 
information about configuring the country or region 
display, see the Sterling Call Center and Sterling Store: 
Implementation Guide.
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To view the details of a service item:

1. In the Availability panel, select the country or region name from the 
drop-down list from where the customer wants to check the 
availability of the service item and enter the postal code.

2. Click Check Availability. If the service is available, the message "This 
location can be serviced" is displayed. Click the View Calendar 
hyperlink. You can view the service appointments.

3. In the Promotions panel, you can view all promotions associated with 
the service item. For more information about promotions, click the 
hyperlink in the Short Description column.

4. If you want to create an order for the selected item, click Create 
Order. 

5. If you want to add service items to the order, click Add to Order.

2.1.3.3 Viewing More Details of the Selected Product Items
You can view more details of the selected product items.

To view more information about the item’s accessories, click the 
Accessories tab. You can view the identifier of the item or the 
alternate item, the item’s description, associated quantity, and the 
unit price of all accessories associated with the item.

To view the bundle component item details, click the Component 
Details tab. You can view the bundle component items, item’s 
description, and the bundle item kit quantity.

To view the item’s specifications, click the Specifications tab.

To view the items available for upsell, click the Upsell tab. You can 
view the identifier of the item or the alternate item, the item’s 
description, associated quantity, and the unit price of all items for 
upsell.

To view the items available for substitutions, click the 
Substitutions tab. You can view the identifier of the item or the 
alternate item, item’s description, associated quantity, and the 
unit price of all items for substitutions.

To view the service options of an item, click the Service Options 
tab. You can view the identifier of the service item, item’s 
description, associated quantity, whether the service scheduling 
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must be held until the item is delivered, the service time offset in 
hours (difference between provided service and product delivery), 
and the unit price of all the services available for the item.

To view the instructions pertaining to an item, click the 
Instructions tab. You can view the sequence number of the 
instructions, the instruction type, and the instructions pertaining 
to the item.

2.1.3.4 Performing an Advanced Item Search
If you do not know the complete details about a product or a service item 
such as the identifier of the item or the alternate item, the item’s 
description, or the manufacturer’s name, you can perform an advanced 
item search.

To perform an advanced item search:

1. Do one of the following to open the Item Search screen:

From Tasks > Search, select Advanced Item Search.

In the Quick Access panel, click Find Item.

In the Item List panel, you can view the item ID, description, 
available quantity, and the unit price of all items.

2. Select an item in the Item List panel to view more information about 
the item in the Item Details panel.

If you select a product, you can view the identifier of the item, 
item’s description, unit of measure, availability, and unit price. 

If you select an independent service, you can view the identifier of 
the item, item’s description, unit of measure, and unit price.

If you cannot find the items that you are searching for, click  icon 
to show the search criteria. You can enter more restrictive search 
criteria for the selected task.

3. Choose any one of the following and click Search: 

Products—Provides a list of items

Independent Services—Provides a list of services

Both—Provides a list of items and services
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4. If you are unable to find the pertinent items, click Show Search 
Criteria to enter more restrictive search criteria.

5. If you select a model item and click the Add to Order button, the 
Style Items pop-up window is displayed. For more information about 
selecting an item’s style, see Section 2.3.1.3, "Selecting an Item’s 
Style".

6. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

7. Double-click on the required item to view the item details.

2.1.4 Viewing Order Summary
A customer may have some queries or may request some changes on an 
order that is already placed. In such situations, you may want to view 
the order details before performing any task.

To view the summary of an order:

1. Perform one of the following tasks to open the Order Summary 
screen:

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 
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From the Quick Access screen, enter the complete order number, 
the customer’s telephone number, or the customer’s e-mail 
address and click Find Order.

If you do not enter the complete order number, the Order Search 
screen is displayed. Enter the appropriate information in the Order 
Search Criteria panel. Click Search. The Order List screen is 
displayed. Double-click the appropriate order number. The Order 
Summary screen is displayed.

2. In the Primary Details panel, you can view the order number, order 
status, display status, order date, total amount, and the channel 
through which the order is placed. Display status is the status of the 
order that the customer sees when viewing the order from the IBM® 
Sterling Multi-Channel Selling Solution. 

To view the price breakdown of the order, click the Total Amount 
value hyperlink. The Order Pricing Summary pop-up window is 
displayed. You can view the details of the prices applied to the 
order, such as the order line prices, the line-level price 
adjustments, the order total, and the order-level price 
adjustments. To view the line-level price adjustments resulting 
from charges and discounts applied to an order line, click the 
corresponding Adjustments value hyperlink. The Line Charges and 

Note: Based on the compatibility level of an order with 
the version of the Sterling Call Center and Sterling Store 
application being used, the corresponding Order Summary 
screen is displayed:

If the order is compatible with the version of the 
application, the Order Summary screen is displayed.

If the order is partially compatible with the version of 
the application, the Order Summary screen is 
displayed, but with only the nonorder-related tasks.

If the order is not compatible with the version of the 
application, the Order Summary screen is displayed 
with most of the tasks disabled. For more information 
about viewing the Order Summary screen in the 
context of incompatible orders, see Viewing Order 
Summary for Incompatible Orders.
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Discounts pop-up window is displayed. To view the order-level 
price adjustments resulting from charges and discounts applied to 
the order, click the Order Adjustments value hyperlink. The Order 
Charges and Discounts pop-up window is displayed. 

If the order has any associated alerts, a hyperlink indicating the 
total number of open alerts is displayed. To view the alert details, 
click the hyperlink associated with the  icon. For more 
information about viewing alerts, see Section 2.11, "Performing 
Alert and Queue Management Tasks".

If the order or any of the order lines are on hold, the  icon is 
displayed. To view and resolve holds, click the  icon. For more 
information about resolving order holds, see Section 2.3.6, 
"Removing Holds". The provided service line is displayed as a 
service line.

3. In the Bill To Address panel, you can view the details of the 
customer’s address.

4. In the Ship To Address panel, you can view the  address to where the 
order is sent. If the order has multiple ship to addresses, the 
message "There are multiple ship to addresses on this order" is 
displayed.

5. In the Completed Order Lines panel, you can view the product and/or 
configured items and/or service order lines that are fulfilled.

6. In the Incomplete Order Lines panel, you can view the product and/or 
configured items and/or service order lines that are not fulfilled. The 

 icon is displayed if a stop delivery request has been placed.

You can also view the indicator icons associated with the items, if 
applicable. Place your cursor on these icons to view their purpose.

Note: Based on the rules configured, you can view the 
bundle component items. For more information about 
configuring the display of bundle items, see the Sterling 
Call Center and Sterling Store: Implementation Guide.
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If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

7. In the Important Notes panel, you can view any additional 
information entered for the order. For more information about viewing 
or adding notes to an order see, Section 2.3.4, "Viewing and Adding 
Notes to an Order".

Note: When you click the tracking number hyperlink in 
the Completed Order Lines panel and the Expected On ship 
date hyperlink in the Incomplete Order Lines panel, the 
Shipment Inquiry screen is displayed. For more information 
about tracking an item, see Section 2.3.10, "Tracking an 
Item or Inquiring About a Shipment".

Note: The Expected On ship date in the Incomplete Order 
Lines panel is displayed the approximate date for the 
expected shipment. When you click the Expected On ship 
date hyperlink, the Shipment Inquiry screen is displayed. 
You can view more appropriate dates for the expected 
shipment, if the fulfillment method is "Shipping" or 
"Delivery". You can also view the expected date for the 
shipment in the Change Fulfillment Options screen.

Note: If an order with future availability contains an item 
whose level of service is not selected, the exact availability 
date will be displayed only after the order is scheduled. For 
the exact availability date, refer to the Fulfillment 
Summary screen.
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8. Right-click on the order line of an item to track the item or view the 
line summary. For more information about tracking an item, see 
Section 2.3.10, "Tracking an Item or Inquiring About a Shipment".

If an order is being modified by a user through a different channel, for 
example, IBM® Sterling Web, and the order contains unsaved changes, 
when this order is opened simultaneously by a Sterling Call Center or 
Sterling Store user to perform modifications, the latter user is prompted 
to either revert the changes made by the Sterling Web user, or close the 
order. If the order does not contain any unsaved changes, the Order 
Summary screen is displayed, and the Sterling Call Center and Sterling 
Store user is allowed to make the necessary changes.

Similarly, if a Sterling Call Center or Sterling Store user is modifying an 
order, and the order is simultaneously opened by a Sterling Web user for 
order modifications, a message is displayed in the Sterling Call Center 
and Sterling Store applications indicating that the order contains unsaved 
changes made through a different channel. The Sterling Call Center or 
Sterling Store user is automatically taken to the Order Summary screen 
and is prompted to either revert the unsaved changes made by the 
Sterling Web user, or close the Order Summary screen.

Viewing Order Summary for Incompatible Orders
The Order Summary screen for incompatible orders is displayed if the 
order is incompatible with the version of the Sterling Call Center and 
Sterling Store application being used. You cannot perform any of the 
modification tasks on the order except cancelling the order if the order is 
in a status that allows cancellation. A message is displayed on the screen 
indicating that the screen has been modified because it is not compatible 
with the version of the application being used.

On the Order Summary screen, you can view the Primary Details, Bill To 
Address, and ship to address pertaining to the order. Click the Cancel 
button to cancel the order. This displays the Cancel Order pop-up 
window, where you must specify the cancellation reason. When the order 
is cancelled, a note containing the reason for the cancellation is 
automatically added to the order.

2.1.4.1 Viewing the Order Line Summary
To view the order line summary or provided service line information, 
right-click the corresponding order line in the Order Summary screen, 
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and select View Line Summary. The Line Summary screen is displayed. 
The following information is displayed in this screen:

Primary Details—This panel displays the line number, item identifiers, 
item description, service, status, display status, quantity, and the unit 
price of an item. The  icon is displayed if the order line is on hold. 
This panel also indicates if the item is an open box or a gift item or 
both. The other details displayed in the screen are:

– If the fulfillment method is Delivery or Shipping, the ship node is 
displayed.

– If the fulfillment method is Pick Up, the store is displayed. Clicking 
the store hyperlink displays the Store Details window. For more 
information about viewing store details, see Section 2.1.4.2, 
"Viewing Store Details".

If the Sterling Call Center and Sterling Store application is configured 
to display the URL of a product Web page pertaining to an item, the 
View Product Web Page hyperlink is displayed. Click the View Product 
Web Page hyperlink to view the Web site providing details of the item.

The gift message is displayed if the user has included a message for 
the gift item.

Ship To Address—You can view the ship to address for an order line in 
this panel.

Components—You can view the bundle component details such as 
bundle component items, item’s description, status, and the 
component quantity in this panel.

Note: To display item aliases in the Line Summary 
screen, configure the Item Alias to Use for the Alternate 
Item ID rule. For more information about configuring the 
rules for alternate item identifiers, see the Sterling Call 
Center and Sterling Store: Implementation Guide.

Note: The Components panel is displayed only when you 
are viewing the order line summary of bundle items.
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Pricing—You can view the extended price, taxes applied, and the line 
total. If the item has been price matched, or if the item price has 
been overridden, you can also view these details in this panel. This 
panel also displays charge breakup and tax breakup information, if 
applicable.

Important Events—You can view cancelled, reshipped, or returned 
information, if any, for the order line. If there are no important 
events for the order line, the message "No important event occurred 
on this line" is displayed. The  icon is displayed if a stop delivery 
request has been placed.

You can also view the indicator icons associated with items, if 
applicable. Place your cursor on these icons to view their purpose.

2.1.4.2 Viewing Store Details
The Store Details pop-up window displays the details about a store such 
as the store name, store address, and the contact information.

2.1.4.3 Viewing Prices of Bundle Items
If the order contains a bundle item, the unit price of the item is displayed 
as a hyperlink. To view the details of the bundle item, click the unit price 
hyperlink. The Component Lines pop-up window is displayed. You can 
view the details of the bundle parent and its components such as the 
quantity, unit price, line total, adjustments, and so on.

The unit price of the bundle parent and its components are computed 
based on the pricing strategy that has been configured for the bundle 
item. The unit price is displayed as follows:

If the bundle pricing strategy is configured such that the price of the 
bundle item is calculated based on both the bundle parent and its 
component items, the unit price of the bundle parent is displayed 
along with the sum of the unit price of the component items in the 
Parent panel.

If the bundle pricing strategy is configured such that the price of the 
bundle item is calculated based only on the bundle parent, only the 
unit price of the bundle parent is displayed in the Parent panel. In 
this scenario, the unit price is displayed as "Included" and the line 
total of the component items are not displayed.
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If the bundle pricing strategy is configured such that the price of the 
bundle item is calculated based only on the bundle components, the 
unit price of the bundle parent is displayed in the Parent panel and 
the unit prices of the component items are displayed in the 
Components panel.

2.1.5 Performing an Advanced Return Order Search
Using additional options, you can make your return order search more 
precise and view more details of the return such as the return order 
number, original order number, customer ID.

To perform an advanced return search:

1. From Tasks > Search, select Advanced Return Search. The Return 
Search screen is displayed.

In the Return Order Search Criteria panel, enter the appropriate 
search criteria. Select an option from the Order By drop-down list 
based on which the records will be sorted. Select Ascending or 
Descending from the adjacent drop-down list and click Search. The 
search results are displayed in the Recent Return Order List panel. If 
you cannot find the pertinent order number, click  icon to show the 
search criteria. You can enter more restrictive search criteria for the 
selected task.

Note: You cannot override the price of a bundle item 
whose pricing strategy is calculated as follows:

The pricing strategy is calculated based on both the 
bundle parent and its component items.

The pricing strategy is calculated based only on the 
bundle components.

However, you can adjust the price of the bundle item using 
the Add/Modify Charges hyperlink if the pricing strategy is 
calculated based on both the bundle parent and its 
component items.

If the pricing strategy is calculated based only on the 
bundle components, you cannot adjust the price of the 
bundle item.



30   User Guide

Performing Search Tasks

2. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed. Click the View History Records hyperlink to 
retrieve return orders from the history table. You can click the View 
Recent Records hyperlink to switch back to recent records. The total 
number of records displayed in a single page is based on pagination 
rules configured. Click the Get Total Record Count hyperlink to view 
the total number of records returned for the search criteria.

3. Double-click the appropriate order number. The Return Order 
Summary screen is displayed. For more information about viewing 
the return order summary details, see Section 2.1.5.1, "Viewing 
Return Order Summary".

2.1.5.1 Viewing Return Order Summary
In the Return Order Summary screen, you can view the details of a 
return order such as the primary details of the return order, refund to 
address, return from address, details of the corresponding exchange 
order.

1. In the Primary Details panel, you can view the return order number, 
order status, return order date, total refund amount, channel through 
which the items will be returned. If the order or any of the order lines 
are on hold, the  icon is displayed. To view and resolve holds, click 
the  icon. For more information about resolving order holds, see 
Section 2.3.6, "Removing Holds". The provided service line is 
displayed as a service line.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again.
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2. In the Refund To panel, you can view the details of the customers 
address.

3. In the Return From panel, you can view the address from where the 
items are being returned.

4. In the Exchange Order Details panel, you can view the details of the 
exchange order such as the exchange order number, status, total 
exchange amount and the exchange type.

5. In the Order Lines panel, you can view the original order number, 
item ID, unit price, quantity, return method and status of each line.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

To track the item, right-click on the item and select Track This Item. 
For more information about tracking an item, see Section 2.3.10, 
"Tracking an Item or Inquiring About a Shipment".

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

You can also view the indicator icons associated with the items, if 
applicable. Place your cursor on these icons to view their purpose.

2.1.5.2 Viewing the Return Order Line Summary
To view the return order line summary or provided service line 
information, right-click the corresponding return order line in the Return 
Order Summary screen, and select View Line Summary. The Line 
Summary screen is displayed. The following information is displayed in 
this screen:

Primary Details—This panel displays the line number, item identifiers, 
item description, service, status, display status, quantity, and the unit 
price of an item. The  icon is displayed if the order line is on hold. 
This panel also indicates if the item is an open box or a gift item or 
both. The other details displayed in the screen are:
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– If the fulfillment method is Delivery or Shipping, the ship node is 
displayed.

– If the fulfillment method is Pick Up, the store is displayed. Clicking 
the store hyperlink displays the Store Details window.

If the Sterling Call Center and Sterling Store application is configured 
to display the URL of a product Web page pertaining to an item, the 
View Product Web Page hyperlink is displayed. Click the View Product 
Web Page hyperlink to view the Web site providing details of the item.

The gift message is displayed if the user has included a message for 
the gift item.

Ship To Address—You can view the ship to address for a return order 
line in this panel.

Components—You can view the bundle component details such as 
bundle component items, item’s description, status, and the 
component quantity in this panel.

Pricing—You can view the extended price, taxes applied, and the line 
total. If the item has been price matched, or if the item price has 
been overridden, you can also view these details in this panel. This 
panel also displays charge breakup and tax breakup information, if 
applicable.

Important Events—You can view cancelled, reshipped, or returned 
information, if any, for the order line. If there are no important 
events for the order line, the message "No important event occurred 
on this line" is displayed. The  icon is displayed if a stop delivery 
request has been placed.

Note: To display item aliases in the Line Summary 
screen, configure the Item Alias to Use for the Alternate 
Item ID rule. For more information about configuring the 
rules for alternate item identifiers, see the Sterling Call 
Center and Sterling Store: Implementation Guide.

Note: The Components panel is displayed only when you 
are viewing the return order line summary of bundle items.
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You can also view the indicator icons associated with items, if applicable. 
Place your cursor on these icons to view their purpose.

2.1.6 Searching for an Opportunity
You can search and view the details of an opportunity, such as the 
opportunity status, the date on which the opportunity is expected to be 
closed, the notes added to the opportunity, and so on.

To search for an opportunity:

1. From Tasks > Search, select Opportunity Search. The Opportunity 
Search screen is displayed.

2. From the Enterprise drop-down list, select the enterprise for which 
the opportunity was created. This drop-down list displays all the 
enterprises that you have access to.

3. Enter the appropriate search criteria and click Search. The search 
results are displayed in the Opportunity Results panel. If you cannot 
find the opportunity you are searching for, click the  icon to 
display the search criteria again. Enter a more restrictive search 
criteria for the selected task and click Search.

4. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If your search criteria results in displaying the records in a 
single page, or if you are viewing the last page, the Get More Records 
hyperlink is not displayed, instead the message "No More Records" is 
displayed.

Note: The Enterprise drop-down list is displayed only if 
you have access to multiple enterprises.
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The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

5. Double-click the appropriate opportunity record. The Opportunity 
Details screen is displayed. For more information about viewing the 
opportunity details, see Section 2.1.6.1, "Viewing the Opportunity 
Details".

2.1.6.1 Viewing the Opportunity Details
You may sometimes want to view the details of an opportunity, such as 
the opportunity’s status, owner, and so on. To view the details of an 
opportunity, you must first search for the corresponding opportunity. For 
more information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity".

You can view the information pertaining to an opportunity using the 
Opportunity Details screen.

In the Create Opportunity panel, you can view the opportunity name, 
date when the opportunity was created, date when the opportunity is 
expected to be closed, opportunity ID, opportunity status, probability 
of the opportunity’s success (in %), opportunity value, source from 
which the lead for creating the opportunity originated, the user who is 
assigned as the owner of the opportunity, and the secondary user 
who is assigned as the co-owner of the opportunity.

In the Customer panel, you can view the customer’s details for whom 
the opportunity has been created.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again.
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In the Quotes panel, you can view any existing quotes that have been 
created for the opportunity. If the quote is a primary quote, the    
icon is displayed.

In the Important Notes panel, you can view and add additional notes 
about the opportunity.

2.1.7 Searching for a Quote
You may sometimes want to view a quote’s summary, such as the quote’s 
status, the items added to the quote, and so on. For example, if a user 
presents a quote to a customer, and if the customer neither accepts nor 
rejects the quote for a considerable period of time, the user may want to 
know the quote’s expiration date so that the user can follow it up with 
the customer.

To search for a quote:

1. Perform one of the following tasks to open the Quote Search screen:

In the Quick Access panel, if the Enterprise drop-down list is 
displayed, select the enterprise for which you want to perform a 
quote search. Enter the appropriate search criteria and click Find 
Quote.

– If a single quote exists that matches the search criteria, the 
Quote Details screen is displayed.

– If multiple quotes exist that match the search criteria, the 
Quote Search screen is displayed.

From Tasks > Search, select Quote Search. The Quote Search 
screen is displayed. From the Enterprise drop-down list, select the 
enterprise for which you want to perform a quote search.

2. Enter the appropriate search criteria and click Search. The search 
results are displayed in the Quote Results panel. If you cannot find 
the quote you are searching for, click the  icon to display the 
search criteria again. Enter a more restrictive search criteria for the 
selected task and click Search.

Note: The Enterprise drop-down list is displayed only if 
you have access to multiple enterprises.
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3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If your search criteria results in displaying the records in a 
single page, or if you are viewing the last page, the Get More Records 
hyperlink is not displayed, instead the message "No More Records" is 
displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

4. Double-click the appropriate quote record. The Quote Summary 
screen for the selected quote is displayed. For more information 
about viewing the quote details, see Section 2.1.7.1, "Viewing the 
Quote Details".

2.1.7.1 Viewing the Quote Details
You may sometimes want to view the details of a quote, such as the 
quote’s status, owner, quote expiration date, and so on. To view the 
details of a quote, you must first search for the corresponding quote. For 
more information about searching for a quote, see Section 2.1.7, 
"Searching for a Quote".

You can view the following information pertaining to a quote using the 
Quote Summary screen:

In the Quote Details panel, you can view the quote name, the 
opportunity for which the quote is created, the opportunity ID, quote 
status, the user who is assigned as the owner of the quote, the 
secondary user who is assigned as the co-owner of the quote, date 
when the quote will expire, actual date when the quote is closed, and 
the date when pricing was calculated for the quote.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again.
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If the quote is a primary quote, the  icon is displayed.

In the Pricing Summary panel, you can view the quote’s subtotal, any 
price adjustments that have been applied to the quote, shipping 
charges applied to the quote, taxes applied to the quote, the quote’s 
grand total, and profit margin (in %) that is earned from the quote if 
the quote is converted into an order, for example, a profit margin of 
20% means a profit of $20 for every $100 earned from the quote.

In the Terms panel, you can view the payment term to be used for 
the quote. The payment term is used to specify the time frame a 
customer is entitled to pay the due amount if the quote is converted 
into an order. You can also view the date on which the items in the 
quote have been requested for delivery, the carrier service that has to 
be used to deliver the items in the quote, and the level of service for 
the quote. The level of service determines how the order will be 
fulfilled if the quote is converted to an order. For example, you may 
choose to either have the items delivered using a normal carrier 
service or an express carrier service. Note that the shipping charges 
may differ based on the level of service you select.

You can also view the items added to the quote along with the 
quantity, price of each item, price adjustments, and the line total.

In the Important Notes panel, you can view and add additional notes 
about the quote.

2.2 Answering Frequent Queries
This section contains some of the questions commonly asked by the 
customers and provides the answers to these questions.

Customers may call you and ask:

Where is my shipment?

Why was I charged?

Why wasn’t I refunded?

How much will I be refunded?

Have you received my returns?

Where are my exchange items?
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2.2.1 Where is my shipment?
Customers may inquire about the status of their orders. For example, if a 
customer does not receive items that were ordered, they may call you to 
inquire about the shipment. For more information about inquiring about a 
shipment, see Section 2.3.10, "Tracking an Item or Inquiring About a 
Shipment".

2.2.2 Why was I charged?
This section provides information to help you answer questions raised by 
customers regarding charges, refunds, and payment methods.

To inquire about these details for an order, the you must search for the 
order. For more information about searching for an order, see 
Section 2.1, "Performing Search Tasks".

After you locate the applicable order by navigating to Tasks > Frequent 
Queries, select Why was I charged? The Payment Inquiry screen is 
displayed. You can view the order total, the pending charges, and the 
payment status of the order. 

You can also view the following information:

Charges and Refunds—In this panel, you can view the date and time 
of the charges applied to the order, charged amount, payment 
reference, and related invoices.

Click the hyperlink in this screen to view invoice details. The Invoice 
Details screen is displayed. You can view the invoice number, invoice 
date, the item identifier and description, quantity, unit price, and the 
line amount. You can also view details such as the sub total, total tax, 
total discount, total charges, total collected, and the balance amount.

Charges Towards Exchange—If the order has exchange information, 
you can view the date and time that the charges were applied and 
the charged amount.

Charges From Returns—If the order has return items, you can view 
the date and time that the charges for the returned items were 
applied and the charged amount.
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2.2.3 Why wasn’t I refunded?
Sometimes customers expect refunds for returned items. If they do not 
receive a refund, they may call to inquire about the refund. In such 
situations, you can view the refund details and inform the customer 
about the reason why they were not issued a refund for the returned 
items. For more information about inquiring about refunds for returned 
items, see Section 2.7.6, "Inquiring About Returns and Exchanges".

2.2.4 How much will I be refunded?
Customers may inquire about the refund amount for the returned items. 
You can view the refund details for the returned items and inform the 
customer about the amount that will be refunded for the returned items. 
For more information about refund inquiries see, Section 2.7.6, 
"Inquiring About Returns and Exchanges".

2.2.5 Have you received my returns?
Customers may inquire about whether or not you have received the 
items that they return. In such situations, you can determine the status 
of the returned items and inform the customer. For more information 
about return inquiries, see Section 2.7.6, "Inquiring About Returns and 
Exchanges".

2.2.6 Where are my exchange items?
Customers may inquire about the current status of the items shipped in 
exchange for returned items. In such situations, you can determine the 
items that are replacements and view the status of the exchange items. 
For more information about exchange inquiries, see Section 2.7.6, 
"Inquiring About Returns and Exchanges".

2.3 Performing Order Tasks
You can perform several tasks on an order placed by a customer. Some 
of the general tasks that you can perform on an order are:

Note: If the order is on a hold which prevents payment 
processing, then the charge details are not displayed.
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Creating an Order

Adding Order Lines

Increasing Order Line Quantity

Viewing and Adding Notes to an Order

Applying Hold

Removing Holds

Canceling an Order

Viewing and Confirming the Payment Details

Returning an Order

Tracking an Item or Inquiring About a Shipment

Adding or Modifying Charges

Scheduling and Releasing an Order

Viewing Procurement Orders

Exempting an Order from Tax

Copying a Draft Order

Ordering Again

E-mailing Order Information

Transferring a Draft Order to IBM Sterling Web

Launching the Application Console

2.3.1 Creating an Order
After identifying a customer, you can create an order for that customer. 
You can enter multiple order lines for an order, modify fulfillment options 
and appointments, and confirm the payment information as requested by 
the customer.

A navigation bar is displayed at the bottom of all the screens in the 
Create Order task flow. This helps you to clearly understand the 
sequence of steps you have to perform to complete the entire task. The 
navigation bar also enables you to revisit the previous screens, move to 
the next screen, or close the Order Entry screen. 
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When performing any of the steps in the order creation task flow, you 
have the option of clicking the Close button to close the Order Entry 
screen before confirming the corresponding order. Before the Order Entry 
screen closes, the Confirm pop-up window is displayed. Following are the 
tasks that you can perform in the Confirm pop-up window:

If there are any changes made to the order that have not been 
saved, perform one of the following actions:

– Enter a name for the order and click Save Changes to save the 
name and any other changes made to the order.

– Click Discard Changes to discard the changes made to the order.

– Click Cancel to remain on the Order Entry screen. 

– Click Delete Draft Order to delete the order.

If you have not made any changes to the order, perform one of the 
following actions:

– Enter a name for the order and click Confirm to save the draft 
order name. 

– Click Cancel to remain on the Order Entry screen.

– Click Delete Draft Order to delete the draft order. 

To create an order:

1. From Navigator > Order, select Create Order or from Tasks > Order, 
select Create Order. The Select Enterprise pop-up window is 
displayed. Select the appropriate enterprise from the drop-down list.

2. Click Confirm. The Create Order: Customer Identification-Ship to 
Address screen is displayed.

3. Click Skip this Page if:

The customer intends to pick up the items at the store 
immediately.

You want to capture the customer information only after 
confirming the inventory availability.
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4. If you have launched this task in the context of a business customer:

To create a new contact, click the Add New Contact hyperlink. The 
Add Contact pop-up window is displayed. For more information 
about creating a new contact, see Section 2.3.1.1, "Adding a New 
Contact".

From the Select a Contact drop-down list, select the contact.

The Ship To Address, Bill To Address, and Sold To Address are 
displayed. 

To change any of the addresses, click the Change hyperlink. The 
Modify Address pop-up window is displayed. For more information 
about modifying an address, see Section 2.3.2.3.2, "Modifying an 
Address".

To exempt the order from tax, perform the following actions in the 
Customer Options panel:

– Select the Allow Tax Exemption check box.

– In the Tax Exemption Code field, enter the Tax Exemption 
Code of the order. 

– From the Currency drop-down list, select the currency.
 

5. If you have launched this task in the context of a consumer 
customer:

Note: Based on how Sterling Call Center and Sterling 
Store is configured, you may be able to search for 
customers based on their type.

Note: If the customer or contact does not have default 
addresses or payment methods defined, the default 
addresses or payment methods for the closest customer in 
the customer hierarchy will be used.

Note: The Currency drop-down list is displayed only when 
multiple currencies are defined for the customer.
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The Bill To Address and Ship To Address are displayed.

If you want to change any of the addresses, click the Change 
hyperlink. The Modify Address pop-up window is displayed. For 
more information about modifying an address, see 
Section 2.3.2.3.2, "Modifying an Address".

6. If this task is not launched in the context of a customer: To search for 
a customer, in the Find Existing Customer panel, do any of the 
following:

Enter the daytime telephone information.

Enter the e-mail address of the customer.

Enter the last name and first name of the customer.

Enter the last name and first few numbers of the postal code of 
the customer.

Enter the first name and first few numbers of the postal code of 
the customer.

7. Click Search.

If more than one customer is found as a result of your search, a 
list of customer information is displayed. Select the appropriate 
customer information from the list.

If customers are not found as a result of your search, the 
following message is displayed: "Your search found zero results".

If more than fifteen customers are found as a result of your 
search, the following message is displayed: "Your search resulted 
in more than 15 matches. Please refine your search criteria". In 
such situations, you need to enter more restrictive search 
information.

8. In the Customer Ship To Address panel, you can modify the Primary 
Info, Street Address, and Contact Information of the customers, if 
applicable.

9. If the Bill To Address of the customer is same as the Ship To Address, 
check the "Use As Bill To Address" box.

If you want to override address verification, check the Override 
Address Verification box.
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If you do not want to override address verification and the 
address verification fails, the message "This is not a valid 
Address" is displayed.

10. Click Next.

If the status of the customer or contact is Inactive, an Invalid 
Customer or Contact pop-up window is displayed. The order 
cannot be created until the status of the customer or contact has 
been changed to Active. 

You can change the status of a consumer customer in the Manage 
Contact Information screen, and you can change the status of a 
business customer in the Manage Customer Information screen.

If the Bill To Address is not the same as the Ship To Address, the 
Customer Bill To Address screen is displayed. Enter the 
appropriate Bill To Address information. 

If the order already contains items and if the customer is not 
entitled to any of these items, an error message is displayed.

Based on the configuration, you will see one of the following screens:

Add Items screen, with panels for each order line.

Large Order Item Entry screen, with a table which is designed to 
handle large number of items.

Note: When the status of a parent business customer 
changes to Inactive or On Hold, the status of the business 
customer and business customer contacts also changes to 
Inactive or On Hold, as appropriate.

Note: If the Bill To Address of the customer is the same 
as the Ship To Address, and if you have not selected the 
"Use As Bill To Address" check box in the Customer Ship To 
Address panel, you can select this check box in the 
Customer Bill To Address screen.
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If the application is configured to display the Add Items screen:

11. To search for an item, in the Item column, click the  icon. The 
Advanced Item Search screen is displayed. You can add the item to 
the order in one of the following ways:

Scan the barcode of the item or the alternate item.

In Item ID, enter the identifier of the item or scan the alternate 
item identifier.

If you have already added an item to the order, click the item 
name hyperlink. The Item Details screen is displayed. For more 
information about viewing the item details, see Section 2.1.3, 
"Searching for an Item".

– If the item’s effective date has expired and the item has an 
associated item that has been configured to substitute it, a 
confirmation pop-up window is displayed. Click Yes to add the 
new item to the order. 

– If the item fails validation, the following error message is 
displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."

Note: The application can be configured to either display 
the Large Order Item Entry screen always, or when the 
number of order lines exceeds a preconfigured number, or 
not at all.

Note: If the customer information is not captured initially, 
the postal code is displayed as a panel on top of the 
screen. This enables you to enter the postal code and 
check for the item availability.

Note: If the order is an existing draft order, an error 
message is displayed if any of the items, or the quantity of 
any of the items in the order fails validation. 
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Click OK. The screen is refreshed, and a message is displayed 
in the Error panel below the order line, indicating why the 
order line failed validation. If the order line failed validation 
because it did not meet the minimum order quantity criteria or 
the maximum order quantity criteria, you can override the 
quantity by selecting the Override <Minimum or Maximum> 
order quantity validation for this item check box. 

12. To delete a particular order line, click the  icon adjacent the 
corresponding order line. A confirmation pop-up window is displayed. 
Click Yes if you want to delete the order line. If the order line has 
related lines associated with it, the order line and the related lines 
associated with it are immediately deleted.

13. To add order line notes, click the  icon associated with the order 
line. For more information about adding order line notes, see 
Section 2.3.4.1, "Adding Notes to an Order Line".

14. You can add related product or service items to an order or you can 
replace the items in an order through a pop-up or a panel based on 
the configuration. For more information about adding related items or 
replacing items, see Section 2.3.1.2, "Adding Related Items or 
Replacing Items".

15. To view the components of a bundle item, click the View Components 
( ) button. The Bundle Components pop-up window is displayed. 
You can view the details of the item, such as Item ID, Description, 
and Kit Quantity of the bundle components. Click Close to close the 

Note: You can search for products, services, or both on 
the Advanced Item Search Screen. When searching for 
services or both products and services, the results display 
both independent and non-independent services. 
Non-independent services cannot be added to an order 
from the Item Inquiry screens.

Note: If the bundle item that is configured as ship 
independent is added to an order, the Choose Store 
hyperlink is not displayed.
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Bundle Components pop-up window. However, if the item is a 
configurable bundle item, perform the following tasks:

If the item is a preconfigured bundle item, you do not have to 
manually configure the item. However, if you want to reconfigure 
the item, click the Reconfigure ( ) button. The Product 
Configurator pop-up window is displayed where you can view the 
components of the preconfigured bundle item and reconfigure the 
item, if needed.

If the item is not a preconfigured bundle item, click the 
Configurable Bundle ( ) button to open the Product 
Configurator pop-up window and configure the item.

16. If you enter partial Item ID of a model item or a stylized item, the 
Style Items pop-up window is displayed. For more information about 
selecting an item’s style, see Section 2.3.1.3, "Selecting an Item’s 
Style". If you scan or enter the item ID of a stylized item, the stylized 
item is added to the order.

17. In the Quantity column, enter the required item quantity.

18. In the UOM column, select the UOM for the item from the drop-down 
list. If a UOM does not exist for an item or if only one UOM exists, 
this column is not editable.

19. In the Unit Price column, you can view the unit price and list price of 
the item. The prices shown are based on the Ordering UOM.

After you update the order, the unit price of the bundle item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

Note: If an item is reconfigured, the fulfillment type and 
pricing information defined for the item will not be 
available until the configuration is completed.
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20. To override the price of an item, click the Override Price hyperlink. 
The Override Price for Item screen is displayed. To override the item 
price:

a. In Overridden Price, enter the new price of the item.

b. From the Reasons for Override drop-down list, select the 
appropriate reason.

c. In the Notes panel, enter any additional information, if applicable.

d. Click Close.

21. In the Fulfillment Method column, choose the appropriate fulfillment 
method. If the selected fulfillment method is not available, the 
message "Not Available" along with the  icon is displayed. The Pick 
Up, Shipping, and Delivery buttons are enabled, and the item 
availability date is displayed next to these buttons. The availability 
date for:

Pick Up—displays the earliest date on which you can pick up the 
product from a store.

Shipping—displays the earliest date on which you can ship the 
item.

Delivery—displays the earliest date on which the product is 
available.

Note: In case of the Delivery fulfillment method, the item 
availability date does not indicate the delivery 
appointment. It only indicates the date on which the 
product is available. You must take a delivery appointment 
at a later point. 
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The availability details do not display if the user interface is not 
configured to do so.

If you want the item to be shipped to the customer, choose Ship.

If you want the item to be delivered to the customer’s doorstep, 
choose Delivery.

If the customer wants to pick up the item from the current store, 
choose Pick Up.

If the customer wants to pick up the item from an alternate store, 
click the Choose Stores hyperlink. The More Stores screen is 
displayed. Select the appropriate store from where you want to 
pick up the item. The selected store is displayed next to the Pick 
Up option. For more information about viewing inventory in other 
stores, see Section 2.3.2.2, "Viewing Inventory in Other Stores".

If the order line has already been created for Pick Up from a store 
other than the one in which the order is created, and if you want 
to pick up the item from the same store, choose Pick Up from 
(Store Name).

If the order line is a service line, the information indicating 
whether or not you can perform the service for that line is 
displayed.

22. In the Line Total column, you can view the order line total along with 
the charges and discounts, if any, applied to the order line.

If you are adding a new item, the  icon is displayed, indicating 
that the order needs to be updated to view the line total. If there 
are any special charges or discounts applied to the item, you will 
not be able to view those charges or discounts until you update 
the order. For example, if there is a 50% discount on the unit 
price of the item, you will not be able to view the discount until 
you update the order. 

Note: If an order with future availability contains an item 
whose level of service is not selected, the exact availability 
date will be displayed only after the order is scheduled. For 
the exact availability date, refer to the Fulfillment 
Summary screen.
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If you make changes to an item that has already been added to 
the order, the  icon is displayed next to the line total value, 
with the tooltip indicating that the order needs to be updated to 
view the line total. 

The charges and discounts applied to the order line are displayed 
as hyperlinks. Click the charges value hyperlink to view the 
charges applied to the order line or click the discounts value 
hyperlink to view the discounts applied to the order line. If the 
order line has been modified so that the line total is not current, 
the order is updated and the Line Charges or Line Discounts 
pop-up window is displayed. You can view the charges or 
discounts applied to the order line. Click Close. 

23. To add more lines to the order, click the Add More Lines hyperlink.

24. To add new service lines, click the Add Independent Services 
hyperlink. The Item Search screen is displayed. Select the service you 
want to add. The service line is added and indicated by the  icon. 
For more information about performing an advanced item search, see 
Section 2.1.3.4, "Performing an Advanced Item Search"

25. To add an open box item, click the Add Open Box Item hyperlink. For 
more information about open box items, see Section 3.3.9, "Adding 
Open Box Items".

26. To view the price breakdown of the order, click the value of the 
Subtotal that is displayed as a hyperlink. The Order Pricing Summary 
pop-up window is displayed. You can view the details of the prices on 
the order, such as the order line prices, line-level price adjustments 
resulting from charges and discounts applied to the order lines, order 
total, order-level price adjustments, order-level shipping charges, and 
taxes on the order. 

To view the charges and discounts applied to an order line, click 
the corresponding Adjustments value that is displayed as a 
hyperlink. The Line Charges and Discounts pop-up window is 
displayed. Click Close. 

To view the charges and discounts applied to the order, click the 
Order Adjustments value that is displayed as a hyperlink. The 
Order Charges and Discounts pop-up window is displayed. Click 
Close. 
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27. To view the updated unit price and line total details, click the Update 
Order button. The screen is refreshed, order lines are sorted 
alphabetically based on the Item ID, and the updated unit prices, and 
the order line total are displayed. 

28. Click Next. If the order contains an item that has been replaced by 
another item in the catalog, or if the quantity of any of the items is 
less than the minimum order quantity or more than the maximum 
order quantity configured for those items, the following error 
message is displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed." 

Click OK. The screen is refreshed, and a message is displayed in the 
Error panel below the order line, indicating why the order line failed 
validation. If it failed validation because it did not meet the minimum 
order quantity criteria or the maximum order quantity criteria, you 
can override the quantity by selecting the Override <Minimum or 
Maximum> order quantity validation for this item check box. 

If the application is configured to display the Large Order Item Entry 
screen:

29. To search for an item, in the Item column, click the  icon. The 
Advanced Item Search screen is displayed. You can add the item to 
the order in one of the following ways:

Scan the barcode of the item or the alternate item.

In Item ID, enter the identifier of the item or scan the alternate 
item identifier.

If you have already added an item to the order, click the item 
name hyperlink. The Item Details screen is displayed. For more 
information about viewing the item details, see Section 2.1.3, 
"Searching for an Item".

– If the item’s effective date has expired and the item has an 
associated item that has been configured to substitute it, a 
confirmation pop-up window is displayed. Click Yes to add the 
new item to the order. 

– If the item fails validation, the following error message is 
displayed:
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"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."

Click OK. The screen is refreshed, the  icon is displayed 
next to the order line, and a message is displayed in the 
Selected Line Information panel, indicating why the order line 
failed validation. If it failed validation because it did not meet 
the minimum order quantity criteria or the maximum order 
quantity criteria, you can override the quantity by selecting 
the Override <Minimum or Maximum> order quantity valida-
tion for this item check box. 

30. To delete a particular order line, click the  icon adjacent the 
corresponding order line. A confirmation pop-up window is displayed. 
Click Yes if you want to delete the order line. If the order line has 
related lines associated with it, the related lines are automatically 
selected for deletion along with the order line.

31. To add order line notes, click the  icon associated with the order 
line. For more information about adding order line notes, see 
Section 2.3.4.1, "Adding Notes to an Order Line".

32. Click the  icon to add related product or service items to the order 
or to replace the items in the order. For more information about 
adding related items or replacing items, see Section 2.3.1.2, "Adding 
Related Items or Replacing Items".

33. To view the components of a bundle item, click the View Components 
hyperlink. The Bundle Components pop-up window is displayed. You 
can view the details of the item, such as Item ID, Description, and Kit 
Quantity of the bundle components. Click Close to close the Bundle 
Components pop-up window. However, if the item is a configurable 
bundle item, perform the following tasks:

If the item is a preconfigured bundle item, you do not have to 
manually configure the item. However, if you want to reconfigure 
the item, click the Reconfigure hyperlink. The Product 
Configurator pop-up window is displayed where you can view the 
components of the preconfigured bundle item and reconfigure the 
item, if needed.

If the item is not a preconfigured bundle item, click the 
Configurable Bundle hyperlink to open the Product Configurator 
pop-up window and configure the item.
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34. If you enter partial Item ID of a model item or a stylized item, the 
Style Items pop-up window is displayed. For more information about 
selecting an item’s style, see Section 2.3.1.3, "Selecting an Item’s 
Style". If you scan or enter the item ID of a stylized item, the stylized 
item is added to the order.

35. In the Quantity column, enter the required item quantity.

36. In the UOM column, select the UOM for the item from the drop-down 
list. If a UOM does not exist for an item or if only one UOM exists, 
this column is not editable.

37. In the Unit Price column, you can view the unit price of the item.

After you update the order, the unit price of the bundle item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

38. In the Fulfillment method, you can view the default fulfillment 
method for the item.

39. In the Line Total column, you can view the order line total along with 
the charges and discounts, if any, applied to the order line.

If you are adding a new item, the "Update Order To View Line 
Total" message is displayed, indicating that the order needs to be 
updated to view the line total. 

The charges and discounts applied to the order line are displayed 
as hyperlinks. Click the charges value hyperlink to view the 
charges applied to the order line or click the discounts value 
hyperlink to view the discounts applied to the order line. If the 
order line has been modified so that the line total is not current, 

Note: If an item is reconfigured, the fulfillment type and 
pricing information defined for the item will not be 
available until the configuration is completed.
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the order is updated and the Line Charges or Line Discounts 
pop-up window is displayed. Click Close. 

40. In the Selected Line Information panel, you can view or modify the 
details pertaining to the selected order line.

You can view the following details pertaining to the order line:

Item information

Fulfillment method and availability (only for product items)

Unit Price

Line Total

Following is the list of information that the corresponding 
availability date displays:

– Pick Up displays the earliest date on which you can pick up the 
product from a store.

– Ship displays the earliest date on which you can ship the item.

– Delivery displays the earliest date on which the product is 
available.

Note: The availability details are not displayed if the user 
interface is not configured to do so. 
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If the fulfillment method is available for the order line, the 
appropriate option is enabled. If the fulfillment method is not 
available for the order line, the message "Not Available" is 
displayed along with the  icon. 

Information indicating whether you can perform the service for 
the order line or not (only for service items)

Price information

You can perform the following tasks on the order line that has been 
selected:

Modify Fulfillment Method

Select Store

Override Price

Change or Select an item’s style (only for stylized items)

Configure or Reconfigure Items (only for bundle items)

41. To modify the fulfillment method, select the appropriate option: 

To ship the item to the customer, select Ship.

To deliver the item to the customer’s doorstep, select Delivery.

If the customer wants to pick up the item from the current store, 
select Pick Up.

Note: In the case of the Delivery fulfillment method, the 
item availability date does not indicate the delivery 
appointment. It only indicates the date on which the 
product is available. You must take a delivery appointment 
at a later point of time. 

Note: If an order with future availability contains an item 
whose level of service is not selected, the exact availability 
date will be displayed only after the order is scheduled. For 
the exact availability date, refer to the Fulfillment 
Summary screen.
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42. To pick up the item from a store other than the current store, click 
the Choose Store hyperlink. The More Stores screen is displayed. 
Select the appropriate store from where you want to pick up the 
item. The selected store is displayed next to the Pick Up option. For 
more information about viewing inventory in other stores, see 
Section 2.3.2.2, "Viewing Inventory in Other Stores".

43. To override the price of an item, click the Override Price hyperlink. 
The Override Price for Item screen is displayed. To override the item 
price:

a. In Overridden Price, enter the new price of the item.

b. From the Reasons for Override drop-down list, select the 
appropriate reason.

c. In the Notes panel, enter any additional information, if applicable.

d. Click Close.

44. If the item is a stylized item, you can change the item’s style or 
select a style for the item: 

To change the item’s style, click the Change Style hyperlink. The 
Style Items pop-up window is displayed. For more information 
about changing an item’s style, see Section 2.3.1.3, "Selecting an 
Item’s Style".

To select a style for the item, click the Choose Style hyperlink. 
The Style Items pop-up window is displayed. For more 
information about selecting an item’s style, see Section 2.3.1.3, 
"Selecting an Item’s Style".

45. If the item is a bundle item, you can configure or reconfigure the 
item: 

To configure the item, click the Configure hyperlink. For more 
information about configuring an item, see the Sterling 
Multi-Channel Selling Solution Administration Guide.

To reconfigure an item, click the Reconfigure hyperlink. For more 
information about configuring an item, see the Sterling 
Multi-Channel Selling Solution Administration Guide.

46. If the item has accessories, the Accessories panel is displayed where 
you can view details about the accessories. To add the accessories to 
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the order, click Add To Order. The Accessories panel is displayed only 
when the order line is selected.

47. To add an open box item, click the Add Open Box Item hyperlink. For 
more information about open box items, see Section 3.3.9, "Adding 
Open Box Items".

48. To add new service lines, click the Add Independent Services 
hyperlink. The Item Search screen is displayed. Select the service you 
want to add. The service line is added and indicated by the  icon. 
For more information about performing an advanced item search, see 
Section 2.1.3.4, "Performing an Advanced Item Search".

49. To view the price breakdown of the order, click the value of the 
Subtotal that is displayed as a hyperlink. If the line total is not 
current, the order is updated and the Order Pricing Summary pop-up 
window is displayed. You can view the details of the prices on the 
order, such as the order line prices, line-level price adjustments, 
order total, order-level price adjustments, order-level shipping 
charges, and taxes on the order. 

To view the line-level price adjustments resulting from charges 
and discounts applied to the order line, click the corresponding 
Adjustments value that is displayed as a hyperlink. The Line 
Charges and Discounts pop-up window is displayed. Click Close.

To view the order-level price adjustments resulting from charges 
and discounts applied to the order, click the Order Adjustments 
value that is displayed as a hyperlink. The Order Charges and 
Discounts pop-up window is displayed. Click Close. 

50. To view the updated unit price and line total details, click the Update 
Order button. The screen is refreshed, order lines are sorted 
alphabetically based on the item ID, updated unit prices, and order 
line total are displayed.

51. Click Next.

If the order contains an item that has been replaced by another item 
in the catalog, or if the quantity of any of the items is less than the 
minimum order quantity or more than the maximum order quantity 
configured for those items, the following error message is displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."
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Click OK. The screen is refreshed, the  icon is displayed next to 
the order line, and a message is displayed in the Selected Line 
Information panel, indicating why the order line failed validation. If it 
failed validation because it did not meet the minimum order quantity 
criteria or the maximum order quantity criteria, you can override the 
quantity by selecting the Override <Minimum or Maximum> order 
quantity validation for this item check box. 

52. The Create Order: Change Fulfillment Options screen is displayed. For 
more information about choosing a fulfillment method, selecting an 
appointment, and viewing payment information, see Section 2.5.1, 
"Modifying Fulfillment Options".

53. Click Next. The Fulfillment Summary screen is displayed. For more 
information about the fulfillment summary details, see Section 2.5.2, 
"Fulfillment Summary".

54. Click Next. 

If order lines are being delivered on this order, the Service 
Appointment screen is displayed where you can create an 
appointment. For more information about creating an 
appointment, see Section 2.5.5, "Modifying Service 
Appointments".

If there are no order lines to be delivered, the Payment 
Confirmation screen is displayed. For more information about 
viewing and confirming payment details, see Section 2.3.8, 
"Viewing and Confirming the Payment Details".

If you are not required to enter the payment information, the 
Order Confirmation screen is displayed.

Note: The Fulfillment Summary screen is displayed only if 
the fulfillment method is either Shipping or Pick Up.

Note: If you have not captured the customer information, 
the Bill To Address screen is displayed for you to enter the 
billing details.
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Table 2–1 Order Confirmation Screen

For more information about configuring the payment options, see the 
Sterling Call Center and Sterling Store: Implementation Guide.

55. To view or modify the payment details for an order:

a. Click the View/Edit Order Payment Details hyperlink. The Order 
Payment Details screen is displayed. Modify the charge details at 
the order level or order line level.

b. Select the Charge Override Reason.

c. In the Notes panel, enter any additional information, if applicable. 
For more information about adding notes to an order, see 
Section 2.3.4, "Viewing and Adding Notes to an Order".

d. Click Confirm to save the changes and return to the Payment 
Confirmation screen.

56. Click Confirm.

2.3.1.1 Adding a New Contact
You can add a new contact for a business customer.

To add a new contact: 

Note: The Order Confirmation screen is displayed only if 
you are not required to enter the payment information or if 
the payment methods are implemented using an external 
payment system. For field value descriptions, see 
Table 2–1, "Order Confirmation Screen".

Field Description

Print and Close Click this button to save notes added to the order, print 
the order information, and close the order tab.

Cancel Order Click this button to cancel the order.

Note: You can modify only the existing charges.
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1. In the Customer panel, click the Add New Contact hyperlink. The Add 
Contact pop-up window is displayed. 

2. Provide the corresponding information in the following panels, and 
click Confirm:

In the Customer Account panel, enter the first name and last 
name, middle initial, e-mail address, job title, and department of 
the contact.

In the Customer Contact Information panel, enter the contact’s 
evening phone number, evening fax number, day phone number, 
day fax number, and mobile phone number.

In the Personal Information panel, enter the appropriate dates. To 
select a date, click the  icon and then select the month, year 
and day.

In the Contact Spending Limit panel, select the currency and 
enter the spending limit for the contact. In addition, specify an 
approving user and a backup approver. An approving user can 
approve an order for a contact who has exceeded a spending 
limit. A backup approver can approve orders for the contact if the 
contact is unavailable.

In the Web User panel, create a web user by entering a login ID, 
and selecting the locale and status for the contact. When you 
include information in these fields, the contact is linked to this 
web user, and an e-mail containing the web user’s password is 
sent to the customer. In addition, you can select the user roles 
that you want to assign to this web user. User roles determine 
what a user can access on the web channel.

2.3.1.2 Adding Related Items or Replacing Items
You can add related product or service items to an order or replace the 
items in an order through a pop-up or a panel.

To add related items to an order or replace the items in an order through 
a pop-up.

1. Click the  icon. The Related Items pop-up window is displayed. 
You can view details such as the item description, item ID, unit price, 
associated quantity and the availability dates for Shipping, Pick Up, 
and Delivery. 
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2. Select the check boxes next to the product or service items that you 
want to add to the order.

3. Click Add to Order. If the item that you added has been configured to 
replace the original item, the new item replaces the original item and 
its related items.

The related item that you added is indicated by the  icon. The 
tooltip for the related item indicator displays the parent item 
description.

To add related product or service items to an order through a panel:

1. Place the cursor on the line for which related lines need to be added. 
The Related Items panel is displayed at the bottom of the screen. You 
can view details such as the item description, item ID, unit price, 
associated quantity, and the availability dates for Shipping, Pick Up, 
and Delivery.

Note:  If the Check Inventory Configuration rule is not 
selected for related items, the availability dates will not be 
displayed.

Note: If an order with future availability contains an item 
whose level of service is not selected, the exact availability 
date will be displayed only after the order is scheduled. For 
the exact availability date, refer to the Fulfillment 
Summary screen.

Note: If the status modification rules do not allow you to 
cancel the original item or any of its related items, the 
check boxes for the items that have been configured to 
replace the original item are disabled. 

Note: If you select an item that has been configured to 
replace the original item, the check boxes for the other 
items are disabled. 
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2. Press the INSERT key to set focus to the related items panel. Press 
Insert if you want to set focus back to the parent item panel.

3. Click Add to Order. If the item that you added has been configured to 
replace the original item, the new item replaces the original item and 
its related items.

The related item that you added is indicated by the  icon. The 
tooltip for the related item indicator displays the parent item 
description.

2.3.1.3 Selecting an Item’s Style
Perform the following steps to select an item’s style. Note that the 
following steps are applicable only if the Sterling Call Center and Sterling 
Store applications are configured to perform real-time availability checks 
for all the child items.

1. To check availability of items, you need to select:

Note:  If the Check Inventory Configuration rule is not 
checked for related items, the availability dates will not be 
displayed.

Note: If an order with future availability contains an item 
whose level of service is not selected, the exact availability 
date will be displayed only after the order is scheduled. For 
the exact availability date, refer to the Fulfillment 
Summary screen.

Note: If the status modification rules do not allow you to 
cancel the original item or any of its related items, you 
cannot select any of the items that have been configured 
to replace the original item.

Note: The associated quantity of related items is always 
displayed for 1 quantity of the parent item.
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Country or Region

State

Zipcode

If the postal code is entered, the fulfillment methods available for the 
items are enabled based on the Catalog Configuration and inventory 
availability.

If the postal code is not entered, then the possible fulfillment 
methods for the items are displayed based on the Catalog 
Configuration and not based on the inventory.

2. In the Fulfillment Options panel, select the fulfillment method.

3. Select the appropriate attributes and click the Add to Order button to 
add the stylized item to the order.

2.3.2 Adding Order Lines
After placing an order, the customer may want to order more of an item 
or order for a new item. In such a situation, you may need to add new 
product or service lines to an existing order.

A navigation bar is displayed at the bottom of all screens in the Add Lines 
to Order task flow. This helps you to understand the sequence of steps 
you need to perform to complete the task. The navigation bar also helps 
you to revisit previous screens easily, if applicable.

Note: If the Sterling Call Center and Sterling Store 
applications have been configured to check the availability 
of child items in a cached inventory, the Fulfillment Options 
panel will not be displayed.
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To add new product or service lines, you must first search for the order. 
For more information about searching for an order, see Section 2.1, 
"Performing Search Tasks".

To add new product or service lines:

1. From Tasks > Order, select Add Lines To Order. The Add Multiple 
Lines: Add Items screen is displayed.

2. For new order lines, in Item, enter the identifier of the item or item 
description, or choose the  to select an item from the Item List. 
You can also click the Add More Lines hyperlink. For more information 
about performing an advanced item search, see Section 2.1.3.4, 
"Performing an Advanced Item Search".

If the item’s effective date has expired and the item has an 
associated item that has been configured to substitute it, a 
confirmation pop-up window is displayed. Click Yes to add the new 
item to the order. 

Note: The user can configure the country or region 
drop-down menu to not appear on screen. For more 
information on how to configure the country or region 
display, see the Sterling Call Center and Sterling Store: 
Implementation Guide.

Note: If the status modification rules do not allow you to 
add an item to the order, an error message is displayed. 
For example, if the status modification rules do not allow 
you to add an item to the order which is in the scheduled 
status, the message "A new item cannot be added to the 
order because the order has already been scheduled" is 
displayed.

Note: Based on the order age configured, you can add 
new order lines to an existing order. If the order creation 
date is greater than the configured days, an error message 
is displayed.
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3. To view the price adjustments applied to an order line, perform the 
following tasks:

To view the charges applied to the order line, click the charges 
value hyperlink in the Line Total column. The Line Charges pop-up 
window is displayed.

To view the discounts applied to the order line, click the discounts 
value hyperlink in the Line Total column. The Line Discounts 
pop-up window is displayed.

4. To view the components of a bundle item, perform the following 
tasks:

In the Add Items screen, click the  icon.

In the Large Order Item Entry screen, click the View Components 
hyperlink.

5. For new service lines, click the Add Independent Services hyperlink. 
The Item Search screen is displayed. Select the service you want to 
add. The service line is added and indicated by the  icon. For more 
information about performing an advanced item search, see 
Section 2.1.3.4, "Performing an Advanced Item Search".

6. To view the updated unit price and line total details, click the Update 
Order button. The screen is refreshed, order lines are sorted 
alphabetically based on the item ID, and the updated unit prices and 
order line total are displayed.

7. Click Next.

If the item fails validation because it does not meet the minimum 
order quantity criteria or the maximum order quantity criteria, the 
following error message is displayed:

Note: If the bundle item that is configured as ship 
independent is added to an order, the Choose Store 
hyperlink is not displayed.

Note: When a new line is added to the order, the order 
line is indicated by the  icon.
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"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."

Click OK. The screen is refreshed and a message is displayed in the 
Error panel below the order line, indicating why the order line failed 
validation. You can override the quantity by selecting the Override 
<Minimum or Maximum> order quantity validation for this item check 
box. 

8. The Add Multiple Line: Change Fulfillment Options screen is displayed. 
You can view a detailed description about the item, quantity, and the 
fulfillment method. For more information about modifying the 
fulfillment options, see Section 2.5.1, "Modifying Fulfillment Options".

Note: The error message is displayed only if the new item 
that is added to the order fails validation.

Note: When you add a bundle item to the order, the 
fulfillment method for the bundle components will default 
to the same fulfillment method as the parent bundle item.

Note: When you add a related line to the order, the 
fulfillment method for the related line will default to the 
same fulfillment method as the parent item. For example, 
if the fulfillment method of the parent item is "Pick Up", 
when you add a related line, the fulfillment method for the 
related line is also "Pick Up". If the related line does not 
support this fulfillment method, a warning message 
displays prompting you to select a different fulfillment 
method.
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9. Choose the appropriate fulfillment option from the Select Fulfillment 
Method panel.

If the fulfillment method is Ship, select the appropriate fulfillment 
option from the drop-down list.

If the fulfillment method is Delivery, select the address to which 
the product needs to be delivered from the drop-down list.

If the fulfillment method is Pick Up, select the country or region 
from the drop-down list and enter the postal code. Click the 
Choose Stores hyperlink.

If the order line is a service line, the Select Service Address panel 
is displayed. 

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

Note: The attributes are displayed based on pre-defined 
configurations. The UOM, Unit Price, Quantity, and the Line 
Total fields are displayed or hidden based on the display 
configuration.
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10. Click Next. The Add Multiple Lines: Fulfillment Summary screen is 
displayed where you can view and modify the configuration of the 
order and how it is being fulfilled. For more information about 
fulfillment summary details, see Section 2.5.2, "Fulfillment 
Summary".

11. Click Next. 

If any order lines are being delivered and the newly added lines 
require a new appointment or an existing appointment needs to 
be retaken, the Service Appointment screen is displayed. For 
more information about creating or modifying an appointment, 
see Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

Note: If the item does not support the selected fulfillment 
method, the fulfillment option will be disabled when you 
select that item. If you select multiple items and they do 
not share a common fulfillment option, an error displays 
indicating that there are no common fulfillment methods 
for selected order lines.

Note: Based on the rules configured, you can modify any 
order line that has the Delivery fulfillment method until the 
delivery line is shipped. For more information about 
configuring special order modification rules, see the 
Sterling Call Center and Sterling Store: Implementation 
Guide.

Note: The Fulfillment Summary screen is displayed only if 
the fulfillment method is either Shipping or Pick Up.
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12. Click Next. The Change Payment Methods screen is displayed. For 
more information about modifying payment methods, see 
Section 2.7.4, "Changing Payment Methods". In the Notes panel, 
enter any additional information, if applicable. For more information 
about adding notes to an order, see Section 2.3.4, "Viewing and 
Adding Notes to an Order".

2.3.2.1 Overriding Item Price
You can override the item price of an item in the Override Price for Item 
screen.

To override the price of an item:

1. From the Unit Price column, select the Override Price hyperlink. The 
Override Price for Item screen is displayed.

2. In Overridden price, enter the new price of the item.

3. From the Reasons for Override drop-down list, select the appropriate 
reason.

4. In the Notes panel, enter any additional information, if applicable.

5. Click Close.

2.3.2.2 Viewing Inventory in Other Stores
If the customer wants to pick up an item from a store that is not 
displayed on a screen, the CSR needs to look for other stores. To search 
for other available stores:

1. Click the View More Stores link. The View More Stores screen is 
displayed.

1. Enter the postal code from where the customer wants to pick the 
item. 

2. Click Search. A list of stores is displayed for the postal code. 

3. Select the appropriate store from the list.

Note: You can override the price of a bundle parent item 
only.
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2.3.2.3 Adding or Modifying Addresses
After a customer places an order, the customer may want to add a new 
address or modify the existing address to deliver the items.

2.3.2.3.1 Adding a New Address  

Adding a new address is a common CSR task.

To add a new address:

1. From the appropriate screen, click the New Address hyperlink. The 
Add New Address pop-up window is displayed. You can view the 
Primary Info, Street Address, and the Contact Info panels.

2. If you have launched this task in the context of a customer, select an 
address from the Bill To Address drop-down list.

3. Enter the primary information, street address, or contact information 
appropriately. In the Display Address As field, enter a description for 
the address. This helps you to easily identify the address the 

Note: You can also view the bundle component items 
while viewing the inventory for a bundle parent item.

Note: To select a store using the keyboard, navigate 
through the list of stores using the Tab key. Once the focus 
is on the check box of the store that you want to select, 
press spacebar.

Note: If you are dealing with a single country or region, 
the country or region drop-down list does not display on 
the screen. For more information about configuring the 
country or region display, see the Sterling Call Center and 
Sterling Store: Implementation Guide.
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customer is referring to when you are performing various 
address-related tasks.

If the address is not valid, the message "This is not a valid address" 
is displayed.

4. If you want to override the address verification, check the Override 
Address Verification box.

5. If you want to add the address to the customer record, select the Add 
this address to the Customer’s record box.

6. In the Change Order : Change Service Appointment screen, if you 
click Previous button, it will take you to the previous screen where 
you can modify the address.  

7. Click Confirm.

2.3.2.3.2 Modifying an Address  

Modifying an existing address is a common CSR task.

To modify an address:

1. From the appropriate screen, select the address you want to modify 
from the drop-down list and click the Modify Address hyperlink. The 
Modify Address pop-up window is displayed.

If there are multiple ship to address with the same information in the 
first line, the Choose Your Address screen is displayed. Select the 
appropriate address.

2. To modify an existing ship to address, click the Modify Address 
hyperlink in the appropriate Ship To Address panel. The Modify 
Address pop-up window is displayed.

Note: The Display Address As field will be displayed only 
if you have launched this task in the context of a customer.

Note: Based on the configuration, the City and State 
names may be populated depending on the information 
provided in the Country or Region and Postal Code fields.
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3. Modify the primary information, street address, or contact 
information appropriately. In the Display Address As field, enter a 
description for the address. This helps you to easily identify the 
address the customer is referring to when you are performing various 
address-related tasks.

If the address is not valid, the message "This is not a valid address" 
is displayed.

4. If you want to override the address verification, check the Override 
Address Verification box.

5. Click Confirm.

2.3.3 Increasing Order Line Quantity
Sometimes a customer may want to increase the quantity of one or more 
items on an order that is already placed. In such situations, the user can 
increase the order line quantity as requested by the customer. The line 
quantity can be increased for orders that have single or multiple order 
lines. For more information about searching for an order, see Section 2.1, 
"Performing Search Tasks".

This task does not check for future availability and should be used to 
increase the quantity on the order when the user is sure that the 
additional quantity is available on the same date as the original ordered 
quantity. In other cases, the Add Lines To Order task can be used. For 
more information about adding multiple lines to an order, see 
Section 2.3.2, "Adding Order Lines".

To increase the quantity of an existing order line:

1. From Navigator > Order, select Increase Line Quantity. The Increase 
Line Quantity screen is displayed.

2. In the Increase Line Quantity panel, you can view information about 
the item such as item description, identifier of the item or the 
alternate item, unit price, status, ordered quantity of the item, 
additional item quantity, and available item quantity.

Note: The Display Address As field will be displayed only 
if you have launched this task in the context of a customer.
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If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

3. In the Additional Quantity column, enter the additional item quantity 
that is required. When you select the Additional Quantity column, by 
default, the additional item quantity is set to 1.

4. If the requested additional item quantity exceeds the available 
quantity, a  icon along with the available item quantity is displayed 
in the Available Quantity column.

5. If you cannot deliver the requested additional item quantity on the 
original delivery date, the following message is displayed: "The 
requested quantity cannot be fulfilled. Please add a new order line".

6. In the Notes panel, you can enter any additional information related 
to increasing the order line quantity. Basic notes display in the Notes 
panel. You can modify this information as needed. For more 
information about adding order notes, see Section 2.3.4, "Viewing 
and Adding Notes to an Order".

7. Click Confirm.

If you attempt to add more quantity to an order line that is already 
released, the system may prompt you to manually verify whether or 
not you can add quantity to that order line. If you can add quantity, 
click Verified.

If the quantity of a service item is increased, the Service 
Appointment screen is displayed. For more information about 
creating or modifying an appointment, see Section 2.5.5, 
"Modifying Service Appointments".

Note: If the status modification rules do not allow you to 
increase the order line quantity, the order line is disabled.
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8. Click Next. The Confirm Payment screen is displayed where you can 
view the payment details for the order. For more information about 
payment confirmation, see Section 2.3.8, "Viewing and Confirming 
the Payment Details".

2.3.4 Viewing and Adding Notes to an Order
You may have to enter additional notes to an order, describing the 
various actions taken on that order, for future reference. The order notes 
can be either entered manually by you or generated automatically by the 
system. To add notes to an order, you must first search for the 
corresponding order. For more information about searching for an order, 
see Section 2.1, "Performing Search Tasks".

To view the notes pertaining to an order:

1. In the Order Summary screen, click the View/Add Notes hyperlink in 
the Important Notes panel. The Order Notes screen is displayed.

2. From the Filter By Note Type drop-down list, select a note type to 
view notes pertaining to a specific note type.

3. By default, the Lower Priority Notes check box is selected. Clear the 
Lower Priority Notes check box if you want to view only high-priority 
notes. 

4. From the Filter by Contact Method drop-down list, select a contact 
method to view notes pertaining to a specific contact method. For 

Note: When you increase the line quantity of a bundle 
item, all the component quantity will be increased in the 
same ratio defined while configuring bundles.

Note: When an order line is a part of a work order that 
has been partially delivered, you cannot increase the order 
line quantity.

Note: The Important Notes panel displays only the high 
priority notes.
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example, to view notes related to a customer’s call, select Phone as 
the contact method.

5. In the Notes Created By field, the User check box is selected by 
default. Select the System check box to view the system-generated 
notes in addition to the manually entered notes.

6. In the Notes Created On field, select the Order Lines check box to 
view the notes pertaining to all the order lines. Select the Return 
check box to view order-level notes for the return orders created for 
a sales order.

7. By default, the notes are truncated and displayed.

Click the Expand All Notes hyperlink to expand all the notes 
displayed in the Order Notes screen.

Click the Expand hyperlink next to a truncated note to expand 
that note. 

To add a note to an order:

1. From the Note Type drop-down list the Order Notes screen, select the 
appropriate note type, if applicable.

2. From the Contact Method drop-down list, select the appropriate 
contact method, if applicable.

3. Select the Mark Priority as High check box if the note is of high 
priority.

4. Select the For Internal Use Only check box to mark the note for 
internal viewing.

5. Enter Contact Details such as the e-mail address or the telephone 
number of the customer.

6. Select the appropriate emoticon (smiley) for an order note, if 
applicable.

7. Enter the text of the note in the space provided.

8. Click Add Note. The note is added and displayed in the Order Notes 
panel.
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9. Click Close.

2.3.4.1 Adding Notes to an Order Line
Sterling Call Center and Sterling Store enables you to add notes to an 
order line.

To view notes and add notes to an order line:

1. In the Order Summary screen, right-click the appropriate order line 
and select Add Line Notes. The Order Line Notes screen is displayed, 
where you can view and add notes.

2. Select the Order Header check box to view the notes pertaining to the 
corresponding sales order. 

3. Select the Return check box to view the notes pertaining to the return 
orders created for this order.

In the Order Summary screen, the order lines that contain notes are 
associated with the  icon. 

2.3.4.2 Adding Notes to a Return Order
Sterling Call Center and Sterling Store enables you to view notes and add 
notes to a return order.

To view notes and add notes to a return order:

Note: You can add notes that are specific to the bundle 
component level if the bundle item is configured as ship 
independent.

Note: If the status modification rules do not allow you to 
add notes to the orders that are in the current status, the 
Notes panel and the Add Note button are disabled.

Note: In the Order Summary screen, the order lines that 
contain notes are associated with the  icon.
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1. In the Return Order Summary screen, click the View/Add Notes 
hyperlink in the Important Notes panel. The Order Notes screen is 
displayed, where you can view and add notes.

2. Select the Order Line check box to view the notes added to the order 
lines.

2.3.5 Applying Hold
After creating an order, you can place the order on hold. Holds are 
usually placed to prevent further modifications to a particular order. For 
example, you may want to place an order on a Fraud Check hold after 
creating the order. Only users who belong to a user group that has the 
necessary permissions can place an order on hold at both the order level 
and the order line level.

To place either an order or order line on hold:

1. From Tasks > Order, select Apply Hold. The Apply Hold screen is 
displayed.

2. To place an order on hold, select the Select the entire order to apply 
an hold option. 

If the status modification rules do not allow you to place the entire 
order on hold, the Select the entire order to apply an hold option is 
disabled, and the message "Hold cannot be applied to the order in 
this status" is displayed, indicating that you cannot place the order on 
hold.

To place an order line on hold, select the Select specific lines to apply 
an hold option.

If the status modification rules do not allow you to place specific 
order lines on hold, the Select specific lines to apply an hold option is 
disabled, and the message "Hold cannot be applied to the order lines 
in this status" is displayed, indicating that you cannot place the order 
lines on hold. Additionally, all the order lines are disabled.

Note: If the status modification rules do not allow you to 
place either the entire order or specific order lines on hold, 
the message "Hold cannot be applied on this order" is 
displayed.
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3. Select the appropriate hold type from the Hold Type drop-down list. 
For more information about defining holds, see the Sterling 
Distributed Order Management: Configuration Guide.

4. In the Notes panel, enter any additional information, if applicable.

5. Click Apply Hold.

2.3.6 Removing Holds
When performing order modifications, the entire order or just certain 
order lines may be placed on hold to prevent further modifications. You 
can remove holds if you belong to the user group that has permission to 
do so. To remove a hold on an order, you must first search for the orders 
that are on hold. For more information about searching for an order, see 
Section 2.1, "Performing Search Tasks".

To remove a hold on an order or order line:

1. From Tasks > Order, select View/Remove Holds. The Order Holds 
screen is displayed.

2. Check the appropriate box next to the hold that you want to remove.

Note: To apply a particular hold, you must belong to a 
user group that has the necessary permission to manually 
apply the hold.

Note: If the order contains a bundle item, the unit price 
of the item is displayed as a hyperlink. To view the details 
of the bundle item, click the unit price hyperlink. The 
Component Lines pop-up window is displayed. You can 
view the details of the bundle parent and its components 
such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy 
defined for the bundle item, see Section 2.1.4.3, "Viewing 
Prices of Bundle Items".
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3. Check the Check All box if you want to remove all holds on the order 
at one time.

4. In the Notes panel, enter any additional information, if applicable. For 
more information about adding notes, see Section 2.3.4, "Viewing 
and Adding Notes to an Order".

5. Click Confirm.

2.3.7 Canceling an Order
A customer may want to cancel an entire order, or just certain product or 
service items of the order. To cancel an order, you must first search for 
the order. For more information about searching for an order, see 
Section 2.1, "Performing Search Tasks".

To cancel an order:

1. From Tasks > Order, select Cancel Order. The Cancel Order screen is 
displayed.

2. To cancel the entire order:

a. In the Quantity To Cancel panel, select the cancellation reason 
from the Reason Code drop-down list.

b. Choose the Select All Available Quantity For Cancellation option.

3. To cancel only some of the items included in the order:

a. In the Quantity To Cancel panel, select the cancellation reason 
from the Reason Code drop-down list.

Note: If you want to remove a particular hold, you must 
belong to the user group that has permission to manually 
remove the hold.

Note: Click the  icon on the Line Summary screen to 
view the order line holds only.
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b. Choose the Select Specific Quantity For Cancellation option.

c. Check the boxes of the items you want to cancel.

d. In the Enter the Quantity to Cancel field, enter the quantity of the 
item you want to cancel. 

e. In the status field of the order line, the  icon is displayed if a 
stop delivery request is placed.

4. In the Notes panel, enter any additional information for an order, if 
applicable. For more information about adding notes, see 
Section 2.3.4, "Viewing and Adding Notes to an Order".

5. Click Confirm. The Confirm Payment screen is displayed. For more 
information about payment confirmation, see Section 2.3.8, "Viewing 
and Confirming the Payment Details".

Note: You cannot select a cancellation reason which is 
enclosed between **. This signifies that the cancellation 
reason is incompatible with the version of the application 
being used.

Note: If the order contains a bundle item, the unit price 
of the item is displayed as a hyperlink. To view the details 
of the bundle item, click the unit price hyperlink. The 
Component Lines pop-up window is displayed. You can 
view the details of the bundle parent and its components 
such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy 
defined for the bundle item, see Section 2.1.4.3, "Viewing 
Prices of Bundle Items".

Note: You cannot cancel order lines that are greyed out.
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2.3.8 Viewing and Confirming the Payment Details
You can view payment details such as the amount reduced, original total, 
new total, and details about the existing payment methods for the order. 
You can also add a coupon or new payment method, if necessary.

In the Detail List of Adjustment panel, you can view the item 
information such as the identifier of the item or the alternate item, 
the item’s description, adjusted quantity, adjusted amount, charge 
refund details, and applied coupon or promotion details.

If a stop delivery request is placed, a confirmation message is 
displayed along with the details of the Item and the Requested 
Quantity for that stop delivery.

If an order is created for an existing customer, you can view the 
payment methods that are available for that customer in the Payment 
Methods panel. (The default payment methods are already selected in 
the panel). To apply a different payment method, select the 
corresponding payment method from the available list or add a new 
payment method. For more information about adding new payment 
methods, see Section 2.7.4.1, "Adding New Payment Methods".

For more information about changing payment methods, see 
Section 2.7.4, "Changing Payment Methods". For more information 
about managing payment methods, see Section 2.8.7, "Managing 
Customer Payment Method".

Note: You can only cancel a bundle parent item. When 
you cancel a bundle item, all the component quantity will 
be cancelled in the same ratio defined while configuring 
bundles.

Note: If the status modification rules do not allow you to 
cancel an order line, then the order line is disabled.

Note: If the line that you want to cancel has related lines, 
the related lines are automatically selected for 
cancellation.
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The funds available on a gift card or a stored value card are 
displayed. The Charge Amount is defaulted to either the order total or 
the funds available on the gift card, whichever is less.

If the payment method is Customer Account, the funds available on 
the Customer Account is displayed in the Funds field.

In case of a credit card, enter the CVV number when real-time 
authorizations are required. If only one credit card is used, the 
charge amount is defaulted from the order total. If multiple credit 
cards are used, enter the charge amount for each of the credit cards.

If the payment method type is Check or Refund Check, you cannot 
modify the check amount.

If you want to add a coupon or promotion to the order, click Add 
Coupon. For more information about adding coupons and promotion 
codes, see Section 2.7.3, "Adding a Coupon or Promotion Code".

If you want to add a new payment method, click Add Payment 
Method. For more information about adding new payment methods, 
see Section 2.7.4.1, "Adding New Payment Methods".

If you want to add a new charge or modify an existing charge, click 
the Add/Modify Charges hyperlink. The Add/Modify Charges pop-up 
window is displayed. For more information about adding or modifying 
charges, see Section 2.3.11.1, "Adding or Modifying Charges".

If you want to enter any additional information for the order, in the 
Notes panel, enter the appropriate notes. For more information about 
adding notes, see Section 2.3.4, "Viewing and Adding Notes to an 
Order".

Click the Previous button to revisit the previous screen.

After you view the details or add a new payment method, click Confirm. 
Payment methods will be authorized and saved on the order. If 
authorization fails on any of the payment methods, the corresponding 
payment method is displayed in red and an error message is displayed. 
You can either click the payment method and make the necessary 
changes or if you feel that the payment method incorrectly returned an 
error, for example, when the payment system is unreachable, you can 
override the error and continue by selecting the Override and Continue 
check box.
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If you are viewing the payment details after creating a return, you will 
see the View/Change Charge Details hyperlink in the Return Order Totals 
panel and Exchange Order Totals panel. For more information about 
viewing charge details, see Section 2.3.11, "Adding or Modifying 
Charges".

Note:

If the payment method is Customer Account, and if the 
account limit is exceeded, a warning message is 
displayed, indicating that the funds available in the 
account are insufficient to fulfill the order, and that the 
order may be put on hold until sufficient funds are 
provided.

If the payment method type is Other, you cannot 
modify the Charge Amount. The Charge Amount is 
deducted from the Provide Method of Payment for 
Amount field.

If you want to clear the value in the Amount to Charge 
field, ensure you enter zero. Do not keep the field 
blank.
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2.3.9 Returning an Order
Customers may want to return or exchange ordered items. For a 
complete description of how to accomplish this, see Section 2.10.1, 
"Creating a Return Order".

2.3.10 Tracking an Item or Inquiring About a Shipment
Customers may sometimes need to know the status of their orders. For 
example, if a customer does not receive items that were ordered, they 
may inquire about the status of a product or service item. To inquire 
about the status of a product or service item, you must first search for 
the order. For more information about searching for an order, see 
Section 2.1, "Performing Search Tasks".

To track an item:

1. Do one of the following to open the Shipment Inquiry screen:

From Tasks > Frequent Queries, select Where is my shipment? 

From Tasks > Order, select Track An Item.

In the Order Summary screen, right-click on the required item 
and select Track This Item. 

Note: If an exchange order is opened from Sales Order 
flow:

The exchange type of the exchange order and the 
return total are not considered for displaying the 
payment information.

If the return order associated with the exchange order 
is a draft order, the Confirm button in the Confirm 
Payment screen is disabled. A message is displayed, 
indicating that the exchange order cannot be confirmed 
because the return order associated with it is yet to be 
confirmed. You can also click the View Return Order 
hyperlink to open the return order and perform the 
appropriate action.
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You can view tracking information for each item. You can also view 
information about holds applied to an order and hyperlinks to 
navigate to the Alert Details screen, if applicable.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

2. Select the item for which you want to view the shipment status.

If the item is in the "Shipped" status:

– You can view the date on which the item is shipped.

– If the item is packed in a container, you can view the tracking 
number, if available. 

– If the item is packed in multiple containers, you can view the 
container details.

– You can view the carrier and service information for the 
shipment.

– If you want to reship a container, click the Reship Container 
hyperlink. The Reship Select Item screen is displayed.

For more information about reshipping, see Section 2.5.9, 
"Reshipping an Item".

– If you want to view the shipment details, click the View 
Shipment hyperlink. The Shipment Details screen is displayed. 
For more information about viewing shipment details, see 
Section 2.3.10.1, "Viewing Shipment Details".

– If you want to view the container activities, click the View 
Container Activities hyperlink. The Container Activities pop-up 
window is displayed.
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If the item is not in the "Shipped" status:

– You can view the date on which the item is scheduled to be 
shipped, and the estimated delivery date.

– If the item is packed in multiple containers, you can view the 
container details.

– If the shipment is created, but the items are not packed into 
the containers, you can view the shipment lines.

– If the order line is on hold, it is indicated by the  icon with 
"This Line is on Hold" message.

– The  icon is displayed if a stop delivery request has been 
placed.

– If the shipment is not created, but inventory is available, the 
estimated ship date and the estimated delivery date is 
displayed.

If the item is in the "Delivered" status:

– You can view the delivery date or estimated delivery date for 
the shipment.

– If the item is packed in multiple containers, you can view the 
container details.

If the item is a service item, you can view the appointment date 
and status of the existing service appointment.

If the customer has picked the item up at a store, you can view 
the date on which the item was picked up.

If the item is in the "Cancelled" status, an appropriate message is 
displayed. The cancelled item quantity and the date on which the 
item was cancelled also display.

Note: If the capability for tracking a container is 
provided, the tracking number is displayed as a hyperlink. 
Click this hyperlink. The appropriate carrier’s Web site is 
displayed where you can view the container’s tracking 
information.
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If an order line is associated with a work order and service 
appointments exist for the work order, you can view the service 
appointments. If there are multiple appointments for a work 
order, the system displays the most recent service appointment.

If an order line is associated with a work order and service 
appointments do not exist for the work order, an appropriate 
message is displayed indicating that an appointment needs to be 
taken.

If a work order is cancelled, you can not view any information on 
the screen.

If an order is on hold, you can view the hold information. You can 
also view alert details associated with the hold, if any.

If the fulfillment method on the order line is different from that on 
the shipment, you can also view the fulfillment method on the 
shipment. 

If the ship to address on the order line is different from that on 
the shipment, the message "The ship to address was modified on 
this shipment" is displayed.

Kit items are shown using an indicator. The tooltip for the kit item 
indicator displays the parent kit item ID. 

Unit Prices are not available for kit items. Therefore, the message 
"Not Available" is displayed for the unit price of the kit item. The 
tooltip for the "Not Available" message displays the parent kit 
item ID.

3. Click Close.

2.3.10.1 Viewing Shipment Details
In the Shipment Details screen:

You can view details about the shipment such as the shipment 
number, service, ship node, status, seller, and number of containers 
by clicking on the View Shipment link.

If you want to reship the shipment, click the Reship Shipment 
hyperlink. The Reship Select Item screen is displayed. For more 
information about reshipping a shipment, see Section 2.5.9, 
"Reshipping an Item".
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In the Shipment Lines in this shipment panel, you can view details 
about the shipment lines such as the identifier of the item or the 
alternate item, item quantity, unit price, and order number. You can 
also view the tracking number, container number information, and 
ship to address.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

If activities are specified for a container, the View Container Activities 
hyperlink is displayed. Click the hyperlink to display the Container 
Activities pop-up window. You can view details such as the activity 
code, time stamp, additional information pertaining to the activity, 
and the user who created the activity.

2.3.11 Adding or Modifying Charges
The Add/Modify Charges screen provides information about the price 
details of an order. To view the charge details, you must first search for 
the order. For more information about searching for an order, 
Section 2.1.1, "Searching for an Order".

From Tasks > Order Tasks, select Add/Modify Charges. The 
Add/Modify Charges screen is displayed.

You can view details such as taxes, charges and discounts at the 
order level and at the line level. 

In the Overall Order Totals panel, you can view the line total, grand 
charges, grand taxes, grand discount and the grand total. 

In the Header Price Details panel, you can view the, header taxes, 
header charges, header discount and the header total.

In the Charge Breakup panel, you can view the break up of the 
charges on the order. If you want to add or modify the charges, click 
the Add/Modify Charges hyperlink. The Add/Modify Charges pop-up 
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window is displayed. For more information about adding or modifying 
charges, see Section 2.3.11.1, "Adding or Modifying Charges".

In the Tax Breakup panel, you can view the break up of the taxes on 
the order.

In the Line Summary Details panel, you can view details of the items 
such as the item ID and description, item quantity and unit price.

In the Line Price Details panel, you can view the price, taxes, charges 
and discount details of the selected line. 

In the Charge Breakup panel, you can view the break up of the 
charges on the line. If you want to add or modify the charges, click 
the Add/Modify Charges hyperlink. The Add/Modify Charges pop-up 
window is displayed. For more information about adding or modifying 
charges, see Section 2.3.11.1, "Adding or Modifying Charges".

In the Tax Breakup panel, you can view the break up of the taxes on 
the line.

Click Close.

2.3.11.1 Adding or Modifying Charges
The Add/Modify Charges pop-up window provides information about the 
existing charges and also lets you modify an existing charge or add a 
new charge. However, you cannot modify the charges applied on an 
order if the charges are based on a pricing rule.

In the Modify Charges panel, you can view the charge category, charge 
name and the charge amount.

1. If you want to add a new charge, click the Add Charge hyperlink. 
Select the category from the Charge Category drop-down list. Select 
the name of the charge from the Charge Name drop-down list. In the 
Charge Amount column, enter the appropriate amount for the charge.

2. In the Notes panel, enter any additional information, if applicable. For 
more information about adding notes to an order, see Section 2.3.4, 
"Viewing and Adding Notes to an Order".

Note: If the status modification rules do not allow you to 
add or modify charges for an order, the Add/Modify 
Charges hyperlink is disabled.
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3. Click Confirm.

2.3.12 Scheduling and Releasing an Order
The Schedule and Release screen provides details of the status of each 
order line and also lets you schedule and release an order. You can 
schedule and release an order if you belong to a user group, which has 
permission to do so.

To schedule or release an order, you must first search for the order. For 
more information about searching for an order, see Section 2.1.1, 
"Searching for an Order".

From Tasks > Order, select Schedule and Release Order. The Schedule 
and Release screen is displayed. 

In the Order Lines by Status panel, you can view the item ID and 
description, unit price, fulfillment method, status of the order line, 
quantity in that status, ship node, expected date and comments if 
applicable.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 

Note:

Charge Category and Charge Name columns cannot be 
modified, only Charge Amount column can be modified.  
The Charge Amount column is shown in a different 
color indicating that it is editable.

If you want to remove a charge, you can set the charge 
amount to zero.

Add/Modify Charges can be performed only if the user 
has permission.

If payments are configured outside Sterling Call Center 
and Sterling Store, then the Payment screen will not be 
displayed. Instead, the Order Summary screen will be 
displayed when clicking the 'Next' button in the Charge 
Detail screen.
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components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

Click Confirm. The screen is refreshed to reflect the new status and 
ship nodes for applicable order statuses.

You can also view the indicator icons associated with items, if 
applicable. Place your cursor on these icons to view their purpose.

2.3.13 Viewing Procurement Orders
You can view the procurement orders for an order (purchase 
order/transfer order), if you belong to a user group which has permission 
to do so.

To view procurement orders for an order, you must first search for the 
order. For more information about searching for an order, see 
Section 2.1.1, "Searching for an Order".

You can filter order lines based on filter criteria.

From Tasks > Order, select View Procurement Orders. The View 
Procurement Orders screen is displayed. In the Procurement Orders 
panel, you can view the order number, document type, status, 
supplier and the order date.

Double-click the appropriate order number. The Procurement Order 
Summary screen is displayed. For more information about viewing 

Note: Order status records which cannot be scheduled 
and/or released are grayed out. If there are no order lines 
to be scheduled and/or released, the message displays “All 
the order lines are already scheduled and released” and 
also the Confirm button is disabled. In case there is a 
problem in scheduling the order, the scheduling failure 
reason is displayed in the comments column.
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procurement order summary details, see Section 2.3.13.1, "Viewing 
Procurement Order Summary".

2.3.13.1 Viewing Procurement Order Summary 
To view the procurement order summary:

1. Do one of the following to open the Procurement Order Summary 
screen:

From the View Procurement Orders screen, right-click on an order 
and select View Details.

From the View Procurement Orders screen, click on the order 
number hyperlink of the order for which you want to view the 
order summary.

2.  The Procurement Order Summary screen is displayed. On this screen 
you can view the following information:

In the Primary Details panel, you can view the order number, 
order status, order date, total amount, document type and 
supplier.

In the Bill To Address panel, you can view the details of the 
address of the organization against which the order is billed.

In the Ship To Address panel, you can view the details of the 
address to which the order is shipped to.

In the Order Lines panel, you can view the product and/or service 
order lines that are fulfilled.

Note:  If there are no procurement orders for the order, 
the message “There are no procurement orders for this 
Order" is displayed.

Note: If there are multiple ship to addresses, the 
message "There are multiple ship to addresses on this 
order" is displayed.
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2.3.14 Exempting an Order from Tax
You can exempt an order from tax for a business customer only if you 
belong to a user group that has the necessary permissions.

To exempt an order from tax, you must first search for the order. For 
more information about searching for an order, see Section 2.1.1, 
"Searching for an Order".

To exempt an order from tax:

1. Navigate to Tasks > Order, and select Change Tax Options. The 
Change Tax Options screen is displayed. 

2. In the Tax Codes panel, select the Allow Tax Exemption check box 
and enter the Tax Exemption Code of the order in the Tax Exemption 
Code field. 

3. In the Overall Order Totals panel, you can view the breakdown of the 
order, such as the order sub-total, charges, discounts, taxes, and the 
order total. 

4. Click Confirm. 

If there is a change in the order total, the Confirm Payment 
screen is displayed. For more information about confirming 
payment details, see Section 2.3.8, "Viewing and Confirming the 
Payment Details".

If there is no change in the order total, the Order Summary 
screen is displayed. For more information about viewing an order 
summary, see Section 2.1.4, "Viewing Order Summary". 

2.3.15 Copying a Draft Order
When creating an order, a customer may decide to use an existing order 
to create new orders in the future, where applicable. For example, a 
customer may place two orders for the same items and may want the 

Note: If the tax options cannot be changed for the order 
in the current status, the following warning message is 
displayed:

"Tax options cannot be changed for an order in this 
status."
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orders to be delivered on different dates. In such a scenario, you can 
copy the existing draft order to create a new order that is similar in 
content.

To copy a draft order, you must first search for the order. For more 
information about searching for an order, see Section 2.1.1, "Searching 
for an Order".

To copy a draft order, navigate to Tasks > Order, and select Copy Draft 
Order. A new Order Entry screen, in which the attributes of the original 
order are copied, is displayed. You can modify the appropriate details 
pertaining to the order, as requested by the customer, and continue with 
the order creation task flow. For more information about creating an 
order, see Section 2.3.1, "Creating an Order".

2.3.16 Ordering Again
After placing an order, a customer may decide to use that order to create 
new orders in the future, where applicable. For example, a customer may 
place an order for a particular list of items every month, with the list 
varying only slightly from month to month. In such a scenario, the 
customer can copy the existing order to create new orders that are 
similar in content.

Note: You can create an order from an existing draft 
order only if you belong to a user group that has the 
necessary permissions.

Note: When you copy a draft order, some information 
from the original order may not be copied to the new order 
such as the appointment dates.

Note: If any of the order lines that are copied to the new 
order contains items that the customer does not have 
entitlements to, the  icon is displayed next to that order 
line, indicating that the order line is no longer valid. 
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To reorder an order, you must first search for the order. For more 
information about searching for an order, see Section 2.1.1, "Searching 
for an Order".

To reorder an order, navigate to Tasks > Order, and select Order Again. A 
new Order Entry screen, in which the attributes of the original order are 
copied, is displayed. You can modify the details pertaining to the order as 
requested by the customer, and continue with the order creation task 
flow. For more information about creating an order, see Section 2.3.1, 
"Creating an Order". 

2.3.17 E-mailing Order Information
If a customer wants to review the information pertaining to an order, you 
can send the information pertaining to the order through an e-mail. 

To send the information pertaining to an order to a customer through 
e-mail, you must first search for the corresponding order. For more 
information about searching for an order, see Section 2.1.1, "Searching 
for an Order".

Note: You can create an order from an existing confirmed 
order only if you belong to a user group that has the 
necessary permissions.

Note: When you copy a confirmed order, based on the 
configuration, the order and order line attributes are 
copied from the original order to the new order. 

Note: If any of the order lines that are copied to the new 
order contains items that the customer does not have 
entitlements to, the  icon is displayed next to that order 
line, indicating that the order line is no longer valid. 

Note: You can send the information pertaining to a draft 
order or a confirmed order to a customer only if you 
belong to a user group that has the necessary permissions.
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To send order information to a customer through e-mail:

1. From Tasks > Order, select Send Order E-mail. The Send Order E-mail 
pop-up window is displayed. 

2. In the To field, if the e-mail address of the customer is not displayed 
by default, enter the corresponding e-mail address.

3. In the Cc field, enter an alternative e-mail address. 

4. In the Introduction field, enter any additional information you want to 
send to the customer.

5. Click Confirm.

2.3.18 Transferring a Draft Order to IBM Sterling Web
Draft orders can be created either by a customer service representative 
through the Sterling Call Center and Sterling Store applications, or by a 
customer through the Sterling Web application. Draft orders created in 
Sterling Web are accessible through Sterling Call Center and Sterling 
Store. However, draft orders that are opened through Sterling Call Center 
and Sterling Store are not accessible through Sterling Web. In such 
situations, you may want to transfer the draft order from Sterling Call 
Center and Sterling Store to Sterling Web to enable customers to access 
the draft orders.

To transfer a draft order from Sterling Call Center and Sterling Store to 
Sterling Web, you must first search for the corresponding draft order. For 
more information about searching for an order, see Section 2.1.1, 
"Searching for an Order".

Note: You can also enter multiple e-mail addresses in the 
To and Cc fields. When entering multiple e-mail addresses, 
separate the e-mail addresses with a comma (,). 
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To transfer a draft order from Sterling Call Center and Sterling Store to 
Sterling Web:

1. Navigate to Tasks > Order, and select Transfer Order to Web. The 
Transfer Order to Web dialog box is displayed.

2. In the Draft Order Name field, enter an appropriate name for the 
draft order.

3. Click OK. A message is displayed, indicating whether the draft order 
was successfully transferred to Sterling Web.

2.3.19 Launching the Application Console
You can use this task to launch the Application Console from within the 
Sterling Call Center and Sterling Store user interface. A CSR may 
sometimes need to launch the Application Console, for example, a CSR 
may want to adjust the inventory for an item. For example, call center 
and store representatives may need to access the detailed order audit 
screens available in the Application Console.

A user can launch the console only if the user belongs to a user group 
that has permissions to launch the console.

To launch the Application Console, from Tasks > Order Tasks, select 
Launch SMCFS Console. The Application Console is displayed.

If the logged in user session times out, enter the user ID and 
password to login again.

Click Close.

Note: Based on the configuration, the Transfer Order to 
Web task is displayed in the Related Tasks panel.

Note: If the draft order is incompatible with the version of 
Sterling Web that is associated with Sterling Call Center 
and Sterling Store, a message is displayed, indicating that 
the draft order cannot be sent to Sterling Web because it is 
incompatible.
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2.4 Performing Opportunity and Quote Tasks
This section explains how to perform the following opportunity and quote 
tasks:

Creating an Opportunity

Modifying Opportunity Details

Marking an Opportunity as Lost

Creating a Quote

Reworking a Quote

Copying a Quote as a New Quote

Copying a Quote as Alternative Quote

Viewing Alternate Quotes

Viewing or Modifying Problem Lines in a Quote

Quote Approvalsl

Presenting a Quote to a Customer

Accepting a Quote on Behalf of a Customer

Rejecting a Quote on Behalf of a Customer

Generating a Proposal

Converting Quote to Order

Abandoning a Quote

2.4.1 Creating an Opportunity
An opportunity is a container to hold a quote or related alternative 
quotes that can be presented to a customer. Related alternative quotes 
are a set of quotes that exist at the same time and are independent of 
each other, but are associated with the same opportunity. Irrespective of 
the number of quotes in an opportunity, only one can be accepted by a 
customer. For example, you may offer a customer three alternative 
quotes:

Quote-A for two desktop computers, each being offered with 5% off 
the unit price.
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Quote-B for one desktop computer and one laptop, each being 
offered with 5% off the unit price.

Quote-C for one desktop computer and two laptops, each being 
offered with 7% off the unit price.

The customer is offered to chose any one quote, Quote-A, Quote-B, or 
Quote-C.

You can create an opportunity for an existing customer or a new 
customer.

To create an opportunity:

1. From Tasks > Quotes/Opportunities, select Create Opportunity. The 
Select Enterprise dialog box is displayed.

2. From the Enterprise drop-down list, select the enterprise for which 
you want to create the opportunity. Click Confirm. The Create 
Opportunity screen is displayed.

3. Perform the following tasks in the Create Opportunity panel:

In the Opportunity Name field, enter a name for the opportunity.

From the Lead Origin drop-down list, select the source from which 
the lead for creating the opportunity originated. For example, a 
lead can originate from a phone conversation, trade show, Web 
site, and so on.

In the Success % field, enter the probability of success (in %). 
The probability of success is used to indicate the opportunity’s 
chances of being successful.

Click the  icon adjacent to the Owner ID field to search and 
assign a user as the owner of the opportunity. The Owner Search 
Criteria pop-up window is displayed. Enter the appropriate search 
criteria and click Search. A list of users is displayed in the User 
Search Results panel. Select a user and click Apply. The User ID of 
the selected user is populated in the Owner ID field.

Click the  icon adjacent to the Anticipated Close Date field to 
select a date by which the opportunity is expected to close.

Note: The Select Enterprise dialog box is displayed only if 
you have access to multiple enterprises.
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In the Opportunity Value field, enter the value of the opportunity. 
The opportunity value is the total amount that will be earned as 
revenue if a quote for the opportunity is accepted by the 
customer.

Click the  icon adjacent to the Co-Owner ID field to search and 
assign a user as the co-owner of the opportunity. A co-owner is 
the secondary owner of the opportunity. The Owner Search 
Criteria pop-up window is displayed. Enter the appropriate search 
criteria and click Search. A list of users is displayed in the User 
Search Results panel. Select a user and click Apply. The User ID of 
the selected user is populated in the Co-Owner ID field.

4. Perform the following tasks in the Find Existing Customer panel:

a. Select the appropriate Customer Type.

b. Enter the required information pertaining to the customer and 
click Search.

c. The search results are displayed in the Customer Search Results 
panel. If you cannot find the customer you are searching for, click 
the  icon to display the search criteria again. Enter a more 
restrictive search criteria for the selected task and click Search.

d. Select the appropriate customer that you need from the Customer 
Search Results panel. The details pertaining to that customer are 
displayed in the Customer panel.

e. If the customer does not exist, create a new Consumer customer 
or Business customer. To create a Consumer customer, click 
Create Consumer. For more information about creating a 
Consumer customer, see Section 2.8.1, "Creating a Consumer 
Customer".

To create a Business customer, click Create Business. For more 
information about creating a Business customer, see 
Section 2.8.2, "Creating a Business Customer".

5. Click Confirm. The Opportunity Details screen containing the details 
of the newly created opportunity is displayed.
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2.4.2 Modifying Opportunity Details
After an opportunity is created for a customer, you can modify the details 
of the opportunity. For example, if the opportunity is expected to be 
closed at a date later than the one you had earlier anticipated, you can 
change the opportunity’s anticipated close date by selecting a new date.

To perform this task, you must first search for the opportunity. For more 
information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity". Information pertaining to the opportunity 
can be modified from the Opportunity details screen.

To modify the opportunity details:

1. Modify the required information in the Create Opportunity panel.

2. In the Customer panel, click the Add New Contact hyperlink to create 
a new customer contact. The Add Contact pop-up window is 
displayed. For more information about creating a new contact, see 
Section 2.3.1.1, "Adding a New Contact".

3. To modify an existing opportunity address, click the Modify hyperlink 
on the corresponding Opportunity Address.

4. In the Quotes panel, if there are no quotes created for the 
opportunity, you can create a new Quote by clicking the New button. 
For more information about creating a new quote, see 
Section 2.4.2.1, "Creating a New Quote for an Opportunity".

If there are any existing quotes that are created for the opportunity, 
click the Copy As New button to copy an existing quote to create a 
new quote and opportunity. For more information about copying a 
quote to create a new quote and opportunity, see Section 2.4.2.2, 
"Copying a Quote to Create a New Quote and New Opportunity".

Click the Copy As Alternate button to copy an existing quote to create 
alternative quotes. For more information about copying an existing 
quote to create alternative quotes, see Section 2.4.2.3, "Copying a 
Quote to Create Alternative Quotes".

To mark a quote as a primary quote, select the quote and click the 
Mark As Primary button.

5. To view or add notes, click the View/Add Notes hyperlink in the 
Important Notes panel. The Opportunity Notes pop-up window is 
displayed where you can view or add notes to the opportunity.
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6. Click Confirm.

2.4.2.1 Creating a New Quote for an Opportunity
After an opportunity is created, you can create a quote for the 
opportunity. You can then define the items, pricing adjustments, 
shipment details, and payment information for the quote. When a quote 
is created for an existing opportunity, the customer who is assigned to 
the opportunity is automatically assigned to the quote.

To perform this task, you must first search for the opportunity. For more 
information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity". You can create a new quote for an 
opportunity using the Opportunity Details screen.

To create a new quote for an opportunity:

1. In the Quotes panel, click the New button. The New Quote dialog box 
is displayed.

2. Enter a name for the quote in the New Quote dialog box and click 
Confirm. The Quote Entry Wizard is displayed using which you can 
add items, enter payment, shipping details, and so on.

2.4.2.2 Copying a Quote to Create a New Quote and New 
Opportunity
You can copy an existing quote to create a new quote and a new 
opportunity, for example, you may want to use an existing quote, which 
you had created for a customer, for a different customer. In such a 
scenario, you can copy the quote along with the product information, 
payment, and shipment details, and then define the customer 
information to create a new quote and opportunity for the new customer.

To perform this task, you must first search for the opportunity. For more 
information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity". You can copy an existing quote and 
create a new quote and opportunity using the Opportunity Details screen.

Note: The New button is displayed only if there are no 
quotes associated with the opportunity
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In the Quotes panel, click the Copy As New button. The Quote Entry 
Wizard is displayed using which you can create a new quote.

2.4.2.3 Copying a Quote to Create Alternative Quotes
You can create an alternative quote within an opportunity by copying an 
existing quote. Alternative quotes are quotes that exist simultaneously 
and are associated with a single opportunity. After copying a quote, you 
can modify the product information, shipment, and payment details for 
the new quote. For example, let us suppose that you have a quote, 
Quote-A, for two desktop computers on which you have offered a 
discount of 5%. To provide another option to your customer, you can 
create an alternative quote, Quote-B, for one desktop computer and one 
laptop, on which you offer a discount of 6%. You can create Quote-B by 
copying Quote-A and modifying the product information accordingly.

To perform this task, you must first search for the opportunity. For more 
information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity". You can copy an existing quote and 
create alternative quotes using the Opportunity Details screen.

To copy an existing quote to create alternative quotes:

1. In the Quotes panel, click the Copy As Alternate button. The Copy As 
Alternate dialog box is displayed.

Note: The Copy As New button is displayed only if there 
is at least one quote associated with the opportunity.

Note: The customer information from the exsiting quote 
will be defaulted to the customer search criteria when 
creating the new quote. However, you can still search for a 
different customer before creating the new quote and 
opportunity.
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2. Enter a name for the alternate quote in the Copy As Alternate dialog 
box and click Confirm. The Quote Entry Wizard is displayed using 
which you can add items, enter payment, shipping details, and so on.

2.4.3 Marking an Opportunity as Lost
You can mark an opportunity as Lost if the opportunity no longer serves 
any purpose. For example, when an opportunity is still in the Inquiry 
status, a customer may have purchased the products from another seller. 
In such a scenario, you may want to mark the opportunity as Lost and 
provide reasons for losing the opportunity.

To perform this task, you must first search for the opportunity. For more 
information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity". You can mark an opportunity as Lost 
using the Opportunity Details screen.

To mark an opportunity as Lost:

1. From Tasks > Quotes/Opportunities, select Mark as Lost. The Mark as 
Lost screen is displayed.

2. From the Loss Reason drop-down list, select a reason for losing the 
opportunity. The loss reason is used to determine the reason why the 
opportunity was Lost, for example, Project Cancelled, Project 
Delayed, Competitor Price, and so on.

3. To view or add notes, click the View/Add Notes hyperlink. The 
Opportunity Notes pop-up window is displayed where you can view or 
add notes to the opportunity.

4. Click Confirm. The Opportunity Details window is displayed with the 
opportunity status as Lost.

2.4.4 Creating a Quote
A quote is a commercial document that allows a prospective buyer to see 
a predetermined set of products and quantities at a predetermined price 
to be delivered on a specific date. A quote is always associated with an 

Note: The Copy As Alternate button is displayed only if 
there is at least one quote associated with the opportunity.
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opportunity. You can create a quote for an existing opportunity or create 
a quote which does not have an associated opportunity. If you create a 
quote which does not have an associated opportunity, the opportunity is 
automatically created when the quote is created.

You can create a quote for an existing customer or a new customer.

To create a quote:

1. From Tasks > Quotes/Opportunities, select Create Quote. The Select 
Enterprise dialog box is displayed.

2. From the Enterprise drop-down list, select the enterprise for which 
you want to create the opportunity. Click Confirm. The Quote Entry: 
Customer Selection screen is displayed.

3. Perform the following tasks in the Quote Entry: Customer Selection 
screen:

In the Create Quote panel, enter a name for the quote.

Click the  icon adjacent to the Expiration Date field to select an 
expiration date on which the quote. If the expiration date is not 
specified when creating the quote, the expiration date will be 
defaulted based on the configuration.

4. Perform the following tasks in the Find Existing Customer panel:

a. Select the appropriate Customer Type.

b. Enter the required information pertaining to the customer and 
click Search.

c. The search results are displayed in the Customer Search Results 
panel. If you cannot find the customer you are searching for, click 
the  icon to again display the search criteria. Enter a more 
restrictive search criteria for the selected task and click Search.

d. Select the appropriate customer from the Customer Search 
Results panel. The customer details are displayed in the Customer 
panel.

Note: The Select Enterprise dialog box is displayed only if 
you have access to multiple enterprises.
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e. If the customer does not exist, create a new Consumer customer 
or Business customer. To create a Consumer customer, click 
Create Consumer. For more information about creating a 
Consumer customer, see Section 2.8.1, "Creating a Consumer 
Customer".

To create a Business customer, click Create Business. For more 
information about creating a Business customer, see 
Section 2.8.2, "Creating a Business Customer".

5. Click Next. The Quote Entry: Add Items screen is displayed.

6. Perform the following tasks in the Quote Entry: Add Items screen:

a. You can add items to the quote by entering the complete item ID 
in the Add Item field or by clicking the  icon to search for a 
particular item. For more information about searching for an item, 
see Section 2.1.3, "Searching for an Item".

b. Click Update to refresh the Create Quote screen with the updated 
items.

c. You can toggle between the Quote Lines tab and the 
Recommended Lines tab to add an item as a quote line or as a 
recommended line.

d. To delete a particular quote line, click the  icon adjacent to the 
corresponding quote line. A confirmation pop-up window is 
displayed. Click Yes if you want to delete the quote line. If the 
quote line has related lines associated with it, the quote line and 
the related lines associated with it are deleted when you update 
the quote.

e. To add quote line notes, select the check box corresponding to a 
quote line and click the  icon. For more information about 
adding quote notes, see Section 2.4.4.1, "Viewing and Adding 
Quote Notes".

f. To add related items or service items to a quote, select the check 
box corresponding to the item and click the  icon. The Related 
Items pop-up window is displayed. Select the check box adjacent 
to the required related item and click Add To Quote.

If there are no related items configured for the item, a message is 
displayed indicating that the item does not have any relationships 
configured.
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g. To view the components of a bundle item, click the  icon. The 
Component Lines pop-up window is displayed. You can view the 
details of the item, such as Item ID, Description, Quantity, unit 
price, adjustments, and so on. You can also adjust the price of the 
component items of the bundle item.

h. If the item is a configurable bundle item, perform the following 
tasks:

– If the item is a preconfigured bundle item, you do not have to 
manually configure the item. However, if you want to 
reconfigure the item, click the  icon. The Product 
Configurator is displayed where you can view the components 
of the preconfigured bundle item and reconfigure the item, if 
needed.

– If the item is not a preconfigured bundle item, click the  
icon to open the Product Configurator and configure the item.

Note: The  icon is displayed only if the item is a bundle 
item.

Note: The unit price of the bundle parent item and its 
components is displayed based on the bundle pricing 
strategy that has been configured for the item. The unit 
price is displayed as follows:

If the bundle pricing strategy has been configured such 
that the price of the bundle item is calculated based on the 
bundle parent, only the unit price of the bundle parent is 
displayed in the Parent panel. In this scenario, the unit 
price and the line total of the product lines are not 
displayed.

The Line Adjustments button is displayed only if a manual 
pricing rule has been added to the item line. For more 
information about adjusting prices for the quote lines, see 
Section 2.4.4.2, "Adjusting Prices".
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i. If you enter a stylized item, the Style Items pop-up window is 
displayed. For more information about selecting an item’s style, 
see Section 2.3.1.3, "Selecting an Item’s Style".

j. To view the details of an item that is added to the quote, click the 
item description hyperlink. The Item Details screen for the 
selected item is displayed.

7. In the Quote Lines tab, to move an item to the Recommended Lines 
tab, select the check box of the corresponding item and click Make 
Recommended.

The selected item is automatically moved to the list of recommended 
items, and is no longer displayed in the list of items under the Quote 
Lines tab.

8. In the Recommended Lines tab, to move an item to the Quote Lines 
tab, select the check box of the corresponding item and click Move to 
Quote.

The selected item is automatically moved to the list of quote items, 
and is no longer displayed in the list of items under the 
Recommended Lines tab.

9. To add line-level adjustments to an item, select the check box of the 
corresponding item and click Add Line Adjustments. The Adjust Price 
pop-up window is displayed.

To modify the price adjustments added to the quote line, click the  
icon on the corresponding quote line. The Adjust Price pop-up window 
is displayed.

For more information about adding or modifying quote line price 
adjustments, see Section 2.4.4.2, "Adjusting Prices".

10. To view the quote price for a different pricing date, click the  icon 
adjacent to the Pricing Date field and select the required date. The 
quote price for the selected date will be displayed when you update 
the quote. The pricing date of a quote is the date on which the quote 
is created.

Note: If you are still reconfiguring the item, the 
fulfillment type and pricing information defined for the item 
will not be available until the configuration is completed.
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11. To perform header-level adjustments for a quote, click the Adjust 
Price button. The Adjust Price pop-up window is displayed. For more 
information about adjusting the quote price, see Section 2.4.4.2, 
"Adjusting Prices".

12. To narrow down the list of quote items displayed in the Quote Lines 
tab or the Recommended Lines tab, click the Show Filter Criteria 
hyperlink in the Search Quote Lines panel.

In the Find Products Within Quote field, enter the item ID or the item 
description as the search criteria. You can also specify additional 
criteria such as:

– All Lines – Searches for all items that match the search criteria.

– Lines Pending Approval – Searches only for the items that match 
the search criteria and are pending approval.

13. Click Next. The Quote Entry: Notes And Terms screen is displayed.

14. Perform the following tasks in the Quote Entry: Notes And Terms 
screen:

a. From the Payment Term drop-down list, select the payment term 
to be applied to the quote. The payment term is used to specify 
the time frame a customer is entitled to for paying the amount 
due if the quote is converted to an order.

b. From the Carrier Service drop-down list, select the carrier service 
to be used for the quote. The carrier service is the transportation 
service provider that will be used to deliver the products in the 
quote if the quote is converted to an order.

c. From the Level of Service drop-down list, select the level of 
service to be used for the quote. The level of service determines 
the way in which the order will be fulfilled if the quote is 
converted to an order. Note that the shipping charges may differ 
based on the level of service you select.

d. Click the  icon adjacent to the Requested Delivery Date field to 
select the requested delivery date for the quote. The requested 
delivery date is the date on which the products in the quote have 
been requested for delivery.

e. In the Shipping Instructions text box, enter the appropriate 
shipping instructions.
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f. To view or add notes, click the View/Add Notes hyperlink in the 
Important Notes panel. The Quote Notes pop-up window is 
displayed where you can view or add notes to the quote. For more 
information about viewing or adding notes, see Section 2.4.4.1, 
"Viewing and Adding Quote Notes".

15. Click Confirm to create the Quote.

2.4.4.1 Viewing and Adding Quote Notes
You may sometimes want to enter additional notes to a quote, describing 
the various actions taken on that quote for future reference. The quote 
notes can be either entered manually or generated automatically by the 
system.

Perform the following steps to view the notes pertaining to the quote:

1. In the Quote Entry: Notes And Terms screen, click the View/Add 
Notes hyperlink. The Quote Notes pop-up window is displayed.

2. From the Filter by Note Type drop-down list, select a note type to 
view notes pertaining to a specific note type.

3. From the Filter by Contact Method drop-down list, select a contact 
method to view notes pertaining to a specific contact method. For 
example, to view notes related to a customer’s call, select Phone as 
the contact method.

4. By default, the Lower Priority Notes check box is selected. Clear the 
Lower Priority Notes check box if you want to view only high-priority 
notes.

5. In the Notes Created By field, the User check box is selected by 
default. Select the System check box to view the system-generated 
notes in addition to the manually entered notes.

6. By default, the notes are truncated and displayed.

Click the Expand All Notes hyperlink to expand all the notes 
displayed in the Quote Notes screen.

Click the Expand hyperlink next to the truncated note to expand 
the note.

Perform the following steps to add a note to a quote:
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1. From the Note Type drop-down list the Quote Notes screen, select the 
appropriate note type.

2. From the Contact Method drop-down list, select the appropriate 
contact method.

3. In the Contact Details text box, enter contact details such as e-mail 
address or telephone number of the customer.

4. Select the Mark Priority as High check box if the note is of a high 
priority.

5. Select the For Internal User Only check box to mark the note for 
internal viewing.

6. Enter the text of the note in the space provided.

7. Click Add Note. The note is added and displayed in the Quote Notes 
screen.

8. Click Close.

2.4.4.2 Adjusting Prices
You may sometimes want to adjust the price of the items in a quote by 
specifying new pricing rules for the items. For example, you might want 
to offer a discount of 5% on all the items in the quote as part of a 
promotional offer.

When adjusting the price of items in a quote, you can view a customer’s 
rating and the metrics used to calculate the rating. The rating can help 
you determine the adjustments to be made to the price of items in a 
quote.

Note: You can add notes at the bundle component level if 
the bundle item is configured as ship independent.

Note: If the status modification rules do not allow you to 
add notes to the quotes that are in the current status, the 
Important Notes panel and the Add Note button are 
disabled.
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You can also refer to Discount Advisor to decide on a suitable price for a 
line item in the quote. The Discount Advisor provides a graphical 
representation of the minimum, maximum, and average discounts 
provided for the item in the past.

Perform the following steps to perform header-level or line-level 
adjustments for a quote:

1. To adjust the price of a quote (header-level), click the Adjust Price 
button in the Quote Entry: Add Items screen.

To adjust the prices of quote lines (line-level), select the check box of 
the corresponding quote line and click the Add Line Adjustments 
button.

The Adjust Price pop-up window is displayed.

2. From the Adjustments drop-down list, select a pricing rule and click 
Add. The pricing rule is displayed. Enter the absolute adjustment or 
percentage adjustment to be applied under the Adjustment field of 
the corresponding pricing rule.

To view the details of a customer’s rating, click the View Details 
hyperlink adjacent to the Customer Rating field. The Customer Rating 
pop-up window is displayed. You can view the details of the customer 

Note: You can view Discount Advisor only for a single 
item line in a quote.

Note: When you adjust the price of multiple items in a 
quote, you can neither view nor remove any of the pricing 
rules that are applied to the items.

Note: You can also adjust the prices of quote lines by 
clicking the Adjust Price button. The adjustments will be 
applied to the corresponding quote lines.

Note: You can add a pricing rule only once.
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based on which the rating is calculated, such as the customer’s 
lifetime revenue, the customer’s average lifetime revenue, the 
customer’s revenue in the previous year, the customer’s average 
lifetime revenue in the previous year, and so on.

To view the discounts that were applied to an item in the past, click 
the Discount Advisor button. The Discount Advisor pop-up window is 
displayed. You can perform the following tasks in the Discount 
Advisor pop-up window:

– Click the Industry tab to view the minimum, maximum, and 
average adjustments provided to the customers belonging to 
the same industry as that of the customer in context.

– Click the Category tab to view the minimum, maximum, and 
average adjustments provided to the items that belong to the 
same category as that of the selected item.

3. To delete a pricing rule, click the  icon adjacent to the pricing rule.

4. Click Confirm. The Quote Entry: Add Items screen is refreshed with 
the updated header-level or line-level price adjustments.

2.4.5 Reworking a Quote
After a quote is Created and before it is Accepted or Ordered, the quote 
can be modified or restored to its original status by reworking the quote. 
The quote rework task restores the quote to the Created status and 

Notes:

The View Details hyperlink is displayed based on the 
configuration.

The View Details hyperlink is disabled if there is no 
information available to display the metrics.

Note: If you select multiple item lines in the quote, the 
Discount Advisor button is disabled indicating that you can 
view the Discount Advisor only for a single item line and 
not multiple lines.
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removes existing approvals on the quote. This enables users to modify 
the quote if it has been rejected internally or by a customer.

If the reworked quote requires approval, then it will be treated as if it has 
never had any approvals attached to it.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to rework a quote:

1. From Tasks > Quotes/Opportunities, select Rework Quote, The 
Rework Quote screen is displayed.

2. The Quote Details panel displays information such as quote name, 
opportunity name, status, quote owner, quote expiration date, and so 
on.

3. To view or add notes, click the View/Add Notes hyperlink. The Quote 
Notes pop-up window is displayed where you can view or add notes 
to the quotes.

4. Click Confirm. The Quote Entry wizard is displayed using which you 
can rework the quote and modify its details.

2.4.6 Copying a Quote as a New Quote
You may sometimes want to copy a quote that is associated with an 
opportunity to create a new quote and opportunity. For example, a user 
may want to use the item information and payment details of an existing 
quote for a different quote and opportunity.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to copy a quote as a new quote:

1. From Tasks > Quotes/Opportunities, select Copy as New Quote. The 
Quote Entry wizard is displayed using which you can create a new 
quote.
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2.4.7 Copying a Quote as Alternative Quote
You may sometimes want to offer alternative quotes to a customer. For 
example, consider that a customer is interested in purchasing 10 
computers. A user may create a quote for 10 desktop computers, 
offering a discount of 5% on the quote total. To provide the customer 
with another option to choose from, the user may create another quote 
for 5 desktop computers and 5 laptops, offering a discount of 7% on the 
quote total.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to copy a quote as an alternative quote:

1. From Tasks > Quotes/Opportunities, select Copy as Alternative 
Quote. The Copy As Alternative Quote dialog box is displayed.

2. Enter a name for the alternative quote in the Copy As Alternative 
Quote dialog box and click Confirm. The Quote Entry wizard is 
displayed using which you can add items, enter payment terms, 
shipping details, and so on.

2.4.8 Viewing Alternate Quotes
Alternative quotes are quotes that are independent of each other, but are 
associated with a single opportunity. Alternative quotes are used to 
present different options to a customer. A customer can, however, accept 
only one option. For example, if a customer is looking at purchasing 
kitchen appliances, you can present the following quotes as alternatives:

Quote1 – One microwave oven at 5% discount and one coffee maker 
at 10% discount

Quote2 – One microwave oven at 10% discount, one dishwasher at 
5% discount, and one sandwich toaster and one coffee maker at 5% 
discount each

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to view alternate quotes:
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1. From Tasks > Quotes/Opportunities, select View Alternate Quotes. 
The Opportunity Details screen is displayed. For more information 
about opportunity details, see the Section 2.1.6.1, "Viewing the 
Opportunity Details".

2.4.9 Viewing or Modifying Problem Lines in a Quote
 and if you request an approval for the quote, present the quote to a 
customer, or convert the quote to an order, you will be redirected to the 
View Problem Lines screen to enable you to fix the problem lines before 
proceeding further. For more information about searching for a quote, 
see Section 2.1.7, "Searching for a Quote".

Perform the following steps to view the problem lines in a quote:

1. From Tasks > Quotes/Opportunities, select View Problem Lines. The 
View Problem Lines screen is displayed.

2. In the Quote Details panel, you can view details such as quote name, 
opportunity name, status, quote owner, quote expiration date, and so 
on.

3. In the Quote Lines panel, you can view the list of items that have 
failed validation.

4. To view the details of each line item, click the corresponding item. 
The Line Problems panel is displayed.

5. To reopen the quote and modify it, double-click the item in the Quote 
Lines panel. The Quote Entry wizard is displayed using which you can 
perform modifications on the quote to resolve the quote line 
problems.

6. Click Close.

2.4.10 Quote Approvals
You can present a quote to a customer only if the quote is in the 
Approved status. Based on the configuration, the quote may or may not 
require to be approved.

If the quote does not require any approval by the approvers as 
defined in an approval plan, Sterling Call Center and Sterling Store 
automatically changes the status of a quote to Approved.



Performing Opportunity and Quote Tasks

Tasks for a Customer Service Representative   117

If the quote requires approval, the quote must be approved by the 
approvers as defined in an approval plan before presenting the quote 
to a customer.

An approval is required if one or more of the following conditions are 
met:

Any of the products in a quote violates an approval rule. For example, 
if an approval rule has been configured such that the quote requires 
to be approved each time the expiration date of the quote is 
modified. In such a scenario, whenever you modify the expiration 
date of the quote, the quote must be approved by the approvers 
before you can present it to a customer.

The price adjustments applied to a quote or any of the products in a 
quote under a manual pricing rule exceed the maximum discount 
limit configured for a rule. For example, if the maximum discount 
limit configured for a 32'' LCD television under a manual pricing rule 
is 5%, and you offer a discount of 7% to a customer, the quote must 
be approved before presenting it to the customer.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to request an approval for a quote:

1. From Tasks > Next Tasks, select Request Approval. The Request 
Approval screen is displayed.

Note: Ensure that you have performed all the necessary 
modifications to the quote before sending the quote for 
approval. After a quote is sent for approval, you cannot 
perform any modifications to the quote.

Note: If any item in the quote fails validation, the View 
Problem Lines screen is displayed with a message 
indicating that the quote has problems and must be 
resolved before placing a request for an approval.
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The Quote Details panel displays information such as quote name, 
opportunity name, status, quote owner, quote expiration date, and so 
on.

2. To view or add notes, click the View/Add Notes hyperlink. The Quote 
Notes pop-up window is displayed where you can view or add notes 
to the quotes.

3. Click Confirm.

If the quote does not require approval, the status of the quote 
changes to Approved.

If the quote requires approval, the Approvals screen is displayed.

2.4.10.1 View Approvals
You can view the approval summary of a quote that is pending approval. 
The approval summary displays the list of violations that require your 
approval. Additionally, if a quote requires approval from multiple 
approvers, you can view the approval status against each approver. For 
example, if a quote requires approval from the Sales Lead and the Sales 
Manager, and the head of the Legal department, you can view the status 
of the approval against each of these users.

When viewing the approval summary of a quote, you can also view the 
customer’s rating and the metrics based on which the rating has been 
calculated.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to view the approval and approve or reject 
the quote:

1. From Tasks > Quotes/Opportunities, select View Approvals. The 
Approvals screen is displayed.

To view the details of a customer’s rating, click the View Details 
hyperlink adjacent to the Customer Rating field. The Customer Rating 
pop-up window is displayed. You can view the details of the customer 
based on which the rating is calculated, such as the customer’s 
lifetime revenue, the customer’s average lifetime revenue, the 
customer’s revenue in the previous year, the customer’s average 
lifetime revenue in the previous year, and so on.
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In the Approval Trail panel, you can view the list of approvers who are 
involved in the approval process and the status of the approval for 
each approver. If you are an approver for the quote, the row 
containing your name and team is automatically selected.

In the Violations That Require Approval panel, you can view the list of 
header-level and line-level violations that have to be approved.

2. To view the details of a particular violation, click the <violations> 
hyperlink. The Violations That Require Approval pop-up window is 
displayed.

Here, <violations> refer to header-level or line-level violations.

You can view the following information in the Violations That Require 
Approval pop-up window:

Rule Name and Rule Description of the violation.

Details of the lines that have violated the rule, such as the unit 
price of the items, the adjustments applied to the items, and so 
on in the Lines Violating Rule panel.

Line total, adjustments applied to the line, profit margin, and so 
on in the Line Totals panel.

3. Click Close to close the Violations That Require Approval pop-up 
window and return to the Approvals screen.

In the Pricing Summary panel, you can view details such as the 
quote’s subtotal, pricing adjustments applied to the quote, shipping 
costs, taxes applied to the quote, the grand total of the quote, and 
the profit margin earned from the quote, if the quote is converted to 
an order.

4. To view or add notes, click the View/Add Notes hyperlink. The Quote 
Notes pop-up window is displayed where you can view or add notes 
to the quotes.

Notes:

The View Details hyperlink is displayed based on the 
configuration.

The View Details hyperlink is disabled if there is no 
information available to display the metrics.
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5. To approve a quote, click Approve. The Approvals screen is refreshed 
and the status of the quote changes to Approved.

6. To reject a quote, click Reject. The Reject Reason pop-up window is 
displayed. Enter appropriate notes to explain why you are rejecting 
the quote and click Close. The Approvals screen is refreshed and the 
status of the quote changes to Rejected.

7. Click Close.

2.4.10.2 Quotes Pending Approval
You can view all the quotes that are pending your approval if you are 
part of the approval process. To perform this task, you must first search 
for the quote. For more information about searching for a quote, see 
Section 2.1.7, "Searching for a Quote".

Perform the following steps to view the quotes that are pending your 
approval:

1. From Tasks > Quotes/Opportunities, select Quotes Pending My 
Approval. The Quotes Pending My Approval screen is displayed.

In the Quotes Pending My Approval panel, you can view details such 
as quote name, customer name, quote owner, quote status, and the 
quote expiration date.

You can double-click on a quote to display the Approvals screen of the 
selected quote.

2. Click Close.

2.4.11 Presenting a Quote to a Customer
After all the necessary approvals have been obtained for a quote, you 
can present the quote to the customer for whom the quote has been 
created so that the customer can provide feedback on the quote.

Note: If there are no quotes that are pending your 
approval, a message is displayed indicating that there are 
no quotes pending approval.
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To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to present a quote to a customer:

1. From Tasks > Quotes/Opportunities, select Present To Customer. The 
Present To Customer screen is displayed.

2. To view or add notes, click the View/Add Notes hyperlink. The Quote 
Notes pop-up window is displayed where you can view or add notes 
to the quotes.

3. Click Confirm. The status of the quote changes to Presented.

2.4.12 Accepting a Quote on Behalf of a Customer
You can accept a quote on behalf of a customer. For example, a customer 
may agree to all the conditions laid down in a quote, and may want the 
quote to be processed so that the customer can place an order for the 
items in the quote.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to accept a quote on behalf of a customer:

1. From Tasks > Next Tasks, select Accept Quote. The Accept Quote 
screen is displayed.

The Quote Details panel displays information such as quote name, 
opportunity name, quote status, quote owner, quote expiration date, 
and so on.

2. To view or add notes, click the View/Add Notes hyperlink in the Add 
Notes to Quote panel. The Quote Notes pop-up window is displayed 
where you can view or add notes to the quotes.

3. Click Confirm. The status of the quote changes to Accepted.

2.4.13 Rejecting a Quote on Behalf of a Customer
After a quote has been presented to a customer, you can reject the quote 
on behalf of the customer. For example, if a customer wants to reject a 
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quote based on the quote price, you can reject the quote on the 
customer’s behalf.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to reject a quote on behalf of a customer:

1. From Tasks > Next Tasks, select Reject Quote. The Reject Quote 
screen is displayed.

The Quote Details panel displays information such as quote name, 
opportunity name, quote status, quote owner, quote expiration date, 
and so on.

2. To view or add notes, click the View/Add Notes hyperlink in the Add 
Notes to Quote panel. The Quote Notes pop-up window is displayed 
where you can view or add notes to the quotes.

3. Click Confirm. The status of the quote changes to Rejected.

After a quote is rejected, you must rework the quote if you want tow ork 
on the quote again. For example, you may want to modify the quote 
price in order to present a customer with a better price for the products 
in the quote.

2.4.14 Generating a Proposal
You may sometimes want to generate a proposal from a quote and send 
it to a customer. For example, you may want to print a proposal in the 
PDF format and e-mail it to the customer as an attachment.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to generate a proposal:

1. From Tasks > Quotes/Opportunities, select Generate Proposal. The 
Generate Proposal screen is displayed.

2. From the Proposal Template drop-down list, select the template to be 
used to generate the proposal.

3. From the Proposal Format drop-down list, select the format in which 
you want to print the proposal.
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4. In the Proposal Title text box, enter a title for the proposal.

5. In the Salutation text box, enter the salutation that you want to 
address the customer, for example, Mr., Mrs., Miss, and so on.

6. In the Opening Comments text box, enter a few words explaining the 
purpose of the proposal.

7. In the Closing Comments, enter the closing comments, for example, 
Thank You, Looking forward to hearing from you, and so on.

8. In the Complimentary Closing text box, enter the words you want to 
end the proposal with, for example Sincerely, Truly, and so on.

9. Select the Show minor lines in the quote check box to include the 
components of a bundle item in the proposal.

10. In the Include in Print panel, select the check boxes corresponding to 
the attributes that you want to include in the proposal.

11. Click Generate. The proposal is displayed in a browser window.

Based on the configuration, you can perform one of the following tasks:

Print the proposal directly from a printer.

View the proposal in the format as configured.

Save the proposal to a specific location.

2.4.15 Converting Quote to Order
After a customer accepts a quote in its current form, a user might want 
to convert the quote to an order.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to convert a quote to an order:

1. From Tasks > Next Tasks, select Convert Quote to Order. The Confirm 
Quote: Payment Confirmation screen is displayed.

Note: You can convert a quote to an order only after the 
quote is accepted by the customer.
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2. If an order is created for an existing customer, you can view the 
payment methods that are available for that customer in the Payment 
Methods panel. (The default payment methods are already selected in 
the panel). To apply a different payment method, select the 
corresponding payment method from the available list or add a new 
payment method. For more information about adding new payment 
methods, see Section 2.7.4.1, "Adding New Payment Methods".

3. The Pricing Summary panel displays information such as sub-total, 
price adjustments, shipping charges, taxes, and so on.

4. The Bill To Address panel displays the bill to address for the quote.

5. The Ship To Address panel displays the Ship To Address for the quote.

6. To view or add notes, click the View/Add Notes hyperlink in the 
Important Notes panel. The Quote Notes pop-up window is displayed 
where you can view or add notes to the quote.

The notes that are marked as high priority are displayed in the 
Important Notes panel.

7. Click Confirm.

2.4.16 Abandoning a Quote
If you feel that a quote no longer serves a purpose, you can abandon the 
quote. For example, due to oversight, if you create a quote, you can 
abandon the quote.

To perform this task, you must first search for the quote. For more 
information about searching for a quote, see Section 2.1.7, "Searching 
for a Quote".

Perform the following steps to abandon a quote:

1. From Tasks > Quotes/Opportunities, select Abandon Quote. The 
Abandon Quote screen is displayed.

Note: If the payment method on the quote does not have 
sufficient funds to fulfill the order, a warning message is 
displayed indicating that the payment method has 
insufficient funds, and the order is placed on hold until 
sufficient funds are provided.
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2. The Quote Details panel displays information such as quote name, 
opportunity name, status, quote owner, expiration quote date, and so 
on.

3. From the Reason panel, select a reason code from the Reason Code 
drop down list.

4. To view or add notes, click the View/Add Notes hyperlink. The Quote 
Notes pop-up window is displayed where you can view or add notes 
to the quotes.

5. Click Confirm. The Quote Summary screen is displayed with the 
status of the quote changed to Abandoned.

2.5 Performing Fulfillment Tasks
This section explains how to perform the following fulfillment-related 
tasks:

Modifying Fulfillment Options

Fulfillment Summary

Delivery and Service Grouping

Modifying Service Instructions

Modifying Service Appointments

Service Fulfillment Summary

Managing Delivery Service Option

Modifying Order Addresses

Reshipping an Item

2.5.1 Modifying Fulfillment Options
When a customer requests a change in the fulfillment options for an 
item, you can modify the fulfillment options as requested. For example, 
after the customer places an order for delivery, the customer may decide 
to pick the items up at a nearby store. In such situations, you can modify 
the fulfillment options as requested. This task is also used when a 
customer wants to modify the delivery address for an order line. To 
modify the fulfillment options, you must first search for the order. For 
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more information about searching for an order, see Section 2.1, 
"Performing Search Tasks".

To modify the fulfillment options:

1. From Tasks > Fulfillment, select Change Fulfillment Options. The 
Change Fulfillment Options screen is displayed.

2. Select the Perform Advanced Service Grouping check box to group 
the order lines into smaller groups to ensure that appointments will 
be available for the various services and click Next. For more 
information about adding order lines to a group, see Section 2.5.3, 
"Delivery and Service Grouping".

3. Check the boxes of the items for which you want to modify the 
fulfillment options.

If you want to modify the fulfillment options for all items on the 
order, check the Check All box.

You can view the expected date of fulfillment for the order line in 
the Expected Date column. The expected date for:

– Pick Up—displays the earliest date on which the customer can 
pick up the item from a store.

– Shipping—displays the earliest date on which the item will be 
shipped from the warehouse.

– Delivery—displays the earliest date on which the item will be 
shipped from the warehouse.

The expected date of fulfillment does not display for the order 
line, if:

– The requested pick up date does not exist.

Note: The Perform Advanced Service Grouping check box 
is displayed in the Change Fulfillment Options screen only 
if delivery or service order lines or both exist and if you 
have permissions to perform the Delivery and Service 
Grouping task.
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– The work order appointment is not created.

4. Choose the appropriate fulfillment method.

5. When the customer wants to pick up items from the store, choose the 
"Pick Up" fulfillment method. 

a. Select the country or region in which the store is located from the 
drop-down list.

b. Enter the postal code or city, and state.

c. Click Search. The More Stores screen is displayed. For more 
information about viewing inventory in other stores, see 
Section 2.3.2.2, "Viewing Inventory in Other Stores".

d. Select the appropriate store and click Apply.

Note: When you change the fulfillment option for a parent 
bundle item which is configured as ship independent, the 
fulfillment method for the component lines is automatically 
selected for modification.

For a bundle parent item which is configured as ship 
together, only the parent bundle item is displayed.

Note: If you want to modify the fulfillment option for a 
parent item that has related lines, the fulfillment method 
for the related lines is automatically selected for 
modification. You can clear the check boxes of the 
appropriate related lines for which you do not want to 
modify the fulfillment option.

Note: The recently added order lines are identified by the 
 icon.

Note: All order lines that are associated with drop ship 
lines are disabled.
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e. Click Next. The Fulfillment Summary Screen is displayed. For 
more information about fulfillment summary details, see 
Section 2.5.2, "Fulfillment Summary".

6. When the customer wants the items to be shipped, follow these 
steps:

a. Choose the Ship fulfillment method. The ship to address must be 
entered.

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

b. From the Service drop-down list, select the appropriate carrier 
service that the customer requests for item delivery.

c. Click Apply. 

d. If you skip the customer identification step when capturing the 
order, you must enter an address for all the order lines that are 
being shipped or delivered.

e. Click Next. 

– The Fulfillment Summary screen is displayed where you can 
view and modify the complete configuration of an order and 
how it is being fulfilled. For more information about fulfillment 
summary, see Section 2.5.2, "Fulfillment Summary".

f. Click Next. 

Note: A fulfillment method can be selected only if the 
item supports the selected fulfillment method.

Note: The Fulfillment Summary screen is displayed only if 
the fulfillment method is either Ship or Pick Up.
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– If any order lines are being delivered and the newly added 
lines require a new appointment or an existing appointment 
needs to be retaken, the Service Appointment screen is 
displayed. For more information about creating or modifying 
an appointment, see Section 2.5.5, "Modifying Service 
Appointments".

– If the order contains existing service appointments that have 
not been affected by the addition of lines, the Service 
Fulfillment Summary screen is displayed. For more information 
about viewing the service fulfillment summary, see 
Section 2.5.6, "Service Fulfillment Summary".

7. When the customer wants the items to be delivered to their doorstep, 
follows these steps:

a. Choose the Delivery fulfillment method. The Deliver To address 
must be entered. 

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

b. If you skipped the customer identification step when capturing the 
order, enter the address for all order lines that are being 
delivered.

Note: Based on the configuration, the Fulfillment option is 
displayed. For more information about displaying the 
Shipping and Delivery as a separate fulfillment option, see 
the Sterling Call Center and Sterling Store: 
Implementation Guide.

Note: You can modify any order line that has the Delivery 
fulfillment method until the delivery line is shipped.
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c. Click Next. 

– If any order lines are being delivered and the newly added 
lines require a new appointment or an existing appointment 
needs to be retaken, the Service Appointment screen is 
displayed. For more information about creating or modifying 
an appointment, see Section 2.5.5, "Modifying Service 
Appointments".

– If the order contains existing service appointments that have 
not been affected by the addition of lines, the Service 
Fulfillment Summary screen is displayed. For more information 
about viewing the service fulfillment summary, see 
Section 2.5.6, "Service Fulfillment Summary".

8. When the customer wants to change the address for the provided 
service line:

a. Select all service lines in the list. The Service Address panel is 
displayed.

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

b. Click Next. The Fulfillment Summary Screen is displayed. For 
more information about the fulfillment summary details, see 
Section 2.5.2, "Fulfillment Summary".

Note: If the status modification rules do not allow you to 
change the fulfillment method of an item, then an error 
message "Order cannot be modified in the current status" 
is displayed and also the order line is displayed in red.
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2.5.2 Fulfillment Summary
The Fulfillment Summary screen provides information about the way in 
which an order is being fulfilled. You can view the details of an order such 
as the recently added order lines, gift items, open box items, related 
items, and so forth. You can group order lines based on the fulfillment 
method. To modify the fulfillment options, you must first search for the 
order. For more information about searching for an order, see 
Section 2.1.1, "Searching for an Order".

Based on the configuration, you can view the fulfillment summary in one 
of the following screens: 

Basic Fulfillment Summary

Advanced Fulfillment Summary

2.5.2.1 Basic Fulfillment Summary Screen
In the Basic Fulfillment Summary screen, you can view the fulfillment 
summary for the order lines that are grouped based on the ship to 
addresses. 

In the Shipment Summary panel, you can view the fulfillment summary 
for the Shipping fulfillment method: 

The address to which the item is shipped is displayed in the header 
panel.

The  icon indicates that the item is a gift item and can be picked 
up or shipped to the gift recipient. For more information about setting 
up gift options, see Section 2.7.1, "Setting Up Gift Options".

The  icon indicates that the item is an open box item. For more 
information about open box items, see Section 3.3.9, "Adding Open 
Box Items".

The image of the item is displayed.

In the Item column, the item description and the Item ID are 
displayed.

Note: If the bundle parent item is configured as ship 
independent, the bundle component items are displayed 
below the bundle parent item.
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In the Quantity column, the order line’s quantity is displayed.

In the Unit Price column, the unit price of the item is displayed.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

In the Available column, the earliest date on which the product is 
available is displayed. If the item is unavailable, the column is 
highlighted in red.

In the Level of Service column, the carrier service for the item is 
displayed. To change the carrier service, select a different carrier 
service from the drop-down list.

In the Expected Date column, the expected delivery date of the 
item is displayed. The expected date for:

– Pick Up—displays the earliest date on which the customer can 
pick up the item from a store.

– Shipping—displays the earliest date on which the customer 
can expect to receive the item.

– Delivery—displays the earliest date on which the customer can 
expect to receive the item.

In the Action column, select one of the following options from the 
drop-down list: 

Note: Order lines added recently are identified by the  
icon.

Note: If you change the carrier service, the expected 
delivery date is updated to reflect the change.
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– Change to Pick Up

– Change to Delivery

– Cancel

If you change the action from Shipping to Change to Pick Up, you will 
be taken back to the Change Fulfillment Options screen, with the 
system automatically selecting the check box against each of the 
modified order lines. For more information about fulfillment options, 
see Section 2.5.1, "Modifying Fulfillment Options".

Click the Gift Options button to modify the gift options for the 
selected items. Select the check box next to the item for which you 
want to add or clear gift information. For more information about gift 
options, see Section 2.7.1, "Setting Up Gift Options".

Click Next to view the Confirm Payment screen containing the 
payment details pertaining to the order. For more information about 
payment confirmation, see Section 2.3.8, "Viewing and Confirming 
the Payment Details". 

In the Pick Up Summary panel, you can view the following information:

The ship node is displayed in the header panel.

The  icon indicates that the item is a gift item and can be picked 
up by the recipient. For more information about setting up gift 
options, see Section 2.7.1, "Setting Up Gift Options".

Note: When a parent line that has related lines is 
selected for cancellation, the related lines are also 
automatically selected for cancellation.

Note: When a parent bundle line is cancelled, all the 
component lines are automatically cancelled.

Note: In the Shipment Summary panel, if you select an 
item that has related items, all the related items shipped 
along with the parent item are automatically selected. 
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The  icon indicates that the item is an open box item. For more 
information about open box items, see Section 3.3.9, "Adding Open 
Box Items".

The image of the item is displayed.

In the Item column, the item description and the item ID are 
displayed.

In the Quantity column, the item’s quantity is displayed.

In the Unit Price column, the unit price of the item is displayed.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

In the Available column, the earliest date on which the product is 
available in the ship node is displayed.

In the Preferred Date column, the date on which the customer prefers 
to pick up the item is displayed. Click the  icon to modify the 
preferred date for picking up the item. The calendar displays the 
dates from the initial product ship date. If the product ship date is 
blank, the calendar does not display any date.

In the Action column, select one of the following options from the 
drop-down list:

– Change to Shipping

– Change to Delivery

– Cancel

Note: Order lines added recently are identified by the  
icon.
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If you change the action from Pick Up to Change to Shipping, you will 
be taken back to the Change Fulfillment Options screen, with the 
system automatically selecting the check box against each of the 
modified order lines. For more information about modifying fulfillment 
options, see Section 2.5.1, "Modifying Fulfillment Options".

Click the Gift Options button to modify the gift options for the 
selected item. Select the check box next to the item for which you 
want to add or clear gift information. For more information about 
setting up gift options, see Section 2.7.1, "Setting Up Gift Options".

Click the Change Store Location button to select the store from which 
you want to pick up the items. Select the check box next to the item 
you want to pick up from an alternative store. For more information 
about alternative pick up locations or stores, see Section 2.3.2.2, 
"Viewing Inventory in Other Stores".

Click Next to view the Confirm Payment screen in which you can view 
the payment details pertaining to the order. For more information 
about payment confirmation, see Section 2.3.8, "Viewing and 
Confirming the Payment Details".

Note: In the Pick Up Summary panel, if you select an 
item that has related items, all the related items that are 
picked up along with the parent item are automatically 
selected.
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2.5.2.2 Advanced Fulfillment Summary Screen
In the Advanced Fulfillment Summary screen, you can view the 
fulfillment summary for the order lines that have been grouped based on 
the shipping options, ship to addresses, and the delivery date. 

In the Shipment Summary panel, you can view the fulfillment summary 
for the Shipping fulfillment method:

Select the appropriate shipping option to be used for fulfilling the 
order lines:

– Group into as few shipments as possible: Select this option to 
optimize the order fulfillment in such a way that the items are 
shipped in as few shipments as possible to reduce shipping costs. 

– Faster. Group items available within a specific period of time, 
could cause additional charges: Select this option to optimize the 
order fulfillment in such a way that the items that are available 
within a specific period of time are shipped together. 

– Fastest. Ship items as they become available, could cause 
additional charges: Select this option to optimize the order 
fulfillment in such a way that the items are shipped as and when 
they become available. This may result in higher shipping costs.

Note: When you click the Next button, reservations are 
created for all the unscheduled and unreserved lines and 
quantities. If some quantity of items is unavailable, and a 
reservation cannot be created entirely, you are taken back 
to the Basic Fulfillment Summary screen where the 
unavailable lines are highlighted.

Note: When modifications are made in the Basic 
Fulfillment Summary screen, the screen is refreshed to 
reflect the updated information.

Note: This option is displayed based on the configuration.
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In the Unavailable Lines panel, the details of the order lines for which 
inventory is not available are displayed.

In the header panel, the address to which the items are shipped and 
the expected shipment date are displayed.

The  icon indicates that the item is a gift item and can be picked 
up or shipped to the recipient. For more information about setting up 
gift options, see Section 2.7.1, "Setting Up Gift Options".

The  icon indicates that the item is an open box item. For more 
information about open box items, see Section 3.3.9, "Adding Open 
Box Items".

The image of the item is displayed. 

In the Item column, the item description and the Item ID are 
displayed.

In the Quantity column, the order line’s quantity is displayed.

In the Unit Price column, the unit price of the item is displayed.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

Note: If the status modification rules do not allow you to 
change the shipping option, the shipping options will not 
be displayed. 

Note: After you select a shipping option, the screen is 
refreshed to reflect the updated information.

Note: Order lines added recently are identified by the  
icon.
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For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

In the Available column, the earliest date on which the item is 
available is displayed.

In the # of Shipments column, the number of shipments the order 
line is included in is displayed. 

– Click the  icon to combine the shipments that the order line is 
included in as one shipment. If you click this icon, the entire 
quantity pertaining to that order line will be shipped at the same 
time. Therefore, even if there is some quantity of items for that 
order line that can be shipped earlier, the items will not be 
shipped until the entire quantity pertaining to that order line is 
available.

– Click the  icon to split the order line into different shipments. If 
you click this icon, the items for the order line will be shipped as 
and when they become available. This may, however, result in 
higher shipping costs.

Click Save and Refresh to save the changes. 

In the Requested Date column, the requested delivery date of the 
item is displayed.

In the Action column, select one of the following options from the 
drop-down list: 

– Change to Pick Up

– Change to Delivery

– Cancel

Note: When an order line is split into multiple shipments, 
if you select one shipment, all the shipments that the order 
line is included in will be selected.
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If you change the action from Shipping to Change to Pick Up, you will 
be taken back to the Change Fulfillment Options screen, with the 
system automatically selecting the check box against each of the 
modified order lines. For more information about fulfillment options, 
see Section 2.5.1, "Modifying Fulfillment Options".

If any order lines have already been released, you can view the 
details of those order lines. To view the released order lines, click the 
View In Progress/Processed Lines hyperlink. The In 
Progress/Processed Items pop-up window is displayed with the details 
of the order lines that have been released. 

Click the Gift Options button to modify the gift options for the 
selected items. Select the check box next to the item for which you 
want to add or clear gift information. For more information about gift 
options, see Section 2.7.1, "Setting Up Gift Options".

Click the Change Line Options button to change the level of service 
and the requested delivery date for an order line. The Order Line 
Options pop-up window is displayed. 

To change the level of service and the requested delivery date:

a. From the Level of Service drop-down list, select the carrier service 
for the order line. 

b. In the Requested Delivery Date field, either enter the requested 
delivery date or select a date. To select a date, click the  icon 
and select the month, year, and date.

c. Click Apply. 

d. Click Save and Refresh.

Note: When a parent line that has related lines is 
selected for cancellation, the related lines are also 
automatically selected for cancellation.

Note: When a parent bundle line is cancelled, all the 
component lines are automatically cancelled.
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Click Next. The Confirm Payment screen, where you can view the 
payment details for an order, is displayed. For more information about 
payment confirmation, see Section 2.3.8, "Viewing and Confirming 
the Payment Details".

In the Pick Up Summary panel, you can view the following information:

The ship node is displayed in the header panel.

The  icon indicates that the item is a gift item and can be picked 
up by the recipient. For more information about setting up gift 
options, see Section 2.7.1, "Setting Up Gift Options".

The  icon indicates that the item is an open box item. For more 
information about open box items, see Section 3.3.9, "Adding Open 
Box Items".

The image of the item is displayed. 

In the Item column, the item description and the Item ID are 
displayed.

In the Quantity column, the item’s quantity is displayed.

In the Unit Price column, the unit price of the item is displayed.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 

Note: If the order line is being shipped in multiple 
shipments, the level of service and the requested delivery 
date for all the units pertaining to that order line are 
changed. 

Note: In the Shipment Summary panel, if you select an 
item that has related items, all the related items shipped 
along with the parent item are automatically selected.

Note: Order lines added recently are identified by the  
icon.
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displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

In the Available column, the earliest date on which the product is 
available in the ship node is displayed. If the items are unavailable, 
the column is displayed in red. 

In the Preferred Date column, the date on which the customer prefers 
to pick up the item is displayed. Click the  icon to modify the 
preferred date for picking up the item. The calendar displays the 
dates from the initial product ship date. If the product ship date is 
blank, the calendar does not display any date.

In the Action column, select one of the following options from the 
drop-down list:

– Change to Shipping

– Change to Delivery

– Cancel

If you change the action from Pick Up to Change to Shipping, you will 
be taken back to the Change Fulfillment Options screen, with the 
system automatically selecting the check box against each modified 
order line. For more information about modifying fulfillment options, 
see Section 2.5.1, "Modifying Fulfillment Options"

Click the Gift Options button to modify the gift options for the 
selected item. Select the check box next to the item for which you 
want to add or clear gift information. For more information about 
setting up gift options, see Section 2.7.1, "Setting Up Gift Options".

Click the Change Store Location button to select the store from which 
you want to pick up the items. Select the check box adjacent to the 
item you want to pick up from an alternative store. For more 
information about alternative pick up locations or stores, see 
Section 2.3.2.2, "Viewing Inventory in Other Stores".
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Click Next to display the Confirm Payment screen in which you can 
view the payment details pertaining to the order. For more 
information about payment confirmation, see Section 2.3.8, "Viewing 
and Confirming the Payment Details". 

2.5.3 Delivery and Service Grouping
When a complex order pertaining to numerous products, provided 
services, and delivery services exists, the task of scheduling 
appointments for these orders in the appointment scheduling screens of 
the Sterling Call Center and Sterling Store application becomes difficult.

To ease this difficulty, the Delivery and Service Grouping screen can be 
used. This screen allows you to select products and services, and assign 
them to a group before selecting an appointment. You can create new 
groups, merge multiple groups, and add or remove lines from the 
existing groups.

The Delivery and Service Grouping screen provides a summary of all the 
work orders and appointments related to an order. All the work orders 
that have the same ship to address are grouped under a single Address 
panel. When the order lines are not assigned to any group, and the 

Note: In the Pick Up Summary panel, if you select an 
item that has related items, all the related items that are 
being picked up along with the parent item are 
automatically selected.

Note: When you click the Next button in the Advanced 
Fulfillment Summary screen, reservations are created for 
all the unscheduled and unreserved lines and quantities. If 
some quantity of items is unavailable and a reservation 
cannot be created entirely, you are taken back to the 
Advanced Fulfillment Summary screen where the 
unavailable lines are highlighted.
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Delivery and Service Grouping screen is accessed for the first time, all 
the order lines are automatically assigned to a default group.

When you add a new order line to an order, either of the following takes 
place:

The new order line is added to a new work order under a new 
Address panel.

The new order line is added to an existing work order.

2.5.3.1 Creating a New Group
To create a new group:

1. Select the check boxes adjacent to the order lines that you want to 
include in a new group.

2. Select the Create New Group option from the Group Selection panel.

3. Click Apply.

2.5.3.2 Adding Order Lines to an Existing Group
To add order lines to a group:

1. Select the check boxes adjacent to the order lines that you want to 
include in an existing group.

2. Select the Add Line(s) to Group option from the Group Selection 
panel.

3. From the Group Number drop-down list, select the group number to 
which you want to assign the order lines.

4. Click Apply.

Note: Cancelled work orders are not displayed in the 
Delivery and Service Grouping screen.
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2.5.4 Modifying Service Instructions
When a customer requests a change in the service instructions for an 
item, you can modify the service instructions as requested. For example, 
if the customer is not available at home at the time of delivery, the 
customer may request that the items be left at the back doorstep. You 
can modify the service instructions accordingly. To modify service 
instructions, you must first search for the order. For more information 
about searching for an order, see Section 2.1, "Performing Search Tasks".

To modify the service instructions, from Tasks > Fulfillment, select 
View/Change Service Instructions. The View/Change Service Instructions 
screen is displayed. You can perform any one of the following action:

Click the View/Change Instructions hyperlink of the appropriate 
appointment. The View/Change Instructions pop-up window is 
displayed. You can either enter new service instructions or modify the 
existing service instructions, and click Confirm.

Click the Change Appointment hyperlink to change the service 
appointment. The Select An Appointment screen is displayed. For 
more information about changing service appointments, see 
Section 2.5.5, "Modifying Service Appointments".

The Notes panel is displayed, if you reach the Service Fulfillment 
Summary screen by performing any one of the following task:

Modifying Service Appointments

Note: Based on the rules configured, an item, say, Item 
A, in an order, supports the delivery fulfillment method 
only if another item, say, Item B, in the same order 
supports it. In such situations, you cannot create different 
groups for these two items. If you try to create different 
groups, an error is displayed indicating that some of the 
order lines (in this context, Item A) are not grouped with a 
valid delivery line.

Note: You can modify the service instructions for 
deliveries that are not complete.
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Modifying Service Instructions

You can add any additional information related to the service 
transaction. For more information about adding order notes, see 
Section 2.3.4, "Viewing and Adding Notes to an Order".

Click the Advanced Service Grouping button to group the service lines 
into different appointment groups. For more information about adding 
order lines to a group, see Section 2.5.3, "Delivery and Service 
Grouping".

Click the Previous button to revisit the previous screen.

2.5.5 Modifying Service Appointments
When a customer requests a change in the service date and time, you 
can change the service appointment for a product or service item.

The appointments that exist for the order is displayed in the top panel.

If you have already taken an appointment, the details about the 
appointment is displayed. 

If there is a problem with the appointment taken, the  icon is 
displayed.

If you have not taken an appointment, a “Not Taken” message is 
displayed.

Note: The Advanced Service Grouping button displays on 
the screen only if you have permission to perform 
advanced service grouping.

Note: You can modify the service instructions for any 
order line that has the "Delivery" fulfillment method and 
are not shipped.

Note: You can modify the service appointment for a 
product or service item only if the existing appointment is 
not complete.
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If you have skipped an appointment by clicking the "Take 
Appointment Later" hyperlink, a "Skipped" message is displayed.

1.  In the Calendar, click the left or right arrow to select the appropriate 
month, and select the day on which you want to take an 
appointment. By default, the current month is displayed in the 
calendar.

2. In the Slots panel, select the appropriate slot for the appointment.

The Sterling Call Center and Sterling Store application provides the 
ability to switch the calender view for the selected appointment by 
clicking any one of the following hyperlinks:

Switch to day-first view—This view displays the calendar to the 
left of the screen. When you select a day, the slots available for 
that day display to the right.

Switch to slot-first view—This view displays the slots to the left of 
the screen. When you select a slot in the Slots panel, the days 
available for the selected slot display to the right.

3. If you do not want to take an appointment for the current work order 
immediately, click the "Take Appointment Later" hyperlink. The 
process of taking the appointment will be skipped, and you can 
continue with the order confirmation process.

If you have already taken an appointment for this work order, a 
"Remove Appointment" hyperlink will be displayed instead of "Take 
Appointment Later".

When the order contains multiple work orders, you must perform step 
3 for each work order if you want to skip the task of taking 
appointments for more than one work order.

Note: The default calendar view is displayed depending 
on the rules configured. For more information about 
configuring the service appointments calendar view, see 
the Sterling Call Center and Sterling Store: 
Implementation Guide.
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If one or more items in a work order are not available, the "Take 
Appointment Later" hyperlink will not be displayed, and the 
unavailable items will be highlighted in red color.

4. In the Service Instructions panel, you can either enter new service 
instructions or modify the existing service instructions for the 
selected appointment.

5. In the Order Lines panel, you can view all items included for the 
selected appointment.

In the Problem Line column, the  icon is displayed only if the newly 
added line cannot be fulfilled for the current appointment.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

In the Available Date column, the earliest date when the product is 
available is displayed. If items are unavailable, the column is 
displayed in red.

If you want to change the fulfillment option of a newly added line or 
or cancel an order line, click the Line Actions hyperlink. The Line 
Actions pop-up window is displayed. In the Action column, select any 
one of the following actions from the drop-down list:

Note: The "Take Appointment Later" hyperlink and the 
"Remove Appointment" hyperlink are displayed only if you 
have permission to omit the task of taking an 
appointment.

Note: Transfer or purchase orders that are created to 
meet inventory reservation will not be cancelled when an 
appointment is removed.
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Change to Pick Up - If the item supports the pick up fulfillment 
method.

Change to Shipping - If the item supports the shipping fulfillment 
method.

Cancel - If the line allows the cancellation.

6. Click Confirm.

If you select Change to Pick Up or Change to Shipping action, the 
Change Fulfillment Options screen is displayed. The boxes of the 
items that you modified are automatically checked. For more 
information about modifying the fulfillment options, see 
Section 2.5.1, "Modifying Fulfillment Options".

If you select the Cancel action, the item is cancelled.

7. Click the Previous button to revisit the previous screen.

8. If you want to group the service lines into different appointment 
groups, click the Advanced Service Grouping button. For more 
information about adding order lines to a group, see Section 2.5.3, 
"Delivery and Service Grouping".

9. Click the Manage Service Option hyperlink to view or add or modify 
the delivery service option.  For more information about viewing or 
adding or modifying the delivery service option, see Section 2.5.7, 
"Managing Delivery Service Option".

10. Click Save Appointment. The inventory is reserved and the capacity is 
allocated for the appointment.

Note: The Store Stock column displays the values "Yes" 
or "No" to indicate whether the item is available in the 
store, or is being procured from some other store.

Note: The Advanced Service Grouping button is displayed 
in the Change Fulfillment Options screen only if delivery or 
service order lines or both exist and if you have 
permissions to perform the Delivery and Service Grouping 
task.
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2.5.6 Service Fulfillment Summary
You can view the summary of all appointments related to an order. The 
appointments are grouped based on the address displayed in the header 
panel. In the Appointment panel, you can view the appointment number, 
the current appointment, if an appointment has been taken, and the 
service charges applicable for the service. You can perform any one of 
the following actions:

Click the  icon to view the order lines included in the appointment.

Click the Change Appointment hyperlink to modify the service 
appointment. For more information about modifying service 
appointments, see Section 2.5.5, "Modifying Service Appointments".

Click the View/Change Instructions hyperlink to view or modify the 
service instructions. For more information about modifying the 
service instructions, see Section 2.5.4, "Modifying Service 
Instructions".

Click the Advanced Service Grouping button to group the service lines 
into different appointment groups. For more information about adding 
order lines to a group, see Section 2.5.3, "Delivery and Service 
Grouping".

Click the Gift Options hyperlink. The Mark/Clear item(s) as gift(s) 
screen is displayed.

Note: If the status modification rules do not allow you to 
change service appointment, the Change Service 
Appointment hyperlink is disabled.

Note: If the status modification rules do not allow you to 
change service instructions, the View/Change Instructions 
hyperlink is disabled.

Note: The Advanced Service Grouping button displays on 
this screen only if you have the permission to perform 
advanced service grouping.
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Choose Mark this line/these lines as gift(s) to mark the item as a 
gift item.

Choose These item(s) are not gift(s) if you no longer want the 
item to display as a gift item.

Click Apply.

Click the Manage Service Option hyperlink to view or add or modify 
the delivery service option. For more information about viewing or 
adding or modifying the delivery service option, see Section 2.5.7, 
"Managing Delivery Service Option".

2.5.7 Managing Delivery Service Option
Sometimes a customer may request you to modify the delivery service 
options for an item, in such case you can modify the delivery service 
options as requested.

To modify the delivery service option, click the Manage Service Options 
hyperlink of the appropriate appointment in the Change Appointment 
screen or Delivery Fulfillment Summary screen. The Manage Service 
Options pop-up window is displayed. You can select the checkbox of the 
corresponding delivery service and modify it. Click Confirm.

You can also modify the quantity and unit price of an item by clicking the 
Override Price hyperlink. For more information about overriding item 
price, see Section 2.3.2.1, "Overriding Item Price".

2.5.8 Modifying Order Addresses
Sometimes a customer provides incorrect order address information 
when placing an order. In such situations, the customer may request that 
you modify the order address. To perform this task, you must first search 
for the order. For more information about searching for an order, see 
Section 2.1, "Performing Search Tasks".

To modify the address for an order:

Note: In the Delivery Fulfillment Summary screen, if an 
appointment is already taken and cannot be changed, you 
cannot modify the delivery service option.



Performing Fulfillment Tasks

Tasks for a Customer Service Representative   151

1. From Tasks > Fulfillment, select Change Order Address. The Change 
Order Address screen is displayed where you can view one or more 
addresses provided by the customer.

2. To modify an existing address, click the Modify Address hyperlink in 
the appropriate Address panel. The Modify Address screen is 
displayed. You can modify the address accordingly.

If you want to override the address verification, check the Override 
Address Verification box in the Modify Address screen.

3. Click Confirm.

If the modified address is not valid, the message "This is not a 
valid address" is displayed.

If there are previously released order lines, you cannot modify the 
address for these order lines. The Previously Released Order Lines 
screen is displayed with the message "The address of the 
following items cannot be modified". You can view the item details 
for the previously released order lines.

If an item is not available for shipping, the Delivery Modification 
Can Not Be Fulfilled screen is displayed with an appropriate 
message.

– If the customer wants to pick the item up from the store, 
choose the Pick up this item from <store_name> option. If the 
customer wants to pick the item up at a store that is not listed 
in the drop-down list, click the More Stores hyperlink. The 
More Stores screen is displayed. For more information about 
viewing inventory in other stores, see Section 2.3.2.2, 
"Viewing Inventory in Other Stores".

– If the customer wants the fulfillment option to be modified 
regardless of any back order, choose Modify the Fulfillment 
Option Regardless of BackOrder.

– If the customer does not want to the fulfillment option to be 
modified, choose Do not modify the fulfillment option for this 
item.
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4. If the customer does not want to change more addresses, click Next. 
If the items need to be delivered, the View/Change Service 
Instructions screen is displayed. For more information about 
modifying service instructions, see Section 2.5.4, "Modifying Service 
Instructions".

2.5.9 Reshipping an Item
Sometimes a customer reports that the item that was ordered has not 
been received or has been damaged in transit. In such situations, you 
may have to reship the items or issue a refund to the customer for the 
shipment. You can reship only those items that are in the "Shipped" or 
"Delivered" status.

To reship an item, you must track the item. For more information about 
tracking an item, see Section 2.3.10, "Tracking an Item or Inquiring 
About a Shipment".

To reship an item:

1. In the Shipment Inquiry screen, click the View Shipment hyperlink. 
The Shipment Details screen is displayed.

2. Click the Reship Shipment hyperlink. The Lines to Reship screen is 
displayed. The Reship Shipment hyperlink is visible only if the items 
are in "Shipped" or "Delivered" status.

3. From the Reasons For Reship drop-down list, select the appropriate 
reasons for reshipping the item.

4. Check the boxes of the items you want to reship.

5. In the Quantity To Reship column, modify the reship quantity, if 
applicable.

6. Click Next. The Reship or Refund screen is displayed. In the Available 
Items panel, you can view items that are available for reshipping. In 
the Unavailable Items panel, you can view items that are not 
available for reshipping.

Note: If the status modification rules do not allow you to 
change the address in the current status, the Modify 
Address hyperlink is disabled.
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If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

7. If you want to reship all available items, in the Available Options 
panel, select Reship Available Items.

8. If you want to reship all available items and need to issue a refund 
for items that are not available, choose Reship Available Items and 
Refund Unavailable Items.

9. If you need to issue a refund for all items, choose Create Refund for 
All Items.

10. In the Notes panel, you can view or add any additional information. 

11. Click Previous to go to the previous screen. If you click the Previous 
button, it does not allow you to undo any previous action.

12. Click Next. 

If the items need to be delivered, the Select An Appointment screen 
is displayed. You can modify the service appointment of the items. 
For more information about modifying service appointments, see 
Section 2.5.5, "Modifying Service Appointments".

13. The Confirm Payment screen is displayed. For more information about 
payment confirmation, see Section 2.3.8, "Viewing and Confirming 
the Payment Details".

Note: If reshipping is not allowed for items, in the Lines 
to Reship screen, select the Override Reship Validation 
condition or the Create Follow-Up Alert condition.
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2.6 Performing Price Match Tasks
This section explains how to perform the following price match related 
tasks:

Matching an Item’s Price

Searching for a Price Match

Adding a New Price Match

Searching for a Competitor

Adding a New Competitor

2.6.1 Matching an Item’s Price
A customer may discover that another retailer is selling the same items 
that were ordered at a lesser price. In such situations, you may look into 
the customer’s claims and price match the items, if necessary. To 
perform a price match for an item, you must first search for the order. 
For more information about searching for an order, see Section 2.1, 
"Performing Search Tasks".

To perform a price match for an item:

1. From Tasks > Price Match, select Price Match An Item. The Price 
Match: Select An Item screen is displayed.

2. Check the box of the item for which you want to match the price and 
click Next. The Price Match WorkSheet screen is displayed.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

Note: If the status modification rules do not allow you to 
change the price of an item, the order line is disabled.
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3. Click the Previous button to revisit the previous screen.

4. In the previous screen, you can also select another item to price 
match.

5. Specify the Competitor name and minimum quantity to be price 
matched.

6. To specify the Competitor name, enter it in the text box or click  
icon. The Competitor Search screen is displayed. For more 
information about searching for a competitor, see Section 2.6.4, 
"Searching for a Competitor". You can modify the minimum quantity 
to be price matched which is defaulted from the order line. Click 
Search.

Note:

The order lines for which reshipping is applied are not 
available for price match. 

The order lines that are cancelled are greyed out and 
are not available for price match.

The order lines that are in Partially Return Created 
status are not available for price match. However, an 
appeasement or an adhoc discount may be provided to 
appease the customer.

Bundle parent items are available for price match. 
However, if the price of a bundle item is not configured 
at the bundle parent, the bundle item will not be 
available for price match.

Bundle component items are not available for price 
match.

Delivery service lines are also not available for price 
match.
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7. If the competitor does not exist, the message "Competitor is not 
found in the database. Would you like to create a new Competitor?" is 
displayed. Click the Create Competitor button to create a new 
competitor. For more information about adding a new competitor, see 
Section 2.6.5, "Adding a New Competitor".

8. If the Competitor exists but has been previously DENIED for 
performing price matches, the message "This competitor cannot be 
used in a price match. If you entered incorrectly, close the message 
and search for a new competitor" will be displayed and the price 
match is rejected.

9. If the Competitor exists, in the Previously Attempted Price Matches 
panel, you can view the previously attempted price matches for this 
competitor and the Price Match Worksheet is displayed. If you click 
Next before entering the values in the Worksheet, the message "The 
price cannot be matched because the worksheet is incomplete. You 
may choose to go back and complete the worksheet or cancel the 
price match. Do you want to complete the worksheet?" is displayed. 
Click Yes to continue with the worksheet. Click No to close the 
worksheet.

10. Click the Select hyperlink to use a previously attempted price match. 
You can modify the price offered by the competitor, discounts and 
shipping charges offered by the competitor.

11. Discounts are defaulted in the Price Match Worksheet. The existing 
discount and charges are editable fields.

You can click Add/Modify Charges hyperlink which is present in the 
Price Match Worksheet to view the existing charges of the order 
displayed in the header and the line level.

Note: Content Assist is available while searching for a 
competitor. When you enter a few characters of the 
competitor’s name, a list of competitors whose name 
begins with the characters entered is displayed.

Note: The minimum quantity entered should be less than 
or equal to the order line quantity.



Performing Price Match Tasks

Tasks for a Customer Service Representative   157

12. The price match difference is displayed in the Refund Amount Per Unit 
From Price Match field. The Price Match Percentage defined for the 
competitor is also displayed when the percentage is anything other 
than 100%. Click Next.

If the competitor’s unit price and discounts is equal to a 
previously approved price match’s unit price and discount, then 
the price match is approved. The Confirm Payment screen is 
displayed. For more information about payment confirmation, see 
Section 2.3.8, "Viewing and Confirming the Payment Details".

If the competitor’s unit price and discounts is greater than 
previously approved price match’s unit price and discount, then 
the price match is approved. The Confirm Payment screen is 
displayed. For more information about payment confirmation, see 
Section 2.3.8, "Viewing and Confirming the Payment Details".

If the competitor’s net price is greater than the price offered by 
Sterling Call Center and Sterling Store, the message "We are 
offering a better price than the price match you have requested 
and the price match will not be applied. You may choose to go 
back to the worksheet and re-do your calculations or cancel the 
price match. Do you want to re-do your calculations?" is 
displayed. Click Yes to re-do the calculations on the Price Match 
Worksheet. Click No to close the Price Match Work Sheet.

If the competitor’s unit price and discount is equal to previously 
rejected price match’s unit price and discount, the message "The 
Price Match record was previously rejected. We cannot match the 
requested price. If you think you have entered something 
incorrectly, please select Close and modify the information. If you 
select Confirm, it means that you can accept that this Price Match 
as rejected." is displayed. Click Close to modify the field values in 
the Price Match Work Sheet. Click Confirm to close the Price 
Match Work Sheet.

Note: The Refund Amount Per Unit From Price Match is 
calculated by applying the price match percentage defined 
for the competitor.
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 If the competitor’s unit price and discount is less than the 
previously rejected price match’s unit price and discount, then the 
price match is rejected.

If an existing price match which is in pending status is selected 
for price match:

– If you do not have permissions to approve price match, the 
price match continues to be in pending status and can only be 
approved by a user who has permissions.

– If you have permissions to approve price match, the Override 
Price match screen is displayed. Select the Approve Price 
Match option to approve the price match. Select the Do not 
allow this price match on future orders option, to not allow the 
price match on future orders. Select the Allow this price match 
on future orders till option to allow the price match until a 
particular date. To select a date, click the  icon and then 
select the month, year and day. Select the Deny Price Match 
option to reject the price match.

If no existing price matches are found, pre-configured price match 
rules are used to check if the price match meets the No Hassle 
Criteria.

If the price matches the No Hassle Criteria, a pop-up to enter 
notes to the price match is displayed. Click Confirm, the price 
match is approved and the Confirm Payment screen is displayed. 
For more information about payment confirmation, see 
Section 2.3.8, "Viewing and Confirming the Payment Details".

If the price match does not satisfy the No Hassle Criteria:

– If you do not have permissions to approve price match, an 
alert is created for the price match which can be 
approved/denied by a user who has permissions.

– If you have permissions to approve price match, the Override 
Price match screen is displayed.
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2.6.2 Searching for a Price Match
You may sometimes need to search for a price match record.

To search for a price match:

1. From Tasks > Price Match, select Price Match Search. The Price Match 
Search and List screen is displayed.

2. Select the enterprise from the drop-down list.

3. Enter the appropriate search criteria and click Search. The search 
results are displayed in the Price Match Results panel.

If you cannot find the pertinent price match, click  icon to show 
the search criteria. You can enter more restrictive search criteria for 
the selected task.

4. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

5. Double-click the appropriate price match. The price match details 
screen is displayed. For more information about viewing the price 
match details, see Section 2.6.2.1, "Viewing Price Match Details".

6. Click the Add button to add a new price match. For more information 
about adding a new price match, see Section 2.6.3, "Adding a New 
Price Match".

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." is displayed. You 
can select the Don't notify me again box, not to display the 
message again. 
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2.6.2.1 Viewing Price Match Details 
In the Price Match Details screen, you can view the details of a price 
match such as competitor's name, enterprise code.

1. In the Price Match Details panel, you can view the enterprise code, 
item ID, UOM, expiration date of the price match, status of the price 
match, competitor, the minimum quantity to be price matched, 
competitor's unit price and competitor's discounts.

2. In the Price Match Description panel, you can view a brief description 
of the price match.

3. In the Order Lines Available panel, you can view the order lines on 
which the price match can be applied.

4. In the Order Lines Unavailable panel, you can view the order lines on 
which the price match cannot be applied.

5. Click Close.

2.6.3 Adding a New Price Match
Sterling Call Center and Sterling Store provides the ability to add a new 
price match, if the price match does not already exist. 

To add a new price match:

1. From Tasks > Price Match, select Add Price Match. The Price Match 
Details screen is displayed.

2. Select the enterprise code from the drop-down list. Enter the item ID 
or click the  icon. The Advanced Add Item Search screen is 
displayed. Select the item from the list.

3. Enter the unit of measure for the item selected.

4. Select the expiration date for the price match. To select a date, click 
the  icon and then select the month, year and day.

5. Select the status for the price match from the drop-down list.

6. Enter the competitor or click the  icon to search for the competitor. 
Enter the minimum quantity to be price matched, the competitor’s 
unit price and competitor’s discounts.

If the competitor is in rejected status, then in such case the price 
match cannot be applied.
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7. Click Confirm to add the price match.

2.6.3.1 Modifying a Price Match
Sterling Call Center and Sterling Store provides the ability to modify an 
existing price match. For example, you may want to extend the 
expiration date of a price match.

To modify an existing price match, you must first search for a price 
match. For more information about searching for a price match, see 
Section 2.6.2, "Searching for a Price Match".

1. In the Price Match Details panel, you can view the enterprise code, 
item ID, UOM, expiration date of the price match, status of the price 
match, competitor, the minimum quantity to be price matched, 
competitor's unit price, and competitor's discounts.

For an approved price match, you can only modify the expiration 
date.

For a pending or rejected price match, you can modify the 
expiration date, status of the price match, competitor’s unit price 
and competitor's discounts.

2. In the Price Match Description panel, enter a brief description of the 
price match.

3. In the Order Lines For Which Price Can Be Matched panel, you can 
view the order lines on which the price match can be applied.

4. In the Order Lines For Which Price Cannot Be Matched panel, you can 
view the order lines on which the price match cannot be applied.

2.6.4 Searching for a Competitor
You may sometimes need to search for a competitor when performing a 
price match.

To search for a competitor:

Note: In the Price Match Notes panel of the Price Match 
Worksheet, notes entered for previously attempted price 
match are displayed. 
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1. From Tasks > Price Match, select Competitor Search. The Competitor 
Search and List screen is displayed.

2. Select the enterprise from the drop-down list.

3. Enter the appropriate search criteria and click Search. The search 
results display in the Competitor Results panel.

If you cannot find the pertinent competitor, click  icon to show the 
search criteria. You can enter more restrictive search criteria for the 
selected task.

4. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

5. Double-click the appropriate competitor. The Competitor details 
screen is displayed. For more information about viewing the 
Competitor details, see Section 2.6.4.1, "Viewing Competitor Details".

2.6.4.1 Viewing Competitor Details
In the Competitor Details screen, you can view the details of a 
competitor such as competitor's name, enterprise code.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 
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1. In the Competitor Details panel, you can view the competitor's name, 
enterprise code, status of the enterprise, percentage of the price 
match, and the web address of the competitor.

2. In the Description panel, you can view a brief description of the 
competitor.

3. Click Close.

2.6.5 Adding a New Competitor
Sterling Call Center and Sterling Store provides the ability to add a 
competitor, if the competitor does not already exist. 

1. Do one of the following to add a new competitor :

From Tasks > Price Match, select Competitor Search. The 
Competitor Search and List screen is displayed. Click the Add 
button, The Add Competitor screen is displayed.

From Tasks > Price Match, select Add Competitor. The Add 
Competitor screen is displayed.

2. In the Competitor Details panel, enter the competitor's name, 
enterprise code, status of the enterprise, percentage of the price 
match, and the web address of the competitor. 

3. In the Description panel, enter a brief description of the competitor.

4. Click Confirm.

2.7 Performing Other Tasks on an Order
Some miscellaneous tasks you may need to perform for a customer 
include:

Setting Up Gift Options

Appeasing Customers

Adding a Coupon or Promotion Code

Changing Payment Methods

Viewing Payment Details

Inquiring About Returns and Exchanges
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Reconfiguring Items

2.7.1 Setting Up Gift Options
When a customer wants to buy an item and gift it to someone, you can 
set the gift options in any one of the following ways:

The customer places an order at the store and wants the gift recipient 
to pick it up from the same store or an alternate store. In such 
situations, the CSR marks the item as a gift item and captures the 
recipient details.

The customer places an order at the store and realizes that the gift 
recipient cannot pick up the item. In such situations, the customer 
decides to pick up the item.

The customer places an order at the store and wants the store to ship 
the items to the recipient as gift items. In such situations, the CSR 
marks the items as gift items and captures the ship to address of the 
recipient.

The customer places an order at the store and wants the store to 
deliver the items to the recipient as gift items. In such situations, the 
CSR marks the items as gift items and captures the delivery address 
of the recipient.

2.7.1.1 Gift Options for Pick Up
This section provides the steps to be performed if the customer or the 
gift recipient wants to pick up gift items from the store.

To set the gift options for pick up:

1. From Tasks > Other Tasks, select Change Gift Options. The Change 
Gift Options screen is displayed.

2. Select the check boxes next to the items you want to assign as gifts 
and click the Gift Options button. The Enter Gift Recipient Information 
pop-up window is displayed.

Note: If the status modification rules do not allow you to 
change gift options for an item, the message "Gift options 
could not be changed for the following Items" is displayed.
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3. Select the Enter Gift Recipient Information option to enter the 
recipient’s First Name, Last Name, and the Phone number.

4. To include a message with an item marked as a gift, enter the 
message in the Gift Message text box.

5. Select the Gift Wrap Item check box to gift wrap an item marked as 
gift. However, the Gift Wrap Item check box will be displayed only if 
both the following conditions are met:

– The item that is to be gift wrapped must support gift wrapping. If 
the item does not support gift wrapping, a message is displayed, 
indicating that the item cannot be gift wrapped.

– The store that ships the item must support gift wrapping services. 
If gift wrapping service is not supported by the corresponding 
store, a message is displayed, indicating that gift wrapping is not 
supported by the store.

6. Select the These item(s) are not gift(s) check box if you no longer 
want the item to be displayed as a gift item.

7. Click Apply.

The  icon is displayed against the corresponding gift item.

The  icon is displayed against the corresponding gift item which is 
to be gift wrapped.

2.7.1.2 Gift Options for Shipping
This section provides the steps to be performed if the customer wants 
the gift items to be shipped.

To set the gift options for shipping:

1. From Tasks > Other Tasks, select Change Gift Options. The Change 
Gift Options screen is displayed.

2. Select the check boxes next to the items you want to assign as gifts 
and click the Change Gift Options button. The Mark Shipping Lines As 
Gift pop-up window is displayed.

3. Select the Mark line(s) as gift(s) option to mark the item as a gift 
item.

4. To include a message with an item marked as a gift, enter the 
message in the Gift Message text box.
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5. Select the Gift Wrap Item check box to gift wrap an item marked as 
gift. However, the Gift Wrap Item check box will be displayed only if 
both the following conditions are met:

– The item that is to be gift wrapped must support gift wrapping. If 
the item does not support gift wrapping, a message is displayed, 
indicating that the item cannot be gift wrapped.

– The store that ships the item must support gift wrapping services. 
If gift wrapping service is not supported by the corresponding 
store, a message is displayed, indicating that gift wrapping is not 
supported by the store.

6. Select the These item(s) are not gift(s) option if you no longer want 
the item to be displayed as a gift item.

7. Click Apply.

The  icon is displayed against the corresponding gift item.

The  icon is displayed against the corresponding gift item which is 
to be gift wrapped.

2.7.1.3 Gift Options for Delivery
This section provides the steps to be performed if the customer wants 
the gift items to be delivered.

1. From Tasks > Other Tasks, select Change Gift Options. The Delivery 
Fulfillment screen is displayed.

2. If the Sterling Call Center and Sterling Store application is configured 
to enable you to select the entire work order as a gift item, click the 
Change Gift Options hyperlink of the corresponding appointment. The 
Mark Delivery Line As Gift pop-up window is displayed.

If the Sterling Call Center and Sterling Store application is configured 
to enable you to select individual work order lines, select the check 
boxes next to the work order lines you want to assign as gifts and 
click the Change Gift Options button. The Mark Delivery Line As Gift 
pop-up window is displayed.

3. Select the Mark line(s) as gift(s) option to mark the work order as a 
gift item.

4. To include a message for an item marked as a gift, enter the message 
in the Gift Message text box.
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5. Select the Gift Wrap Item check box to gift wrap an item marked as a 
gift. However, the Gift Wrap Item check box will be displayed only if 
both the following conditions are met:

– The items in a work order that are to be gift wrapped must 
support gift wrapping. If any of the items do not support gift 
wrapping, a message is displayed, indicating that the item cannot 
be gift wrapped.

– The store that ships the item must support gift wrapping services. 
If gift wrapping service is not supported by the corresponding 
store, a message is displayed, indicating that gift wrapping is not 
supported by the store.

6. Select the These item(s) are not gift(s) option if you no longer want 
the work order to be displayed as a gift item.

7. Click Apply.

The  icon is displayed against the corresponding gift item.

The  icon is displayed against the corresponding gift item which is 
to be gift wrapped.

2.7.2 Appeasing Customers
When a customer reports not being satisfied or has had a bad experience 
with any of the services that were provided, you can present them with 
an option to appease them. For example, a customer may report 
problems faced when placing an order online or report having received a 
damaged item. In such situations, you need to perform an appeasement 
task to make amends for the bad experience. To perform this task, you 
must first search for the order. For more information about how to search 
for an order, see Section 2.1.1, "Searching for an Order".

To appease a customer:

1. From Related Tasks > Other Tasks, select Customer Appeasement. 
The Customer Appeasement: Select Reasons for Customer 
Appeasement screen is displayed.

You can view the customer’s rating and the metrics based on which 
the rating has been calculated. To view the details of a customer’s 
rating, click the View Details hyperlink adjacent to the Customer 
Rating field. The Customer Rating pop-up window is displayed. You 
can view the details of the customer based on which the rating is 
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calculated, such as the customer’s lifetime revenue, the customer’s 
average lifetime revenue, the customer’s revenue in the previous 
year, the customer’s average lifetime revenue in the previous year, 
and so on.

2. From the Reason For Appeasement drop-down list, select the 
applicable appeasement reason.

3. Select "Select All Available Items to Provide Appeasement", if the 
appeasement applies to all the available items of the order.

4. Select "Select Specific Items to Provide Appeasement", if the 
appeasement applies to some of the items of the order.

Check the boxes of the applicable items for which the appeasement 
applies.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

5. To view the customer credentials, such as the total revenue 
generated by the customer for the last twelve months, total lifetime 
revenue generated by the customer, and the average value of the 
customer’s order accumulated over the lifetime of the customer, click 
the Display Customer Credentials hyperlink. The Customer 
Credentials pop-up window is displayed.

Notes:

The View Details hyperlink is displayed based on the 
configuration.

The View Details hyperlink is disabled if there is no 
information available to display the metrics.
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The customer’s credentials are displayed as a bubble graph. Two 
bubbles are displayed. One bubble represens the customer and the 
other bubble represents the average customer. The x-coordinate in 
the bubble graph represents the total life time revenue generated by 
the customer. The y-coordinate represents the revenue generated by 
the customer for the last twelve months, and the z-coordinate 
(bubble size) represents the average value of the customer’s order 
accumulated over the lifetime of the customer.

6. To view any additional notes for the order, click the View/Add Notes 
hyperlink. For more information about viewing order notes, see 
Section 2.3.4, "Viewing and Adding Notes to an Order".

7. In the Previous Appeasements panel, you can view appeasements 
that were previously applied to the order.

8. Click Next. The Customer Appeasement: Select Offer screen is 
displayed.

You can view the customer’s rating and the metrics based on which 
the rating has been calculated. To view the details of a customer’s 
rating, click the View Details hyperlink adjacent to the Customer 
Rating field.

The Display Customer Credentials hyperlink is displayed based on 
user permissions, and if the order is created in the context of a 
customer. Click this hyperlink to view the customer’s credentials.

9. In the Appeasement Action panel, select the offer that is applicable 
for the appeasement. The preferred appeasement option is displayed 
in bold. Use your best judgement when deciding which option to 
apply to the order.

Note: The Display Customer Credentials hyperlink is 
displayed only if the order is created in the context of a 
customer, and if you belong to a user group that has the 
necessary permission to view the customer credentials.

Important: If there are previous appeasements for an 
order, consider another appeasement.



170   User Guide

Performing Other Tasks on an Order

10. In the Notes panel, you can view appropriate notes regarding the 
appeasement action. You can add other information on the order and 
modify notes, if applicable. For more information about viewing or 
entering order notes, see Section 2.3.4, "Viewing and Adding Notes 
to an Order".

11. Click the Previous button to revisit the previous screen.

12. Click Confirm.

2.7.3 Adding a Coupon or Promotion Code
You can add a coupon or promotion code to an order upon the request of 
a customer who has already placed an order. You can add any number of 
coupons to an order. To add a coupon or promotion code to an order, you 
must first search for the order. For more information about searching for 
an order, see Section 2.1, "Performing Search Tasks". After finding the 
order, the system checks the validity of the coupon before applying it to 
the order.

To add a coupon or promotion code:

1. From Tasks > Other Tasks, select Add a Coupon/Promotion Code. The 
Add Coupons: Entry screen is displayed.

2. In Add New Coupon/Promotion Code, enter the coupon or the 
promotion code.

3. Click Apply.

You can view details such as the line sub-total, total charges, total 
taxes, total discount, and grand total.

You can also view the type of coupon or promotion code added 
and the amount by which the order total is reduced.

If the coupon or promotion code cannot be added to the order, an 
appropriate message is displayed.

Note: If the user has permission, a text box is displayed 
which enables the user to manually enter a suitable 
appeasement offer.
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4. Click the Remove hyperlink to remove any coupon or promotion code 
that is already applied to an order.

5. Click Next. The Add Coupon: Confirm Payment screen is displayed. 
For more information about payment confirmation, see Section 2.3.8, 
"Viewing and Confirming the Payment Details".

2.7.4 Changing Payment Methods
A customer may need to change the mode of payment for an order. To 
change the payment method for an order, you need to first search for the 
order. For more information about searching for an order, see 
Section 2.1.1, "Searching for an Order". Based on the configuration, 
either the Change Payment Methods screen or the enhanced Change 
Payment Methods screen will be displayed.

Change Payment Methods Screen
To change the payment method for an order:

1. From the Quick Access screen, navigate to Tasks > Other Tasks and 
select the Change Payment Method task. The Change Payment 
Methods screen is displayed.

You can view payment details such as order total, sub-total, charges, 
taxes, and discounts on the order.

In the Details panel, you can view the payment type, total amount 
charged, and the total amount refunded.

a. To edit a payment method, click the corresponding Payment Type 
hyperlink. The Modify Payment Method pop-up window is 
displayed. Make the necessary changes and click Apply.

b. From the Action drop-down list, select the appropriate action 
needed for the payment method.

Note: If the status modification rules do not allow you to 
add a coupon or promotion code to an order in the current 
status, the Add Coupon/Add promotion panel is disabled. If 
you do not have permissions to remove a coupon or 
promotion code, the Remove hyperlink is disabled.
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– To activate the current payment method for an order, select 
Activate.

– To suspend the current payment method for any charges, 
select Suspended for Charges.

– To suspend the current payment method for any charges and 
refunds, select Suspended for Charges and Refunds.

c. If there is no maximum charge limit specified for the current 
payment method, from the Unlimited Charges drop-down list, 
select "YES".

d. If there is a maximum charge limit to be applied on the current 
payment method, from the Unlimited Charges drop-down list, 
select "NO". In the Maximum Charge Limit column, enter the 
maximum amount that can be collected against the current 
payment method.

e. Click the address hyperlink to edit the address corresponding to 
the payment method. The Modify Payment Method pop-up window 
is displayed. Make the necessary changes and click Apply. If it is 
too late to modify the address because the order is already being 
processed, the address cannot be edited.

If the customer wants to add a new payment method, click Add New 
Payment Method. The Add Payment Method screen is displayed. For 
more information about adding new payment methods, see 
Section 2.7.4.1, "Adding New Payment Methods".

2. Click Confirm.

Enhanced Change Payment Methods Screen
To change the payment method for an order:

Note: If it is too late to change the payment method 
because the order is already being processed, the Action 
drop-down list, Unlimited Charges drop-down list and the 
Max Charge Limit column in the Details panel and the Add 
Payment Method button are disabled.



Performing Other Tasks on an Order

Tasks for a Customer Service Representative   173

1. From the Quick Access screen, navigate to Tasks> Other Tasks and 
select the Change Payment Method task. The enhanced Change 
Payment Methods screen is displayed. You can view the payment 
methods, order total, and bill to address pertaining to the 
corresponding order.

If an order is created in the context of a registered customer, you can 
view all the payment methods that have been saved against that 
customer, in the Payment Methods panel of the enhanced Change 
Payment Methods screen. Against each payment method, you can 
view the payment details, payment activity, maximum charge 
amount, and the transactions performed on the payment method, if 
applicable.

The Payment Details column displays information pertaining to the 
payment method, such as the type of payment method used, the 
amount charged on that payment method, and so on.

The Payment Activity column displays the authorized amount, amount 
charged or refunded against a particular payment method.

Perform the following tasks, as applicable:

To modify the attributes of a payment method, click the Edit 
button. The Edit Payment Method pop-up window is displayed. 
Make the necessary changes and click the Apply button. The 
Adjust Charges pop-up window is then displayed with the charges 
adjusted on all the payment methods.

To adjust the maximum charge amount for a payment method, 
click the Adjust Charges button. The Adjust Charges pop-up 
window is displayed with the charges defaulted on the payment 
methods, if applicable. You can view the pending amount, total 
amount, and payment methods. For each payment method, you 
can view the charged amount, as also the total amount to be 
charged for an order. Modify the charges and click the Apply 
button. Based on the changes made, the charges on the payment 
methods are adjusted accordingly.

To remove a payment method that is yet to be processed, click 
the Remove button. If a payment method has already been 
processed, the Revoke button is displayed instead of the Remove 
button. You can click the Revoke button to suspend any further 
transactions to be performed on the payment method. 
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The Show Payment Transaction hyperlink is displayed if the 
payment method has already been processed. The Payment 
Transactions panel displays the date of the transaction, type of 
transaction, amount that is authorized, collected, or pending 
authorization, status of the transaction and error messages, if 
any, pertaining to the transaction.

2. If the customer wants to add a new payment method, click the Add 
Payment Method hyperlink in the enhanced Change Payment Methods 
screen. The Add Payment Method pop-up window is displayed. After a 
payment method is added, the Adjust Charges pop-up window is 
displayed with the charges adjusted on payment methods, if 
applicable. For more information about adding new payments, see 
Section 2.7.4.1, "Adding New Payment Methods".

3. In the Notes panel, enter any additional information, if applicable.

4. Click Confirm.

2.7.4.1 Adding New Payment Methods
A customer may need to add a new payment method for an order. To add 
a new payment method, you need to first search for the order. For more 
information about searching for an order, see Section 2.1.1, "Searching 
for an Order".

To add a new payment method:

1. Do one of the following to open the Add Payment Method screen:

From the Payment Method screen, select Add Payment Method.

From the Confirm Payment screen of any task, click Add Payment 
Method.

Note: If a payment method is revoked, click the Restore 
button to enable further transactions on the payment 
method.

Note: If the total amount to be charged is not equal to or 
is less than the order total, an error message is displayed, 
indicating that there is a pending amount on the order.



Performing Other Tasks on an Order

Tasks for a Customer Service Representative   175

2. The Add New Payment Method pop-up window is displayed. Enter the 
information in the applicable fields as described in Table 2–2 to 
Table 2–8.

Table 2–2 Payment Type, Check

Table 2–3 Payment Type, Credit Card

Table 2–4 Payment Type, Customer Account

Table 2–5 Payment Type, Other

Field Description

Check Account Number Enter the check account number.

Check Amount Enter the check amount.

Check Reference Enter the check reference number.

Field Description

Credit Card Type Select the type of credit card from the drop-down list.

Name on Card Enter the name of the credit card holder as displayed 
on the card.

Credit Card # Enter the credit card number.

Expiration Date Enter the date through which the credit card is valid.

Credit Card Bill To 
Address

Enter the bill to address for the credit card.

Contact Info Enter the contact information of the credit card holder.

Field Description

Customer Account # Enter the customer’s account number.

Field Description

Payment Reference1 Enter the payment reference information, if applicable.

Payment Reference2 Enter the payment reference information, if applicable.

Payment Reference3 Enter the payment reference information, if applicable.

Maximum Charge Limit Enter the maximum amount you can collect against 
this payment method.
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Table 2–6 Payment Type, Pre-Paid

Table 2–7 Payment Type, Refund Check

Table 2–8 Payment Type, Stored Value Card

3. If you use a credit card for payment, select Use Bill To Address if you 
want to use the same Bill To Address as the original order, or select 
Use Another Address and modify the Bill To Address and contact 
information of the customer.

4. Click Apply.

When adding payment methods to an order, if a payment method is 
defined as CREDIT CARD or OTHER payment method, you can save 
the payment method against the order and the customer record. The 
Max Charge Limit on the Credit Card or Other Payment Method is 
saved only against the order and not against the customer record. 

Field Description

Transaction # Enter the transaction number for the pre-paid 
payment type.

Register # Enter the register number, if applicable.

Tender Type Enter the tender type, if applicable.

Maximum Charge Limit Enter the maximum amount you can collect against 
this payment method.

Field Description

Check Account Number Enter the check account number.

Check Amount Enter the check amount.

Check Reference Enter the check reference number.

Field Description

SVC Card No Enter the Stored Value Card number.

Payment Reference1 Enter the payment reference information, if applicable.

Payment Reference2 Enter the payment reference information, if applicable.

Payment Reference3 Enter the payment reference information, if applicable.
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If a contact is defined on the order, the payment method is saved 
against the contact record. If a contact is not defined on the order, 
and if the Save Against Customer check box is selected, the payment 
method is saved against the customer record.

2.7.5 Viewing Payment Details
You can view payment details for a customer’s order such as charges, 
refunds, and payment methods. To view payment details for an order, 
you must first search for the order. For more information about searching 
for an order, see Section 2.1, "Performing Search Tasks".

To view payment details, from Tasks > Other Tasks, select View Payment 
Details. The Payment Inquiry screen is displayed. For more information 
about viewing payment details, see Section 2.2.2, "Why was I charged?".

2.7.6 Inquiring About Returns and Exchanges
Customers may call to ask questions regarding returns, exchanges, and 
refunds for an order. To provide answers to the customer, you must first 
search for the order. For more information about searching for an order, 
see Section 2.1, "Performing Search Tasks".

1. Do one of the following to open the Return/Exchange Details screen:

From Tasks > Frequent Queries, select Have you received my 
returns?

From Tasks > Frequent Queries, select Where are my exchange 
items?

From Tasks > Frequent Queries, select Why wasn’t I refunded?

From Tasks > Frequent Queries, select How much will I be 
refunded?

From Tasks > Other Tasks, select View Return/Exchange Details.

In the Return/Exchange Details panel, you can view the total return 
value, total exchange value, total refund amount, amount refunded, 
and pending refund.

Note: You cannot view the payment details of the order, if 
the order is on hold and the message "No payment details 
have been recorded" is displayed.
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You can view details about the return items such as the item ID and 
description, item quantity, unit price, status, return reason, and 
whether or not the customer can keep the shipped item.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

If the order has exchange items, you can view details about the 
exchange items such as the item ID and description, item quantity, 
unit price, the expected shipment date (ESD), and the fulfillment 
option.

To view more information about an exchange order, click on the View 
Exchange Summary hyperlink. The Order Summary screen for the 
exchange order is displayed. For more information about viewing the 
order summary screen, see Section 2.1.4, "Viewing Order Summary".

2. To see the breakup of totals, click the View/Change Charge Details 
hyperlink corresponding to the total return values or the total 
exchange values. For more information about viewing charge details, 
see Section 2.3.11, "Adding or Modifying Charges".

3. Click the View Details hyperlink corresponding to the amount 
refunded. The Refund Details screen is displayed where you can view 
the refund amount, amount applied to an exchange (if available), and 
the total return value processed.

4. Click Close.

2.7.7 Reconfiguring Items
Sterling Call Center and Sterling Store provides rich functionality to 
reconfigure bundle items. For example, if the customer has ordered for a 
computer and wants to change the configuration of the processor, this 
task enables you to change the necessary configurations. To change the 
configuration of an item, you must first search for the order. For more 
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information about searching for an order, see Section 2.1, "Performing 
Search Tasks".

1. From Tasks > Other Tasks, select Reconfigure Items. The Reconfigure 
Items screen is displayed.

2. In the Configure Order Lines panel, you can view the details of the 
item such as the item ID, description, bundle unit price, ordered 
quantity, status. Click the Reconfigure link in the Reconfigure column. 
The Reconfigure screen is displayed.

3. Click Next. The Change Fulfillment Options screen is displayed. For 
more information about changing the fulfillment options, see 
Section 2.5.1, "Modifying Fulfillment Options".

4. Click Next. 

If any order lines are being delivered and the newly added lines 
require a new appointment or an existing appointment needs to 
be retaken, the Service Appointment screen is displayed. For 
more information about creating or modifying an appointment, 
see Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

If there are no order lines to be delivered, the Payment 
Confirmation screen is displayed. For more information about 
viewing and confirming the payment details, see Section 2.3.8, 
"Viewing and Confirming the Payment Details".

If you are not required to enter the payment information, the 
Order Summary screen is displayed.

Note: If the items on the order are not configurable, the 
message "There are no lines on this order which can be 
configured" is displayed.
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2.8 Performing Customer Tasks
This section explains how to perform the following customer tasks:

Creating a Consumer Customer

Creating a Business Customer

Managing Customer Contacts

Resetting a User’s Password

Managing Business Customer Information

Managing Customer Addresses

Managing Customer Payment Method

Assigning Customer to a Team

Customer User Assignments

Customer Self Assignments

Viewing Account Activity

Viewing and Adding Customer Notes and Contact Notes

2.8.1 Creating a Consumer Customer
Sterling Call Center and Sterling Store provides the functionality to 
create, manage, and view consumer customers.

To create a consumer customer:

1. From the Quick Access screen, navigate to Tasks > Customer, and 
select Create Consumer. 

The Create Consumer screen is displayed.

2. In the Customer Account panel, enter the customer’s first name, 
middle initial, last name, e-mail address, job title, and department.

Note: If the user has access to multiple enterprises, and 
the enterprises are associated to more than one Customer 
Master Organization, the Select Enterprise pop-up window 
is displayed. Select an enterprise from the drop-down list, 
and click the Confirm button.
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3. In the Web User panel, you have the option to create a web user by 
entering a login ID and locale for the customer. When you add 
information in these fields, a web user is created for this customer, 
and an e-mail containing the web user’s password is sent to the 
customer. 

4. In the Customer Contact Information panel, enter the customer's 
evening phone number, evening fax number, day phone number, day 
fax number, and mobile phone number.

5. In the Personal Information panel, provide the customer’s date of 
birth, spouse’s date of birth, and wedding anniversary date. To select 
a date, click the  icon and then select the month, year and day.

6. In the Ship To Address panel, enter the address to where the orders 
for this customer will be sent. In the Display Address As field, enter a 
description for the address. This helps you to easily identify the 
address the customer is referring to when you are performing various 
address-related tasks.

7. If the Bill To Address of the customer is the same as the Ship To 
Address, select the Use Ship To Address check box. Alternatively, 
enter the address of the customer to whom the order is billed to.

Note: If you enter a login ID, you must also enter a locale 
and e-mail address. The login ID cannot be changed after 
it has been entered and saved.

Note: If the login ID entered is unique across the entire 
Sterling Call Center and Sterling Store application, the 
same login ID is also used for the web user. If the login ID 
entered is unique to only the customer enterprise, the web 
user’s login ID has an underscore and the enterprise 
organization’s suffix appended to the login ID entered.

Note: Based on the configuration, the City and State 
fields may be populated depending on the information 
provided in the Country or Region and Postal Code fields.
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8. Click Next. The Add Payment Method screen is displayed based on the 
configuration.

To add a payment method, click the Add Payment Method hyperlink. 
In the Add New Payment Method pop-up window, select a payment 
method from the drop-down list, enter the applicable payment 
information, and click the Apply button. To add additional payment 
methods, click the Add Payment Method hyperlink again. To specify a 
default payment method, select the Default Payment Method check 
box in the applicable Payment Method panel.

9. Click the Confirm button to save the changes. The Consumer Details 
screen of the newly created consumer customer is displayed. 

For information about viewing customer details, see Section 2.1.2.2, 
"Viewing Customer Details". For information about modifying a consumer 
customer, see Section 2.8.3.1, "Modify a Consumer Customer Contact".

2.8.2 Creating a Business Customer
Sterling Call Center and Sterling Store provides the functionality to 
create, manage, and view business customers.

To create a business customer:

1. From the Quick Access screen, navigate to Tasks > Customer, and 
select Create Business Customer. 

Note: If payment methods do not need to be entered for 
the customer, proceed to step 9.

Note: When a consumer customer is created, the status 
of the consumer customer is automatically set to Active.

Note: If the user has access to multiple enterprises, and 
the enterprises are associated to more than one Customer 
Master Organization, the Select Enterprise pop-up window 
is displayed. Select an enterprise from the drop-down list, 
and click the Confirm button.
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The Customer Entry screen is displayed.

2. In the Buyer Organization panel, enter the customer ID, business 
name, Web site, default currency, shipping preferences, and tax 
exemption code, if tax exempt is selected.

In addition, enter the following business customer classifications:

Dunn/Bradstreet #

Relationship type

Customer level

Vertical

3. In the Parent Customer panel, search for an existing business 
customer to associate to the new customer, if applicable. To search 
for an existing customer:

a. Click the Search button. The Parent Customer Search screen is 
displayed. 

b. Enter the appropriate search criteria and click the Search button 
again. The search results are displayed in the Customer Search 
Results panel. 

c. Select the appropriate parent customer, and click the Apply 
button. The name of the selected parent is displayed in the Parent 
Customer panel of the Customer Entry screen.

4. In the Ship To Address panel, enter the address to where orders for 
this customer should be sent. In the Display Address As field, enter a 
description for the address. This helps you to easily identify the 
address the customer is referring to when you are performing various 
address-related tasks. 

Note: Customer ID cannot be changed after it has been 
entered and saved.

Note: Based on the configuration, the City and State 
fields may be populated depending on the information 
provided in the Country or Region and Postal Code fields.
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5. If the Bill To Address of the customer is the same as the Ship To 
Address, select the Use Ship To Address check box. Alternatively, 
enter the address of the customer to whom the order is billed.

6. If the Sold To Address of the customer is the same as the Ship To 
Address, select the Use Ship To Address check box. Alternatively, 
enter the address of the customer to whom the order is sold.

7. In the Contact Info panel, enter the phone number, alternative phone 
number, and e-mail address of the contact.

8. Click the Next button. The Contact Entry screen is displayed, in which 
you can enter customer contact information.

9. In the Customer Account panel to the left of the screen, enter the 
customer contact’s first name, middle initial, last name, e-mail 
address, job title, and department.

10. In the Customer Account panel to the right of the screen, you have 
the option to create a web user by entering a login ID and locale for 
the customer contact. When you add information in these fields, a 
web user is created for the customer, and an e-mail containing the 
web user’s password is sent to the customer. In addition, you can 
select the user roles that you want to assign to this web user. 

11. In the Customer Contact Information panel, enter the customer 
contact’s evening phone number, evening fax number, day fax 
number, and mobile phone number.

12. In the Ship To Address panel, enter the address to where the orders 
for this customer should be sent. In the Display Address As field, 

Note: If you enter a login ID, you must also enter a locale 
and e-mail address. Login cannot be changed after it has 
been entered and saved.

Note: If the login ID entered is unique across the entire 
Sterling Call Center and Sterling Store application, the 
same login ID is also used for the web user. If the login ID 
entered is unique to only the customer enterprise, the web 
user’s login ID has an underscore and the enterprise 
organization’s suffix appended to the login ID entered.
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enter a description for the address. This helps you to easily identify 
the address the customer is referring to when you are performing 
various address-related tasks. 

13. If the Bill To Address of the customer contact is the same as the Ship 
To Address, select the Use Ship To Address check box. If the Bill To 
Address is not the same as the Ship To Address, enter the 
appropriate Bill To Address details.

14. If the Sold To Address of the customer contact is the same as the 
Ship To Address, select the Use Ship To Address check box. If the 
Sold To Address is not the same as the Ship To Address, enter the 
appropriate Sold To Address details.

15. Click the Next button. The Payment Entry screen is displayed based 
on the configuration.

To add a payment method, click the Add Payment Method hyperlink. 
In the Add New Payment Method pop-up window, select a payment 
method from the drop-down list, enter the applicable payment 
information, and click the Apply button. To add additional payment 
methods, click the Add Payment Method hyperlink again. To specify a 
default payment method, select the Default Payment Method check 
box in the applicable Payment Method panel. For more information 
about adding payment methods, see Section 2.7.4.1, "Adding New 
Payment Methods".

16. Click the Confirm button to save the changes. The Business Customer 
Details screen is displayed. 

Note: Based on the configuration, the City and State 
fields may be populated depending on the information 
provided in the Country or Region and Postal Code fields.

Note: If payment methods do not need to be entered for 
the customer, proceed to step 16.

Note: When a business customer is created, the status of 
the business customer is automatically set to Active.
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For information about viewing customer details, see Section 2.1.2.2, 
"Viewing Customer Details". For information about managing contacts, 
see Section 2.8.3.2, "Manage Business Customer Contacts". For 
information about managing business customer information, see 
Section 2.8.5, "Managing Business Customer Information".

2.8.2.1 Creating Business Customer Contacts
Sterling Call Center and Sterling Store provides the functionality to 
create business customer contacts. You can access this feature from the 
Business Customer Details screen and all business customer-related 
screens.

To create a business customer contact:

1. From the Business Customer Details screen or any business 
customer-related screen, navigate to Tasks > Customer, and select 
Create Customer Contact. The Create Customer Contact screen is 
displayed.

2. In the Customer Account panel, enter the contact’s first name, middle 
initial, last name, e-mail address, job title, and department.

3. In the Customer Contact Information panel, enter the contact’s 
evening phone number, evening fax number, day phone number, day 
fax number, and mobile phone number. 

4. In the Personal Information panel, select the contact's date of birth, 
spouse's date of birth, and their wedding anniversary date. To select 
a date, click the  icon and then select the month, year, and day.

5. In the Contact Spending Limit panel, select a currency from the 
drop-down list, and specify a spending limit. A spending limit 
prevents an order from being processed if the contact’s order is over 
a specified amount. In addition, specify an approving user and a 
backup approver. An approving user can approve an order for a 
contact who has exceeded a spending limit. A backup approver can 
approve orders for the contact if the contact is unavailable.

Note: After a contact is created, if the customer 
associated to that contact has an editor open, the editor 
will be closed and the customer details screen will be 
reopened so that the update is immediately visible.
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6. In the Web User panel, you have the option to create a web user by 
entering a login ID, locale, and status for the contact. When you 
include information in these fields, the contact is linked to this web 
user, and an e-mail containing the web user’s password is sent to the 
customer. In addition, you can select the user roles that you want to 
assign to this web user. 

7. Click the Confirm button. The Contact Details screen of the newly 
created contact is displayed.

2.8.3 Managing Customer Contacts
Sterling Call Center and Sterling Store provides the functionality to 
manage customer contacts.

2.8.3.1 Modify a Consumer Customer Contact
To modify a consumer customer contact:

Note: If you enter information in the Login field, you 
must also enter a locale and e-mail address. Login cannot 
be changed after it has been entered and saved.

Note: If the login ID entered is unique across the entire 
Sterling Call Center and Sterling Store application, the 
same login ID is also used for the web user. If the login ID 
entered is unique to only the customer enterprise, the web 
user’s login ID has an underscore and the enterprise 
organization’s suffix appended to the login ID entered.

Note: You can view and add contact notes by clicking the 
View/Add Notes hyperlink in the Important Notes panel of 
the Contact Details screen.

Note: You can view and add contact notes by clicking the 
View/Add Notes hyperlink in the Contact Details screen.
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1. From the Consumer Details screen, navigate to Tasks > Customer, 
and select Manage Contact Information. The Manage Contact 
Information screen is displayed.

In the Customer Account panel, you can modify the customer’s 
first name, middle initial, last name, e-mail address, job title, and 
department.

In the Web User panel, you can modify the customer’s locale and 
status.

In the Customer Contact Information panel, you can modify the 
customer’s evening phone number, evening fax number, day 
phone number, day fax number, and mobile phone number.

In the Personal Information panel, you can modify the customer’s 
date of birth, spouse’s date of birth, and wedding anniversary. To 
select a date, click the  icon and then select the month, year, 
and day.

2. Click the Confirm button to save the changes.

2.8.3.2 Manage Business Customer Contacts
You can create additional business customer contacts, as well as modify 
and delete existing business customer contacts. You can access these 
tasks from the Business Customer Details screen and all the business 
customer-related screens. 

When you select a contact and click the View Contact Details hyperlink in 
the Business Customer Details screen, the Contact Details screen 
pertaining to the selected contact is displayed.

Note: The Login field is disabled if a login ID was 
previously provided. For additional information about login 
IDs, see Section 2.8.1, "Creating a Consumer Customer".

Note: After a contact is created, if the customer 
associated to that contact has an editor open, the editor 
will be closed and the customer details screen will be 
reopened so that the update is immediately visible.
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Create a Contact

To create a new business customer contact, navigate to Tasks > 
Customer, and select Create Customer Contact from either the Business 
Customer Details screen or the Contact Details screen of a business 
customer contact. For details about how to create a new contact, see 
Section 2.8.2.1, "Creating Business Customer Contacts".

Modify a Contact

To modify a business customer contact:

1. From the Business Customer Details screen, select the contact you 
want to modify and click the View Contact Details hyperlink. The 
Contact Details screen for that contact is displayed. 

2. Navigate to Tasks > Customer, and select Manage Customer Contact. 
The Manage Customer Contact screen is displayed. 

In the Customer Account panel, you can modify the contact’s first 
name, middle initial, last name, e-mail address, job title, and 
department.

In the Customer Contact Information panel, you can modify the 
contact’s evening phone number, evening fax number, day phone 
number, day fax number, and mobile phone number.

In the Personal Information panel, you can modify the contact’s 
date of birth, spouse’s date of birth, and wedding anniversary. To 
select a date, click the  icon and then select the month, year, 
and day.

In the Contact Spending Limit panel, you can modify the currency, 
spending limit, approving user, and backup approver. A spending 
limit prevents an order from being processed if the contact’s order 
is over a specified amount. An approving user can approve an 
order for a contact who has exceeded a spending limit. A backup 
approver can approve orders for the contact if the contact is 
unavailable.

In the Web User panel, you can modify the contact’s locale, 
status, and user roles.

Note: The Login field is disabled if a login ID was 
previously provided. For additional information about login 
IDs, see Section 2.8.2, "Creating a Business Customer".
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3. Click the Confirm button to save the changes.

Delete a Contact

To delete a contact:

1. From the Business Customer Details screen, select the contact that 
you want to delete, and click the View Contact Details hyperlink. The 
Contact Details screen for that contact is displayed.

2. Navigate to Tasks > Customer, and select Delete Customer Contact. 
The Contact Deletion pop-up window is displayed, prompting you to 
confirm the deletion.

3. Click the Yes button to confirm the deletion. The corresponding 
contact is removed from the Business Customer Details screen.

Modify a Contact’s Addresses

You can modify a contact’s addresses from the Business Customer Details 
screen and all business customer-related screens. To modify a contact’s 
addresses, navigate to Tasks > Customer, and select Manage Customer 
Addresses. The Manage Customer Addresses screen is displayed. For 
additional information about managing customer addresses, see 
Section 2.8.6, "Managing Customer Addresses".

Modify a Contact’s Payment Methods

You can modify a contact’s payment methods from the Business 
Customer Details screen and all business customer-related screens. To 
modify a contact’s payment methods, navigate to Tasks > Customer, and 
select Manage Customer Payment Methods. For additional information 
about managing payment methods, see Section 2.8.7, "Managing 
Customer Payment Method".

2.8.4 Resetting a User’s Password
A customer may call the Sterling Call Center and Sterling Store because 
the customer forgot the password for logging into the retailer’s Web site. 
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Sterling Call Center and Sterling Store provides the functionality to reset 
a user’s password.

For a consumer customer, you can access this feature from the Consumer 
Details screen. For a business customer contact, you can access this 
feature from the Contact Details screen.

To reset a user’s password:

1. From the Quick Access screen, navigate to Tasks > Customer, and 
select Reset User Password. The Reset User Password pop-up window 
is displayed, prompting you to confirm that the user wants to have 
the password reset.

2. Click either the Confirm button to reset the password, or the Cancel 
button to cancel the reset password action. 

If you click the Confirm button, a new password is automatically 
generated, and an e-mail is sent to the user. The e-mail contains the 
following information:

A link to the Web site that contains a reference for the user to 
reset the password. Using this link, the user can immediately 
reset the password.

A request stating that the user should change the password the 
next time the user logs in to the Web site. 

2.8.5 Managing Business Customer Information
Sterling Call Center and Sterling Store provides the functionality to 
manage business customer information. You can access this feature from 
the Business Customer Details screen. 

To manage business customer information:

Note: This functionality is available only if a login ID was 
previously entered for the consumer customer or business 
customer contact, resulting in a Web user being created for 
the corresponding consumer customer or business 
customer contact.
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1. From the Business Customer Details screen, navigate to Tasks > 
Customer, and select Manage Customer Information. The Manage 
Customer Information screen is displayed.

2. In the Buyer Organization panel, you can modify the business name, 
Web site, status, shipping preferences, and tax information.

In addition, you can modify the following business customer 
classifications:

Dunn/Bradstreet #

Relationship type

Customer level

Vertical

3. In the Parent Customer panel, you can change the parent customer, 
as follows:

a. Click the Search button. The Parent Customer Search screen is 
displayed. 

b. Enter the appropriate search criteria and click the Search button 
again. The search results are displayed in the Customer Search 
Results panel. 

c. Select the appropriate parent customer and click the Apply 
button. The parent customer’s name is displayed in the Parent 
Customer panel of the Manage Customer Information screen.

4. In the Customer Currencies panel, you can modify the selected 
currencies. To select a default currency, select a currency check box 
and then select a currency from the Default Currency drop-down list.

5. Click the Confirm button to save your changes.

2.8.6 Managing Customer Addresses
You can define multiple addresses for each customer. To manage 
customer addresses, you must first search for a customer. For more 
information about searching for a customer, see Section 2.1.2, 
"Searching for a Customer". Double click the appropriate customer 
record or contact record. The details screen for the applicable consumer 
customer, business customer, or business customer contact is displayed.
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1. From Tasks > Customer, select Manage Customer Addresses. The 
Manage Customer Addresses screen is displayed.

If an address description has been provided, the address description 
is displayed in the corresponding address panels within the Customer 
Addresses panel. For more information about entering an address 
description, see Section 2.3.2.3, "Adding or Modifying Addresses".

2. To modify an address, click the Modify Address hyperlink in the 
corresponding Customer Address panel. The Modify Address pop-up 
window is displayed. Modify the information as applicable, and click 
Apply.

3. To select an address as the default bill to address, select the Default 
Bill To Address check box.

4. To select an address as the default ship to address, select the Default 
Ship To Address check box.

5. To select an address as the default sold to address, select the Default 
Sold To Address check box.

6. To delete an address, click the Delete hyperlink in the corresponding 
Customer Address panel. The Confirm Address Deletion pop-up 
window is displayed. Click OK to confirm the deletion. The applicable 
address panel is removed from the Manage Customer Addresses 
screen.

7. To add a new address, click the Add Address hyperlink. The Add New 
Customer Address pop-up window is displayed. Enter the appropriate 
information and click Apply.

8. Click Confirm to save the changes and return to the details screen of 
the applicable consumer customer, business customer, or business 
customer contact.

2.8.7 Managing Customer Payment Method
You can define multiple payment methods for a customer, based on the 
configuration. To manage customer payment methods, you must first 
search for a customer. For more information about searching for a 
customer, see Section 2.1.2, "Searching for a Customer". Double click 
the appropriate customer record or contact record. The details screen for 
the applicable consumer customer, business customer, or business 
customer contact is displayed.
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1. From Tasks > Customer Tasks, select Manage Customer Payment 
Methods. The Manage Customer Payment Methods screen is 
displayed.

2. You can view all the payment methods that exist for the customer.

3. To delete a payment method, click the Delete hyperlink.

4. To modify the attributes of a payment method, click the Modify 
hyperlink. The Modify Payment Method pop-up window is displayed. 

You can modify all attributes of a customer payment method, except 
the following:

For the Credit Card payment method, you cannot modify the 
Credit Card #.

For the Customer Account payment method, you cannot modify 
the Account #.

For other payment methods, you cannot modify any attribute that 
has a unique identifier.

5. To add a new payment method, click the Add Payment Method 
hyperlink. The Add New Payment Method pop-up window is displayed. 
For more information about adding a new payment method, see 
Section 2.7.4.1, "Adding New Payment Methods".

6. Click Confirm to save the changes and return to the details screen of 
the applicable consumer customer, business customer, or business 
customer contact.

2.8.8 Assigning Customer to a Team
Sterling Call Center and Sterling Store enables you to assign customers 
to a team after the customer is created. A supervisor can assign a 
customer from his team to any of his sub teams. To assign a customer to 
a team, you must first search for a customer. For more information about 
searching for a customer, see Section 2.1.2, "Searching for a Customer".

Note: On customer accounts, the currencies displayed are 
the currencies that are defined for the enterprise to which 
the customer belongs.
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1. From Tasks > Customer, select Assign Customer To Team. The  
Manage Team Assignments screen is displayed.

2. In the Assigned Teams panel, you can view the customer ID and 
organization.

3. In the Available Teams panel, you can view the list of teams assigned 
to the supervisor.

4. In the Assigned Teams panel, you can view the list of teams currently 
assigned to the customer.

5. Click the arrow buttons to move the teams from one panel to the 
other. You can also drag a team from one panel and drop it into the 
other panel.

2.8.9 Customer User Assignments
Sterling Call Center and Sterling Store enables you to assign customers 
to a user after the customer is created. A supervisor can assign a 
customer from his team to any of the users in his team. 

To assign a customer to a user:

1. From Tasks > Customer, select Customer User Assignments. The  
Manage User Assignments screen is displayed.

2. In the User Search Criteria panel, enter the appropriate search 
criteria and click Search. The search results are displayed in the User 
List panel. Select the appropriate user and click Next.

3. In the Available Customers panel, you can search for a customer. 
Enter the appropriate search criteria and click Search.

4. In the Selected User panel, you can view the details of the selected 
user such as the user name, first name and last name.

5. In the Available Customers panel, you can view the list of customers 
assigned to the supervisor.

6. In the Assigned Customers panel, you can view the list of customers 
currently assigned to the user.

Note: This task is permission controlled and is displayed 
only if the user has permissions to access the customer 
record.



196   User Guide

Performing Customer Tasks

7. Click the arrow buttons to move the customers from one panel to the 
other.

2.8.10 Customer Self Assignments
Sterling Call Center and Sterling Store enables you to assign customers 
to a user, once the customer is created. A user can assign a customer to 
himself only if the user is assigned permissions to access the customer 
record.

To assign a customer to a user:

1. From Tasks > Customer, select Customer Self Assignments. The 
Manage Subscriptions screen is displayed.

2. In the Available Customers panel, you can search for a customer. 
Enter the appropriate search criteria and click Search.

3. In the Available Customers panel, you can view the list of available 
customers.

4. In the Assigned Customers panel, you can view the list of customers 
currently assigned to the user.

5. Click the arrow buttons to move the customers from one panel to the 
other. You can also drag a customer from one panel and drop it into 
the other panel.

2.8.11 Viewing Account Activity
Sterling Call Center and Sterling Store provides the functionality to view 
the Sterling Multi-Channel Selling Solution’s Account Activity.

Note: This task is permission controlled and is displayed 
only if the user has permissions to access the customer 
record.

Note: This task is permission controlled and is displayed 
only if the user has permissions to access the customer 
record.
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To view the Sterling Multi-Channel Selling Solution’s Account Activity, 
from Tasks > Other Tasks, select View Account Activity. The Sterling 
Multi-Channel Selling Solution’s Account Activity screen is displayed. 

This screen provides access to the Sterling Multi-Channel Selling 
Solution’s CSR work space. From here, the user can access the Activity, 
Quotes, Wish Lists, and Registries tasks. The user can modify carts and 
quotes through the Sterling Multi-Channel Selling Solution before the 
order is placed.

The Wish Lists and Registries tasks allow the user to create, modify and 
view wish lists and registries for the customer they are working with. The 
user can also place order for the items on the customer's lists or other 
customer's public wish lists or registries. For more information about 
account activity, see the Sterling Multi-Channel Selling Solution 
Administration Guide.

2.8.12 Viewing and Adding Customer Notes and Contact 
Notes

Sterling Call Center and Sterling Store provides the functionality to enter 
additional notes about a customer or contact. For example, you may 
want to add a note stating that a customer can be contacted only on 
Tuesdays and Thursdays.

To view the notes pertaining to a customer or contact:

1. In the details screen of the customer or contact, click the View/Add 
Notes hyperlink in the Important Notes panel. The Customer Notes 
screen for a customer displays all the notes associated with the 
customer. The Customer Notes screen for a contact displays all the 
notes associated with the contact.

2. From the Filter by Note Type drop-down list, select a note type to 
view the notes pertaining to that note type.

3. From the Filter by Contact Method drop-down list, select a contact 
method to view notes pertaining to that contact method. For 

Note: A user can launch the Sterling Multi-Channel 
Selling Solution’s Account Activity only if the user belongs 
to a user group that has the permissions to launch the 
Order Selling Account Activity screen.
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example, to view notes related to a customer’s call, select Phone as 
the contact method. 

4. In the Include panel:

Select the Lower Priority Notes check box to include lower priority 
notes.

Select the Include Internal Notes check box to include notes 
marked for internal viewing only.

Select the System check box to view system-generated notes.

Select the User check box to view notes that were entered 
manually.

5. By default, the notes are truncated and displayed. 

Click the Expand All Notes hyperlink to expand all the notes 
displayed in the Customer Notes screen.

Click the Expand hyperlink next to a truncated note to expand 
that note.

To add a note pertaining to a customer or contact:

1. From the Type drop-down list in the Customer Notes screen, select 
the appropriate note type, if applicable.

2. From the Contact Method drop-down list, select the appropriate 
contact method, if applicable.

3. Select the Mark Priority As High check box if the note is of high 
priority.

4. Select the For Internal User Only check box to mark the note for 
internal viewing only.

5. Enter Contact Details, such as the e-mail address or the telephone 
number of the customer.

6. Enter the text of the note in the space provided.

7. Click the Add Note button. The note is added and saved against the 
customer or contact.

8. Click the Close button.
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2.9 Performing User Management Tasks
This section explains how to perform the following user management 
tasks:

Managing Users

A user is an employee of the enterprise organization who can log in to 
the Sterling applications.

Managing User Teams

A user team is a collection of users who have common data and user 
interface access requirements. User teams can have access to specific 
document types, enterprises, ship nodes, customers, and screens 
within the user interfaces.

2.9.1 Changing Passwords
You can change your password in this screen.

To change your password:

1. From Tasks > User Security, select Change Password. The Change 
Password screen is displayed.

2. In Old Password, enter your old password.

3. In New Password, enter a new password.

4. In Confirm Password, enter your new password again for 
confirmation.

5. Click Confirm.

2.9.2 Managing Users
Sterling Call Center and Sterling Store enables the CSR to create and 
manage users. For example, a CSR lead may need to create an additional 
CSR user within the organization.

Note: Passwords are case sensitive, and can be any 
combination of printable characters.
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2.9.2.1 Creating a User
With the required privileges, you can create users for any organization 
for which you have access.

To create a user:

1. From the Quick Access screen, navigate to Tasks > User 
Management, and select Create User. The User Entry screen is 
displayed.

2. Provide the following information in the Primary User Information 
panel:

From the Organization drop-down list, select the Organization to 
which you want to assign the user.

In the Login field, enter the User ID that the user uses to access 
the system.

From the Department drop-down list, select the department 
within the organization to which the user is assigned.

In the Name field, enter the user’s name.

In the E-mail Address field, enter the user’s e-mail address.

From the Theme drop-down list, select a theme.

The theme determines the color scheme of the Sterling 
applications for that user. The available themes are Earth, Ice, 
Jade, and Sapphire.

From the Menu Group drop-down list, select the menu group 
representing the menu options you want this user to see when 
logging in to the Sterling Call Center and Sterling Store Consoles. 

From the Locale drop-down list, select the locale in which the user 
is located.

Note: A user who is configured for the Eastern Time Zone 
but logs in while physically in the Pacific Time Zone, sees 
locale-specific information pertaining to the Eastern Time 
Zone.
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From the Team drop-down list, select the team to which you want 
to assign the user. 

Select the Active check box if the user is currently active in the 
organization. Inactive users cannot log in.

Select the Supervisor check box if the user is a personnel 
supervisor. A supervisor can access all customers associated to his 
team.

In the Customer Limit field, enter the maximum number of 
customers that this user can be assigned to manage. If zero is 
entered, the user can be assigned to an infinite number of 
customers.

3. In the Contact Address panel, click the Modify Address hyperlink to 
add a contact address. In the Modify Address pop-up window, enter 
the user’s contact address, and click the Apply button to save the 
information. 

4. In the Bill To Address panel, click the Modify Address hyperlink to add 
a bill to address. In the Modify Address pop-up window, enter the 
user’s bill to address, and click the Apply button to save the 
information.

5. In the User Roles panel, select the user roles to which you want to 
assign this user. The user roles define the permissions that the user 
will have when accessing any of the Sterling applications.

6. Click the Next button to save the changes. The Queue Subscriptions 
screen is displayed.

7. The Queue Subscriptions screen enables you to subscribe users to 
queues so that the users will receive alerts.

The left panel lists the available queues, and the right panel lists the 
queues to which the user is subscribed. If you are creating a new 
user, the right panel will be empty. To assign a new queue or 

Note: The list contains all the teams configured for the 
organization to which the user belongs, and the parent 
organization, if applicable. In addition, it contains the 
teams configured for the user’s customer master 
organization.



202   User Guide

Performing User Management Tasks

additional queues to the user, select the queue in the left panel, click 
the Assign button, and the queue name moves to the Assigned 
Queues panel.

8. Click the Confirm button. The user is created.

2.9.2.2 Modifying a User
To modify an existing user’s information, search for the user whose 
information you want to update, and modify the user’s information in the 
Modify User screens.

To modify a user:

1. From the Quick Access screen, navigate to Tasks > User 
Management, and select Modify User. The User Search screen is 
displayed.

2. Search for the user whose information you want to modify: 

In the User Search Criteria panel, enter the applicable search criteria 
and click the Search button. If only one result is returned, the 
information for that user is automatically displayed. If more than one 
result is returned, the search results are displayed in the User Search 
Results panel. From the User Search Results panel, select the user 
whose information you want to modify. The details of the user are 
displayed in the User Entry screen. 

3. Modify the user’s information.

4. Click the Next button. The Queue Subscriptions screen is displayed.

5. Modify the queues to which the user is subscribed, and click the 
Confirm button. 

2.9.3 Managing User Teams
Sterling Call Center and Sterling Store enables the CSR to create and 
manage user teams. 

Note: The Organization and Login fields are disabled. 
Changes cannot be made to these fields after the user has 
been created.
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A team is created so that specific CSR users can be assigned to a set of 
customers. This enables customers to maintain relationships with specific 
CSRs and receive better customer service. 

2.9.3.1 Creating a User Team
To create a user team:

1. From the Quick Access screen, navigate to Tasks > User 
Management, and select Create User Team. The Create User Team 
screen is displayed.

2. Provide the following information in the Team Information panel:

In the Team ID field, enter an identifier for the user team.

In the Description field, enter a brief description of the user team.

From the Parent Team drop-down list, select the parent team for 
this user team.

All the data security permissions that are defined by the parent 
team will be inherited by the user team, except for the customer 
access permissions, which you can define as described below.

From the Organization drop-down list, select the organization to 
which you want to assign the user team.

Select the appropriate Customer Access Mode: 

– If you select All Customers, the user team can view and 
manage all customers. Proceed to step 5.

– If you select Assigned Customers, you must assign customers 
to the user team, as described in step 3 and step 4.

– If you select User To Customer Assignment Required, you 
must assign customers to the team so that those customers 
can be assigned to users on that team in the future. When 
customers are assigned to users in the team, only those users 
and supervisors can access the customers’ data.

Note: The Organization field is displayed only if the user 
has access to more than one customer master 
organization.
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For information about how to assign customers to users, see 
Section 2.8.9, "Customer User Assignments" and 
Section 2.8.10, "Customer Self Assignments".

3. Search for customers in the Find Existing Customer panel, as follows:

a. Select a customer organization from the Customer Organization 
drop-down list to search for customers belonging to the selected 
customer organization.

b. Search for customers you want to assign to the user team. You 
can search by business customer or consumer customer. Enter the 
applicable search criteria and click the Search button. The results 
are displayed in the Customer Search Results panel.

4. Assign customers to the user team, as follows:

a. In the Customer Search Results panel, select a customer that you 
want to assign to the user team. 

b. In the Assigned Customers panel, select either Business 
Assignments or Consumer Assignments. 

c. Click the Assign button. The customer’s name will be moved to 
the Assigned Customers panel. 

To assign additional customers to the team, repeat this step.

5. Click the Confirm button to save your changes. 

2.9.3.2 Managing a User Team
To manage a user team, search for the team whose information you want 
to update, and modify the team’s information in the Team Management 
screen.

To manage a user team:

1. From the Quick Access screen, navigate to Tasks > User 
Management, and select Manage User Teams. The Manage User Team 
screen is displayed.

Note: The Customer Organization drop-down list is 
displayed only if the user has access to more than one 
customer master organization.



Performing User Management Tasks

Tasks for a Customer Service Representative   205

2. Search for the user team whose information you want to modify. 

In the Team Search Criteria panel, enter the applicable search criteria 
and click the Search button. 

If only one result is returned, the information for that user team is 
automatically displayed. If more than one result is returned, the 
search results are displayed in the Team ID panel. From the Team ID 
panel, select the name of the team whose information you want to 
modify. The information pertaining to that team is displayed.

3. You can make the following changes to the user team:

Modify the Description and Parent Team fields. 

Change the Customer Access Mode:

– If you change the Customer Access Mode to All Customers, 
the team will be able to view and manage all the customers 
and, therefore, the customer search and assignment panels 
will no longer be visible.

– If you change the Customer Access Mode to Assigned 
Customers, you can assign customers to the user team.

– If you change the Customer Access Mode to User To Customer 
Assignment Required, you can assign customers to the user 
team so that those customers can be assigned to users on 
that team in the future.

For information about how to assign customers to users, see 
Section 2.8.9, "Customer User Assignments" and 
Section 2.8.10, "Customer Self Assignments".

You may assign new customers to the user or remove customers 
from the Assigned Customers lists.

Note: The Organization field is displayed only if the user 
has access to more than one customer master 
organization.

Note: The Team ID field is disabled. Changes cannot be 
made to this field after the team has been created.
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4. Click the Confirm button to save your changes.

2.10 Performing Return Order Tasks
When a customer wants to return items, you can perform the following 
tasks to accomplish this:

Creating a Return Order

Adding a Return Reason

Adding Items to an Exchange

Viewing or Modifying Return and Exchange Fulfillment Options

Viewing or Modifying Fulfillment Summary

Viewing or Modifying the Payment Summary

Changing Return Address

Viewing or Modifying Service Fulfillment Summary

Issuing a Refund

Modifying Service Appointments

Reporting Extra Items

Reporting Wrong Items

Reporting Unexpected Items

Canceling a Return Order

Creating an Exchange Order

Changing Return Method

2.10.1 Creating a Return Order
You can create a return from single or multiple sales orders. Create the 
return order as follows:

1. Select Create Return from the Quick Access Task Panel. Click Confirm.

2. The four Return Order tabs that are displayed enable you to begin the 
return process in any of four ways:
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By Order - Either enter the Order Number or search for the order. 
(For information about searching for an order, see Section 2.1.1, 
"Searching for an Order".)

When you locate the order, it is displayed. Select the check boxes 
for the lines that are to be returned or select the Select All check 
box at the top of the screen. (You can also include lines from 
multiple orders on the same return.) When you click Next, the 
Return Reason screen is displayed. For more information on the 
Return Reason screen, see Section 2.10.2, "Adding a Return 
Reason".

By Tracking # (container) - Enter the Tracking Number of a 
container. The Order Lines are displayed for that container. Either 
select the check boxes for the lines that you want to return or 
select the Select All check box at the top of the screen.  You can 
also select the Return Specific Container hyperlink on this screen. 
This displays a list of all containers that contain items being 
returned. Click the Include in Return check box to return an entire 
container or several containers. Click Confirm.

By Items Without An Order - On entering the Item ID, the item 
is displayed as a line not associated with an order. When you click 
Next, the Return Reason screen is displayed.

By Extra Item - This tab is for orders that a customer received 
by mistake. On entering the Item ID, the item is displayed as a 
line that was received but not ordered. When you click Next, the 
Return Reason screen is displayed.

You can combine any of these methods to create a return order that 
includes lines from sales orders, lines without orders, and lines of 
extra items. You can also indicate whether the items are being 
returned by the customer who originally purchased it or by a gift 
recipient.

If you do not enter the correct Item ID, Order Number, or Tracking 
Number, an error message is displayed indicating that the Item 
Number, Order Number, or Tracking Number could not be found. For 
information about searching for an item, see Section 2.1.3, 
"Searching for an Item". For information about searching for an order, 
see Section 2.1.1, "Searching for an Order".
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2.10.2 Adding a Return Reason
The Return Reason screen displays the list of items you have designated 
for return. It enables you to review the return policy for each item, 
override the return policy (if applicable), and enter the return reason. 
You can use this screen as follows:

1. Review the items on the screen to determine whether these are the 
items that you want to return. Select the Remove Line hyperlink to 
delete an item on the return order.

2. Highlight each return line to view the return policy for that item. 

3. To override the return policy on an item, click the Override Return 
Policy button. If an item is not returnable, override the Return Policy 
to continue. The Override Return Policy text screen is displayed, 
enabling you to perform the following actions:

Select an icon that signifies the customer’s level of satisfaction.

Select a Contact Method (E-mail, Phone, or In Person) and enter 
Contact Details, such as the customer’s phone number.

Mark the priority of the note as High.

Enter text to describe the reason for the override.  

Click Confirm to close the Override Policy text screen.

4. From the Return Reason drop-down list, select the reason for 
returning the item. You must select return reason; otherwise, items 
cannot be returned.

5. In addition to the Return Reason, more options are displayed in the 
panel on the right:

Add Return Service - Click this hyperlink to display a pop-up 
listing available return services for the selected item. Select the 
service and click Add to Order. This adds the service line to the 
Return Reason screen. The service is displayed under the 
associated line with a Service icon.

Price Match This Item - If a customer indicates that this item is 
offered for a lower price by a competitor, click this hyperlink to 
enter a price match.

See Section 2.6.1, "Matching an Item’s Price" for more 
information about price matching an item.
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After performing the a price match, the wizard returns to the 
Return Reason screen.

The corresponding line or all related lines are deleted from the 
return order.

Create Appeasement - If a customer is dissatisfied with any 
aspect of the product or service, click this hyperlink to select an 
appropriate offer for appeasement. You can choose an 
appeasement for an item or for an entire order.

After performing the an appeasement, the wizard returns to the 
Return Reason screen.

The corresponding line or all related lines are deleted from the 
return order.

6. For a simple return without exchange, click Next to go to the 
Fulfillment/Return Summary. 

7. To exchange the return item for the same item, select the Include on 
exchange order check box. This automatically preselects the 
Exchange Order Required check box at the top of the screen. Click 
Next to go to the Add Items screen that has details for the same 
exchange item filled in. See Section 2.10.4, "Adding Items to an 
Exchange".

8. To exchange the return item for a different item, select the Exchange 
Order Required check box at the top of the screen. (The Include on 
exchange order check box on the side of the screen should not be 
selected.) Click Next to go to the Add Items screen or Customer 
Identification screen.
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2.10.3 Identifying a Customer
The Customer Identification screen is displayed only when the customer 
is not identified when a return is created. Typically, the customer for a 
return is the same as the original sales order customer. However, if you 
create a return for Items Without An Order or Extra Items, or if the items 
are being returned by a gift recipient, you should identify the customer 
before creating the return. In the Customer Identification screen, you 
can search for an existing customer and create a new Business customer 
or Consumer customer. 

To search for an existing customer:

1. Select the appropriate Customer Type.

2. Enter the required information pertaining to the customer and click 
Search.

3. The search results are displayed in the Customer Search Results 
panel. If you cannot find the customer you are searching for, click the 

 icon to display the search criteria again. Enter a more restrictive 
search criteria for the selected task and click Search.

4. Select the appropriate customer that you need from the Customer 
Search Results panel. The details pertaining to that customer are 
displayed in the Customer panel.

5. If the customer does not exist, create a new Business customer or 
Consumer customer. To create a Consumer customer, click Create 
Consumer. For more information about creating a Consumer 
customer, see Section 2.8.1, "Creating a Consumer Customer". 

Note: If a draft exchange order is already created for 
some items and if you try to add the same items to the 
draft exchange order by navigating back to the Return 
Reason screen, the newly added items will not be added to 
the exchange order.

You can add the same item to the exchange order as a 
new line or you can increase the quantity for the existing 
line.
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To create a Business customer, click Create Business. For more 
information about creating a Business customer, see Section 2.8.2, 
"Creating a Business Customer".

6. Click Next to go to the Add Items to Exchange screen or Exchange 
Fulfillment Options screen.

2.10.4 Adding Items to an Exchange
If you are performing an even exchange, the Add Items screen is 
displayed with the items automatically filled in. You can add more items 
to the exchange, if necessary.

If you are not performing an even exchange, you can add exchange 
items on this screen. In the Item column, enter the identifier of the item 
or item description, or choose the  to select an item from the Item 
List. You can also click the Add More Lines hyperlink. For more 
information about performing an advanced item search, see 
Section 2.1.3.4, "Performing an Advanced Item Search".

You can perform the following options on the Add Items screen:

Change the quantity on exchange lines.

Change the Unit of Measure (UOM) when performing an uneven 
exchange.

Override the price on the exchange line.

Select the fulfillment options for the exchange line.

Change the default exchange type, which defines how refunds are 
applied to the exchange.

After completing any modifications, click Next to go to the Exchange 
Fulfillment Options screen.

2.10.5 Viewing or Modifying Return and Exchange 
Fulfillment Options

The Exchange Fulfillment Options screen enables you to change the 
fulfillment method on the exchange order, including shipping/delivery 
addresses and pick up locations.

For more information about changing the fulfillment method, see 
Section 2.5.1, "Modifying Fulfillment Options".
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The customer information pertaining to the associated return order is 
filled in on the Exchange Fulfillment Options screen. 

If customer information is missing, click Next to display the Customer 
Information screen. For more information about performing customer 
searches, see Section 2.1.2, "Searching for a Customer".

2.10.6 Viewing or Modifying Fulfillment Summary
The Fulfillment Summary screen displays return and exchange lines 
grouped by fulfillment method and address. You can specify Shipping, 
Pick Up, and Delivery methods.

2.10.6.1 Return Fulfillment Method: Shipping Panel
You can view the return fulfillment summary for the "Shipping" fulfillment 
method.

1. In the Lines being shipped to panel, you can view the return items 
that are being shipped back.

2. You can view the details of the item such as the item ID, quantity and 
unit price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

3. In the Ship To items panel, you can view the return address to which 
the item will be shipped.

4. To change the fulfillment method to Pick Up, select the lines and click 
Change To Pick Up. The selected item is moved to the Return Pick Up 
Summary panel.
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5. Click Next. 

If any order lines are being delivered and the newly added lines 
require a new appointment or a changed appointment, the 
Change Service Appointment screen is displayed. For more 
information about creating or modifying an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

6. To allow the customer to keep an item, select the line and click the 
Customer Can Keep button. The selected item is moved to the Keep 
These Items panel.

2.10.6.2 Return Fulfillment Method: Pick Up Panel
You can view the return fulfillment summary for the "Pick Up" fulfillment 
method.

1. In the Lines being picked up from panel, you can view the return 
items that are being picked up.

2. You can view the details of the item such as the item ID, quantity and 
unit price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

Note: The Change to Pick Up button is displayed only if 
the item supports Pick Up return method.
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3. In the Pick up items from panel, you can view the address from which 
the items will be picked up.

4. To change the address from which the items are being picked up, 
select the lines and click the Change Address button. The Add a New 
Address pop-up window is displayed. Enter the appropriate details 
and click Confirm.

5. Click Next.

If any order lines are being delivered and the newly added lines 
require a new appointment or a changed appointment, the 
Change Service Appointment screen is displayed. For more 
information about creating or modifying an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

6. To change the fulfillment method to shipping, select the lines and 
click the Change To Shipping button. The selected item is moved to 
the Return Shipment Summary panel.

7. To allow the customer to keep the items, select the lines and click the 
Customer Can Keep button. The selected item is moved to the Keep 
These Items panel.

2.10.6.3 Keep These Items Panel
You can view the details of the items that the customer can keep.

1. In the Keep these items with our compliments panel, you can view 
the details of the items, such as the item ID, description, quantity, 
and unit price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.
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For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

2. Click Change To Shipping to ship the item back. The selected item is 
moved to the Return Shipment Summary panel.

3. Click Change To Pick Up for the item to be picked up. The selected 
item is moved to the Return Pick Up Summary panel.

If any order lines are being delivered and the newly added lines 
require a new appointment or a changed appointment, the 
Change Service Appointment screen is displayed. For more 
information about creating or modifying an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

2.10.6.4 Exchange Fulfillment Method—Shipping Panel
You can view the fulfillment summary for the "Shipping" fulfillment 
method.

The address to which the item is shipping is displayed in the header 
panel, if the fulfillment method is "Shipping".

The  icon indicates that the item is a gift and can be picked up or 
shipped to the gift recipient. For more information about setting up 
gift options, see Section 2.7.1, "Setting Up Gift Options".

The open box icon indicates that the item is an open-box item. For 
more information about open-box items, see Section 3.3.9, "Adding 
Open Box Items".

The item image displays an image of the actual item.

The item description and the item identifier display.

Note: The Change to Pick Up, Change to Shipping buttons 
are displayed only if the item supports Pick Up, Shipping 
return methods.
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The Quantity column displays the order line quantity.

The Unit Price column displays the item price for one unit.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

The Available column displays the latest date on which the product is 
available. If items are unavailable, the column is displayed in red, 
indicating unavailability.

The Level of Service column enables you to change the carrier service 
with cost from the drop-down list.

The expected delivery column displays the expected delivery dates of 
the items.

You can choose the following actions from the drop-down list: 

– Change to Pick Up

– Change to Delivery

– Cancel

Note: Whenever the carrier service is changed, the 
expected delivery date is updated to reflect the change.
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When the action is changed from Shipping to ’Change to Pick Up’, the 
screen returns to the Change Fulfillment Options screen and the 
system automatically checks the box against each modified order 
line. For more information about the fulfillment options, see 
Section 2.5.1, "Modifying Fulfillment Options".

Click the Gift Options button to modify the gift options for the 
selected items. You must check the box for the item for which you 
want to add or clear the gift information. For more information about 
gift options, see Section 2.7.1, "Setting Up Gift Options".

Click ’Go to the Change Fulfillment Options’ if you want to make 
changes to the fulfillment methods. For more information about 
changing fulfillment options, see Section 2.5.1, "Modifying Fulfillment 
Options".

Click Confirm or Next. All items in the order line are reserved.

Note: When the parent line that has related lines is 
selected for cancellation, the related lines are 
automatically selected for cancellation.

Note: When the parent bundle line is cancelled, all the 
components lines are automatically cancelled.

Note: If an order with future availability contains an item 
whose level of service is not selected, the exact availability 
date will be displayed only after the order is scheduled. For 
the exact availability date, refer to the Fulfillment 
Summary screen.

Note: If you select the parent line that has related lines 
associated with it to perform actions such as modification 
or cancellation, the related lines are automatically selected 
for modification of cancellation.
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If any exchange lines are being delivered and the newly added lines 
require a new or changed appointment, the Service Appointment 
screen is displayed. For more information about creating or modifying 
an appointment, see Section 2.5.5, "Modifying Service 
Appointments".

Click Next. The Confirm Payment screen is displayed where you can 
view the payment details for an order. For more information about 
payment confirmation, see Section 2.10.7, "Viewing or Modifying the 
Payment Summary".

2.10.6.5 Exchange Fulfillment Method—Pick Up Panel
You can view the fulfillment summary for the "Pick Up" fulfillment 
method.

If the fulfillment method is "Pick Up", the ship node is displayed.

The  icon indicates that the item is a gift and can be picked up by 
the recipient. For more information about setting up the gift options, 
see Section 2.7.1, "Setting Up Gift Options".

The  icon indicates that the item is an open box. For more 
information about open-box items, see Section 3.3.9, "Adding Open 
Box Items".

The item image displays an image of the actual item.

The item description and the item identifier display.

The Quantity column displays the item quantity.

The Unit Price column displays the item price for one unit.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

The Preferred column displays the date on which the customer 
prefers to pick up the item. Click the  icon to modify the preferred 
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date for picking up the item. The calendar displays the dates from the 
initial product ship date. If the product ship date is blank, the 
calendar does not display any dates.

The Available column displays the latest date when the product is 
available in the ship node.

You can choose any of the following actions from the drop-down list:

– Change to Shipping

– Cancel

When the action changes from Pick Up to ’Change to Shipping’, the 
screen returns to the Change Fulfillment Options screen and the 
system automatically checks the box against each modified order 
line. For more information about modifying the fulfillment options, 
see Section 2.5.1, "Modifying Fulfillment Options"

Click the Gift Options button to modify the gift options for the 
selected item. You must check the box for the item for which you 
want to add or clear the gift information. For more information about 
setting up gift options, see Section 2.7.1, "Setting Up Gift Options".

Click the Change Store Location button to select the store from where 
you want to pick up the items. You must check the box of the item 
you want to pick up from an alternate store. For more information 
about alternate pick up locations or stores, see Section 2.3.2.2, 
"Viewing Inventory in Other Stores".

Click ’Go to Change Fulfillment Options’ if you want to make changes 
to the fulfillment method. For more information about the fulfillment 
options screen, see Section 2.5.1, "Modifying Fulfillment Options".

Click Next. All items in the order line are reserved.

If a work order or delivery service is required, the Service 
Appointment screen is displayed. For more information about creating 
or modifying an appointment, see Section 2.5.5, "Modifying Service 
Appointments".

Click Next. The Confirm Payment screen is displayed where you can 
view the payment details for the order. For more information about 
payment confirmation, see Section 2.10.7, "Viewing or Modifying the 
Payment Summary".
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After you have finished with the Fulfillment Summary, click Next to view 
the Payment Return Order Payment Summary. See Section 2.10.7, 
"Viewing or Modifying the Payment Summary" for more information.

2.10.7 Viewing or Modifying the Payment Summary
In the Payment Summary screen, you can view payment details such as 
payment adjustments for return orders and payment adjustments for 
exchange orders.

In the top left corner of the Payment Summary screen, the Overall 
Payment Details are displayed. This panel includes Credits from Returns, 
New Charges from Exchanges, if any, and the Net Balance of the  
customer refund amount or the amount due from the customer.

The Return Order Totals panel on the lower left lists Refunded Charges, 
Taxes, and Fees for items being returned. To add or modify return fees:

1. Click the Add/Modify Return Charges button.

Note: When the Next button is clicked, reservations are 
created for all the unscheduled, unreserved lines and 
quantities. If some quantity of items is unavailable and a 
reservation cannot be created entirely, you revert back to 
the Fulfillment Summary screen highlighting the 
unavailable lines.

Note: After you first visit the Fulfillment Summary 
screen, if you then make changes elsewhere in the Return 
Order wizard and revisit the Fulfillment Summary screen, it 
may not contain changes from your original visit. The 
Fulfillment Summary screen always chooses options based 
on the configuration that is set by your enterprise. To help 
you remember this, a warning message is displayed on the 
second and subsequent visits to the Fulfillment Summary 
screen reminding you to review the information carefully 
on this screen and ensure that options you previously set 
are still in effect. You can reset these options, if necessary.
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2. The Add/Modify Charges screen is displayed. In the Fee Breakup 
panel, click the Add/Modify hyperlink.

3. The Add/Modify Charges pop-up window is displayed. Click the Add 
Charges hyperlink.

From the Charge Category drop-down list, select a Charge 
Category.

From the Charge Name drop-down list, select a Charge Name.

Enter the Charge Amount.

Add notes, if necessary.

Click Apply.

Click Close.

4. Click Close.

These changes are reflected in the totals on the Overall Payment Details 
panel in the Payment Summary screen.

For more information about adding or modifying charges, see 
Section 2.3.11.1, "Adding or Modifying Charges".

The Exchange Order Totals panel on the lower right lists Charges, Taxes, 
and Discounts for items being exchanged. To add or modify exchange 
fees:

1. Click the Add/Modify Exchange Charges button.

2. The Add/Modify Charges screen is displayed. In the Charge Breakup 
panel, click the Add/Modify hyperlink.

3. The Add/Modify Charges pop-up window is displayed. Click the Add 
Charges hyperlink.

From the Charge Category drop-down list, select a Charge 
Category.

From the Charge Name drop-down list, select a Charge Name.

Enter the Charge Amount.

Add notes, if necessary.

Click Apply.

Click Close.
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4. Click Close.

These changes are reflected in the totals on the Overall Payment Details 
panel in the Payment Summary screen.

You can enter a payment method in the Payment Methods panel in the 
top right corner of the Payment Summary screen. To add a payment 
method:

1. Click the Add Payment Method button.

2. In the Add New Payment Method pop-up window, select the Payment 
Type from the drop-down list.

3. Depending on the Payment Type that you enter, you may be 
prompted for more details, such as the customer’s name and credit 
card number.

4. After you have supplied all the Payment Type information, the 
amount to be paid and the method of payment is displayed in the 
Payment Methods panel.

5. You can apply a coupon or promotion to this amount by clicking the 
Add Coupon button.

For more information about adding new payment methods, see 
Section 2.7.4.1, "Adding New Payment Methods".

For more information about adding coupons and promotion codes, see 
Section 2.7.3, "Adding a Coupon or Promotion Code".

You can also process real-time credit card authorizations while confirming 
a draft exchange order. For more information about real-time 
authorizations, see Section 2.3.8, "Viewing and Confirming the Payment 
Details".

2.10.8 Changing Return Address
Sometimes a customer may want to change the address of a return 
order. To change the return address, you must search for the return 
order. For more information about searching for a return order, see 
Section 2.1.5, "Performing an Advanced Return Order Search".

To change the return address:

1. From Tasks > Return, select Change Return Address. The Change 
Return Address screen is displayed.
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2. To modify the return address, click the Modify Address hyperlink from 
the appropriate address panel.

3. The Modify Address pop-up window is displayed. You can modify the 
address accordingly. Click Confirm.

4. Click Next.

If any appointment needs to retaken, the Change Service 
Appointment screen is displayed. For more information about 
creating an appointment, see Section 2.10.11, "Modifying Service 
Appointments".

The Viewing and Confirming Return Order Payment Details screen 
is displayed if there is a payment impact. For more information 
about viewing and confirming payment details, see 
Section 2.10.7, "Viewing or Modifying the Payment Summary".

If you are not required to enter payment information, the Return 
Order Summary screen is displayed.

2.10.9 Viewing or Modifying Service Fulfillment Summary
You can view the summary of all appointments related to the return 
order and the corresponding exchange order, if applicable. In the 
Appointment panel, you can view the appointment number, the current 
appointment, if an appointment has been taken, and the service charges 
applicable for the service. You can perform any one of the following 
actions:

1. Click the  icon to view the return/exchange order lines included in 
the appointment.

2. Click the Change Appointment hyperlink to modify the service 
appointment. For more information about changing service 
appointment, see Section 2.10.11, "Modifying Service Appointments".

Note: If there are no work orders for the return order, 
then the message "No valid work orders are existing in this 
order" is displayed.



224   User Guide

Performing Return Order Tasks

3. Click the View/Change Instructions hyperlink to view or modify the 
service instructions.

4. In case of exchange order lines, the gift options hyperlink is 
displayed. Click the Gift Options hyperlink. The Mark/Clear item(s) as 
gift(s) screen is displayed.

Choose Mark this line/these lines as gift(s) to mark the item as a 
gift item.

Choose These item(s) are not gift(s) if you no longer want the 
item to display as a gift item.

Click Apply.

5. Click Next. 

The Viewing and Confirming Return Order Payment Details screen 
is displayed if there is a payment impact. For more information 
about viewing and confirming payment details, see 
Section 2.10.7, "Viewing or Modifying the Payment Summary".

6. The Return Order Summary screen is displayed.

2.10.10 Issuing a Refund
A customer may call to inquire about why he has not been refunded for 
items he returned. Sterling Call Center and Sterling Store provides the 
Issue Refund Now task, which enables you to issue a refund to the 
customer immediately.

You can start to issue a refund in one of two ways:

Note: If the status modification rules do not allow you to 
change service appointment, the Change Service 
Appointment hyperlink is disabled.

Note: If the status modification rules do not allow you to 
change service instructions, the View/Change Instructions 
hyperlink is disabled.
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You can issue a refund on items that are not associated with an 
order by creating a Return ’By Items Without An Order’, as 
described in Section 2.10.1, "Creating a Return Order". Perform a 
typical return and follow the return order flow to the Payment 
Summary, where the customer is issued a refund.

 Search for an existing return order as described in Section 2.1.5, 
"Performing an Advanced Return Order Search". 

1. From Tasks > Return, select Issue Refund Now. The Issue Refund 
Now screen is displayed.

2. In the 'Select Lines to Refund Now' panel, select the Select All box to 
select all the lines for a refund. To select specific lines to refund, 
check the box for those lines.

3. You can view the details of the item, such as Item ID, fulfillment 
method, shipment number, refundable quantity, and unit price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

4. In the Important Notes panel, you can view and add information 
entered for the order. 

5. Click Next. The amount for the selected lines is refunded and the 
Invoice Details screen is displayed. In the Invoice Details panel, you 
can view the total refund amount.

6. In the Header Details panel, you can view the Header charge details 
and tax details.

7. In the Header Charges panel, you can view the charges and charge 
amount at the header level. 

8. In the Tax Breakup panel, you can view the details of the line, such 
as the Item ID, original order number, quantity, and amount.
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9. In the Line Charges panel, you can view the charge and the charge 
amount of the selected line.

10. Click the Previous button to revisit the previous screen. If there are 
order lines available for refund, you can select them for an immediate 
refund.

11. Click Close. The Return Order Summary is displayed.

2.10.11 Modifying Service Appointments
Sometimes a customer may want to change the service appointment of a 
return order. To change the service appointment, you must search for the 
return order. For more information about searching for a return order, 
see Section 2.1.5, "Performing an Advanced Return Order Search".

To change the service appointment:

1. From Tasks > Return, select Change Service Appointment. The 
Service Fulfillment Summary screen is displayed. Click the Change 
Appointment hyperlink. The Change Service Appointment screen is 
displayed.

The appointments that exist for the order is displayed in the top 
panel.

If you have already taken an appointment, the details about the 
appointment is displayed.

If there is a problem with the appointment taken, the  icon is 
displayed.

If you have not taken an appointment, a “Not Taken” message is 
displayed.

2. In the Calendar, click the left or right arrow to select the appropriate 
month and select the day on which you want appointment. By 
default, the current month is displayed in the calendar.

Note: When you visit the Issue Refund Now screen, if 
there are no order lines that can be refunded, the message 
"The order does not contain any order line that can be 
refunded" is displayed.
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3. In the Slots panel, select the appropriate slot for the appointment.

Sterling Call Center and Sterling Store provides the ability to switch 
the calender view for the selected appointment by clicking any one of 
the following hyperlinks:

Switch to day-first view—This view displays the calendar to the 
left of the screen. When you select a day, the slots available for 
that day display to the right.

Switch to slot-first view—This view displays the slots to the left of 
the screen. When you select a slot in the Slots panel, the days 
available for the selected slot display to the right.

4. In the Service Instructions panel, you can either enter new service 
instructions or modify the existing service instructions for the 
selected appointment.

5. In the Return Order Lines panel, you can view all return items 
included for the selected appointment.

6. In the Exchange Order Lines panel, you can view all exchange items 
included for the selected appointment.

In the Problem Line column, the  icon is displayed only if the newly 
added line cannot be fulfilled for the current appointment.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

Note: The default calendar view is displayed depending 
on the rules configured. For more information about 
configuring the service appointments calendar view, see 
the Sterling Call Center and Sterling Store: 
Implementation Guide.
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In the Available Date column, the earliest date when the product is 
available is displayed. If items are unavailable, the column is 
displayed in red.

If you want to change the fulfillment option of a newly added line or 
or cancel an order line, click the Line Actions hyperlink. The Line 
Actions pop-up window is displayed. In the Action column, select any 
one of the following actions from the drop-down list:

Change to Pick Up

If the item supports the pick up fulfillment method

Change to Shipping

If the item supports the shipping fulfillment method

Cancel

7. Click Confirm.

If you select Change to Pick Up or Change to Shipping action, the 
Change Fulfillment Options screen is displayed. The boxes of the 
items that you modified are automatically checked. For more 
information about modifying the fulfillment options, see 
Section 2.5.1, "Modifying Fulfillment Options".

If you select the Cancel action, the item is cancelled.

8. Click the Previous button to revisit the previous screen.

9. Click Save Appointment. The inventory is reserved and the capacity is 
allocated for the appointment.

10. Click Next. The Service Fulfillment Summary screen is displayed.
 

2.10.12 Reporting Extra Items
Sometimes a customer may report that the customer has received extra 
items. In such situations, the extra items can either be returned back or 
you can allow the customer to keep the extra items. To report extra 

Note: The Availability Date column is displayed only for 
exchange order lines.
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items, you must first search for the order. For more information about 
searching for an order, see Section 2.1, "Performing Search Tasks".

To report extra items:

1. From Tasks > Return, select Report Extra Items. The Report Extra 
Items: Identify Items screen is displayed.

2. In the Identify items that were shipped incorrectly panel, enter the 
Item ID or click the search icon. The Item Search screen is displayed. 
Enter the appropriate search criteria and click Search. The search 
results are displayed in the Item List panel. Select the appropriate 
item and click Select.

3. If you do not know the item ID, select the Could Not Identify Item 
option. Enter the quantity of the item, and enter the item description 
in the Item description panel.

4. To report another extra item, click the Add Another Item button and 
enter the appropriate details.

5. In the Important Notes panel, you can view any additional 
information entered for the order. For more information about viewing 
or adding notes to an order see, Section 2.3.4, "Viewing and Adding 
Notes to an Order".

6. Click Next. The Report Extra Items: Fulfillment Summary screen is 
displayed. For more information about fulfillment summary details of 
a return item, see Section 2.10.6, "Viewing or Modifying Fulfillment 
Summary".

7. Click Next.

If there are order lines with fulfillment method as Pick Up, the 
Change Service Appointment screen is displayed. For more 
information about creating an appointment, see Section 2.10.11, 
"Modifying Service Appointments".

If there are no order lines that need to be picked up, the Order 
Summary screen is displayed.

2.10.13 Reporting Wrong Items
Sometimes a customer may report that he did not receive the items that 
were ordered. In such situations you may need to reship the items that 
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were ordered and also create a return for the wrong items that were 
delivered.

To report wrong items:

1. From Tasks > Return, select Report Wrong Items. The Reship Select 
Items screen is displayed.

2. In the Shipped items panel, select the reason for reship from the 
drop-down list.

3. Select the items that you want to reship and enter the quantity to 
reship.

4. Click Next.

If the items are not eligible for a reship, the message "These 
items are not eligible for a reship. They may have been 
reshipped." is displayed. Click the Create Follow-up Alert button to 
create a follow-up alert. For more information about creating an 
alert, see Section 2.11.1, "Creating Alerts".

To override the validation for reship, select the Override Reship 
Validation box. 

5. Click Next. The Reship Items screen is displayed. 

In the available options panel: Select Reship All Items option, to 
reship all the items.

a. Click Next. The Identify Items screen is displayed. In the Identify 
items that were shipped incorrectly panel, enter the Item ID or 
click the search icon. The Item Search screen is displayed. Enter 
the appropriate search criteria and click Search. The search 
results are displayed in the Item List panel. Select the appropriate 
item and click Select.

b. If you do not know the item ID, select the Could Not Identify Item 
option. Enter the quantity of the item, and enter the item 
description in the Item description panel.

Note: If you want to override reship validation, you must 
belong to the user group that has permission to override 
reship validation.
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c. To report another extra item, click the Add Another Item button 
and enter the appropriate details.

d. In the Important Notes panel, you can view any additional 
information entered for the order. For more information about 
viewing or adding notes to an order see, Section 2.3.4, "Viewing 
and Adding Notes to an Order".

e. Click Next. The Report Extra Items: Fulfillment Summary screen is 
displayed. For more information about fulfillment summary details 
of a return item, see Section 2.10.6, "Viewing or Modifying 
Fulfillment Summary".

f. Click Next.

g. If there are order lines with fulfillment method as Pick Up, the 
Change Service Appointment screen is displayed. For more 
information about creating an appointment, see Section 2.10.11, 
"Modifying Service Appointments".

h. If there are no order lines that need to be picked up, the Order 
Summary screen is displayed.

In the available options panel: Select Create Refund for All Items 
option, to refund for all the items.

a. Click Next. The Identify Items screen is displayed. In the Identify 
items that were shipped incorrectly panel, enter the Item ID or 
click the search icon. The Item Search screen is displayed. Enter 
the appropriate search criteria and click Search. The search 
results are displayed in the Item List panel. Select the appropriate 
item and click Select.

b. If you do not know the item ID, select the Could Not Identify Item 
option. Enter the quantity of the item, and enter the item 
description in the Item description panel.

c. To report another extra item, click the Add Another Item button 
and enter the appropriate details.

d. In the Important Notes panel, you can view any additional 
information entered for the order. For more information about 
viewing or adding notes to an order see, Section 2.3.4, "Viewing 
and Adding Notes to an Order".

e. Click Next. The Report Extra Items: Fulfillment Summary screen is 
displayed. For more information about fulfillment summary details 
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of a return item, see Section 2.10.6, "Viewing or Modifying 
Fulfillment Summary".

f. Click Next.

g. If there are order lines with fulfillment method as Pick Up, the 
Change Service Appointment screen is displayed. For more 
information about creating an appointment, see Section 2.10.11, 
"Modifying Service Appointments".

If there are no order lines that need to be picked up, the Return: 
Payment Confirmation screen is displayed. For more information 
about viewing and confirming return order payment details, see 
Section 2.10.7, "Viewing or Modifying the Payment Summary".

2.10.14 Reporting Unexpected Items
Sometimes a customer may report that he did not order items that he 
received. In such situations you may need to create a customer and then 
create a return for the wrongly shipped items.

To report unexpected items:

1. From Tasks > Return, select Report Unexpected Items. The Customer 
Identification screen is displayed.

2. To search for an existing customer, enter the appropriate details in 
the Find Existing Customer panel and click Search. The search results 
are displayed in the Results panel. Select the customer record and 
click Next.

3. If the customer does not exist, you need to create a new customer. 
To create a new customer:

Click Create Consumer to create a consumer customer.

Click Create Business to create a business customer.

Enter the appropriate details and click Next.

4. The Report Extra Items: Identify Items screen is displayed.

5. In the ’Identify items that were shipped incorrectly’ panel, enter the 
Item ID or click the search icon. The Item Search screen is displayed. 
Enter the appropriate search criteria and click Search. The search 
results are displayed in the Item List panel. Select the appropriate 
item and click Select.
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6. If you do not know the item ID, select the Could Not Identify Item 
option. Enter the quantity of the item, and enter the item description 
in the Item description panel.

7. To report another extra item, click the Add Another Item button and 
enter the appropriate details.

8. In the Important Notes panel, you can view any additional 
information entered for the order. For more information about viewing 
or adding notes to an order see, Section 2.3.4, "Viewing and Adding 
Notes to an Order".

9. Click Next. The Report Extra Items: Fulfillment Summary screen is 
displayed. For more information about fulfillment summary details of 
a return item, see Section 2.10.6, "Viewing or Modifying Fulfillment 
Summary".

10. Click Next.

If there are order lines with fulfillment method as Pick Up, the 
Service Fulfillment Summary screen is displayed. For more 
information about creating an appointment, see Section 2.10.11, 
"Modifying Service Appointments".

If there are no order lines that need to be picked up, the Return 
Order Summary screen is displayed.

2.10.15 Canceling a Return Order
A customer may want to cancel some of the items or the entire return 
order. The customer may also want to cancel the exchange order 
corresponding to the return order. To cancel a return order, you must 
search for a return order. For more information about searching for a 
return order, see Section 2.1.5, "Performing an Advanced Return Order 
Search".

1. From Tasks > Return, select Cancel Return Order. The Cancel Return 
Order screen is displayed.

2. In the Cancel Return Order panel, select the reason code from the 
drop-down list.

If you want to cancel all the items, select the Select All Available 
Quantity for Cancellation option.
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If you want to cancel only some of the items included in the order, 
select the Select Specific Quantity for Cancellation option. Select 
the lines that you want to cancel and enter the quantity for 
cancellation.

3. In the Important Notes panel, you can view any additional 
information entered for the order. For more information about viewing 
or adding notes see, Section 2.3.4, "Viewing and Adding Notes to an 
Order".

4. Click Confirm.

If there is an exchange order created for the return order, the 
Cancel Return Order: Cancel Exchange Order screen is displayed. 
In the Cancel Exchange Order panel, select the reason code from 
the drop-down list. 

a. If you do not want to cancel any exchange order, select the 
Cancellation of Exchange Order not required option. 

b. If you want to cancel all the items, select the Select All Available 
Quantity for Cancellation option. 

c. If you want to cancel only some of the items included in the order, 
select the Select Specific Quantity for Cancellation option. Select 

Note: If the status modification rules do not allow you to 
cancel an order line, then the order line is disabled.

Note: If you attempt to cancel a line for which an invoice 
has been created, the Sterling Call Center and Sterling 
Store application displays an error, and does not allow you 
to cancel the line.

Note: If the line that you want to cancel has related lines, 
the related lines are automatically selected for 
cancellation.
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the lines that you want to cancel and enter the quantity for 
cancellation. Click Confirm.

2.10.16 Creating an Exchange Order
A customer may want exchange items to be created for the items that 
are being returned. In such situations, you need to create an exchange 
order for the corresponding return order. To create an exchange order, 
you must search for the return order. For more information about 
searching for a return order, see Section 2.1.5, "Performing an Advanced 
Return Order Search".

1. From Tasks > Return, select Create Exchange Order. The Create 
Exchange : Add Items screen is displayed. In the Item column, enter 
the identifier of the item or item description, or choose the  to 
select an item from the Item List. You can also click the Add More 
Lines hyperlink. For more information about performing an advanced 
item search, see Section 2.1.3.4, "Performing an Advanced Item 
Search".

2. Click Next. The Create Exchange : Change Fulfillment Options screen 
is displayed. For more information about changing the fulfillment 
method, see Section 2.5.1, "Modifying Fulfillment Options".

3. Click Next. The Create Exchange : Fulfillment Summary screen is 
displayed. For more information about viewing the fulfillment 
summary, see Section 2.5.2, "Fulfillment Summary".

Note: When you cancel a bundle item, all the component 
quantity will be cancelled in the same ratio defined while 
configuring bundles.

Note: When you revisit the Cancel Return Order screen 
and items are available for cancellation, the message "The 
previous cancellation request has been executed. Select 
’Proceed Without Cancellation’ to continue without 
anymore cancellations" is displayed.

If no items are available for cancellation, the message "No 
items on this order are available for cancellation" is 
displayed.
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4. Click Next.

If order lines are being delivered on this order, the Service 
Appointment screen is displayed where you can create an 
appointment. For more information about creating an 
appointment, see Section 2.10.11, "Modifying Service 
Appointments".

If there are no order lines to be delivered, the Confirm Payment 
screen is displayed. For more information about viewing payment 
information, see Section 2.10.7, "Viewing or Modifying the 
Payment Summary".

If you are not required to enter the payment information, the 
Return Order Summary screen is displayed. For more information 
about viewing the return order summary, see Section 2.1.5.1, 
"Viewing Return Order Summary".

2.10.17 Changing Return Method
Sometimes a customer may want to change the fulfillment method of a 
return order. To change the return method, you must search for the 
return order. For more information about searching for a return order, 
see Section 2.1.5, "Performing an Advanced Return Order Search".

To change the return method:

1. From Tasks > Return, select Change Return Method. The Fulfillment 
Summary screen is displayed.

2.10.17.1 Return Fulfillment Method: Shipping Panel
You can view the return fulfillment summary for the "Shipping" fulfillment 
method.

1. In the Lines being shipped to panel, you can view the return items 
that are being shipped back.

2. You can view the details of the item such as the item ID, quantity and 
unit price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
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components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

3. In the Ship To items panel, you can view the return address to which 
the item will be shipped.

4. To change the fulfillment method to Pick Up, select the lines and click 
Change To Pick Up. The selected item is moved to the Return Pick Up 
Summary panel.

5. Click Next. 

If any order lines are being delivered and the newly added lines 
require a new appointment or a changed appointment, the 
Change Service Appointment screen is displayed. For more 
information about creating or modifying an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

6. To allow the customer to keep an item, select the line and click the 
Customer Can Keep button. The selected item is moved to the Keep 
These Items panel.

2.10.17.2 Return Fulfillment Method: Pick Up Panel
You can view the return fulfillment summary for the "Pick Up" fulfillment 
method.

1. In the Lines being picked up from panel, you can view the return 
items that are being picked up.

2. You can view the details of the item such as the item ID, quantity and 
unit price.

Note: The Change to Pick Up button is displayed only if 
the item supports Pick Up return method.
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If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

3. In the Pick up items from panel, you can view the address from which 
the items will be picked up.

4. To change the address from which the items are being picked up, 
select the lines and click the Change Address button. The Add a New 
Address pop-up window is displayed. Enter the appropriate details 
and click Confirm.

5. Click Next.

If any order lines are being delivered and the newly added lines 
require a new appointment or a changed appointment, the 
Change Service Appointment screen is displayed. For more 
information about creating or modifying an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

6. To change the fulfillment method to shipping, select the lines and 
click the Change To Shipping button. The selected item is moved to 
the Return Shipment Summary panel.

7. To allow the customer to keep the items, select the lines and click the 
Customer Can Keep button. The selected item is moved to the Keep 
These Items panel.

2.10.17.3 Keep These Items Panel
You can view the details of the items that the customer can keep.
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1. In the Keep these items with our compliments panel, you can view 
the details of the items, such as the item ID, description, quantity, 
and unit price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

2. Click Change To Shipping to ship the item back. The selected item is 
moved to the Return Shipment Summary panel.

3. Click Change To Pick Up for the item to be picked up. The selected 
item is moved to the Return Pick Up Summary panel.

If any order lines are being delivered and the newly added lines 
require a new appointment or a changed appointment, the 
Change Service Appointment screen is displayed. For more 
information about creating or modifying an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

If the order contains existing service appointments that have not 
been affected by the addition of lines, the Service Fulfillment 
Summary screen is displayed. For more information about viewing 
the service fulfillment summary, see Section 2.5.6, "Service 
Fulfillment Summary".

2.10.17.4 Exchange Fulfillment Method—Shipping Panel
You can view the fulfillment summary for the "Shipping" fulfillment 
method.

The address to which the item is shipping is displayed in the header 
panel, if the fulfillment method is "Shipping".

Note: The Change to Pick Up, Change to Shipping buttons 
are displayed only if the item supports Pick Up, shipping 
return methods.
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The  icon indicates that the item is a gift and can be picked up or 
shipped to the gift recipient. For more information about setting up 
gift options, see Section 2.7.1, "Setting Up Gift Options".

The open box icon indicates that the item is an open-box item. For 
more information about open-box items, see Section 3.3.9, "Adding 
Open Box Items".

The item image displays an image of the actual item.

The item description and the item identifier display.

The Quantity column displays the order line quantity.

The Unit Price column displays the item price for one unit.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

The Available column displays the latest date on which the product is 
available. If items are unavailable, the column is displayed in red, 
indicating unavailability.

The Level of Service column enables you to change the carrier service 
with cost from the drop-down list.

The expected delivery column displays the expected delivery dates of 
the items.

You can choose the following actions from the drop-down list: 

– Change to Pick Up

– Change to Delivery

Note: Whenever the carrier service is changed, the 
expected delivery date is updated to reflect the change.
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– Cancel

When the action is changed from Shipping to ’Change to Pick Up’, the 
screen returns to the Change Fulfillment Options screen and the 
system automatically checks the box against each modified order 
line. For more information about the fulfillment options, see 
Section 2.5.1, "Modifying Fulfillment Options".

Click the Gift Options button to modify the gift options for the 
selected items. You must check the box for the item for which you 
want to add or clear the gift information. For more information about 
gift options, see Section 2.7.1, "Setting Up Gift Options".

Click ’Go to the Change Fulfillment Options’ if you want to make 
changes to the fulfillment methods. For more information about 
changing fulfillment options, see Section 2.5.1, "Modifying Fulfillment 
Options".

Click Confirm or Next. All items in the order line are reserved.

If any exchange lines are being delivered and the newly added lines 
require a new or changed appointment, the Service Appointment 
screen is displayed. For more information about creating or modifying 
an appointment, see Section 2.5.5, "Modifying Service 
Appointments".

Note: When the parent line that has related lines is 
selected for cancellation, the related lines are 
automatically selected for cancellation.

Note: When the parent bundle line is cancelled, all the 
components lines are automatically cancelled.

Note: If you select the parent line that has related lines 
associated with it to perform actions such as modification 
or cancellation, the related lines are automatically selected 
for modification of cancellation.
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Click Next. The Confirm Payment screen is displayed where you can 
view the payment details for an order. For more information about 
payment confirmation, see Section 2.10.7, "Viewing or Modifying the 
Payment Summary".

2.10.17.5 Exchange Fulfillment Method—Pick Up Panel
You can view the fulfillment summary for the "Pick Up" fulfillment 
method.

If the fulfillment method is "Pick Up", the ship node is displayed.

The  icon indicates that the item is a gift and can be picked up by 
the recipient. For more information about setting up the gift options, 
see Section 2.7.1, "Setting Up Gift Options".

The  icon indicates that the item is an open box. For more 
information about open-box items, see Section 3.3.9, "Adding Open 
Box Items".

The item image displays an image of the actual item.

The item description and the item identifier display.

The Quantity column displays the item quantity.

The Unit Price column displays the item price for one unit.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

The Preferred column displays the date on which the customer 
prefers to pick up the item. Click the  icon to modify the preferred 
date for picking up the item. The calendar displays the dates from the 
initial product ship date. If the product ship date is blank, the 
calendar does not display any dates.

The Available column displays the latest date when the product is 
available in the ship node.
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You can choose any of the following actions from the drop-down list:

– Change to Shipping

– Cancel

When the action changes from Pick Up to ’Change to Shipping’, the 
screen returns to the Change Fulfillment Options screen and the 
system automatically checks the box against each modified order 
line. For more information about modifying the fulfillment options, 
see Section 2.5.1, "Modifying Fulfillment Options"

Click the Gift Options button to modify the gift options for the 
selected item. You must check the box for the item for which you 
want to add or clear the gift information. For more information about 
setting up gift options, see Section 2.7.1, "Setting Up Gift Options".

Click the Change Store Location button to select the store from where 
you want to pick up the items. You must check the box of the item 
you want to pick up from an alternate store. For more information 
about alternate pick up locations or stores, see Section 2.3.2.2, 
"Viewing Inventory in Other Stores".

Click ’Go to Change Fulfillment Options’ if you want to make changes 
to the fulfillment method. For more information about the fulfillment 
options screen, see Section 2.5.1, "Modifying Fulfillment Options".

Click Next. All items in the order line are reserved.

If a work order or delivery service is required, the Service 
Appointment screen is displayed. For more information about creating 
or modifying an appointment, see Section 2.5.5, "Modifying Service 
Appointments".

Click Next. The Confirm Payment screen is displayed where you can 
view the payment details for the order. For more information about 
payment confirmation, see Section 2.10.7, "Viewing or Modifying the 
Payment Summary".

Note: When the Next button is clicked, reservations are 
created for all the unscheduled, unreserved lines and 
quantities. If some quantity of items is unavailable and a 
reservation cannot be created entirely, you revert back to 
the Fulfillment Summary screen highlighting the 
unavailable lines.
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After you have finished with the Fulfillment Summary, click Next to view 
the Payment Return Order Payment Summary. See Section 2.10.7, 
"Viewing or Modifying the Payment Summary" for more information.

2.11 Performing Alert and Queue Management 
Tasks

The Alert Management tasks enable you to create, resolve, and assign 
alerts. Typically, alerts are either raised by the system or created by you. 
For example, when scheduling an order, the system may hit a predefined 
error condition such as ‘inventory not found’. In such situations, alerts 
are created against an order and assigned to the appropriate queue to 
ensure that they are resolved. Similarly, you can also create alerts and 
assign them to a queue. The Alert and Queue Management task also 
provides an alert statistics report. This report provides visibility into 
alerts that are assigned to a specific user or queue.

The alert and queue management tasks include:

Creating Alerts

Viewing Alert Information

Searching for Alerts

Notifying Users of Assigned Alerts

Assigning Alerts to a User

Moving Alerts to a Queue

Note: After you first visit the Fulfillment Summary 
screen, if you then make changes elsewhere in the Return 
Order wizard and revisit the Fulfillment Summary screen, it 
may not contain changes from your original visit. The 
Fulfillment Summary screen always chooses options based 
on the configuration that is set by your enterprise. To help 
you remember this, a warning message is displayed on the 
second and subsequent visits to the Fulfillment Summary 
screen reminding you to review the information carefully 
on this screen and ensure that options you previously set 
are still in effect. You can reset these options, if necessary.
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Viewing the Next Alert

Resolving Alerts

Closing Alerts

2.11.1 Creating Alerts
You can create new alerts in the system and log notes for future 
reference.

To create an alert:

1. From Tasks > Alerts, select Create Alert. The Create Alert screen is 
displayed.

2. From the Enterprise drop-down list, select the enterprise for which 
you want to create the alert.

3. From the Alert Type drop-down list, select the appropriate alert type.

4. In the User field, enter the appropriate user identifier.

If you do not know the user’s identifier, click the Find User hyperlink. 
The Find User screen is displayed. For more information about 
searching for a user, see Section 2.11.1.1, "Searching for a User".

5. In the Priority field, enter the priority for the alert.

6. In the Queue field, select the queue from the drop-down list to assign 
it to an alert.

7. If you need to create a follow-up date for the alert, enter an 
appropriate date in the Follow-up Date field.

8. In the Associated Order field, enter the order number associated with 
the alert.

9. To search for the order, click the Find Order hyperlink. The Order 
Search screen is displayed. For more information about searching for 
an order, see Section 2.1, "Performing Search Tasks".

10. In the Details panel, enter the appropriate alert details.

11. Click Create.

2.11.1.1 Searching for a User
To search for a user:
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1. In the User Id Contains field or the User Name Contains field, enter 
the appropriate information.

2. Click Find User. A list of users that matches the search criteria is 
displayed.

3. Double-click the appropriate user’s identifier.

2.11.2 Viewing Alert Information
You can view a list of alerts that are due for follow-up actions, all open 
alerts that are categorized by alert types, and all queues to which the 
current user is subscribed.

To view the alert information:

1. From Tasks > Alerts, select View My Alerts and Queues. The 
Alert/Queues screen is displayed. You can view a tree structure that 
provides a list of various alerts and queues.

The tree structure contains one or more of the following:

My Queues—Displays all queues to which the user is subscribed. 
The number within the parenthesis indicates the total number of 
open alerts assigned to the user in that particular queue.

My Alerts—Displays all the alerts assigned to the user and the 
queue to which the user is subscribed. The number within the 
parenthesis indicates the number of open alerts.

My Alerts Due For Follow-Up—Displays alerts assigned to the user 
that are due for follow-up.

2. Select an alert or queue for which you want to view details.

If only one alert or queue exists, the Alert Details screen is 
displayed. You can view the alert or queue information 
appropriately.

If multiple alerts or queues exist, a list of alerts or queues is 
displayed. Select the alert or queue for which you want to view 
the details.

3. Click Close.
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2.11.3 Searching for Alerts
You may sometimes need to search for alerts that are already created.

To search for an alert:

1. From Tasks > Alerts, select Alert Search. The Alert Search screen is 
displayed.

2. Enter the appropriate search criteria.

3. Click Search. You can view the alert details.

4. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

2.11.3.1 Viewing Alert Details
You can view the details of alerts that meet your search criteria.

If only one alert matches your search criteria, the Alert Details screen 
is displayed where you can view the detailed information about the 
alert.

If there are multiple alerts that match your search criteria, a list of 
alerts is displayed. Double-click the appropriate alert. The Alert 
Details screen is displayed. You can view the appropriate alert details 
depending on the type of alert. 

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 
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If you want to change the status of the alert, select the appropriate 
alert status from the Alert Status drop-down list and click Save.

If you want to modify the follow-up date for the alert, enter the 
appropriate date in the Follow-up Date field and click Save.

In the Notes panel, you can view any additional information about the 
alert.

If you want to enter notes regarding alerts, click on the Add Note 
hyperlink. The Add Notes for the Alert screen is displayed. 

To add notes:

a. From the Contact Method drop-down list, select the appropriate 
contact method.

b. In Contact Details, enter the appropriate information.

c. Enter notes regarding alerts. Select the appropriate emoticon 
(smiley) for the alert notes, if applicable.

d. If you want to view the alert notes along with the associated 
order, check the Save Note on Associated Order box.

e. Click Add Note. You can view the notes in the Notes panel. 

Click Close.

2.11.4 Notifying Users of Assigned Alerts
You can be notified of open alerts assigned to you or to the queues to 
which you are subscribed. 

Users are notified of assigned alerts in any one of the following ways: 

The number of open alerts is displayed in the CSR message panel as 
an  (alerts) icon. Click on the number of open alerts.

– The number of open alerts assigned to the current user is 
displayed, if configured for the user.

– The number of priority 1 alerts is displayed, if configured to 
display alerts for queues to which the current user is subscribed. 
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Upon clicking the number of open alerts, if there is only one open alert, 
the View Alert Details screen is displayed. Otherwise, the Alert Search 
and List screen is displayed. For more information about viewing alerts, 
see Section 2.11.2, "Viewing Alert Information". For more information 
about searching for alerts, see Section 2.11.3, "Searching for Alerts".

Based on the polling time configuration, a window pops up with a 
beep. A hyperlink on the pop-up window is displayed:

– The number of open alerts assigned to the current user, if 
configured for users. If there are no open alerts assigned to the 
current user, the follow-up alerts assigned to the user display.

– The number of priority 1 alerts added to the queue to which the 
current user is subscribed, if configured to display alerts for 
queues.

– Select the Do not notify box, if you do not wish to see alert 
notifications.

2.11.5 Assigning Alerts to a User
Sometimes, an alert task needs to be addressed by a particular user. For 
example, some alerts may require a CSR Lead to perform the necessary 
action. In such situations, you can assign alerts to a specific user.

To assign alerts to different users:

1. Search for the alert. For more information about searching for an 
alert, see Section 2.11.3, "Searching for Alerts". The Alert Details 
screen is displayed.

2. From the Alert Details screen > Tasks > Alert, select Assign To User. 
The Assign To User screen is displayed. 

In the Currently Assigned To User Id field, you can view the identifier 
of the user to whom the alert is currently assigned.

Note: The number adjacent to the  (alerts) icon is 
refreshed regularly based on the polling time configured.

Note: The Do Not Notify check box is displayed only to 
users with the necessary permissions.
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3. In the Assign To User Id field, enter the appropriate identifier of the 
user.

If you do not know the user’s identifier, click the Find User hyperlink. 
The Find User screen is displayed. For more information about 
searching for a user, see Section 2.11.1.1, "Searching for a User".

4. In the Notes panel, enter any additional notes about assigning the 
alert to a particular user, if applicable.

5. Click Assign.

2.11.6 Moving Alerts to a Queue
You can move a particular alert to a different queue.

To move an alert to a different queue:

1. Search for the alert. For more information about searching for an 
alert, see Section 2.11.3, "Searching for Alerts". The Alert Details 
screen is displayed.

2. From the Alert Details screen > Tasks > Alert, select Move To Queue. 
The Move To Queue screen is displayed.

In the Currently Assigned To Queue Id field, you can view the 
identifier of the queue to which the alert is currently assigned.

3. In the Assign To Queue Id field, enter the appropriate queue 
identifier.

4. To search for a queue, enter the appropriate information in the Queue 
Id Contains or the Queue Name Contains fields.

5. Click Find Queue. The list of queues matching the search criteria is 
displayed.

6. Double-click the appropriate queue identifier.

7. You can add any additional notes about assigning the alert to a 
particular queue in the Notes panel, if necessary.

8. Click Assign.
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2.11.7 Viewing the Next Alert
This task considers all open alerts that are not assigned to any user. 
These alerts are assigned to a user based on the alert priority as follows:

An alert with the highest priority is considered first.

An alert with the earliest follow-up date is considered next.

An alert with the earliest creation time is considered next.

To view the next alert that may be assigned to you:

1. From Tasks > Alerts, select Get Next Alert.

If alerts are available, the Alert Details screen is displayed where 
you can view the alert information.

If alerts are not available, the message "No Assigned Alerts 
Available" is displayed.

2. Click Close.

2.11.8 Resolving Alerts
Different alert types can be resolved in different ways. Some alerts can 
be resolved by simply closing the alert. For more information about 
closing an alert, see Section 2.11.9, "Closing Alerts". Some alerts, such 
as FTC Notification Alerts, should be resolved using other methods.

2.11.8.1 FTC Notification Alerts
The FTC Alert Details screen is used when you contact a customer to 
inform them of a delay or when a customer contacts the call center in 
response to a notification about a delay. In any event, these alerts should 
not be resolved without the customer’s consent.

There are two ways in which you can resolve an FTC Notification:

Accepting the delay on each line.

Cancelling the lines that are being delayed. 
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2.11.8.1.1 Resolving a Single Alert  

To resolve a single alert:

1. Search for the alert. For more information about searching for an 
alert, see Section 2.11.3, "Searching for Alerts". The Alert Details 
screen is displayed.

2. If the customer agrees to a delay on any of the lines, select the lines 
whose delay is being accepted, and click Accept Delay. The Notes 
pop-up window is displayed.

3. Enter the appropriate notes and click OK. The Alert Details screen is 
refreshed.

4. If the customer does not agree to a delay on any of the lines, select 
the lines whose delay is not being accepted, and click Cancel Lines. 
The Notes pop-up window is displayed.

5. Enter the appropriate notes and click OK. The Alert Details screen is 
refreshed.

6. If more lines have to be resolved, repeat Step 2 through Step 5 for 
the corresponding lines until all the lines are resolved. After all the 
lines are resolved the alert will also be resolved and automatically 
closed.
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2.11.8.1.2 Resolving Multiple Alerts  

If an order has multiple FTC Notification alerts open at the same time, 
the Alert Details screen will function a little differently.

To resolve multiple alerts:

1. Search for the alert. For more information about searching for an 
alert, see Section 2.11.3, "Searching for Alerts". The Alert Details 
screen is displayed.

2. Click the Review all FTC Alerts hyperlink. The Multi Alert Details 
screen is displayed.

3. Perform Step 2 through Step 6 explained in Section 2.11.8.1.1, 
"Resolving a Single Alert". You can select lines from different alerts 
and resolve them all at the same time. As and when individual alerts 
get resolved, they will be automatically closed and removed from this 
screen. When all the alerts have been resolved, the screen will 
automatically close.

2.11.8.2 Price Match Alerts
The Price Match Alert Details screen is used when a customer contacts 
the call center that another retailer is selling the same items that were 
ordered at a lesser price. In such situations, you may look into the 
customer’s claims and price match the items, if necessary. If the user 
does not have permissions to approve the price match, an alert will be 
created which can be approved/denied by a user who has permissions.

To resolve a price match alert:

1. Search for the alert. For more information about searching for an 
alert, see Section 2.11.3, "Searching for Alerts". The Alert Details 
screen is displayed.

2. Click the Approve button to approve the price match.

3. Click the Deny button to reject the price match.
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2.11.9 Closing Alerts
You can close alerts that have been resolved or are no longer valid.

To close an alert:

1. Search for the alert. For more information about searching for an 
alert, see Section 2.11.3, "Searching for Alerts". The Alert Details 
screen is displayed.

2. From the Alert Details screen > Tasks > Alert, select Close Alert. The 
Close Alert screen is displayed. You can view the identifier of the user 
who closed the alert.

3. In the Notes panel, enter the appropriate notes, if applicable.

4. Click Save.

2.12 Performing Announcement Tasks
CSRs can post messages and other useful information pertaining to other 
CSRs, for example, information about delivery of goods to a certain 
region being delayed because of bad weather conditions. This information 
has to be conveyed to other CSRs to ensure that they are aware of the 
delay. Users who belong to a user group that has the necessary 
permissions can create, view, and cancel announcements.

2.12.1 Creating an Announcement
Using the Announcements task, you can create an announcement. 
However, after an announcement is created, you cannot modify the 
announcement but you can cancel it.

To create an announcement:

1. Perform one of the following tasks to open the Create Announcement 
screen:

From the Actions menu, select Create Announcement. 

In Related Tasks panel, click Create Announcement.

2. From the Send To drop-down list, select the appropriate queue for 
which you want to create the announcement.

3. In the Expiration Date field, click the  icon and select the date until 
when you want the announcement to be available.
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4. In the Subject field, enter a suitable title for the announcement. The 
length of the value should not exceed 100 characters.

5. In the Link field, specify the URLs of the corresponding Web sites, if 
applicable.

6. In Summary, enter additional information pertaining to the 
announcement, if applicable. 

7. Click Announce.

2.12.2 Viewing and Canceling Announcements
An Announcements panel is provided in the Quick Access screen. Users 
who belong to a user group that has the necessary permission, can view 
the announcements. The Announcements panel displays the subject of 
an announcement, a brief description of the announcement, the date on 
which the announcement was created, the date on which the 
announcement expires, and a View Details hyperlink.

On clicking the View Details hyperlink of the corresponding 
announcement, the Announcement Details screen is displayed. This 
screen displays the same information that is displayed in the 
Announcements panel. While creating an announcement, if the user has 
specified the URL of a Web site, the Web site will be displayed in the 
Announcement Details screen. You can also view the Web site on an 
external browser by clicking the View in browser hyperlink.

If you have the permission to cancel an announcement, click the Cancel 
Announcement button in the Announcement Details screen to cancel an 
announcement.

2.13 Setting User Preferences
Sterling Call Center and Sterling Store enables you to set user 
preferences such as the display of alert notifications, additional help 

Note: In the Announcements panel, you can view up to 
200 characters of the description. If the length of the 
description exceeds 200 characters, you can view the 
remaining description in the Announcement Details screen.
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messages, keyboard shortcuts, customer message panel, scratch pad, 
position of related tasks, and CSR message/customer message panel.

To set user preferences, from the View menu, select Preferences. The 
User Preferences pop-up window is displayed. You can set the following 
preferences and click Confirm to save your changes:

Select the Display alert notifications check box, to display alert 
notifications. Deselecting the Display alert notifications check box will 
disable the pop-up window configured to display on top of the CSR 
message panel based on the polling time.

Select the Display additional help messages and icon legends check 
box, to display help messages. Deselecting the Display additional help 
messages and icon legends check box will disable the additional help 
messages of a screen whenever the screen is opened.

Select the Display keyboard shortcuts for related tasks check box, to 
display keyboard shortcuts. Deselecting the Display keyboard 
shortcuts for related tasks check box will disable the keyboard 
shortcut display within the related task panel.

Select the Hide customer message panel check box, to hide the 
customer message panel. Deselecting the Hide customer message 
panel check box will allow the customer message panel to show up.

Select the Remember pagination preference check box, to remember 
the pagination preferences. While retrieving the records, if a sorting 
or filtering is applied, the message "New records are returned to a 
table that has been sorted or filtered. As a result, the new records 
are inserted into the table based on the existing sort or filter criteria. 
All new records are highlighted." are displayed. Clearing this check 
box will allow the pagination message pop-up to show up at search 
screens.

In the Position of CSR message/Customer message panel, select top 
or bottom, to display the CSR message/Customer message panel on 
the top or bottom respectively.

Note: The Display alert notification option is not displayed 
if the application is configured to never notify users.
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Under Display Scratch Pad As, select Related Task to display the 
scratch pad in the Related Tasks panel, or Popup to display the 
scratch pad in a pop-up window.

Select the Display the scratch pad after logging in check box to 
display the scratch pad soon after a user logs in to the application. 
Clear the Display the scratch pad after logging in check box if you do 
not want to display the scratch pad after a user logs in to the 
application.

Depending on whether you want the Related Tasks panel to be 
displayed on the left or right side of the screen, select Left or Right in 
the Position of Related Tasks view

2.14 Viewing the Documentation Library
Sterling Call Center and Sterling Store enables you to access the product 
documentation library to view all the Sterling Call Center and Sterling 
Store application documents. Based on the configuration, either the 
Online Documentation Library or the Local Documentation Library is 
displayed. 

The Online Documentation Library provides online access to the Sterling 
Call Center and Sterling Store documentation in HTML and PDF formats. 
The combination of Google mini search capability with the HTML format 
enables users to search the entire documentation set and narrow their 
results quickly.

The Local Documentation Library provides access to the Sterling Call 
Center and Sterling Store documentation in HTML format, as well as 
index and search capability on a book-by-book basis.

You can access the product documentation library by selecting the 
Documentation Library option from the Help Menu.

Note: You must restart the application for some of the 
user preferences to take effect, such as collapsible 
customer message panel, position of the Related Tasks 
panel, and CSR Message/Customer Message panel.
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2.15 Performing Report Tasks
Sterling Call Center and Sterling Store provides rich functionality to 
generate reports such as cross sell reports, CSR reports, and price match 
reports.

To view reports, from Tasks > Reports, select View My Reports. The My 
Reports screen is displayed. Click the YCD-Analytics hyperlink. The list of 
reports which can be generated is displayed.

2.15.1 Cognos 8 Business Intelligence Toolbar
This section describes the Cognos 8 Business Intelligence toolbar that 
appears in the Sterling Call Center and Sterling Store report.

Figure 2–1 Default Cognos 8 Business Intelligence Toolbar

The Cognos 8 Business Intelligence toolbar that appears in the Sterling 
Call Center and Sterling Store report contains the following icons:

View in HTML format

Note: You can access the documentation library only if 
you belong to a user group that has the necessary 
permissions.

Save as Report View

Email Report

Run
Drill Down

Drill Up

Enter the page number you 
want to view

View in HTML format

View in PDF format

View in XML format

Click the down arrow, and select any 
one of the following:
View in Excel 2000 Single Sheet Format
View in Excel 2000 Format
View in Excel 2002 Format
View in CSV Format
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Click  to view the report in Hypertext Markup Language format. By 
default, the Sterling Call Center and Sterling Store reports are 
displayed in HTML format.

View in PDF format

Click  to view the report in Portable Document Format.

View in XML format

Click  to view the report in eXtensible Markup Language Format.

View in Excel or CSV formats

Click  the down arrow provided next to the icon. The various 
Excel formats and CSV format are displayed. Click the appropriate 
format in which you want to view the report.

2.15.2 Cross Sell Reports
Call Center Managers and Store Managers may need information about 
the cross sales performance of the call center or store. This report 
provides information about the best cross selling items. This report also 
allows you to compare the average cross sell revenue per order for a 
given period with the previous period. Figure 2–2 shows a sample Cross 
Sell Report.

To generate cross sell reports:

1. Click the Cross Sell Reports hyperlink. The Cross Sell Report screen is 
displayed.

2. Select the enterprise for which you want to view the report from the 
Choose the Enterprise drop-down list.

3. Select the period for which you want to view the report from the 
Choose the period to view the report for panel.

4. Select the start date for the period from the Choose the start date of 
the period panel.
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5. Click Finish. The Cross Sell Report is displayed.

For each day within a specific time period, the graph displays the 
average cross sell revenue per order. The second graph displays the 
average number of cross sell items per order. The third graph displays 
the number of items sold for best cross sell items. Graphs for the 
previous period are also displayed, adjacent to the graphs for the 
current period. 

Note: If you select a start date that is earlier than the 
current system date, the Cross Sell report is displayed for 
the period following the start date. However, if the start 
date that is selected is same as the current system date, 
the Cross Sell report is displayed for the period preceding 
the start date.
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Figure 2–2 Cross Sell Report
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2.15.3 CSR Reports
Call Center Managers and Store Managers may need to track information 
about the number of sales and revenue generated by a particular CSR or 
store associate. This report provides visibility into the number of sales, 
total cross sell, revenue generated, and alerts resolved during a specific 
period of time. Figure 2–3 shows a sample CSR Report.

To generate CSR reports:

1. Click the CSR Reports hyperlink. The CSR Report screen is displayed.

2. Select the enterprise for which you want to view the report from the 
Choose the Enterprise drop-down list.

3. Select the Start and End date for which you want to generate the 
report. To select a date, click the  icon and then select the year, 
month, and day. 

4. Click Finish. The CSR Report is displayed. You can view the following 
details:

CSR—The name of the CSR.

Number Of Orders Placed—The number of orders created by the 
CSR.

Revenue From Orders—Total revenue from the orders created by 
the CSR.

Average Items Per Order—The average items per order for all the 
orders created by the CSR.

Average Revenue Per Order—The average revenue per order for 
all the orders created by the CSR. 

Total Cross Sell Revenue—Total cross sell revenue from the orders 
created by the CSR.

Average Cross Sell Items Per Order—The average cross sell items 
per order for all the orders created by the CSR.

Number Of Alerts Resolved—The number of alerts resolved by the 
CSR.
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Figure 2–3 CSR Report

2.15.4 Price Match Reports
Pricing Analysts and Product Managers may need information about the 
items that are frequently price matched, competitor against who the 
items are frequently priced matched etc. This report helps in making 
decisions such as:

If a large number of items are price matched against a particular 
competitor, verify if there is a sale or if the competitor is a discount 
retailer and exclude the competitor from the price match list.

If an item has been price matched frequently, then the pricing analyst 
may need to re-price the item. If an item is not price matched, then 
the pricing analyst may want to re-price the item at a higher price.

Figure 2–4 shows a sample Price Match Report.

To generate price match reports:

1. Click the Price Match Report hyperlink. The Price Match Report screen 
is displayed.

2. Select the enterprise for which you want to view the report from the 
Choose the Enterprise drop-down list.

3. Select the Start and End date for which you want to generate the 
report. To select a date, click the  icon and then select the year, 
month, and day.

4. To view the price match report for a particular item, enter one or 
more keywords and click the Search button. Click the Options 
hyperlink to restrict the search criteria. The search results are 
displayed in the Results panel. Select the items for which you want to 
generate a report and click the Insert button. The item is added to 
the Choices panel. To remove an item, select the item in the Choices 
panel and click the  Remove button.
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5. Click Finish. The Price Match Report is displayed.

For each item, you can view the number of orders for which price match 
was performed. You can also view the numbers of orders for each 
competitor against whom the price match was performed. The graph 
displays the price match percentage for each competitor.

Figure 2–4 Price Match Report

2.16 Launching the IBM Sterling Business Center 
Application

Sterling Call Center and Sterling Store enables you to launch the IBM® 
Sterling Business Center application from within the Sterling Call Center 
and Sterling Store application. Sterling Business Center provides you 
with access to item and pricing configurations. For example, you may 
have to configure the pricing rules for an organization, or you may have 
to configure catalog entitlements.
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You can launch Sterling Business Center from Sterling Call Center and 
Sterling Store only if you belong to a Sterling Call Center and Sterling 
Store user group that has the necessary permissions to access Sterling 
Business Center.

You can launch Sterling Business Center from the Quick Access screen of 
Sterling Call Center and Sterling Store. Navigate to Tasks, and select 
Sterling Business Center. The Sterling Business Center home page is 
displayed.

For information about configuring items and pricing in Sterling Business 
Center, see the Sterling Business Center: Pricing Administration Guide 
and the Sterling Business Center: Item Administration Guide.

Note: By default, the Related Tasks panel is hidden when 
Sterling Business Center is launched. To display the 
Related Tasks panel, click the Maximize icon that is located 
at the top right of the Sterling Business Center home page. 
To restore the original view of the Sterling Business Center 
home page, click the Restore icon.
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3
Tasks for a Store Representative

The role of a store representative is to capture and maintain an order 
through the Sterling Store application. The store representative typically 
deals directly with the customer and takes action on an order in response 
to a customer visiting the customer service counter at the store.

The Sterling Store application provides keyboard shortcuts using which 
the store representative can easily execute tasks. For more information 
about using keyboard shortcuts, see Chapter 1, "Using the IBM Sterling 
Call Center and IBM Sterling Store Dialogs and Windows".

A store representative may frequently be:

Performing Search Tasks

Answering Frequent Queries

Performing Order Tasks

Performing Opportunity and Quote Tasks

Performing Fulfillment Tasks

Performing Price Match Tasks

Performing Other Tasks on an Order

Performing Customer Tasks

Performing User Management Tasks

Performing Return Order Tasks

Performing Order Print Tasks

Performing Alert and Queue Management Tasks

Performing Announcement Tasks



268   User Guide

Performing Search Tasks

Setting User Preferences

Viewing the Documentation Library

Performing Reports Tasks

Performing In-Store Pick up Tasks

User Security

Launching the IBM Sterling Business Center

3.1 Performing Search Tasks
This task assumes that you need to take some action on an existing 
order or item in Sterling Call Center and Sterling Store. A customer may 
walk into the store to inquire about the order placed at the store. 
Generally, the customer knows the order number or has more 
information to help you locate the order or item.

3.1.1 Searching for an Order
If you know the order number, telephone number, or the e-mail address 
of the customer, use the Quick Access screen to directly navigate to the 
order. For more information about searching for an order, see 
Section 2.1.1, "Searching for an Order".

3.1.1.1 Performing an Advanced Order Search
Using additional options, you can make your order search more precise 
and view more information about the order number, customer’s 
telephone number, or the customer’s e-mail address. For more 
information about performing an advanced order search, see 
Section 2.1.1.1, "Performing an Advanced Order Search".

Using Sterling Call Center and Sterling Store application, you can search 
for existing draft orders and orders that were created in your store. Draft 
orders are orders in the process of being entered that have not been 
confirmed.

To search for draft orders:

1. To search for draft orders, enter the appropriate search criteria in the 
Advanced Order Search screen and check the Show only draft orders 
box.
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2. To search for draft orders in your store, enter the appropriate search 
criteria and check the Show orders created in this store only box and 
check the Show only draft orders box.

3. Click Search. Based on your search criteria, in the Order List panel 
you can view a list of draft orders.

3.1.2 Searching for a Customer
If you know the customer's e-mail address, ID, phone number or the 
name of the business in case of a business customer, you can use the 
Quick Access screen to directly navigate to the customer.

To search for a customer:

1. In the Quick Access screen, select the customer type.

2. Enter the customer's e-mail address, user ID, phone number or the 
name of the business in case of a business customer.

3. Click Find Customer.

If a single customer exists for the search criteria you entered, the 
Customer Details screen is displayed.

If multiple customers exist for the search criteria you entered, the 
Customer Search screen is displayed. Enter the appropriate 
information in the Customer Search Criteria panel. Click Search. 
The Customer List screen is displayed. Double-click the 
appropriate Customer. The Customer Details screen is displayed. 
For more information about viewing customer details, see 
Section 3.1.2.2, "Viewing Customer Details".

3.1.2.1 Performing an Advanced Customer Search
If you do not know the complete details of a customer such as the 
customer's id, phone number or e-mail address you can perform an 
Advanced Customer Search.

To perform an advanced customer search:

1. From Tasks > Search, select Advanced Customer Search.

2. Select the organization from the drop-down list.

Enter the appropriate search criteria and click Search. The search 
results are displayed in the Customer Search Results panel. If you 



270   User Guide

Performing Search Tasks

cannot find the right customer, click  icon to show the search 
criteria. You can enter more restrictive search criteria for the selected 
task.

3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

4. Double-click the appropriate customer record. The Customer Details 
screen is displayed. For more information about viewing the customer 
details, see Section 3.1.2.2, "Viewing Customer Details".

3.1.2.2 Viewing Customer Details
You can view the details of consumer customers and business customers.

Viewing Consumer Customer Details
In the Customer Details screen, you can view the details of the customer 
such as the customer's name, ID, e-mail address, phone number, date of 
birth, bill to address and ship to address.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 

Note: The Draft Orders, Order History, Return History, 
Opportunities, and Quote History tabs support pagination.
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The customer's name, login ID, and status are displayed in the top 
panel.

In the Contact Information panel, you can view the customer's e-mail 
address, mobile phone number, day phone number, day fax number, 
evening phone number, evening fax number, date of birth, spouse's 
date of birth, and wedding anniversary.

In the Bill To Address panel, you can view the details of the 
customer’s bill to address.

In the Ship To Address panel, you can view the ship to address to 
which orders for this customer will be sent.

In the Draft Orders tab, you can view all the draft orders that exist 
for the customer.

The Channel column indicates whether the orders were created (or 
last modified) in the Web or Call Center. To modify or confirm a draft 
order, double-click the appropriate record in the list of draft orders.

In the Order History tab, you can view the details of previous orders 
created for the customer. You can filter the list of orders by hold type 
and status. To filter by hold type, select a hold type from the Hold 
Type drop-down list, and click the Search button. To filter by status, 
select either Open, Backordered, or Shipped, and click the Search 
button. You can click the View History Orders hyperlink to retrieve 
orders from the history table. You can click the View Recent Orders 
hyperlink to switch back to recent records.

In the Return History tab, you can view the details of the return 
orders that were created for the customer.

In the Opportunities tab, you can view the details of the opportunities 
that were created for the customer.

In the Quote History tab, you can view details of all the quotes that 
were created for the customer. You can filter the list of quotes based 
on hold type and/or status. To filter by hold type, select a hold type 
from the Hold Type drop-down list, and click the Search button. To 

Note: Login cannot be changed after it has been entered 
and saved.
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filter by status, select either the Open, Closed, or All Quotes, and 
click the Search button.

Open displays quotes that have neither been abandoned nor 
converted to orders.

Closed displays quotes that have either been abandoned or 
converted to orders.

All Quotes displays all the quotes that have been created for the 
customer up-to-date.

In the Addresses tab, you can view the additional addresses of the 
customer. Address descriptions, if any, will be displayed in the shaded 
panels above the addresses.

In the Payment Methods tab, you can view the details of the payment 
methods assigned to the customer.

In the Important Notes panel, you can view and add additional 
information about the customer. For more information about viewing 
or adding notes, see Section 2.8.12, "Viewing and Adding Customer 
Notes and Contact Notes".

Viewing Business Customer Details
In the Business Customer Details screen, you can view the details of the 
business customer, such as the customer's name, ID, bill to address, and 
ship to address.

The customer’s business name, customer ID, and status are displayed 
in the top panel. You can click on the customer’s business name to 
access the customer’s Web site, if available, which will open in the 
default browser.

Note: The Payment Methods panel is displayed based on 
the configuration.

Note: The Draft Orders, Order History, Return History, 
Opportunities, and Quote History tabs support pagination.
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In the Bill To Address panel, you can view the details of the 
customer’s bill to address.

In the Ship To Address panel, you can view the ship to address to 
which orders for the customer will be sent.

In the Sold To Address panel, you can view the address details of the 
buyer. 

In the Contacts tab, you can view the list of contacts that exist for 
the business customer. To view details about a contact, either 
double-click a contact in the list, or click the View Contact Details 
hyperlink in the details panel.

In the Draft Orders tab, you can view all the draft orders that exist 
for the customer.

The Channel column indicates whether the orders were created (or 
last modified) in the Web or Call Center. To modify or confirm a draft 
order, double-click the appropriate record in the list of draft orders.

In the Order History tab, you can view the details of previous orders 
created for the customer. You can filter the list of orders by hold type 
and status. To filter by hold type, select a hold type from the Hold 
Type drop-down list, and click the Search button. To filter by status, 
select either Open, Backordered, or Shipped, and click the Search 
button. You can click the View History Orders hyperlink to retrieve 
orders from the history table. You can click the View Recent Orders 
hyperlink to switch back to recent records.

In the Return History tab, you can view the details of the return 
orders that were created for the customer.

Note: If the status of the parent business customer 
changes to Inactive or On Hold, the status of the business 
customer and business customer contacts also changes to 
Inactive or On Hold, as appropriate. 

Note: Customer ID and Login cannot be changed after 
they have been entered and saved.
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In the Opportunities tab, you can view the details of the opportunities 
that were created for the customer.

In the Quote History tab, you can view details of all the quotes that 
were created for the customer. You can filter the list of quotes based 
on hold type and/or status. To filter by hold type, select a hold type 
from the Hold Type drop-down list, and click the Search button. To 
filter by status, select either the Open, Closed, or All Quotes, and 
click the Search button.

Open displays quotes that have neither been abandoned nor 
converted to orders.

Closed displays quotes that have either been abandoned or 
converted to orders.

All Quotes displays all the quotes that have been created for the 
customer up-to-date.

In the Addresses tab, you can view the additional addresses of the 
customer. Address descriptions, if any, will be displayed in the shaded 
panels above the addresses.

In the Payment Methods tab, you can view the details of the payment 
methods assigned to the customer.

In the Child Customers tab, you can view the list of child customers 
belonging to the current customer. To view a child customer’s details, 
double-click the child customer. To view the parent customer’s details, 
click the Parent Customer hyperlink.

In the Important Notes panel, you can view and add additional 
information about the customer. For more information about viewing 
or adding notes, see Section 2.8.12, "Viewing and Adding Customer 
Notes and Contact Notes".

3.1.2.3 Viewing Customer Contact Details
You can view the consumer contact details directly from the Consumer 
Details screen.

Note: The Payment Methods panel is displayed based on 
the configuration.
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To view the contact details pertaining to a business customer, double- 
click a contact in the Contacts list of the Business Customer Details 
screen or click the View Contact Details hyperlink in the contact 
information display panel. The Contact Details screen is displayed.

In the Contact Details screen, you can view the following details 
pertaining to the customer contact, such as the contact’s name, ID, bill 
to address, and ship to address:

The contact’s name, ID, and status are displayed in the top panel.

In the Contact Information panel, you can view the contact’s e-mail 
address, day phone number, evening phone number, day fax number, 
evening fax number, mobile phone number, job title, department, 
date of birth, spouse’s date of birth, wedding anniversary, and 
spending limit.

In the Bill To Address panel, you can view the details of the contact’s 
bill to address.

In the Ship To Address panel, you can view the details of the 
contact’s ship to address.

In the Sold To Address panel, you can view the details of the 
contact’s sold to address.

The panel below the address panels displays information about the 
approving user and backup approver. 

An approving user can approve an order for a contact who has 
exceeded his or her spending limit. A backup approver can approve 
orders for the contact if the contact is unavailable.

In the Important Notes panel, you can view and add additional 
information about the customer contact. For more information about 
viewing or adding notes, see Section 2.8.12, "Viewing and Adding 
Customer Notes and Contact Notes". 

3.1.3 Searching for an Item
If you know the identifier, description, or the manufacturer’s name of the 
item you are searching for, you can use the Quick Access screen to 
directly navigate to the item. You can also search for items based on 
specification.

To search for an item:
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1. In the Quick Access screen, enter the complete identifier for the item, 
partial description of the item, or the complete name of the item 
manufacturer.

2. Click Find Item. 

If a single item exists that matches your search criteria, the Item 
Detail screen is displayed.

If multiple items exist that match your search criteria, the Item 
Search screen is displayed with a list of product items.

If the search criteria does not match with any item, the Advanced 
Item Search screen is displayed. Click  icon to show the search 
criteria. You can enter more restrictive search criteria for the selected 
task. Based on the configuration, either the Search Through All Items 
panel or the Search Items Currently Being Sold panel is displayed in 
the Advanced Item Search screen. If the Advanced Item Search 
screen is configured to allow the both the panels, the Search Through 
All Items panel is displayed and a Switch To Search Through All Items 
hyperlink is displayed which will allow you to switch between both the 
panels.

Search Through All Items Panel

In the Search Through All Items panel, you can search for items 
using the identifier of the item or the alternate identifier, description 
of the item, or the manufacturer’s name of the pertinent item.

Search Items Currently Being Sold Panel

In the Search Items Currently Being Sold panel, you can search for 
items based on the enterprise. Select an enterprise from the 
Enterprise drop-down list. You can enter a search criteria for the 
item, specify a price range, and also search for items based on 
entitlements.

You can search for the items using the Bar Code scanning. When the 
store representative scans any item using the barcode scanner, the UPC 
code is populated in the Item Id field. Using this information, the store 
representative can search for more details about the item.

When you select an item from the Item List panel, you can view the 
details of the item in the Item Details panel. To add the item to the order, 
select Add To Order.
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3.1.3.1 Viewing the Product Item Details
In the Item Detail screen, you can view the details of an item such as the 
extended description of the item, price, manufacturer or brand 
information, and so forth.

1. In the Availability panel, you can view the quantity of the item 
available at the store. You can also view information whether the item 
is available for Delivery or Pick Up. If pick up is allowed for an item, 
the pick up date is displayed.

2. If the customer wants to view the availability of the item at other 
stores, click the View Nearby Stores For Availability hyperlink. The 
Details of Near-By Stores screen is displayed.

a. Enter the postal code of the area from where you need the item.

b. Click Search. You can view a list of all stores where the item is 
available. You can also view the store address and the 
approximate distance of the store from the current location.

3. In the Promotions panel, you can view all promotions associated with 
the item. For more information about promotions, click the hyperlink 
in the Short Description column.

4. If the customer wants to create an order for the selected item, click 
Create Order.

5. If you want to view more details about the item, click More Details. 
The More Details of Selected Item screen is displayed.

6. If you are viewing the details of a model item, the View Style Items 
hyperlink is displayed. Click this hyperlink to select an item’s style. 
For more information about selecting an item’s style, see 
Section 3.3.1.3, "Selecting an Item’s Style".

Note: If the 
YCD_NO_AVAILABILITY_CHECK_IN_ITEM_INQUIRY rule is 
set to "Y", the Availability column does not display, and 
therefore, you cannot check the item availability.

Note: The availability of the bundle parent item depends 
on the availability of the bundle component items.
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7. If the Sterling Call Center and Sterling Store application is configured 
to display the URL of a product Web page pertaining to an item, the 
View Product Web Page hyperlink is displayed. Click the View Product 
Web Page hyperlink to view the Web site providing details of the item.

8. If you want to add the item to the order, click Add to Order.

3.1.3.2 Viewing the Service Item Details
In the Service Item Details screen, you can view the details of provided 
services such as the service description, price, UOM, and the availability 
of the service item.

To view the details of a service item:

1. In the Availability panel, select the country or region name from the 
drop-down list from where the customer wants to check the 
availability of the service item and enter the postal code.

2. Click Check Availability. If the service is available, the message "This 
location can be serviced" is displayed. Click the View Calendar 
hyperlink. You can view the service appointments.

3. In the Promotions panel, you can view all promotions associated with 
the service item. For more information about promotions, click the 
hyperlink in the Short Description column.

4. If you want to create an order for the selected item, click Create 
Order. 

5. If you want to add service items to the order, click Add to Order.

3.1.3.3 Viewing More Details of the Selected Product Items
You can view more details of the selected product items.

To view more information about the item’s accessories, click the 
Accessories tab. You can view the identifier of the item or the 
alternate item, the item’s description, associated quantity, and the 
unit price of all accessories associated with the item.

To view the bundle component item details, click the Component 
Details tab. You can view the bundle component items, item’s 
description, and the bundle item kit quantity.

To view the kit details, click the Kit Details tab. You can view the 
kit components, item’s description, and the kit quantity.
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To view the item’s specifications, click the Specifications tab.

To view the items for upsell, click the Upsell tab. You can view the 
identifier of the item or the alternate item, item’s description, 
associated quantity, and the unit price of all items available for 
upsell.

To view the items for substitutions, click the Substitutions tab. 
You can view the identifier of the item or the alternate item, 
item’s description, associated quantity, and the unit price of all 
items available for substitutions.

To view the service options of an item, click the Service Options 
tab. You can view the identifier of the service item, item’s 
description, associated quantity, whether the service scheduling 
must be held until the item is delivered, the service time offset in 
hours (difference between provided service and product delivery), 
and the unit price of all the services available for the item.

To view the instructions pertaining to an item, click the 
Instructions tab. You can view the sequence number of the 
instructions, the instruction type, and the instructions pertaining 
to the item.

3.1.3.4 Performing an Advanced Item Search
If you do not know the complete details about an item such as the 
identifier of the item or the alternate item, the item’s description, or the 
manufacturer’s name, you can perform an advanced item search.

To perform an advanced item search:

1. Do one of the following to open the Item Search screen:

From Tasks > Search, select Advanced Item Search.

In the Quick Access panel, click Find Item.

In the Item List panel, you can view the item ID, description, 
available quantity, and the unit price of all items.

2. Select an item in the Item List panel to view more information about 
the item in the Item Details panel.

If you select a product, you can view the identifier of the item, 
item’s description, unit of measure, availability, and unit price. 
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If you select an independent service, you can view the identifier of 
the item, item’s description, unit of measure, and unit price.

If you cannot find the items that you are searching for, click  icon 
to show the search criteria. You can enter more restrictive search 
criteria for the selected task.

3. Choose any one of the following and click Search: 

Products—Provides a list of items

Independent Services—Provides a list of services

Both—Provides a list of items and services

4. If you are unable to find the pertinent items, click Show Search 
Criteria to enter more restrictive search criteria.

5. If you select a model item and click the Add to Order button, the 
Style Items pop-up window is displayed. For more information about 
selecting an items style, see Section 3.3.1.3, "Selecting an Item’s 
Style".

6. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

7. Double-click on the required item to view the item details.

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 
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3.1.4 Viewing Order Summary
A customer may have some queries or may request some changes on an 
order that is already placed. In such situations, you may want to view 
the order details before performing any task.

Navigate to the Order Summary screen. In the Origin Store field, you can 
view the store in which the order was created. If an order line has a note 
associated with it, the  icon is displayed in the order line table. Click 
this icon to view the order line notes.

For more information about viewing the summary of an order, see 
Section 2.1.4, "Viewing Order Summary".

3.1.4.1 Viewing the Order Line Summary
To view the order line summary, from the Order Summary screen, 
right-click on an order line and select View Line Summary. The Line 
Summary screen is displayed. For more information about viewing the 
order line summary, see Section 2.1.4.1, "Viewing the Order Line 
Summary".

In the Important Notes panel you can view any important notes that are 
added on that order line. To add notes to that order line, click the 
View/Add Notes hyperlink. The Order Line Notes screen is displayed. For 
more information about adding order line notes, see Section 3.3.12, 
"Adding Notes to an Order".

3.1.5 Performing an Advanced Return Order Search
Using additional options, you can make your return order search more 
precise and view more details of the return such as the return order 
number, original order number, customer ID.

To perform an advanced return search:

1. From Tasks > Search, select Advanced Return Search. The Return 
Search screen is displayed.

In the Return Order Search Criteria panel, enter the appropriate 
search criteria. Select an option from the Order By drop-down list 
based on which the records will be sorted. Select Ascending or 
Descending from the adjacent drop-down list and click Search. The 
search results are displayed in the Recent Return Order List panel. If 
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you cannot find the pertinent order number, click  icon to show the 
search criteria. You can enter more restrictive search criteria for the 
selected task.

2. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed. Click the View History Records hyperlink to 
retrieve return orders from the history table. You can click the View 
Recent Records hyperlink to switch back to recent records. The total 
number of records displayed in a single page is based on pagination 
rules configured. Click the Get Total Record Count hyperlink to view 
the total number of records returned for the search criteria.

3. Double-click the appropriate order number. The Return Order 
Summary screen is displayed. For more information about viewing 
the return order summary details, see Section 3.1.5.1, "Viewing 
Return Order Summary".

3.1.5.1 Viewing Return Order Summary
In the Return Order Summary screen, you can view the details of a 
return order such as the primary details of the return order, refund to 
address, return from address, details of the corresponding exchange 
order.

1. In the Primary Details panel, you can view the return order number, 
order status, return order date, total refund amount, channel through 
which the items will be returned. If the order or any of the order lines 
are on hold, the  icon is displayed. To view and resolve holds, click 
the  icon. For more information about resolving order holds, see 

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again.
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Section 3.3.5, "Removing Holds". The provided service line is 
displayed as a service line.

2. In the Refund To panel, you can view the details of the customers 
address.

3. In the Return From panel, you can view the address from where the 
items are being returned.

4. In the Exchange Order Details panel, you can view the details of the 
exchange order such as the exchange order number, status, total 
exchange amount and the exchange type.

5. In the Order Lines panel, you can view the original order number, 
item ID, unit price, quantity, return method and status of each line.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

To track the item, right-click on the item and select Track This Item. 
For more information about tracking an item, see Section 3.3.11, 
"Tracking an Item or Inquiring About a Shipment".

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

You can also view the indicator icons associated with the items, if 
applicable. Place your cursor on these icons to view their purpose.

3.1.5.2 Viewing the Return Order Line Summary
To view the return order line summary or provided service line 
information, right-click the corresponding return order line in the Return 
Order Summary screen, and select View Line Summary. The Line 
Summary screen is displayed. The following information is displayed in 
this screen:

Primary Details—This panel displays the line number, item identifiers, 
item description, service, status, display status, quantity, and the unit 
price of an item. The  icon is displayed if the order line is on hold. 
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This panel also indicates if the item is an open box or a gift item or 
both. The other details displayed in the screen are:

– If the fulfillment method is Delivery or Shipping, the ship node is 
displayed.

– If the fulfillment method is Pick Up, the store is displayed. Clicking 
the store hyperlink displays the Store Details window.

If the Sterling Call Center and Sterling Store application is configured 
to display the URL of a product Web page pertaining to an item, the 
View Product Web Page hyperlink is displayed. Click the View Product 
Web Page hyperlink to view the Web site providing details of the item.

The gift message is displayed if the user has included a message for 
the gift item.

Ship To Address—You can view the ship to address for a return order 
line in this panel.

Components—You can view the bundle component details such as 
bundle component items, item’s description, status, and the 
component quantity in this panel.

Pricing—You can view the extended price, taxes applied, and the line 
total. If the item has been price matched, or if the item price has 
been overridden, you can also view these details in this panel. This 
panel also displays charge breakup and tax breakup information, if 
applicable.

Important Events—You can view cancelled, reshipped, or returned 
information, if any, for the order line. If there are no important 
events for the order line, the message "No important event occurred 

Note: To display item aliases in the Line Summary 
screen, configure the Item Alias to Use for the Alternate 
Item ID rule. For more information about configuring the 
rules for alternate item identifiers, see the Sterling Call 
Center and Sterling Store: Implementation Guide.

Note: The Components panel is displayed only when you 
are viewing the return order line summary of bundle items.
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on this line" is displayed. The  icon is displayed if a stop delivery 
request has been placed.

You can also view the indicator icons associated with items, if applicable. 
Place your cursor on these icons to view their purpose.

3.1.6 Searching for an Opportunity
You can search and view the details of an opportunity. You may 
sometimes want to see the details of an opportunity, such as the 
opportunity status, the date on which the opportunity is expected to be 
closed, the notes added to the opportunity, and so on. For more 
information about searching for an opportunity, see Section 2.1.6, 
"Searching for an Opportunity".

3.1.7 Searching for a Quote
You may sometimes want to view a quote’s summary, such as the quote’s 
status, the items added to the quote, and so on. For example, if a user 
presents a quote to a customer, and if the customer neither accepts nor 
rejects the quote for a considerable period of time, the user may want to 
know the quote’s expiration date so that the user can follow it up with 
the customer. For more information about searching for a quote, see 
Section 2.1.7, "Searching for a Quote".

3.2 Answering Frequent Queries
This section contains some of the questions commonly asked by the 
customers and provides the answers to these questions.

Customers may call you and ask:

Where is my shipment?

Why was I charged?

Why wasn’t I refunded?

How much will I be refunded?

Have you received my returns?

Where are my exchange items?
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3.3 Performing Order Tasks
You can perform several tasks on an order placed by a customer. Some 
of the general tasks that you can perform on an order are:

Creating an Order

Canceling an Order

Viewing and Confirming the Payment Details

Applying Hold

Removing Holds

Creating Store Returns

Initiating a Return

Adding Order Lines

Adding Open Box Items

Increasing Order Line Quantity

Tracking an Item or Inquiring About a Shipment

Adding Notes to an Order

Adding or Modifying Charges

Scheduling and Releasing an Order

Viewing Procurement Orders

Exempting an Order from Tax

Copying a Draft Order

Ordering Again

E-mailing Order Information

Transferring a Draft Order to IBM Sterling Web

Launching the Applications Manager

3.3.1 Creating an Order
This feature helps you to identify a customer and create an order for that 
customer. You can enter multiple order lines for an order, modify 
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fulfillment options and appointments, and confirm the payment 
information as requested by the customer.

A navigation bar is displayed at the bottom of all the screens in the order 
creation task flow. This helps you to clearly understand the sequence of 
steps you have to perform to complete the entire task. The navigation 
bar also enables you to revisit the previous screens, move to the next 
screen, or close the Order Entry screen. 

When performing any of the steps in the order creation task flow, you 
have the option of clicking the Close button to close the Order Entry 
screen before confirming the corresponding order. Before the Order Entry 
screen closes, the Confirm pop-up window is displayed.

If there are any changes made to the order that have not been 
saved, perform one of the following actions:

– Enter a name for the order and click Save Changes to save the 
name and any other changes made to the order.

– Click Discard Changes to discard the changes made to the order.

– Click Cancel to remain on the Order Entry screen. 

– Click Delete Draft Order to delete the order.

If you have not made any changes to the order, perform one of the 
following actions:

– Enter a name for the order and click Confirm to save the draft 
order name. 

– Click Cancel to remain on the Order Entry screen.

– Click Delete Draft Order to delete the draft order. 

To create an order:

1. From Navigator > Order, select Create Order or from Tasks > Order, 
select Create Order. The Select Enterprise screen is displayed. Select 
the appropriate enterprise from the drop-down list.

2. Click Confirm. The Create Order: Customer Identification-Ship To 
Address screen is displayed.

3. Click Skip this Page if:

The customer intends to pick up the items at the store 
immediately.
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You want to capture the customer information only after 
confirming the inventory availability.

4. If you have launched this task in the context of a business customer:

To create a new contact, click the Add New Contact hyperlink. The 
Add Contact pop-up window is displayed. For more information 
about creating a new contact, see Section 3.3.1.1, "Adding a New 
Contact".

Select the contact from the Select a Contact drop-down list. 

The Ship To Address, Bill To Address, and Sold To Address are 
displayed. 

If you want to change any of the addresses, click the Change 
hyperlink. The Modify Address pop-up window is displayed. For 
more information about modifying an address, see 
Section 2.3.2.3.2, "Modifying an Address".

To exempt the order from tax, perform the following actions in the 
Customer Options panel:

– Select the Allow Tax Exemption check box.

– In the Tax Exemption Code field, enter the Tax Exemption 
Code of the order. 

– From the Currency drop-down list, select the currency.

Note: Based on how Sterling Call Center and Sterling 
Store is configured, you may be able to search for 
customers based on their type.

Note: If the customer or contact does not have default 
addresses or payment methods defined, the default 
addresses or payment methods for the closest customer in 
the customer hierarchy will be used.
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5. If you have launched this task in the context of  a consumer 
customer:

The Bill To Address and Ship To Address are displayed.

If you want to change any of the addresses, click the Change 
hyperlink. The Modify Address pop-up window is displayed. For 
more information about modifying an address, see 
Section 2.3.2.3.2, "Modifying an Address".

6. If this task is not launched in the context of a customer: To search for 
a customer: In the Find Existing Customer panel, do any of the 
following.

Enter the daytime telephone information.

Enter the e-mail address of the customer.

Enter the last name and first name of the customer.

Enter the last name and first few numbers of the postal code of 
the customer.

Enter the first name and first few numbers of the postal code of 
the customer.

7. Click Search.

If more than one customer is found as a result of your search, a 
list of customer information is displayed. Select the appropriate 
customer information from the list.

If customers are not found as a result of your search, the 
following message is displayed: "Your search found zero results".

If more than fifteen customers are found as a result of your 
search, the following message is displayed: "Your search resulted 
in more than 15 matches. Please refine your search criteria". In 
such situations, you need to enter more restrictive search 
information.

Note: The Currency drop-down list is displayed only when 
multiple currencies are defined for the customer.
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8. In the Customer Ship To Address panel, you can modify the Primary 
Info, Street Address, and Contact Information of the customers, if 
applicable.

9. If the Bill To Address of the customer is same as the Ship To Address, 
check the "Use As Bill To Address" box.

If you want to override address verification, check the Override 
Address Verification box.

If you do not want to override address verification and the 
address verification fails, the message "This is not a valid 
Address" is displayed.

10. Click Next.

If the status of the customer or contact is Inactive, an Invalid 
Customer or Contact pop-up window is displayed. The order 
cannot be created until the status of the customer or contact has 
been changed to Active.

You can change the status of a consumer customer in the Manage 
Contact Information screen, and you can change the status of a 
business customer in the Manage Customer Information screen.

If the Bill To address is not the same as Ship To address, the 
Customer Bill To Address screen is displayed. Enter the 
appropriate Bill To Address information.

If the order already contains items and if the customer is not 
entitled to any of these items, an error message is displayed.

Note: When the status of a parent business customer 
changes to Inactive or On Hold, the status of the business 
customer and business customer contacts also changes to 
Inactive or On Hold, as appropriate.

Note: If the Bill To Address of the customer is the same 
as the Ship To Address, and if you have not checked the 
"Use As Bill To Address" box in the Customer Ship To 
Address panel, you can check this box in the Customer Bill 
To Address screen.
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Based on the configuration, you will see one of the following screens:

Add Items screen, with panels for each order line.

Large Order Item Entry screen, with a table which is designed to 
handle large number of items.

 

If the application is configured to display the Add Items screen:

11. To search for an item, in the Item column, click the  icon. The 
Advanced Item Search screen is displayed. You can add the item to 
the order in one of the following ways:

Scan the barcode of the item or the alternate item.

In Item ID, enter the identifier of the item or scan the alternate 
item identifier.

If you have already added an item to the order, click the item 
name hyperlink. The Item Details screen is displayed. For more 
information about viewing the item details, see Section 3.1.3, 
"Searching for an Item".

– If the item’s effective date has expired and the item has an 
associated item that has been configured to substitute it, a 

Note: The application can be configured to either display 
the Large Order Item Entry screen always, or when the 
number of order lines exceeds a preconfigured number, or 
not at all.

Note: If the customer information is not captured initially, 
the postal code is displayed as a panel on top of the 
screen. This enables you to enter the postal code and 
check for the item availability.

Note: If the order is an existing draft order, an error 
message is displayed if any of the items, or the quantity of 
any of the items in the order fails validation. 
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confirmation pop-up window is displayed. Click Yes to add the 
new item to the order. 

– If the item fails validation, the following error message is 
displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."

Click OK. The screen is refreshed and a message is displayed 
in the Error panel below the order line, indicating why the 
order line failed validation. If it failed validation because it did 
not meet the minimum order quantity criteria or the maxi-
mum order quantity criteria, you can override the quantity by 
selecting the Override <Minimum or Maximum> order quan-
tity validation for this item check box. 

12. To delete a particular order line, click the  icon adjacent the 
corresponding order line. A confirmation pop-up window is displayed. 
Click Yes if you want to delete the order line. If the order line has 
related lines associated with it, the order line and the related lines 
associated with it are immediately deleted.

13. To add order line notes, click the  icon associated with the order 
line. For more information about adding order line notes, see 
Section 2.3.4.1, "Adding Notes to an Order Line".

14. You can add related product or service items to an order or you can 
replace the items in an order through a pop-up or a panel based on 
the configuration. For more information about adding related items or 
substituting items, see Section 3.3.1.2, "Adding Related Items or 
Replacing Items".

15. To view the components of a bundle item, click the View Components 
( ) button. The Bundle Components pop-up window is displayed. 

Note: The user can search for products, services or both 
products and services on the Advanced Item Search 
Screen. When searching for services or both products and 
services, the results display both independent and 
non-independent services. Non-independent services 
cannot be added to an order from the Item Inquiry 
Screens.
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You can view the details of the item, such as Item ID, Description, 
and Kit Quantity of the bundle components. Click Close to close the 
Bundle Components pop-up window. However, if the item is a 
configurable bundle item, perform the following tasks:

If the item is a preconfigured bundle item, you do not have to 
manually configure the item. However, if you want to reconfigure 
the item, click the Reconfigure ( ) button. The Product 
Configurator pop-up window is displayed where you can view the 
components of the preconfigured bundle item and reconfigure the 
item, if needed.

If the item is not a preconfigured bundle item, click the 
Configurable Bundle ( ) button to open the Product 
Configurator pop-up window and configure the item.

16. If you enter partial Item ID of a model item or a stylized item, the 
Style Items pop-up window is displayed. For more information about 
selecting an item’s style, see Section 3.3.1.3, "Selecting an Item’s 
Style". If you scan or enter the item ID of a stylized item, the stylized 
item is added to the order.

17. In the Quantity column, enter the required item quantity.

18. In the UOM column, select the UOM for the item from the drop-down 
list. If a UOM does not exist for an item or if only one UOM exists, 
this column is not editable.

19. In the Unit Price column, you can view the unit price and list price of 
the item. The prices shown are according to the Ordering UOM.

After you update the order, the unit price of the bundle item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

Note: If an item is reconfigured, the fulfillment type and 
pricing information defined for the item will not be 
available until the configuration is completed.



294   User Guide

Performing Order Tasks

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

20. To override the price of an item, click the Override Price hyperlink. 
The Override Price for Item screen is displayed. To override the item 
price:

a. In Overridden Price, enter the new price of the item.

b. From the Reasons for Override drop-down list, select the 
appropriate reason.

c. In the Notes panel, enter any additional information, if applicable.

d. Click Close.

21. In the Fulfillment Method column, choose the appropriate fulfillment 
method. If the selected fulfillment method is not available, the 
message "Not Available" along with the  icon is displayed. The Pick 
Up, Ship, and Delivery buttons are enabled, and the item availability 
date is displayed next to these buttons. The availability date for:

Pick Up—displays the earliest date on which you can pick up the 
product from a store.

Ship—displays the earliest date on which you can ship the item.

Delivery—displays the earliest date on which the product is 
available.

The availability details do not display if the user interface is not 
configured to do so.

If you want the item to be shipped to the customer, choose Ship.

If you want the item to be delivered to the customer’s doorstep, 
choose Delivery.

Note: In case of the Delivery fulfillment method, the item 
availability date does not indicate the delivery 
appointment. It only indicates the date on which the 
product is available. You must take a delivery appointment 
at a later point. 
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If the customer wants to pick up the item from the current store, 
choose Pick Up.

If the customer wants to pick up the item from an alternate store, 
click the Choose Stores hyperlink. The More Stores screen is 
displayed. Select the appropriate store from where you want to 
pick up the item. The selected store is displayed next to the Pick 
Up option. For more information about viewing inventory in other 
stores, see Section 2.3.2.2, "Viewing Inventory in Other Stores".

If the order line has already been created for pick up from a store 
other than the one in which the order is created, and if you want 
to pick up the item from the same store, choose Pick Up from 
(Store Name).

If the order line is a service line, the information indicating 
whether or not you can perform the service for that line is 
displayed.

22. In the Line Total column, you can view the order line total.

If you are adding a new item, the  icon is displayed indicating 
that the order needs to be updated to view the line total. If there 
are any special charges or discounts applied to the item, you will 
not be able to view those charges or discounts until you update 
the order. For example, if there is a 50% discount on the unit 
price of the item, you will not be able to view the discount until 
you update the order. 

If you make changes to an item that has already been added to 
the order, the  icon is displayed next to the line total value, 
with the tooltip indicating that the order needs to be updated to 
view the line total. 

The charges and discounts applied to the order line are displayed 
as hyperlinks. Click the charges value hyperlink to view the 
charges applied to the order line or click the discounts value 
hyperlink to view the discounts applied to the order line. If the 
order line has been modified so that the line total is not current, 
the order is updated and the Line Charges or Line Discounts 
pop-up window is displayed. You can view the charges or 
discounts applied to the order line. Click Close. 

23. To add more lines to the order, click the Add More Lines hyperlink.
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24. To add new service lines, click the Add Independent Services 
hyperlink. The Item Search screen is displayed. Select the service you 
want to add. The service line is added and indicated by the  icon. 
For more information about performing an advanced item search, see 
Section 3.1.3.4, "Performing an Advanced Item Search"

25. To add an open box item, click the Add Open Box Item hyperlink. For 
more information about open box items, see Section 3.3.9, "Adding 
Open Box Items".

26. To view the price breakdown of the order, click the value of the 
Subtotal that is displayed as a hyperlink. The Order Pricing Summary 
pop-up window is displayed. You can view the details of the prices 
applied to the order, such as the order line prices, line-level price 
adjustments resulting from charges and discounts applied to the 
order lines, order total, order-level price adjustments, order-level 
shipping charges, and taxes on the order. 

To view the charges and discounts applied to an order line, click 
the corresponding Adjustments value that is displayed as a 
hyperlink. The Line Charges and Discounts pop-up window is 
displayed. Click Close.

To view the charges and discounts applied to an order, click the 
Order Adjustments value that is displayed as a hyperlink. The 
Order Charges and Discounts pop-up window is displayed. Click 
Close.

27. To view the updated unit price and line total details, click the Update 
Order button. The screen is refreshed, order lines are sorted 
alphabetically based on the Item ID, and the updated unit prices, and 
the order line total are displayed.

28. Click Next. If the order contains an item that has been replaced by 
another item in the catalog, or if the quantity of any of the items is 
less than the minimum order quantity or more than the maximum 
order quantity that is configured for those items, the following error 
message is displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."

Click OK. The screen is refreshed and a message is displayed in the 
Error panel below the order line, indicating why the order line failed 
validation. If it failed validation because it did not meet the minimum 
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order quantity or the maximum order quantity criteria, you can 
override the quantity by selecting the Override <Minimum or 
Maximum> order quantity validation for this item check box.

If the application is configured to display the Large Order Item Entry 
screen:

29. To search for an item, in the Item column, click the  icon. The 
Advanced Item Search screen is displayed. You can add the item to 
the order in one of the following ways:

Scan the barcode of the item or the alternate item.

In Item ID, enter the identifier of the item or scan the alternate 
item identifier.

If you have already added an item to the order, click the item 
name hyperlink. The Item Details screen is displayed. For more 
information about viewing the item details, see Section 3.1.3, 
"Searching for an Item".

– If the item’s effective date has expired and the item has an 
associated item that has been configured to substitute it, a 
confirmation pop-up window is displayed. Click Yes to add the 
new item to the order. 

– If the item fails validation, the following error message is 
displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."

Click OK. The screen is refreshed, the  icon is displayed 
next to the order line, and an error message is displayed in 
the Selected Line Information panel, indicating why the order 
line failed validation. If it failed validation because it did not 
meet the minimum order quantity or the maximum order 
quantity criteria, you can override the quantity by selecting 
the Override <Minimum or Maximum> order quantity valida-
tion for this item check box. 

30. To delete a particular order line, click the  icon adjacent the 
corresponding order line. A confirmation pop-up window is displayed. 
Click Yes if you want to delete the order line.If the order line has 
related lines associated with it, the related lines are automatically 
selected for deletion along with the order line.
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31. To add order line notes, click the  icon associated with the order 
line. For more information about adding order line notes, see 
Section 2.3.4.1, "Adding Notes to an Order Line".

32. Click the  icon to add related product or service items to the order 
or to replace the items in the order. For more information about 
adding related items, see Section 3.3.1.2, "Adding Related Items or 
Replacing Items".

33. To view the components of a bundle item, click the View Components 
hyperlink. The Bundle Components pop-up window is displayed. You 
can view the details of the item, such as Item ID, Description, and Kit 
Quantity of the bundle components. Click Close to close the Bundle 
Components pop-up window. However, if the item is a configurable 
bundle item, perform the following tasks:

If the item is a preconfigured bundle item, you do not have to 
manually configure the item. However, if you want to reconfigure 
the item, click the Reconfigure hyperlink. The Product 
Configurator pop-up window is displayed where you can view the 
components of the preconfigured bundle item and reconfigure the 
item, if needed.

If the item is not a preconfigured bundle item, click the 
Configurable Bundle hyperlink to open the Product Configurator 
pop-up window and configure the item.

34. If you enter partial Item ID of a model item or a stylized item, the 
Style Items pop-up window is displayed. For more information about 
selecting an item’s style, see Section 3.3.1.3, "Selecting an Item’s 
Style". If you scan or enter the item ID of a stylized item, the stylized 
item is added to the order.

35. In the Quantity column, enter the required item quantity.

36. In the UOM column, select the UOM for the item from the drop-down 
list. If a UOM does not exist for an item or if only one UOM exists, 
this column is not editable.

Note: If an item is reconfigured, the fulfillment type and 
pricing information defined for the item will not be 
available until the configuration is completed.
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37. In the Unit Price column, you can view the unit price of the item.

After you update the order, the unit price of the bundle item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

38. In the Fulfillment method, you can view the default fulfillment 
method for the item.

If you are adding a new item, the "Update Order To View Line 
Total" message is displayed, indicating that the order needs to be 
updated to view the line total. 

The charges and discounts applied to the order line are displayed 
as hyperlinks. Click the charges value hyperlink to view the 
charges applied to the order line or click the discounts value 
hyperlink to view the discounts applied to the order line. If the 
order line has been modified so that the line total is not current, 
the order is updated and the Line Charges or Line Discounts 
pop-up window is displayed. Click Close.

39. In the Selected Line Information panel, you can view or modify the 
details pertaining to the selected order line.

You can view the following details pertaining to the order line:

Item information

Fulfillment method and availability (only for product items) 

Following is the list of information that the corresponding 
availability date displays:

– Pick Up displays the earliest date on which you can pick up the 
product from a store.

Note: The availability details are not displayed if the user 
interface is not configured to do so. 
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– Ship displays the earliest date on which you can ship the item.

– Delivery displays the earliest date on which the product is 
available.

If the fulfillment method is available for the order line, the 
appropriate option is enabled. If the fulfillment method is not 
available for the order line, the message "Not Available" is 
displayed along with the  icon. 

Information indicating whether you can perform the service or not 
(only for service items)

Price information

You can perform the following tasks on the order line that has been 
selected:

Modify Fulfillment Method

Select Store

Override Price

Change or Select an item’s style (only for stylized items)

Configure or Reconfigure Items (only for bundle items)

40. To modify the fulfillment method, select the appropriate option: 

To ship the item to the customer, select Ship.

To deliver the item to the customer’s doorstep, select Delivery.

If the customer wants to pick up the item from the current store, 
select Pick Up.

41. To pick up the item from a store other than the current store, click 
the Choose Store hyperlink. The More Stores screen is displayed. 
Select the appropriate store from where you want to pick up the 
item. The selected store is displayed next to the Pick Up option. For 

Note: In the case of the Delivery fulfillment method, the 
item availability date does not indicate the delivery 
appointment. It only indicates the date on which the 
product is available. You must take a delivery appointment 
at a later point of time. 
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more information about viewing inventory in other stores, see 
Section 2.3.2.2, "Viewing Inventory in Other Stores".

If the order line has already been created for pick up from a store 
other than the one in which the order is created, and if you want to 
pick up the item from the same store, select Pick Up from <Store 
Name>.

42. To override the price of an item, click the Override Price hyperlink. 
The Override Price for Item screen is displayed. To override the item 
price:

a. In Overridden Price, enter the new price of the item.

b. From the Reasons for Override drop-down list, select the 
appropriate reason.

c. In the Notes panel, enter any additional information, if applicable.

d. Click Close.

43. If the item is a stylized item, you can change the item’s style or 
select a style for the item: 

To change the item’s style, click the Change Style hyperlink. The 
Style Items pop-up window is displayed. For more information 
about changing an item’s style, see Section 3.3.1.3, "Selecting an 
Item’s Style".

To select a style for the item, click the Choose Style hyperlink. 
The Style Items pop-up window is displayed. For more 
information about selecting an item’s style, see Section 3.3.1.3, 
"Selecting an Item’s Style".

44. If the item is a bundle item, you can configure or reconfigure the 
item: 

To configure the item, click the Configure hyperlink. For more 
information about configuring an item, see the Sterling 
Multi-Channel Selling Solution Administration Guide. 

To reconfigure an item, click the Reconfigure hyperlink. For more 
information about configuring an item, see the Sterling 
Multi-Channel Selling Solution Administration Guide.

45. If the item has accessories, the Accessories panel is displayed where 
you can view details about the accessories. To add the accessories to 
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the order, click Add To Order. The Accessories panel is displayed only 
when the order line is selected.

46. To add an open box item, click the Add Open Box Item hyperlink. For 
more information about open box items, see Section 3.3.9, "Adding 
Open Box Items".

47. To add new service lines, click the Add Independent Services 
hyperlink. The Item Search screen is displayed. Select the service you 
want to add. The service line is added and indicated by the  icon. 
For more information about performing an advanced item search, see 
Section 3.1.3.4, "Performing an Advanced Item Search".

48. To view the price breakdown of the order, click the value of the 
Subtotal that is displayed as a hyperlink. If the line total is not 
current, the order is updated and the Order Pricing Summary pop-up 
window is displayed. You can view the details of the prices on the 
order, such as the order line prices, line-level price adjustments, 
order total, order-level price adjustments, order-level shipping 
charges, and taxes on the order. 

To view the line-level price adjustments resulting from charges 
and discounts applied to the order line, click the corresponding 
Adjustments value that is displayed as a hyperlink. The Line 
Charges and Discounts pop-up window is displayed. Click Close.

To view the order-level price adjustments resulting from charges 
and discounts applied to the order, click the Order Adjustments 
value that is displayed as a hyperlink. The Order Charges and 
Discounts pop-up window is displayed. Click Close.

49. To view the updated price details, click the Update Order button. The 
screen is refreshed, order lines are sorted alphabetically based on the 
item ID, updated unit prices, and order line total are displayed.

50. Click Next. 

If the order contains an item that has been replaced by another item 
in the catalog, or if the quantity of any of the items is less than the 
minimum order quantity or more than the maximum order quantity 
that is configured for those items, the following error message is 
displayed:

"Some of the items have errors that must be corrected. Please 
correct the errors in order to proceed."
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Click OK. The screen is refreshed, the  icon is displayed next to 
the order line, and an error message is displayed in the Selected Line 
Information panel, indicating why the order line failed validation. If it 
failed validation because it did not meet the minimum order quantity 
or the maximum order quantity criteria, you can override the quantity 
by selecting the Override <Minimum or Maximum> order quantity 
validation for this item check box. 

51. The Create Order: Change Fulfillment Options screen is displayed. For 
more information about choosing a fulfillment method, selecting an 
appointment, and viewing payment information, see Section 3.5.1, 
"Modifying Fulfillment Options".

52. Click Next. The Fulfillment Summary screen is displayed. For more 
information about the fulfillment summary details, see Section 3.5.2, 
"Fulfillment Summary".

53. Click Next. 

If order lines are being delivered on this order, the Service 
Appointment screen is displayed where you can create an 
appointment. For more information about creating an 
appointment, see Section 3.5.5, "Modifying Service 
Appointments".

If there are no order lines to be delivered, the Payment 
Confirmation screen is displayed. For more information about 
viewing and confirming payment details, see Section 3.3.3, 
"Viewing and Confirming the Payment Details".

If you are not required to enter the payment information, the 
Order Confirmation screen is displayed.

Note: The Fulfillment Summary screen is displayed only if 
the fulfillment method is either Shipping or Pick Up.

Note: If you have not captured the customer information, 
the Bill To Address screen is displayed for you to enter the 
billing details.
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Table 3–1 Order Confirmation Screen

For more information about configuring the payment options, see the 
Sterling Call Center and Sterling Store: Implementation Guide.

54. To view or modify the payment details for an order:

a. Click the View/Edit Order Payment Details hyperlink. The Order 
Payment Details screen is displayed. Modify the charge details at 
the order level or order line level.

b. Select the Charge Override Reason.

c. In the Notes panel, enter any additional information, if applicable. 
For more information about adding notes to an order, see 
Section 3.3.12, "Adding Notes to an Order".

d. Click Confirm to save the changes and return to the Payment 
Confirmation screen.

55. Click Confirm.

Note: The Order Confirmation screen is displayed only if 
you are not required to enter the payment information or if 
the payment methods are implemented using an external 
payment system. For field value descriptions, see 
Table 3–1, "Order Confirmation Screen".

Field Description

Print and Close Click this button to save notes added to the order, print 
the order information, and close the order tab.

Cancel Order Click this button to cancel the order.

Note: You can modify only the existing charges.
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3.3.1.1 Adding a New Contact
You can add a new contact for a business customer.

To add a new contact: 

1. In the Customer panel, click the Add New Contact hyperlink. The Add 
Contact pop-up window is displayed. 

2. Provide the corresponding information in the following panels, and 
click Confirm:

In the Customer Account panel, enter the first name and last 
name, middle initial, e-mail address, job title, and department of 
the contact.

In the Customer Contact Information panel, enter the contact’s 
evening phone number, evening fax number, day phone number, 
day fax number, and mobile phone number.

In the Personal Information panel, enter the appropriate dates. To 
select a date, click the  icon and then select the month, year 
and day.

In the Contact Spending Limit panel, select the currency and 
enter the spending limit for the contact. In addition, specify an 
approving user and a backup approver. An approving user can 
approve an order for a contact who has exceeded a spending 
limit. A backup approver can approve orders for the contact if the 
contact is unavailable.

In the Web User panel, create a web user by entering a login ID, 
and selecting the locale and status for the contact. When you 
include information in these fields, the contact is linked to this 
web user, and an e-mail containing the web user’s password is 
sent to the customer. In addition, you can select the user roles 
that you want to assign to this web user. User roles determine 
what a user can access on the web channel.

3.3.1.2 Adding Related Items or Replacing Items 
You can add related product or service items to an order or replace the 
items in an order through a pop-up or a panel.
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To add related items to an order or replace the items in an order through 
a pop-up:

1. Click the  icon. The Related Items pop-up window is displayed. 
You can view details such as the item description, item ID, unit price, 
associated quantity and the availability dates for Shipping, Pick Up, 
and Delivery. 

2. Select the check boxes next to the product or service items that you 
want to add to the order.

3. Click Add to Order. If the item that you added has been configured to 
replace the original item, the new item replaces the original item and 
its related items. 

The related item that you added is indicated by the  icon. The 
tooltip for the related item indicator displays the parent item 
description.

To add related product or service items to an order through a panel:

1. Place the cursor on the line for which related lines needs to be added. 
The Related Items panel is displayed at the bottom of the screen. You 
can view details such as the item description, item ID, unit price, 
associated quantity and the availability dates for Shipping, Pick Up, 
and Delivery.

2. Press the INSERT key to set focus to the related items panel. Press 
Insert if you want to set focus back to the parent item panel.

3. Click Add to Order. If the item that you added has been configured to 
replace the original item, the new item replaces the original item and 
its related items. 

Note:  If the Check Inventory Configuration rule is not 
selected for related items, the availability dates will not be 
displayed.

Note:  If the Check Inventory Configuration rule is not 
checked for related items, the availability dates will not be 
displayed.
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The related item that you added is indicated by the  icon. The 
tooltip for the related item indicator displays the parent item 
description.

3.3.1.3 Selecting an Item’s Style
Perform the following steps to select an item’s style. Note that the 
following steps are applicable only if the Sterling Call Center and Sterling 
Store applications are configured to perform real-time availability checks 
for all the child items.

1. To check availability for items, you need to select:

Country or Region

State

Zipcode

If the postal code is entered, the fulfillment methods available for the 
items are enabled based on the Catalog Configuration and inventory 
availability.

If the postal code is not entered, then the possible fulfillment 
methods for the items are displayed based on the Catalog 
Configuration and not based on the inventory.

2. In the Fulfillment method panel, select the fulfillment method.

Note: The associated quantity of related items is always 
displayed for 1 quantity of the parent item.

Note: When a related line is added to the order, the 
fulfillment method for the related line is copied from that 
of the parent line. For example, if the fulfillment method of 
the parent line is "Pick Up", and when a related line is 
added, the fulfillment method of the related line will also 
be "Pick Up". If the related line does not support the 
selected fulfillment method, the fulfillment option of the 
line is set to the default fulfillment method.
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3. Select the appropriate attributes and click the Add to Order button to 
add the stylized item to the order.

If the selected combination is not available, a message is displayed 
indicating you to change your selection since the item is not 
available.

3.3.2 Canceling an Order
A customer may want to cancel an entire order or only some of the items 
ordered. The items on an order can be cancelled as long as they are 
present in the store. For example, you can cancel items that are included 
in shipment but still present in the store, as requested by the customer.

In the Sterling Store application, you can validate whether or not the 
items to cancel are present in the store. After you enter the order 
cancellation details, the Validate Cancellation screen is displayed. You can 
verify whether or not the items to cancel are present in the store. After 
you complete the manual verification process, click OK.

The order lines that contain local shipments are associated with an  
icon. Place your cursor on this icon to view the quantity of items that 
need manual verification for the changes made.

For more information about canceling an order, see Section 2.3.7, 
"Canceling an Order".

3.3.3 Viewing and Confirming the Payment Details
You can view payment details such as the amount reduced, original total, 
new total, and details about the existing payment methods for the order. 
You can also add a coupon or new payment method, if necessary. For 
more information about viewing and confirming payment details, see 
Section 2.3.8, "Viewing and Confirming the Payment Details".

Note: If the Sterling Call Center and Sterling Store 
applications have been configured to check the availability 
of child items in a cached inventory, the Fulfillment Options 
panel will not be displayed.
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3.3.4 Applying Hold
After creating an order, you can place the order on hold. Holds are 
usually placed to prevent further modifications to a particular order. 
Users who belong to a particular user group that has the necessary 
permissions can place an order on hold, at both the order level and the 
order line level. For more information about applying holds, see 
Section 2.3.5, "Applying Hold".

3.3.5 Removing Holds
When performing order modifications, the entire order or just certain 
order lines may be placed on hold to prevent further modifications. You 
can remove holds only if you belong to the user group that has 
permission to remove holds. For more information about removing holds, 
see Section 2.3.6, "Removing Holds".

3.3.6 Creating Store Returns
Customers may want to return or exchange the ordered items. The 
Create Store Return task that enables you to select items from the order 
you want to return, enter a return reason, enter exchange items, if 
applicable, and confirm the payment. To create a return for an order, you 
must first search for the order. For more information about searching for 
an order, see Section 3.1, "Performing Search Tasks".

To create a return:

1. From Tasks > Order, select Create Store Return. The Create Store 
Return screen is displayed.

2. If the customer wants to return the entire order, choose "Select All 
Available Quantity For Return".

3. If the customer wants to return only a few items on the order, choose 
"Select Specific Quantity For Return". You can either select the items 
manually or scan them using a barcode scanner.

If you are selecting the items manually:

– Check the boxes of the items the customer wants to return. 

– In the Enter Qty to Return field, enter the quantity of the item 
that the customer wants to return.
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– In the UOM column, select the UOM for the selected items 
from the drop-down list, if applicable.

– If a UOM does not exist for an item or if only one UOM exists, 
this column is not editable.

If you are selecting the items using a barcode scanner, the 
identifier of the item or the alternate item is populated in the Item 
field. The item identifier that you last scanned and the UOM of the 
item is displayed. Each time you scan an item, the item quantity 
to be returned increases by 1.

4. If any of the order lines have reship lines associated with them, the 
Show Reship Items check box is displayed.

5. If you want to view both original and reship order lines, check the 
Show Reship Items box. A  icon against the reship order line is 
displayed.

6. Click Next.

If order lines are not available for return on an order, the error 
message "No Item on this order are available for Return" is 
displayed.

If you want to select specific quantity for return, and if you have 
not selected any item, the message "Please select at least one 
item" is displayed.

If the item quantity entered in the Enter Quantity To Return 
column exceeds the available quantity for return, the message 
"Return Quantity is more than the returnable quantity. Please 
check the Return Quantity and the Return UOM and select the 
appropriate values" is displayed.

If the above mentioned validations are passed, the Create Store 
Return screen is displayed.

7. From the Return Reason drop-down list, select the appropriate reason 
for returning the item.

Note: If the customer wants to return any reshipped 
items, they must have received both original and 
reshipped items.
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From the Disposition drop-down list, select the appropriate 
disposition code.

8. If the customer wants to exchange some or all of the returned items, 
check the "Create An Exchange For This Return" box.

9. If the customer wants to exchange an item for the same item, check 
the Exchange the item for this item box.

If the same return reason, disposition code, and exchange applies to 
all items in the order, click Apply to all Items.

10. Click Next. 

If there are no items for exchange, the Create Return: Customer 
Identification screen is displayed. You can enter the customer 
information, select a fulfillment method, schedule an 
appointment, and view the payment information. 

If there are items for exchange, the Create Order: Add Item 
screen is displayed. 

For more information about performing these tasks, see 
Section 3.3.1, "Creating an Order".

3.3.7 Initiating a Return
Customers may want to return or exchange some ordered items. In such 
situations, you can perform the Initiate Return task for those items that 
are in the shipped, delivered, or pick up status. For more information 
about initiating a return, see Section 2.3.9, "Returning an Order".

3.3.8 Adding Order Lines 
After placing an order, a customer may want to add more of an item or 
add new items to the order. The Sterling Store application enables you to 
add multiple items to an order. To add multiple items to an order, you 
must first search for the order. For more information about searching for 
an order, see Section 3.1, "Performing Search Tasks".

Note: If you cannot return the items due to some return 
policy constraint, the Override Return Policy check box is 
displayed. Check this box to override the return policy.
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A navigation bar is displayed at the bottom of all screens in the add 
items task flow. This helps you to understand the sequence of steps to be 
performed to complete the entire task. The navigation bar also helps you 
to revisit previous screens easily, if applicable.

To add multiple items to an order:

1. From Tasks > Order, select Add Lines To Order. The Add Multiple 
Lines: Add Items screen is displayed.

2. In the Item column, click the  icon. The Item Detail screen is 
displayed. Select the item you want to add to the order and click Add 
To Order. You are returned to the Add Multiple Lines: Add Items 
screen.

3. Perform Step 11 through Step 55 explained in Section 3.3.1, 
"Creating an Order".

4. Click Confirm.

3.3.9 Adding Open Box Items
Sometimes, items are returned due to slight defects. Such items are sold 
at a discounted price and are added to new orders as open box items.

To add open box items to an order:

1. From Navigator > Order, select Create Order or Tasks > Create Order. 
The Create Order: Add Items screen is displayed.

2. Click the Add Open Box Item hyperlink to add open box items. The 
Add Open Box Item screen is displayed.

3. Enter the appropriate identifier of the open box item and click OK. 
The Create Order screen is displayed. All open box items are 
indicated by the  icon.

If the open box identifier is invalid, the message "Could not find Open 
Box Item for <open_box_identifier>" is displayed.

Note: The newly added order line is identified by the  
icon.
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3.3.10 Increasing Order Line Quantity
Sometimes a customer may want to increase the quantity of one or more 
items on an order that is already placed. In such situations, you can 
increase the order line quantity as requested by the customer. The line 
quantity can be increased for orders that have single or multiple order 
lines. To increase the order line quantity, first search for the order. For 
more information about increasing an order line quantity, see 
Section 2.3.3, "Increasing Order Line Quantity".

3.3.11 Tracking an Item or Inquiring About a Shipment
Customers may need to know the status of their orders. For example, if a 
customer does not receive items that were ordered, the customer may 
inquire about the shipment status. You can determine the shipment 
status for the order and inform the customer. For more information about 
tracking an item or inquiring about a shipment, see Section 2.3.10, 
"Tracking an Item or Inquiring About a Shipment".

3.3.12 Adding Notes to an Order 
You may need to enter some additional notes on an order describing the 
various actions taken on that order for future reference. The Sterling 
Store application enables you to add notes at the order level and order 
line level, thus enabling you to track some important events. For more 
information about adding order notes, see Section 2.3.4, "Viewing and 
Adding Notes to an Order".

3.3.13 Adding or Modifying Charges
The Add/Modify Charges screen provides information about the price 
details of an order. For more information about charge details, see 
Section 2.3.11, "Adding or Modifying Charges".

Note: The quantity of the open box item line cannot be 
increased as each open box item is considered as a unique 
item. You cannot change the unit of measure of the open 
box item.
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3.3.14 Scheduling and Releasing an Order
The Schedule and Release screen provides details of the status of each 
order line and also lets you to schedule and release an order. You can 
schedule and release an order if you belong to a user group, which has 
permission to do so.

For more information about scheduling and releasing an order, see 
Section 2.3.12, "Scheduling and Releasing an Order".

3.3.15 Viewing Procurement Orders
You can view the procurement orders for an order (purchase 
order/transfer order), if you belong to a user group which has permission 
to do so. 

For more information about viewing procurement orders, see 
Section 2.3.13, "Viewing Procurement Orders".

3.3.16 Exempting an Order from Tax
You can exempt an order from tax for a business customer only if you 
belong to a user group that has the necessary permissions. 

For more information about exempting orders from tax, see 
Section 2.3.14, "Exempting an Order from Tax". 

3.3.17 Copying a Draft Order
When creating an order, a customer may decide to use an existing order 
to create new orders in the future, where applicable. For example, a 
customer may want to place two orders for the same items and may 
want the orders to be delivered on different dates. In such a scenario, 
you can copy the existing draft order to create a new order that is similar 
in content. 

For more information about copying a draft order, see Section 2.3.15, 
"Copying a Draft Order".

Note: You can create a new order from an existing draft 
order only if you belong to a user group that has the 
necessary permissions. 
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3.3.18 Ordering Again
After placing an order, a customer may want to use that order to create a 
new order. 

For more information about reordering an order, see Section 2.3.16, 
"Ordering Again". 

3.3.19 E-mailing Order Information
If a customer wants to review the information pertaining to an order, you 
can send the information pertaining to the order through an e-mail. 

For more information about sending order information to a customer 
through e-mail, see Section 2.3.17, "E-mailing Order Information". 

3.3.20 Transferring a Draft Order to IBM Sterling Web
Draft orders can be created either by a customer service representative 
through the Sterling Call Center and Sterling Store applications, or by a 
customer through the Sterling Web application. Draft orders created in 
Sterling Web are accessible through Sterling Call Center and Sterling 
Store. However, draft orders that are opened through Sterling Call Center 
and Sterling Store are not accessible through Sterling Web. In such 
situations, you may want to transfer the draft order from Sterling Call 
Center and Sterling Store to Sterling Web to enable customers to access 
the draft orders. For more information about transferring draft orders to 
Sterling Web, see Section 2.3.18, "Transferring a Draft Order to IBM 
Sterling Web".

Note: You can create a new order from an existing 
confirmed order only if you belong to a user group that has 
the necessary permissions.

Note: You can send the information pertaining to a draft 
order or a confirmed order to a customer only if you 
belong to a user group that has the necessary permissions.
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3.3.21 Launching the Applications Manager
You can use this task to launch the Applications Manager from within the 
Sterling Call Center and Sterling Store user interface. A CSR may 
sometimes need to launch the Applications Manager, for example, a CSR 
may want to adjust the inventory for an item. For more information 
about launching the Applications Manager, see Section 2.3.19, 
"Launching the Application Console".

3.4 Performing Opportunity and Quote Tasks
This section explains how to perform the following opportunity and quote 
tasks:

Creating an Opportunity

Modifying Opportunity Details

Marking an Opportunity as Lost

Creating a Quote

Reworking a Quote

Copying a Quote as a New Quote

Copying a Quote as Alternative Quote

Viewing Alternate Quotes

Viewing or Modifying Problem Lines in a Quote

Quote Approvals

Presenting a Quote to a Customer

Accepting a Quote on Behalf of a Customer

Rejecting a Quote on Behalf of a Customer

Generating a Proposal

Converting Quote to Order

Abandoning a Quote
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3.4.1 Creating an Opportunity
An opportunity is a container to hold a quote or related alternative 
quotes that can be presented to a customer. Related alternative quotes 
are a set of quotes that exist at the same time and are independent of 
each other, but are associated with the same opportunity. Irrespective of 
the number of quotes in an opportunity, only one can be accepted by a 
customer. for more information about creating an opportunity, see 
Section 2.4.1, "Creating an Opportunity".

3.4.2 Modifying Opportunity Details
After an opportunity is created for a customer, you can modify the details 
of the opportunity, for example, if the opportunity is expected to be 
closed at a date later than the one you had earlier anticipated, you can 
change the opportunity’s Anticipated Close Date by selecting a new date. 
For more information about modifying the opportunity details, see 
Section 2.4.2, "Modifying Opportunity Details".

3.4.3 Marking an Opportunity as Lost
You can mark an opportunity as Lost if the opportunity no longer serves 
any purpose. For example, when an opportunity is still in the Inquiry 
status, a customer may have purchased the products from another seller. 
In such a scenario, you may want to mark the opportunity as Lost and 
provide reasons for losing the opportunity. For more information about 
marking an opportunity as Lost, see Section 2.4.3, "Marking an 
Opportunity as Lost".

3.4.4 Creating a Quote
A quote is a commercial document that allows a prospective buyer to see 
a predetermined set of products and quantities at a predetermined price 
to be delivered on a specific date. For more information about creating a 
quote, see Section 2.4.4, "Creating a Quote".

3.4.5 Reworking a Quote
After a quote is Created and before it is Accepted or Ordered, the quote 
can be modified or restored to its original status by reworking the quote. 
The quote rework task restores the quote to the Created status and 
removes existing approvals on the quote. This enables users to modify 
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the quote if it has been rejected internally or by a customer. For more 
information about reworking a quote, see Section 2.4.5, "Reworking a 
Quote".

3.4.6 Copying a Quote as a New Quote
You may sometimes want to copy a quote that is associated with an 
opportunity to create a new quote and opportunity. For example, a user 
may want to use the item information and payment details of an existing 
quote for a different quote and opportunity. For more information about 
copying a quote as a new quote, see Section 2.4.6, "Copying a Quote as 
a New Quote".

3.4.7 Copying a Quote as Alternative Quote
You may sometimes want to offer alternative quotes to a customer. For 
example, consider that a customer is interested in purchasing 10 
computers. A user may create a quote for 10 desktop computers, 
offering a discount of 5% on the quote total. To provide the customer 
with another option to choose from, the user may create another quote 
for 5 desktop computers and 5 laptops, offering a discount of 7% on the 
quote total. For more information about copying a quote as an 
alternative quote, see Section 2.4.7, "Copying a Quote as Alternative 
Quote".

3.4.8 Viewing Alternate Quotes
Alternative quotes are quotes that are independent of each other, but are 
associated with a single opportunity. Alternative quotes are used to 
present different options to a customer. A customer can, however, accept 
only one option. For more information about viewing alternate quotes, 
see Section 2.4.8, "Viewing Alternate Quotes".

3.4.9 Viewing or Modifying Problem Lines in a Quote
If a quote contains problem lines and if you request an approval for the 
quote, present the quote to a customer, or convert the quote to an order, 
you will be redirected to the View Problem Lines screen to enable you to 
fix the problem lines before proceeding further. For more information 
about viewing problem lines of a quote, see Section 2.4.9, "Viewing or 
Modifying Problem Lines in a Quote".



Performing Opportunity and Quote Tasks

Tasks for a Store Representative   319

3.4.10 Quote Approvals
You can present a quote to a customer only if the quote is in the 
Approved status. Based on the configuration, the quote may or may not 
require to be approved.

If the quote does not require any approval by the approvers as 
defined in an approval plan, Sterling Call Center and Sterling Store 
automatically changes the status of a quote to Approved.

If the quote requires approval, the quote must be approved by the 
approvers as defined in an approval plan before presenting the quote 
to a customer.

For more information about quote approvals, see Section 2.4.10, "Quote 
Approvals".

3.4.11 Presenting a Quote to a Customer
After all the necessary approvals have been obtained for a quote, you 
can present the quote to the customer for whom the quote has been 
created so that the customer can provide feedback on the quote. For 
more information about presenting a quote to a customer, see 
Section 2.4.11, "Presenting a Quote to a Customer".

3.4.12 Accepting a Quote on Behalf of a Customer
You can accept a quote on behalf of a customer. For example, a customer 
may agree to all the conditions laid down in a quote, and may want the 
quote to be processed so that the customer can place an order for the 
products in the quote. For more information about accepting a quote on 
behalf of a customer, see Section 2.4.12, "Accepting a Quote on Behalf of 
a Customer".

3.4.13 Rejecting a Quote on Behalf of a Customer
After a quote has been presented to a customer, you can reject the quote 
on behalf of the customer. For example, if a customer wants to reject a 
quote based on the quote price, you can reject the quote on the 
customer’s behalf. For more information about rejecting a quote on 
behalf of a customer, see Section 2.4.13, "Rejecting a Quote on Behalf of 
a Customer".



320   User Guide

Performing Fulfillment Tasks

3.4.14 Generating a Proposal
You may sometimes want to generate a proposal from a quote and send 
it to a customer. For example, you may want to print a proposal in the 
PDF format and e-mail it to the customer as an attachment. For more 
information about generating a proposal, see Section 2.4.14, "Generating 
a Proposal".

3.4.15 Converting Quote to Order
After a customer accepts a quote in its current form, a user might want 
to convert the quote to an order. For more information about converting 
a quote into an order, see Section 2.4.15, "Converting Quote to Order".

3.4.16 Abandoning a Quote
If you feel that a quote no longer serves a purpose, you can abandon the 
quote. For example, due to oversight, if you create a quote, you can 
abandon the quote. For more information about abandoning a quote, see 
Section 2.4.16, "Abandoning a Quote".

3.5 Performing Fulfillment Tasks
This section explains how to perform the following fulfillment tasks:

Modifying Fulfillment Options

Fulfillment Summary

Delivery and Service Grouping

Modifying Service Instructions

Modifying Service Appointments

Managing Delivery Service Option

Modifying the Ship To Address

Reshipping an Item

3.5.1 Modifying Fulfillment Options
When a customer requests a change in the fulfillment options for an 
item, you can modify the fulfillment options as requested. For example, 
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after the customer places an order for delivery, the customer may decide 
to pick the items up at your store. In such situations, you can modify the 
fulfillment options as requested. You can also perform this task when a 
customer requests to modify the delivery address for an order line. To 
modify the fulfillment options, you must first search for the order. For 
more information about searching for an order, see Section 2.1, 
"Performing Search Tasks".

To modify the fulfillment options:

1. From Navigator > Fulfillment, select Change fulfillment options. The 
Change Order Fulfillment Options screen is displayed.

2. Select the Perform Advanced Service Grouping check box to group 
the order lines into smaller groups to ensure that appointments will 
be available for the various services and click Next. For more 
information about adding order lines to a group, see Section 2.5.3, 
"Delivery and Service Grouping".

3. Check the boxes of the items for which you want to modify the 
fulfillment options.

If you want to modify the fulfillment options for all items on the 
order, check the Check All box.

You can view the expected date of fulfillment for the order line in 
the Expected Date column. The expected date for:

– Pick Up—displays the earliest date on which the customer can 
pick up the item from a store.

– Shipping—displays the earliest date on which the item will be 
shipped from the warehouse.

– Delivery—displays the earliest date on which the item will be 
shipped from the warehouse.

The expected date of fulfillment does not display for the order line 
if:

Note: The Perform Advanced Service Grouping check box 
is displayed in the Change Fulfillment Options screen only 
if delivery or service order lines or both exist and if you 
have permissions to perform the Delivery and Service 
Grouping task.
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– The requested pick up date does not exist

Or

– The work order appointment is not created

4. Choose the appropriate fulfillment method.

5. When the customer wants to pick up items from the store, choose the 
"Pick Up" fulfillment method. 

a. If the customer wants to pick up the items from the store where 
the order was placed, choose Pick Up from Current Store.

If the customer wants to pick up the items from other stores:

– Choose Select other store. 

– Select the country or region from the drop-down list where 
you want to pick up the items.

– Enter the Postal Code or City, State.

– Click Search. The More Stores screen is displayed. For more 
information about viewing inventory in other stores, see 
Section 2.3.2.2, "Viewing Inventory in Other Stores".

Note: When you change the fulfillment option for a parent 
bundle item which is configured as ship independent, the 
fulfillment method for the component lines is automatically 
selected for modification.

For a bundle parent item which is configured as ship 
together, only the parent bundle item is displayed.

Note: If the line for which you want to modify the 
fulfillment option has related lines associated with it, the 
fulfillment method for related lines also gets updated with 
the changed fulfillment method as the parent line.

Note: All order lines that are associated with drop ship 
lines are disabled.
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– Select the appropriate store.

– Click Apply.

b. Click Next. The Fulfillment Summary Screen is displayed. For 
more information about fulfillment summary details, see 
Section 2.5.2, "Fulfillment Summary".

6. When the customer wants the items to be shipped, follow these 
steps:

a. Choose the Ship fulfillment method. The Ship To address must be 
entered.

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

b. From the Service drop-down list, select the appropriate carrier 
service that the customer requests for item delivery.

c. Click Apply. 

d. If you skip the customer identification step when capturing the 
order, you must enter an address for all the order lines that are 
being shipped or delivered.

e. Click Next. 

– The Fulfillment Summary screen is displayed where you can 
view and modify the complete configuration of an order and 
how it is being fulfilled. For more information about fulfillment 
summary, see Section 2.5.2, "Fulfillment Summary".

Note: A fulfillment method can be selected only if the 
item supports the selected fulfillment method.
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f. Click Next. 

– If any order lines are being delivered and the newly added 
lines require a new appointment or an existing appointment to 
be retaken, the Service Appointment screen is displayed. For 
more information about selecting an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

– If the order contains existing service appointments that have 
not been affected by the addition of lines, the Service 
Fulfillment Summary screen is displayed. For more information 
about the service fulfillment, see Section 2.5.6, "Service 
Fulfillment Summary".

7. When the customer wants the items to be delivered to their doorstep, 
follows these steps:

a. Choose the Delivery fulfillment method. The Deliver To address 
must be entered. 

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

Note: The Fulfillment Summary screen is displayed only if 
the fulfillment method is either Ship or Pick Up.
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b. If you skipped the customer identification step when capturing the 
order, enter the address for all order lines that are being 
delivered.

c. Click Next. 

– If any order lines are being delivered and the newly added 
lines require a new appointment or an existing appointment to 
be retaken, the Service Appointment screen is displayed. For 
more information about selecting an appointment, see 
Section 2.5.5, "Modifying Service Appointments".

– If the order contains existing service appointments that have 
not been affected by the addition of lines, the Service 
Fulfillment Summary screen is displayed. For more information 
about the service fulfillment, see Section 2.5.6, "Service 
Fulfillment Summary".

8. When the customer wants to change the address for the provided 
service line:

a. Select all service lines in the list. The Service Address panel is 
displayed.

– Select an address and click the Modify Address hyperlink to 
modify the address and click Apply.

Note: Based on the configuration, the Fulfillment option is 
displayed. For more information about displaying Shipping 
and Delivery as a separate fulfillment option, see the 
Sterling Call Center and Sterling Store: Implementation 
Guide.

Note: You can modify any order line that has the Delivery 
fulfillment method until the delivery line is shipped.

Note: If the status modification rules do not allow you to 
change the fulfillment method of an item, the order line is 
displayed in red.
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– Click the New Address hyperlink to enter a new address and 
click Apply.

For more information about adding new addresses or modifying 
the existing address, see Section 2.3.2.3, "Adding or Modifying 
Addresses".

b. Click Next. The Fulfillment Summary Screen is displayed. For 
more information about the fulfillment summary details, see 
Section 2.5.2, "Fulfillment Summary".

9. If the customer wants to pick up the items at a nearby store, select 
Pick Up Selected Items From This Store. By default, the local store is 
selected.

a. From the Store Pick Up drop-down list, select the store from 
where the customer wants to pick up the items.

If you cannot find the store in the drop-down list:

– Click the More Stores hyperlink. The More Stores screen is 
displayed.

– Select the store from where the customer wants to pick up the 
item.

– To search for a store located in a particular area, enter the 
postal code of the area and click Search. A list of available 
stores is displayed. Select the appropriate store from the list.

– Enter the pick up date as requested by the customer.

b. Click Apply. 

c. Click Next. The Confirm Payment screen is displayed where you 
can view the payment details for the order. For more information 
about payment confirmation, see Section 2.3.8, "Viewing and 
Confirming the Payment Details".

10. In certain situations, your store may be processing orders for which 
the customer has requested a change in the fulfillment options. For 
example, an order is created and about to be shipped to the 
customer from your store, the customer may request to pick the 
items from the store. In such situations, an appropriate message 
displays that prompts you to manually verify whether the fulfillment 
options can be modified. After performing the manual verification 
process, click Verified.
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11. To change the fulfillment options for one or more shipments, click the 
"Shipments for the order exist for this store" hyperlink. The Change 
Shipment Fulfillment Options screen is displayed where you can view 
shipments from the local ship node.

You can view each shipment in a different panel along with the item 
details and fulfillment type. The check box provided against each 
shipment panel is enabled only if the shipment is not shipped. 

If the fulfillment method is "Shipping", you can view the ship to 
address.

If the fulfillment method is "Pick Up", you can view the pick up 
date.

12. To view or modify the fulfillment options for one or more order lines, 
click the "View all order lines" hyperlink. The Change Order 
Fulfillment Options screen is displayed. Perform Step 1 through Step 
11, if applicable.

13. Modify the fulfillment method or ship to address of an item 
appropriately.

14. Click Apply. A warning message displays prompting you to verify if 
the changes requested by the customer can actually be made. 

15. Verify if the modifications made can be applied to the item and click 
Verified. 

16. Click Next. The Confirm Payment screen is displayed where you can 
view the payment details for the order. For more information about 
payment confirmation, see Section 2.3.8, "Viewing and Confirming 
the Payment Details".

3.5.2 Fulfillment Summary
The Fulfillment Summary screen provides information about how an 
order is created and is being fulfilled. For instance, you can view the 
details of an order such as the recently added order lines, gift items, 
open box items, related items, and so forth. You can group order lines 
together based on the fulfillment method. For more information about 

Note: If you cannot modify the fulfillment option for an 
item, an appropriate message is displayed.
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viewing the fulfillment summary for an order, see Section 2.5.2, 
"Fulfillment Summary".

3.5.2.1 Override Availability
This screen provides visibility to items available in a store. You can also 
modify the item availability details. This feature is broadly classified into 
the following ways:

System Returns Availability

System Returns Unavailability

3.5.2.1.1 System Returns Availability  

This is a scenario where the system returns the availability of items in a 
particular store. If you know whether or not items are available at that 
store, you can override availability by choosing either of the following:

Item cannot be physically located in a store. Override the system 
availability.

Item is available. Do not change the system availability.

3.5.2.1.2 System Returns Unavailability  

This is a scenario where the system returns the unavailability of items in 
a particular store. You can override availability by choosing either of the 
following:

Item is available in a store. Override the system availability.

Item cannot be located. Do not change the system availability.

3.5.3 Delivery and Service Grouping
When a complex order pertaining to numerous products, provided 
services, and delivery services exists, users can group the order lines 
into smaller groups to ensure that appointments are available for the 
various services. For more information about grouping order lines, see 
Section 2.5.3, "Delivery and Service Grouping".
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3.5.4 Modifying Service Instructions
When a customer requests a change in the service instructions for an 
item at the time of delivery, you can modify the service instructions as 
requested. For more information about modifying service instructions, 
see Section 2.5.4, "Modifying Service Instructions".

3.5.5 Modifying Service Appointments
When a customer requests a change in the service date and time, you 
can change the service appointment. For more information about 
modifying service appointments, see Section 2.5.5, "Modifying Service 
Appointments".

3.5.6 Managing Delivery Service Option
When a customer request to modify the delivery service options for an 
item, in such cases you can modify the delivery service options as 
requested. For more information about modifying delivery service 
options, see Section 2.5.7, "Managing Delivery Service Option".

3.5.7 Modifying the Ship To Address
Sometimes, a customer provides incorrect ship to address information 
when placing an order. In such situations, the customer may request to 
modify the ship to address. For more information about modifying the 
ship to address, see Section 2.5.8, "Modifying Order Addresses".

3.5.8 Reshipping an Item
Sometimes a customer reports that the item that was ordered has not 
been received or has been damaged in transit. In such situations, you 
may have to reship the items or issue a refund to the customer for the 
shipment. You can reship only those items that are in the "Shipped" or 
"Delivered" status.

To reship an item, you must track the item. For more information about 
tracking an item, see Section 2.3.10, "Tracking an Item or Inquiring 
About a Shipment".
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To reship an item:

1. In the Shipment Inquiry screen, click the View Shipment hyperlink. 
The Shipment Details screen is displayed.

2. Click the Reship Shipment hyperlink. The Lines to Reship screen is 
displayed. The Reship Shipment hyperlink is visible only if the items 
are in "Shipped" or "Delivered" status.

3. From the Reasons For Reship drop-down list, select the appropriate 
reasons for reshipping the item.

4. Check the boxes of the items you want to reship.

5. In the Quantity To Reship column, modify the reship quantity, if 
applicable.

6. Click Next. The Reship or Refund screen is displayed. In the Available 
Items panel, you can view items that are available for reshipping. In 
the Unavailable Items panel, you can view items that are not 
available for reshipping.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

7. If you want to reship all available items, in the Available Options 
panel, select Reship Available Items.

8. If you want to reship all available items and need to issue a refund 
for items that are not available, choose Reship Available Items and 
Refund Unavailable Items.

Note: If reshipping is not allowed for items, in the Lines 
to Reship screen, select the Override Reship Validation 
condition or the Create Follow-Up Alert condition.
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9. If you need to issue a refund for all items, choose Create Refund for 
All Items.

10. In the Notes panel, you can view or add any additional information. 

11. Click Previous to go to the previous screen. If you click the Previous 
button, it does not allow you to undo any previous action.

12. Click Next. 

If the items need to be delivered, the Select An Appointment screen 
is displayed. You can modify the service appointment of the items. 
For more information about modifying service appointments, see 
Section 2.5.5, "Modifying Service Appointments".

13. The Confirm Payment screen is displayed. For more information about 
payment confirmation, see Section 3.3.3, "Viewing and Confirming 
the Payment Details".

3.6 Performing Price Match Tasks
This section explains how to perform the following price match related 
tasks:

Matching an Item’s Price

Searching for a Price Match

Adding a New Price Match

Searching for a Competitor

Adding a New Competitor

3.6.1 Matching an Item’s Price
A customer may discover that another retailer is selling the same items 
that were ordered at a lesser price. In such situations, you may look into 
the claims of the customer and price match the items, if necessary. For 
more information about matching the price of an item, see Section 2.6.1, 
"Matching an Item’s Price".

3.6.2 Searching for a Price Match
You may sometimes need to search for a price match record.
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To search for a price match:

1. From Tasks > Price Match, select Price Match Search. The Price Match 
Search and List screen is displayed.

2. Enter the appropriate search criteria and click Search. The search 
results are displayed in the Price Match Results panel.

If you cannot find the pertinent price match, click  icon to show 
the search criteria. You can enter more restrictive search criteria for 
the selected task.

3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

4. Double-click the appropriate price match. The price match details 
screen is displayed. For more information about viewing the price 
match details, see Section 3.6.2.1, "Viewing Price Match Details".

5. Click the Add button to add a new price match. For more information 
about adding a new price match, see Section 3.6.3, "Adding a New 
Price Match".

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 



Performing Price Match Tasks

Tasks for a Store Representative   333

3.6.2.1 Viewing Price Match Details 
In the Price Match Details screen, you can view the details of a price 
match such as competitor's name, enterprise code.

1. In the Price Match Details panel, you can view the enterprise code, 
item ID, UOM, expiration date of the price match, status of the price 
match, competitor, the minimum quantity to be price matched, 
competitor's unit price and competitor's discounts.

2. In the Price Match Description panel, you can view a brief description 
of the price match.

3. In the Order Lines Available panel, you can view the order lines on 
which the price match can be applied.

4. In the Order Lines Unavailable panel, you can view the order lines on 
which the price match cannot be applied.

3.6.3 Adding a New Price Match
Sterling Call Center and Sterling Store provides the ability to add a new 
price match, if the price match does not already exist. 

To add a new price match:

1. From Tasks > Price Match, select Add Price Match. The Price Match 
Details screen is displayed.

2. Enter the item ID or click the  icon. The Advanced Add Item 
Search screen is displayed. Select the item from the list.

3. Enter the unit of measure for the item selected.

4. Select the expiration date for the price match. To select a date, click 
the  icon and then select the month, year and day.

5. Select the status for the price match from the drop-down list.

6. Enter the competitor or click the  icon to search for the competitor. 
Enter the minimum quantity to be price matched, the competitor’s 
unit price and competitor’s discounts.

7. Click Confirm to add the price match.
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3.6.3.1 Modifying a Price Match
Sterling Call Center and Sterling Store provides the ability to modify an 
existing price match, for example, you may want to extend the expiration 
date of a price match.

To modify an existing price match, you must first search for a price 
match. For more information about searching for a price match, see 
Section 3.6.2, "Searching for a Price Match".

1. In the Price Match Details panel, you can view the enterprise code, 
item ID, UOM, expiration date of the price match, status of the price 
match, competitor, the minimum quantity to be price matched, 
competitor's unit price, and competitor's discounts.

For an approved price match, you can only modify the expiration 
date.

For a pending or rejected price match, you can modify the 
expiration date, status of the price match, competitor’s unit price 
and competitor's discounts.

2. In the Price Match Description panel, enter a brief description of the 
price match.

3. In the Order Lines Available panel, you can view the order lines on 
which the price match can be applied.

4. In the Order Lines Unavailable panel, you can view the order lines on 
which the price match cannot be applied.

3.6.4 Searching for a Competitor
You may sometimes need to search for a competitor when performing a 
price match.

To search for a competitor:

1. From Tasks > Price Match, select Competitor Search. The Competitor 
Search and List screen is displayed.

2. Enter the appropriate search criteria and click Search. The search 
results display in the Competitor Results panel.

If you cannot find the pertinent competitor, click  icon to show the 
search criteria. You can enter more restrictive search criteria for the 
selected task.
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3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

4. Double-click the appropriate competitor. The Competitor details 
screen is displayed. For more information about viewing the 
Competitor details, see Section 3.6.4.1, "Viewing Competitor Details".

3.6.4.1 Viewing Competitor Details
In the Competitor Details screen, you can view the details of a 
competitor such as competitor's name, enterprise code.

1. In the Competitor Details panel, you can view the competitor's name, 
enterprise code, status of the enterprise, percentage of the price 
match, and the web address of the competitor.

2. In the Description panel, you can view a brief description of the 
competitor.

3.6.5 Adding a New Competitor
Sterling Call Center and Sterling Store provides the ability to add a 
competitor if the competitor does not already exist. 

1. Do one of the following to add a new competitor :

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 
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From Tasks > Price Match, select Competitor Search. The 
Competitor Search and List screen is displayed. Click the Add 
button, The Add Competitor screen is displayed.

From Tasks > Price Match, select Add Competitor. The Add 
Competitor screen is displayed.

2. In the Competitor Details panel, enter the competitor's name, 
enterprise code, status of the enterprise, percentage of the price 
match, and the web address of the competitor.

3. In the Description panel, enter a brief description of the competitor.

4. Click Confirm.

3.7 Performing Other Tasks on an Order
Some miscellaneous tasks you may need to perform on an order, include:

Setting Up Gift Options

Appeasing Customers

Adding a Coupon or Promotion Code

Changing Payment Methods

Viewing Payment Details

Inquiring About Returns and Exchanges

Reconfiguring Items

3.7.1 Setting Up Gift Options
When a customer wants to buy an item and wants to gift it to someone, 
you can set up the gift options in any one of the following ways: 

The customer places an order at the store and wants the recipient to 
whom the item is to be gifted to pick it up from the same store or an 
alternate store. In this case, you must mark the item as a gift item 
and capture the recipient details.

The customer places an order at the store and realizes that the 
recipient to whom the item is to be gifted is unable to pick it up. In 
such situations, the customer picks up the item. You must clear the 
gift flag and recipients information. 
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The customer places an order at the store and wants the store to ship 
the items to the recipient as a gift. In this case, you must mark the 
item as gift and capture the recipient’s ship to address.

The customer places an order at the store and wants the store to 
deliver the items to the recipient as gift items. In such situations, the 
CSR marks the items as gift items and captures the delivery address 
of the recipient.

For more information about marking items as gift items, see 
Section 2.7.1, "Setting Up Gift Options".

3.7.2 Appeasing Customers
When a customer is not satisfied or has had a bad experience with any of 
the services that were provided, you can present them with the option to 
appease them. For example, a customer may walk in to a store to report 
having received a damaged item. In such situations, you need to perform 
an appeasement task to make amends for the bad experience. For more 
information about appeasing customers, see Section 2.7.2, "Appeasing 
Customers".

3.7.3 Adding a Coupon or Promotion Code
You can add a coupon or promotion code to an order on the request of a 
customer who has already placed an order. You can add any number of 
coupons to an order. For more information about adding a coupon or 
promotion code, see Section 2.7.3, "Adding a Coupon or Promotion 
Code".

3.7.4 Changing Payment Methods
A customer may need to change the mode of payment for an order. To 
change the payment method for an order, you need to first search for the 
order. For more information about changing payment methods, see 
Section 2.7.4, "Changing Payment Methods".

3.7.5 Viewing Payment Details
You can view payment details for an order placed by the customer such 
as charges, refunds, and payment methods. For more information about 
viewing payment details, see Section 2.7.5, "Viewing Payment Details".
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3.7.5.1 Adding or Modifying Charges
The Add/Modify Charges screen provides information about the existing 
charges and also lets you to modify an existing charge or add a new 
charge.

In the Modify Charges panel, you can view the charge category, charge 
name and the charge amount.

1. If you want to add a new charge, click the Add Charge hyperlink. 
Select the category from the Charge Category drop-down list. Select 
the name of the charge from the Charge Name drop-down list. In the 
Charge Amount column, enter the appropriate amount for the charge.

2. In the Notes panel, enter any additional information, if applicable. For 
more information about adding notes to an order, see Section 2.3.4, 
"Viewing and Adding Notes to an Order".

3. Click Confirm.

3.7.6 Inquiring About Returns and Exchanges
Customers may inquire about returns, exchanges, and refunds for an 
order. For more information about inquiring about returns and 
exchanges, see Section 2.7.6, "Inquiring About Returns and Exchanges".

3.7.7 Reconfiguring Items
Sterling Call Center and Sterling Store provides rich functionality to 
reconfigure bundle items. For example, if the customer has ordered for a 
computer and wants to change the configuration of the processor, this 
task enables you to change the necessary configurations. For more 
information about reconfiguring an item, see Section 2.7.7, 
"Reconfiguring Items".

3.8 Performing Customer Tasks
This section explains how to perform the following customer tasks:

Creating a Consumer Customer

Creating a Business Customer

Managing Customer Contacts
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Resetting a User’s Password

Managing Business Customer Information

Managing Customer Addresses

Managing Customer Payment Method

Assigning Customer to a Team

Customer User Assignments

Customer Self Assignments

Viewing Account Activity

Viewing and Adding Customer Notes and Contact Notes

3.8.1 Creating a Consumer Customer
Sterling Call Center and Sterling Store provides the functionality to 
create, manage, and view consumer customers. For more information 
about creating a consumer customer, see Section 2.8.1, "Creating a 
Consumer Customer".

3.8.2 Creating a Business Customer
Sterling Call Center and Sterling Store provides the functionality to 
create, manage, and view business customers. For more information 
about creating a business customer, see Section 2.8.2, "Creating a 
Business Customer".

3.8.3 Managing Customer Contacts
You can define multiple contacts for each business customer. To manage 
a customer contact, you must first search for a customer. For more 
information about managing customer contacts, see Section 2.8.3, 
"Managing Customer Contacts".

3.8.4 Resetting a User’s Password
Sterling Call Center and Sterling Store provides the functionality to reset 
a user’s password, if a user ID is associated to the user’s record. For 
more information about resetting a user’s password, see Section 2.8.4, 
"Resetting a User’s Password".
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3.8.5 Managing Business Customer Information
Sterling Call Center and Sterling Store provides the functionality to 
manage business customer information. For more information about 
managing business customer information, see Section 2.8.5, "Managing 
Business Customer Information".

3.8.6 Managing Customer Addresses
You can define multiple addresses for each customer. To manage 
customer addresses, you must first search for a customer. For more 
information about managing customer addresses, see Section 2.8.6, 
"Managing Customer Addresses".

3.8.7 Managing Customer Payment Method
You can define multiple payment methods for a customer, based on the 
configuration. To manage customer payment methods, you must first 
search for the corresponding customer. For more information about 
managing customer payment methods, see Section 2.8.7, "Managing 
Customer Payment Method".

3.8.8 Assigning Customer to a Team
Sterling Call Center and Sterling Store enables you to assign customers 
to a team after the customer is created. A supervisor can assign a 
customer from his team to any of his sub teams. To assign a customer to 
a team, you must first search for a customer. For more information about 
managing team assignments, see Section 2.8.8, "Assigning Customer to 
a Team".

3.8.9 Customer User Assignments
Sterling Call Center and Sterling Store enables you to assign customers 
to a user after the customer is created. A supervisor can assign a 
customer from his team to any of the users in his sub-teams. For more 
information about managing user assignments, see Section 2.8.9, 
"Customer User Assignments".
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3.8.10 Customer Self Assignments
Sterling Call Center and Sterling Store enables you to assign customers 
to a user, once the customer is created. A user can assign a customer to 
himself only if the user is assigned permissions to access the customer 
record. For more information about managing user assignments, see 
Section 2.8.10, "Customer Self Assignments".

3.8.11 Viewing Account Activity
Sterling Call Center and Sterling Store provides the functionality to view 
the Sterling Multi-Channel Selling Solution’s Account Activity. For more 
information about viewing account activity, see Section 2.8.11, "Viewing 
Account Activity".

3.8.12 Viewing and Adding Customer Notes and Contact 
Notes

Sterling Call Center and Sterling Store provides the functionality to enter 
additional notes about a customer or contact. For example, you may 
want to add a note stating that a customer can be contacted only on 
Tuesdays and Thursdays. For more information about viewing and adding 
customer notes and contact notes, see Section 2.8.12, "Viewing and 
Adding Customer Notes and Contact Notes". 

3.9 Performing User Management Tasks
This section explains how to perform the following user management 
tasks:

Managing Users

A user is an employee of the enterprise organization who can log in to 
the Sterling applications.

Managing User Teams

A user team is a collection of users who have common data and user 
interface access requirements. User teams can have access to specific 
document types, enterprises, ship nodes, customers, and screens 
within the user interfaces.
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3.9.1 Managing Users
Sterling Call Center and Sterling Store provides the ability to create and 
manage users. For more information about creating and managing users, 
see Section 2.9.2, "Managing Users".

3.9.2 Managing User Teams
Sterling Call Center and Sterling Store provides the ability to create and 
manage user teams. For more information about creating and managing 
user teams, see Section 2.9.3, "Managing User Teams".

3.10 Performing Return Order Tasks
This section explains how to perform the following return order-related 
tasks:

Create a Return Order

Add a Return Reason

Add Items to an Exchange

View or Change Return and Exchange Fulfillment Options

View or Change Fulfillment Summary

View or Change Payment Summary

Change Return Address

View or Change Service Fulfillment Summary

Issue a Refund

Modify Service Appointments

Report Extra Items

Report Wrong Items

Report Unexpected Items

Cancel a Return Order

Creating an Exchange Order

Changing Return Method
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3.10.1 Create a Return Order
A customer may want to return or exchange items that were purchased. 

This section describes only the Sterling Store functionality for creating 
creating a Return Order. For more information about creating returns, 
see Section 2.10.1, "Creating a Return Order".

Sterling Store provides the functionality to scan an item into a return 
order.

To scan an item for return, select the By Order tab. An Item ID field is 
displayed. When you scan the item, the Item ID is displayed in the Item 
ID field. If the item scanned is not on the order, an error message is 
displayed indicating that the Item ID was not found.

An item that you scan is automatically marked "in hand" when you scan 
it. Returns without a receipt and returns by Extra Item (items that the 
customer received by mistake) are also assumed to be "in hand" by the 
system. 

If you are not scanning an item, the return panel contains Item is in 
Hand and All Selected Items Are Present check boxes.

You can also indicate whether the items are being returned by the 
customer who originally purchased it or by a gift recipient.

3.10.2 Add a Return Reason
When you perform a return for a customer, you must enter a return 
reason. 

This section describes only the Sterling Store functionality for the Return 
Reason screen. For more information about the Return Reason screen, 
see Section 2.10.2, "Adding a Return Reason".

Sterling Store provides the ability to enter disposition notes for the items 
that are in hand.

For items that are marked in hand on the line selection screen, enter the 
Return Disposition Code in the drop-down list on the Return Reason 

Note: In the Sterling Store application, returns without a 
receipt and returns by Extra Item will always be considered 
as "in hand".
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screen. Your enterprise may have Disposition Codes such as Sent for 
Repair, Scrapped, Restocked, and others.

3.10.3 Identifying a Customer
The Customer Identification screen allows you to search for an existing 
customer and create a new Business customer or Consumer customer. 
For more information about customer identification, see Section 2.10.3, 
"Identifying a Customer".

3.10.4 Add Items to an Exchange
If a customer wants to exchange items that are being returned, you need 
to create an exchange order for the corresponding return order. For more 
information about creating an exchange order, see Section 2.10.4, 
"Adding Items to an Exchange".

3.10.5 View or Change Return and Exchange Fulfillment 
Options

The Exchange Fulfillment Options screen enables you to change the 
fulfillment method on the exchange order, as well as changing the 
shipping/delivery addresses and pick up locations. If customer 
information is missing, the Customer Information screen is displayed. For 
more information, see Section 2.1.2, "Searching for a Customer".

For more information about changing the fulfillment method, see 
Section 2.5.1, "Modifying Fulfillment Options".

3.10.6 View or Change Fulfillment Summary
The Fulfillment Summary screen enables you to view and change 
Shipping, Pick Up, and Delivery methods for return and exchange lines. 
These are grouped by fulfillment method and address. You can also see 
lines that are in hand displayed in their own panel. You cannot change 
the in hand status on this screen.

For more information about the Fulfillment Summary, see Section 2.10.6, 
"Viewing or Modifying Fulfillment Summary".
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3.10.7 View or Change Payment Summary
You can view and change the return and exchange order payment details 
on the Payment Summary screen. 

This section describes the Sterling Store functionality only for the 
Payment Summary. For more information about the Payment Summary, 
see Section 2.10.7, "Viewing or Modifying the Payment Summary".

The following Sterling Store features apply:

When items that are not in hand are received at a warehouse, a 
receipt is started so that the customer receives a refund.

When items are in hand, the system sets items that are to be picked 
up or shipped to Released status.

3.10.8 Change Return Address
If a customer wants to change the address of a return order, you must 
search for the return order. For more information about changing return 
address, see Section 2.10.8, "Changing Return Address".

3.10.9 View or Change Service Fulfillment Summary
You can view the summary of all appointments related to the return 
order and the corresponding exchange order, if applicable. In the 
Appointment panel, you can view the appointment number, the current 
appointment, if an appointment has been taken, and the service charges 
applicable for the service. For more information about viewing the service 
fulfillment summary, see Section 2.10.9, "Viewing or Modifying Service 
Fulfillment Summary".

3.10.10 Issue a Refund
A customer may call to inquire about why he has not been refunded for 
the items which have already been returned. In such situations, you 
need to issue a refund for the items immediately. Sterling Call Center 
and Sterling Store provides the Issue Refund Now task that enables you 
to issue a refund to the customer immediately. For more information 
about issuing a refund, see Section 2.10.10, "Issuing a Refund".
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3.10.11 Modify Service Appointments
Sometimes a customer may want to change the service appointment of a 
return order. To change the service appointment, you must search for the 
return order. For more information about modifying service 
appointments, see Section 2.10.11, "Modifying Service Appointments".

3.10.12 Report Extra Items
Sometimes a customer may report that the customer has received extra 
items. In such situations, the extra items can either be returned back or 
you can allow the customer to keep the extra items. To report extra 
items, you must first search for the order. For more information about 
searching reporting extra items, see Section 2.10.12, "Reporting Extra 
Items".

3.10.13 Report Wrong Items
Sometimes a customer may report that he did not receive the items that 
were ordered. In such situations you may need to reship the items that 
were ordered and also create a return for the wrong items that were 
delivered. For more information about reporting wrong items, see 
Section 2.10.13, "Reporting Wrong Items".

3.10.14 Report Unexpected Items
Sometimes a customer may report that he did not order for any items 
but has received some items. In such situations you may need to create 
a customer and then create a return for the wrongly shipped items. For 
more information about reporting unexpected items, see 
Section 2.10.14, "Reporting Unexpected Items".

3.10.15 Cancel a Return Order
A customer may want to cancel some of the items or the entire return 
order. The customer may also want to cancel the exchange order 
corresponding to the return order. For more information about canceling 
a return order, see Section 2.10.15, "Canceling a Return Order".
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3.10.16 Creating an Exchange Order
A customer may want exchange items to be created for the items that 
are being returned. In such situations, you need to create an exchange 
order for the corresponding return order. For more information about 
creating an exchange order, see Section 2.10.16, "Creating an Exchange 
Order".

3.10.17 Changing Return Method
Sometimes a customer may want to change the fulfillment method of a 
return order. For more information about changing the return method, 
see Section 2.10.17, "Changing Return Method".

3.11 Performing Order Print Tasks
A customer may visit a store to either place an order or make some 
modifications to an existing order, which may result in some payment 
changes. In such situations, you must issue an order slip of the 
transaction to the customer.

The following print tasks are performed in the Sterling Store application:

Printing Order Creation or Summary Slips

Printing Change Order Slips

Printing Return Order and Exchange Order Slips

3.11.1 Printing Order Creation or Summary Slips
Whenever you confirm a draft order, you must issue the customer an 
Order Sales Slip that has a snapshot of the order. Typically, the snapshot 
displays order lines and payment details.

When you confirm a draft order, the Order Sales Slip is automatically 
printed. You can also select Print Order task under Order to print the 
Order Sales Slip. This slip provides the order summary information.

The order can also be printed by selecting the 'Print Order' related task 
from the Order Summary screen.

For more information about configuring payment options, see the 
Sterling Call Center and Sterling Store: Implementation Guide.
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3.11.2 Printing Change Order Slips
Whenever you make changes to an existing order that results in payment 
modifications, a Change Order Slip is generated based on how the print 
options are configured in Sterling Call Center and Sterling Store. A 
change order slip can be automatically printed, never printed, or the user 
can be prompted to print the change order slip. Payment modifications 
include: order cancellation, adding a coupon, increase in the order line 
quantity, changes in the fulfillment options, and so forth.

3.11.3 Printing Return Order and Exchange Order Slips
When a customer returns items to a store, the Return Order Slip is 
printed, which provides payment information about the returned items. If 
the customer requests an exchange of the items, an Exchange Order Slip 
is printed, which provides payment information about the exchanged 
order.

3.11.3.1 Printing Return Order Without Exchange Order Slips
If payment is handled externally to Sterling Call Center and Sterling 
Store, the Return Order Confirmation screen is displayed:

This screen is displayed only if payment is handled externally. For field 
value descriptions, see Table 3–2, "Return Order Without Exchange Order 
Slip Screen".

Table 3–2 Return Order Without Exchange Order Slip Screen

3.11.3.2 Printing Return Order With Exchange Order Slips
If payment is handled externally to Sterling Call Center and Sterling 
Store, the Return Order Confirmation screen is displayed:

This screen is displayed only if payment is handled externally. For field 
value descriptions, see Table 3–3, "Return Order With Exchange Order 
Slip Screen".

Field Description

Print and Close Choose this button to save any notes to the order, print 
the order, and close the order tab.

Cancel Order Choose this button to cancel the order.
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Table 3–3 Return Order With Exchange Order Slip Screen

3.12 Performing Alert and Queue Management 
Tasks

The Alert Management task enables you to create, resolve, and assign 
alerts to users. Typically, alerts are either raised by the system or 
manually created. The alert can be assigned to specific users or queues. 
The Alert and Queue Management task also provides an alert statistics 
report. This report provides visibility to alerts that are assigned to a 
specific user or queue. For more information about performing alert 
tasks, see Section 2.11, "Performing Alert and Queue Management 
Tasks".

3.13 Performing Announcement Tasks
The Announcement task enables users to post messages and other useful 
information pertaining to other users. Announcements can be created for 
specific user groups. Users who belong to a user group that has the 
necessary permission can create, view, and cancel announcements. For 
more information about announcements, see Section 2.12, "Performing 
Announcement Tasks".

3.14 Setting User Preferences
The Sterling Call Center and Sterling Store application enables you to 
configure user preferences such as display of alert notifications, 
additional help messages, keyboard shortcuts, customer message panel, 
scratch pad, position of related tasks, CSR Message/Customer Message 
panel, For more information about setting user preferences, see 
Section 2.13, "Setting User Preferences".

Field Description

Print and Close Choose this button to save any notes to the order, print 
the order, and close the order tab.

Cancel Order Choose this button to cancel the order.
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3.15 Viewing the Documentation Library
Sterling Call Center and Sterling Store enables you to access the product 
documentation library to view all the Sterling Call Center and Sterling 
Store application documents. Based on the configuration, either the 
Online Documentation Library or the Local Documentation Library is 
displayed. For more information about the documentation library, see 
Section 2.14, "Viewing the Documentation Library".

3.16 Performing Reports Tasks
Sterling Call Center and Sterling Store provides rich functionality to 
generate reports such as cross sell reports, CSR reports, and price match 
reports.

To view reports, from Tasks > Reports, select View My Reports. The My 
Reports screen is displayed. Click the YCD-Analytics hyperlink. The list of 
reports which can be generated is displayed.

3.16.1 Cognos 8 Business Intelligence Toolbar
This section describes the Cognos 8 Business Intelligence toolbar that 
appears in the Sterling Call Center and Sterling Store report. For more 
information about cognos business intelligence, see Section 2.15.1, 
"Cognos 8 Business Intelligence Toolbar".

3.16.2 Cross Sell Reports
Call Center Managers and Store Managers may need information about 
the cross sales performance of the call center or store. This report 
provides information about the best cross selling items. This report also 
allows you to compare the average cross sell revenue per order for a 
given period with the previous period. For more information about cross 
sell reports, see Section 2.15.2, "Cross Sell Reports".

3.16.3 CSR Reports
Call Center Managers and Store Managers may need to track information 
about the number of sales and revenue generated by a particular CSR or 
store associate. This report provides visibility into the number of sales, 
total cross sell, revenue generated, and alerts resolved during a specific 
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period of time. For more information about CSR reports, see 
Section 2.15.3, "CSR Reports".

3.16.4 Price Match Reports
Pricing Analysts and Product Managers may need information about the 
items that are frequently price matched, competitor against who the 
items are frequently priced matched etc. For more information about 
price match reports, see Section 2.15.4, "Price Match Reports".

3.17 Performing In-Store Pick up Tasks
This section explains how to perform pick up tasks.

Performing an Advanced Shipment Search

Performing Backroom Pick

Performing Undo Backroom Pick

Performing Customer Pick

Printing Pick Ticket

3.17.1 Performing an Advanced Shipment Search
The Sterling Store application provides the advanced shipment search 
task to search for shipments which need to be picked up by the customer 
from the current store.

To perform an advanced shipment search:

1. From Tasks > In-Store Tasks, select Advanced Shipment Search. The 
Shipment search screen is displayed.

2. Enter the appropriate search criteria and click Search. The search 
results are displayed in the Search Results panel. If you cannot find 
the right shipment, click  icon to show the search criteria. You can 
enter more restrictive search criteria for the selected task.

3. You can view details about the records being retrieved at the bottom 
of the screen. Click the Get More Records hyperlink to retrieve more 
records. If the search criteria specified results in a single page of 
records or if you are viewing the last page of records, the Get More 
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Records hyperlink is not displayed, instead the message "No More 
Records" is displayed.

The total number of records is displayed based on pagination rules 
configured. Click the Get Total Record Count hyperlink to view the 
total number of records returned for the search criteria.

4. Double-click the appropriate shipment record. The Shipment Details 
screen is displayed. For more information about viewing shipment 
details, see Section 3.17.1.1, "Viewing Shipment Details".

3.17.1.1 Viewing Shipment Details
In the Shipment Details screen you can view the details of a shipment 
such as the shipment number, status of the shipment.

In the Shipment Details panel, you can view the shipment number, 
status of the shipment, service, seller, ship node and the number of 
containers in the shipment.

In the Ship To Address panel, you can view the ship to address to 
where the shipment is sent.

In the Bill To Address panel, you can view the details of the 
customer’s address.

In the Shipment Lines in this Shipment panel, you can view the items 
included in the shipment, quantity, unit price of the item and the 
order number corresponding to the shipment line.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 

Note: While retrieving the records, if any sorting or 
filtering is applied, the following message is displayed: 
"New records have been returned to a table that has been 
sorted or filtered. As a result, the new records have been 
inserted into the table based on the existing sort or filter 
criteria. All new records are highlighted." You can select 
the Don't notify me again box, not to display the message 
again. 
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components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

From the shipment details screen, you can perform any of the store 
tasks such as backroom pick, undo backroom pick, customer pick and 
print pick ticket.

Click Close.

3.17.2 Performing Backroom Pick
A customer or a gift recipient may visit a store to pick up the items that 
were ordered. You may want to move the inventory to the customer pick 
area from where the customer can pick up the items.

To perform backroom pick:

1. From Tasks > In-Store Tasks, select Backroom Pick. The Shipment 
Search screen is displayed.

2. Enter the shipment number and click Search.

3. In the Shipment Details panel, you can view the order number, the 
date the store was notified on, shipment number, and the name of 
the customer.

4. In the Scan Item panel, scan the barcode of the item or the alternate 
item. The last scanned item is displayed in the Last Scanned Item 
field.

Note: If the shipment number is not valid, an error 
message "Enter a valid shipment number" is displayed.

Note: If the status of a shipment does not allow you to 
perform a backroom pick, the message "Shipment cannot 
be backroom picked in the current status" is displayed.
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5. In the Items to be picked panel, you can view the item description, 
quantity to pick, and UOM. Enter the quantity you want to pick in the 
Quantity column.

6. Click Next. If the backroom pick is completed, the message 
"Backroom Pick is successful" is displayed. If there is a shortage, the 
Backroom Pick: Shortage Resolution screen is displayed.

In the Shortage Resolution panel:

Select the Shortage Resolution Applies To All Lines option, if the 
shortage resolution is the same for all lines. Select the Inventory 
Shortage option if the reason for shortage is inventory shortage. 
Select the Will pick the items later option if the customer wants to 
pick up the items at a later time.

Select the Shortage Resolution Varies Line By Line option for 
selecting a shortage resolution for each line. In the Shortage 
Resolution column select the resolution from the drop-down list.

7. Click the Previous button to revisit the previous screen.

8. Click Confirm.

3.17.3 Performing Undo Backroom Pick
Sterling Store enables you to undo a back room pick. To undo a 
backroom pick you must first search for a shipment. For more 
information about searching for a shipment, see Section 3.17.1, 
"Performing an Advanced Shipment Search".

To perform an undo backroom pick:

1. From Tasks > In-Store Tasks, select Undo Pick. The Undo Pick screen 
is displayed.

Note: You can only undo backroom pick for a complete 
shipment line or an entire shipment.

If the backroom picked quantity is zero for all shipments 
lines, the message "No shipment line is available for undo 
pick" is displayed.
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2. In the Undo Pick panel, select the Undo Pick for entire shipment 
option, to undo pick of the complete shipment.

3. Select the Undo Pick for specific items option, to undo pick of 
individual lines and select the lines for which you want to perform an 
undo pick.

4. In the Shipment Lines in this Shipment panel, you can view the items 
included in the shipment, the order number corresponding to the 
shipment line, shipment quantity and quantity available for undo 
backroom pick.

5. In the Notes panel, you can add notes for the undo backroom pick 
activity. For more information about viewing or adding notes to an 
order, see Section 3.3.12, "Adding Notes to an Order".

6. Click Confirm.

3.17.4 Performing Customer Pick
A customer or a gift recipient may visit a store to pick up the items that 
were ordered. In such situations, you may have to verify the 
customer/gift recipient and then record the customer pick.

To perform a customer pick:

1. From Tasks > In-Store Tasks, select Customer Pick. The Shipment 
Search screen is displayed.

2. Enter the appropriate search criteria and click Search. The search 
results are displayed in the Search Results panel. If you cannot find 
the right shipment, click  icon to show the search criteria. You can 
enter more restrictive search criteria for the selected task.

Note: If the shipment is in a status for which you cannot 
undo backroom pick, the message "The shipment cannot 
be picked in the current status" is displayed.

Note: If the shipment is in a status for which you cannot 
perform customer pick, the message "Shipment not ready 
for customer pick" is displayed.
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3. In the Search Results panel, you can view the name of the customer 
or gift recipient, address, order number, the date the store was 
notified on and the status of the shipment. 

4. Double-click the appropriate shipment record. If you entered a credit 
card number as the search criteria, the Choose Item and Quantity to 
pick screen is displayed else the Customer Verification screen is 
displayed. 

5. In the Customer Verification screen,

In the Shipment Details panel, you can view the order number, 
status of the shipment, requested pick date and shipment 
number.

In the Bill To Address panel, you can view the details of the 
customer’s address.

If a gift recipient is picking up the items, you can view the details 
of the gift recipient such as the gift recipient’s first name, last 
name and telephone number in the Gift Recipient Details panel. 

In the Verification Details panel, select a verification type.

In the Notes panel, you can add notes for the customer 
verification activity. For more information about viewing or adding 
notes to an order, see Section 3.3.12, "Adding Notes to an Order".

6. Click Next. The Choose Item and Quantity to pick screen is displayed. 

In the Order Summary panel, you can view the name of the 
customer or name of the gift recipient, order number, the date the 
store was notified on, status of the shipment. 

In the Bill To Address panel, you can view the details of the 
customer's address.

Note: You can configure other verification types to be 
displayed in the Customer Verification screen.

Note: You can use Up and Down arrow keys to navigate 
through the verification types.
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In the Scan Item panel, scan the barcode of the item or the 
alternate item. The last scanned item and quantity are displayed 
in the Last Scanned Item and Last Scanned Quantity fields.

In the Select Items to Pick panel, you can view the item 
description, ordered quantity, picked quantity, UOM, ordered unit 
price and total price.

If the order contains a bundle item, the unit price of the item is 
displayed as a hyperlink. To view the details of the bundle item, click 
the unit price hyperlink. The Component Lines pop-up window is 
displayed. You can view the details of the bundle parent and its 
components such as the quantity, unit price, line total, adjustments, 
and so on.

For more information about handling the pricing strategy defined for 
the bundle item, see Section 2.1.4.3, "Viewing Prices of Bundle 
Items".

7. Click Next. If there is a shortage for some items, the Shortage 
Resolution screen is displayed. 

Select the Customer will pick remaining later due to option, if the 
customer wants to pick the remaining items later. Select 
Inventory Shortage or Customer Preference.

Select the Cancel Remaining option, if the customer wants to 
cancel the remaining items and select the reason for cancellation 
from the drop-down list.

Select the Shortage Resolution varies by line option and select the 
reason for cancellation for each line in the Shortage Resolution 
column.

8. Click Next. The Summary screen is displayed.

In the Item Picked panel, you can view the item description, 
ordered quantity and picked quantity.

In the Items not picked panel, you can view the item description, 
ordered quantity, shortage quantity and the shortage reason.

In the Items Cancelled panel, you can view the item description, 
ordered quantity, cancelled quantity and the cancellation reason.

9. Click the Previous button to revisit the previous screen.

10. Click Confirm.
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3.17.5 Printing Pick Ticket
Sterling Store provides the functionality to print a pick ticket with the 
details of the items to be picked from the backroom area to the customer 
pick area.

To print pick ticket:

1. From Tasks > In-Store Tasks, select Print Pick Ticket. The Print Pick 
Ticket screen is displayed.

2. In the Print Pick Tickets for panel, select the appropriate option.

Select All Shipments pending pick, to print pick ticket for all 
shipments for which pick ticket has not been printed.

Select All Shipments for Order # and enter the order number to 
print pick ticket of all shipments for that order.

Select the Search for Shipments to print pick tickets, to search for 
the shipments for which you want to print pick ticket. In the 
Shipment Search panel, enter the appropriate search criteria and 
click Search. The search results are displayed in the Search 
Results panel. Select the appropriate shipments for which you 
want to print pick ticket.

3. Click Print.

4. To reprint a pick ticket, select the Print Pick Ticket related task from 
the shipment details screen.

3.18 User Security
This section describes how to establish and manage store users. The 
users can change their password, when needed. The store users can 
belong to multiple user groups. A user who belongs to multiple user 
groups retains the least restrictive set of permission defined by the 
groups to which the user belongs.

Note: If configured, an acknowledgement receipt 
summarizing the customer picked items is printed.



User Security

Tasks for a Store Representative   359

The store administrator can change the credentials of the store users 
such as the user groups, user activation, and deactivation. The store 
administrator can also transfer a user from one store to another.

3.18.1 Changing Passwords
You can change your password in this screen.

To change your password:

1. From Tasks > User Security, select Change Password. The Change 
Password screen is displayed.

2. In Old Password, enter your old password.

3. In New Password, enter a new password.

4. In Confirm Password, enter your new password again for 
confirmation.

5. Click Confirm.

3.18.2 Managing Users
This section explains how to modify credentials of the selected user.

Store administrators can search for users, change user credentials, or 
transfer users to another store. Sterling Call Center and Sterling Store 
does not allow users to modify their own credentials. 

3.18.2.1 Searching for Users
You can search for a user and modify their credentials.

To search for a user:

1. From Tasks > User Security, select Manage Users. The Manage Users 
screen is displayed.

2. In the Search Users panel: 

a. In Store, the store name is displayed.

Note: Passwords are case sensitive, and can be any 
combination of printable characters.
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b. In User ID, enter the identifier of the user. You can either enter 
the complete identifier or a part of the identifier.

c. In User Name, enter the name of the user whose status or group 
needs to be changed.

d. In Status:

– Choose Active, if the user is currently an active user.

– Choose Inactive, if the user is currently an inactive user.

3. Click Search.

If only one user is found as a result of your search criteria, the 
Modifying User Details screen is displayed. For more information 
about modifying user credentials, see Section 3.18.2.2, "Modifying 
User Credentials".

If multiple users are found as a result of your search criteria, the 
search results display in the Search Result panel. You can view 
the user identifier, user name, and store details. Select the User 
ID whose credentials you want to modify and click Proceed.

3.18.2.2 Modifying User Credentials
The store administrator can modify credentials for the selected user and 
also assign user groups.

In the User Detail panel, you can view the identifier of the user, user 
name, store details, and the current status of the user.

To change user credentials:

1. In the Change User Credentials panel:

Choose Activate to activate the user.

Click Deactivate to deactivate the user.

2. In the Assign User Groups panel:

To subscribe the user to a user group, select the user group and 
click . 

Note: Both User ID and User Name are case sensitive.
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To unsubscribe the user from a user group, select the user group 
and click .

3. Click Confirm.

3.18.2.3 Transferring Users to a Store
You can transfer a selected user to another store.

To transfer the selected user to another store:

1. From Tasks > User Security, select Transfer Store. The Transfer Store 
screen is displayed.

2. In Transfer <name_of_the_user> to Store, enter the store name. If 
you want to search for a store, click . For more information about 
searching a store, see Section 3.18.2.3.1, "Searching for a Store".

3. Click Confirm.

3.18.2.3.1 Searching for a Store  

You can search for different stores to transfer the users.

To search for a store:

1. In Store #, enter the store number, if applicable.

2. In Store Name, enter the complete store name or a part of the store 
name, if applicable. 

3. In City, enter the complete city name or a part of the city name, if 
applicable. 

4. In State, enter the complete state name or a part of the state name, 
if applicable. 

Note: The user you are transfering must not belong to a 
Team that is specific to a store. If the user belongs to a 
Team, remove the user from the Team before transferring 
the user to a store.
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For example, if you enter the state as California, all stores available in 
California display in the Search Results panel.

5. In Max Records, enter the maximum number of records to be listed 
as a result of your search.

By default, the value entered is 30. 

6. Click Search. The search results display in the Search Result panel.

7. From the Store List panel, select the store to which you want to 
transfer the user. 

8. Click Proceed.

3.19 Launching the IBM Sterling Business Center
Sterling Call Center and Sterling Store enables you to launch the Sterling 
Business Center application from within the Sterling Call Center and 
Sterling Store application. Sterling Business Center provides you with 
access to item and pricing configurations. For example, you may have to 
configure the pricing rules for an organization, or you may have to 
configure catalog entitlements.

You can launch Sterling Business Center from Sterling Call Center and 
Sterling Store only if you belong to a Sterling Call Center and Sterling 
Store user group that has the necessary permissions to access Sterling 
Business Center. 

You can launch Sterling Business Center from the Quick Access screen of 
Sterling Call Center and Sterling Store. Navigate to Tasks, and select 

Note: The Store Name, City, and State fields are case 
sensitive.



Launching the IBM Sterling Business Center

Tasks for a Store Representative   363

Sterling Business Center. The Sterling Business Center home page is 
displayed.

For information about configuring items and pricing in Sterling Business 
Center, see the Sterling Business Center: Pricing Administration Guide 
and the Sterling Business Center: Item Administration Guide.

Note: By default, the Related Tasks panel is hidden when 
Sterling Business Center is launched. To display the 
Related Tasks panel, click the Maximize icon that is located 
at the top right of the Sterling Business Center home page. 
To restore the original view of the Sterling Business Center 
home page, click the Restore icon.
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Notices

This information was developed for products and services offered in the 
U.S.A. 

IBM may not offer the products, services, or features discussed in this 
document in other countries. Consult your local IBM representative for 
information on the products and services currently available in your area. 
Any reference to an IBM product, program, or service is not intended to 
state or imply that only that IBM product, program, or service may be 
used. Any functionally equivalent product, program, or service that does 
not infringe any IBM intellectual property right may be used instead. 
However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject 
matter described in this document. The furnishing of this document does 
not grant you any license to these patents. You can send license 
inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) 
information, contact the IBM Intellectual

Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
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Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or 
any other country where such provisions are inconsistent with 
local law: INTERNATIONAL BUSINESS MACHINES CORPORATION 
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do

not allow disclaimer of express or implied warranties in certain 
transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical 
errors. Changes are periodically made to the information herein; these 
changes will be incorporated in new editions of the publication. IBM may 
make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of 
those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own 
risk. 

IBM may use or distribute any of the information you supply in any way 
it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between 
independently created programs and other programs (including this one) 
and (ii) the mutual use of the information which has been exchanged, 
should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA__95141-1003
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U.S.A. 

Such information may be available, subject to appropriate terms and 
conditions, including in some cases, payment of a fee. 

The licensed program described in this document and all licensed 
material available for it are provided by IBM under terms of the IBM 
Customer Agreement, IBM International Program License Agreement or 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating 
environments may vary significantly. Some measurements may have 
been made on development-level systems and there is no guarantee that 
these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through 
extrapolation. Actual results may vary. Users of this document should 
verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the 
suppliers of those products, their published announcements or other 
publicly available sources. IBM has not tested those products and cannot 
confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM 
products should be addressed to the suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to 
change or withdrawal without notice, and represent goals and objectives 
only.

This information is for planning purposes only. The information herein is 
subject to change before the products described become available. This 
information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples 
include the names of individuals, companies, brands, and products. All of 
these names are ficticious and any similarity to the names and addresses 
used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source 
language, which illustrate programming techniques on various operating 
platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, 
using, marketing or distributing application programs conforming to the 
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application programming interface for the operating platform for which 
the sample programs are written. These examples have not been 
thoroughly tested under all conditions. IBM, therefore, cannot guarantee 
or imply reliability, serviceability, or function of these programs. The 
sample programs are provided "AS IS", without warranty of any kind. 
IBM shall not be liable for any damages arising out of your use of the 
sample programs. 

Each copy or any portion of these sample programs or any derivative 
work, must include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample 
Programs. 
© Copyright IBM Corp. 2011. 

If you are viewing this information softcopy, the photographs and color 
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered 
trademarks of International Business Machines Corp., registered in many 
jurisdictions worldwide. Other product and service names might be 
trademarks of IBM or other companies. A current list of IBM trademarks 
is available on the Web at “Copyright and trademark information” at 
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either 
registered trademarks or trademarks of Adobe Systems Incorporated in 
the United States, and/or other countries.

IT Infrastructure Library is a registered trademark of the Central 
Computer and Telecommunications Agency which is now part of the 
Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel 
Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and 
Pentium are trademarks or registered trademarks of Intel Corporation or 
its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, 
other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks 
of Microsoft Corporation in the United States, other countries, or both.

www.ibm.com/legal/copytrade.shtml
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ITIL is a registered trademark, and a registered community trademark of 
the Office of Government Commerce, and is registered in the U.S. Patent 
and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States 
and other countries.

Java and all Java-based trademarks and logos are trademarks or 
registered trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, 
Inc. in the United States, other countries, or both and is used under 
license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are 
trademarks of HP, IBM Corp. and Quantum in the U.S. and other 
countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, 
Gentran®, Gentran:Basic®, Gentran:Control®, Gentran:Director®, 
Gentran:Plus®, Gentran:Realtime®, Gentran:Server®, 
Gentran:Viewpoint®, Sterling Commerce™, Sterling Information 
Broker®, and Sterling Integrator® are trademarks or registered 
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or 
service marks of others.
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Add Coupon

Confirm Payment screen, 171
Entry screen, 170

Add Multiple Line
Add Items, 64

Add Multiple Lines
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Add Payment Method screen, 174
Advanced Fulfillment Summary, 136

Pick up details, 140
Shipping details, 136

Advanced Order Search screen, 9
Alert Details screen, 247
Alert Search screen, 247
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B
Basic Fulfillment Summary, 131

Pick up details, 133
Shipping details, 131
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bundle items

viewing prices, 28
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adding new contact, 59, 305

C
Change Order Address screen, 151

Change Order Fulfillment Options screen, 321
Change Service Instructions screen, 126
Change Shipment Fulfillment Options screen, 327
Change Tax Options screen, 93
Confirm Payment screen, 74
confirmed orders

re-ordering, 315
Create Alert screen, 245
Customer Appeasement

Select Offer screen, 169
Select Reasons screen, 167

D
draft order, 268
draft orders

copying, 93, 314

E
environment variable

YANTRA_HOME, xx

F
Find User screen, 245, 250
Fulfillment Summary, 131

I
Invoice Details screen, 38
Item Detail screen, 17, 276
Item Details screen, 18, 19, 277
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Item Search screen, 21, 279

L
Line Summary screen, 27, 31, 281, 283
Lines to Reship screen, 152, 330

M
Modify Address screen, 71
More Details Of Selected Item screen, 19
More Details of Selected Item screen, 277

N
Notes

Note Type, 74

O
oportunity

creating new quote, 102
opportunity

copying an existing quote to create a new quote 
and new opportunity, 102

copying an existing quote to create alternative 
quotes, 103

creating, 98
marking the opportunity Lost, 104
modifying, 101
searching, 33
viewing details, 34

Order Line Notes screen, 76
order notes

adding, 75
marking as private, 75
viewing, 74

Order Notes screen, 74
Order Summary screen, 22

viewing price breakdown, 23
orders

adding related items, 60, 305
adding upsell items, 60, 305
e-mailing details to customer, 95, 315

exempting from tax, 93, 314
re-ordering, 94

Override Availability, 328
Override Price for Item screen, 69

P
Payment Inquiry screen, 38
Price Match

Select An Item screen, 154

Q
Quick Access screen, 8, 268
quote

abandon, 124
accept on behalf of a customer, 121
add quote notes, 110
adjust quote line prices, 111
adjust quote price, 111
approvals, 116
convert to order, 123
copy as alternative quote, 115
copy as new quote, 114
creation, 104
generating a proposal, 122
present to a customer, 120
reject on behalf of a customer, 121
rewok quote, 113
searching, 35
view alternate quotes, 115
view or modify problem lines, 116
view quote notes, 110
viewing details, 36

R
Refund Details screen, 178
related items, 60, 61, 306
Removing a Hold on an Order, 78, 309
Reship or Refund screen, 152, 330
Reship Select Item screen, 85
Return/Exchange Details screen, 177
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Store Details popup, 28
Store Details window, 27, 32, 284

T
tasks
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